
Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ce guide décrit la configuration et l’utilisation de la Interchangeable Lens Digital Camera ILME-FR7 / ILME-FR7K.

Consultez ce manuel et le mode d’emploi pour les dispositifs connexes, si nécessaire.

Présentation

Applications d’utilisation courante

Configuration du système

Contrôle d’un seul appareil à l’aide de la télécommande infrarouge fournie

Contrôle d’un seul appareil à l’aide d’une tablette ou d’un ordinateur

Contrôle d’un seul appareil à l’aide d’un pupitre de télécommande externe

Contrôle de plusieurs appareils à l’aide d’un pupitre de télécommande externe

Localisation et fonctions des pièces

Vue de face

Vue arrière

Bloc de connecteur

Vue de côté

Vue du dessus

Vue du dessous

Support d’objectif

Emplacement et fonctions des pièces de la télécommande infrarouge (fournie)

Écran de l’application Web

Présentation de l’écran de l’application Web

Structure des zones communes des écrans

Structure de l’écran d’opération en direct

Structure de l’écran d’opération de lecture

Structure de l’écran des réglages
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Préparatifs

Menu de la caméra

Affichage de l’écran de la caméra

Montage de l’appareil

Montage à la verticale dans un emplacement fixe

Montage à la verticale dans un emplacement élevé et fixe

Montage au plafond

Fixation/retrait d’un objectif

Précautions lors de la fixation/retrait d’un objectif

Vérification des commutateurs d’objectif

Précautions à prendre lors de l’utilisation d’un objectif zoom

Fixation d’un objectif

Retrait d’un objectif

Raccordement des câbles

Connexion de l’appareil à un périphérique réseau via une connexion filaire

Connexion d’une alimentation électrique

Utilisation de l’alimentation CA

Utilisation de l’alimentation PoE++

Réinitialisation de panoramique/inclinaison

Configuration avant la prise de vue

Initialisation de l’appareil à l’aide de l’application Web

Accès à l’application Web depuis un navigateur Web

Initialisation de l’appareil

Configuration des opérations de base

Préparation des cartes mémoire

Cartes mémoire prises en charge

Insertion des cartes mémoire

Éjection d’une carte mémoire
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Prise de vue

Formatage (initialisation) de cartes mémoire

Vérification de la durée d’enregistrement restante

Restauration de cartes mémoire

Fonctionnement de base

Démarrage/arrêt de l’enregistrement

Sélection alternative des cartes mémoire

Vérification de l’audio

Spécification des données temporelles

Passage en revue de l’enregistrement (Rec Review)

Réglage du cadrage

Écran de réglage du cadrage

Réglage de la direction de prise de vue

Réglage de la direction de la prise de vue à l’aide de l’application Web

Réglage de la vitesse d’opération de panoramique/inclinaison

Réglage de l’accélération d’opération de panoramique/inclinaison

Réglage de la direction de la prise de vue à l’aide de la télécommande infrarouge fournie

Réglage du zoom

Réglage du type de zoom

Réglage du zoom à l’aide de l’application Web

Réglage de la vitesse d’opération du zoom

Réglage du zoom à l’aide de la télécommande infrarouge fournie

Sauvegarde/restauration de la position du panoramique/inclinaison/zoom de la caméra (position prédéfinie)

Étalonnage d’un objectif à monture E

Sauvegarde/restauration du panoramique/inclinaison, de la position du zoom et du réglage de mise au point à l’aide de
l’application Web

Renommage des positions prédéfinies à l’aide de l’application Web

Remplacement d’une position prédéfinie sauvegardée par une nouvelle position à l’aide de l’application Web

Suppression d’une position prédéfinie sauvegardée à l’aide de l’application Web

Synchronisation de l’opération de panoramique/inclinaison et de l’opération de zoom/mise au point lors de la restauration d’une
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position prédéfinie

Modification de la vitesse de transition (panoramique-inclinaison/zoom/mise au point) lors de la restauration d’une position
prédéfinie

Sauvegarde/restauration de la position du panoramique/inclinaison et du zoom à l’aide de la télécommande infrarouge fournie

Enregistrement/lecture des opérations de cadrage de la caméra (PTZ Trace)

Enregistrement des opérations de cadrage de la caméra à l’aide de l’application Web

Lecture des opérations de cadrage de la caméra à l’aide de l’application Web

Suppression des opérations de cadrage enregistrées par la caméra à l’aide de l’application Web

Enregistrement des opérations de cadrage de la caméra à l’aide de la télécommande infrarouge fournie

Lecture des opérations de cadrage de la caméra à l’aide de la télécommande infrarouge fournie

Réglage de la mise au point

Écran de réglage de la mise au point

Réglage manuel de la mise au point (Manual Focus)

Réglage manuel à l’aide de l’application Web

Réglage manuel à l’aide de la télécommande infrarouge fournie

Mise au point en spécifiant une position de mise au point (mise au point sur un point)

Utilisation temporaire de la mise au point automatique (Push Auto Focus (AF))

Utilisation de la mise au point automatique à prise de vue unique (Push Auto Focus (AF-S))

Réglage automatique de la mise au point (Auto Focus)

Réglage automatique à l’aide de l’application Web

Réglage automatique à l’aide de la télécommande infrarouge fournie

Réglage de la zone/position de mise au point automatique (zone de mise au point)

Modification rapide de la zone de mise au point (Réglage de mise au point)

Déplacement du cadre de la zone de mise au point par opération tactile (zone de mise au point tactile)

Réglage de l’opération de mise au point automatique par pression (vitesse de transition AF, sensibilité de changement de sujet AF)

Réglage manuel de la cible de mise au point automatique (AF Assist) à l’aide de l’application Web

Mise au point manuelle pendant la mise au point automatique à l’aide de la télécommande infrarouge fournie

Utilisation de la mise au point manuelle lors de la mise au point automatique (Mise au point manuelle par pression)

Suivi à l’aide de la détection des visages/yeux (Face/Eye Detection AF)

Suivi d’un sujet spécifié (Realtime Tracking AF)
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Fonctions utiles

Réglage de la luminosité

Écran de réglage de la luminosité

Réglage de la sensibilité de base

Réglage du niveau cible pour le réglage automatique de la luminosité

Réglage du diaphragme

Réglage automatique du diaphragme

Réglage manuel du diaphragme

Réglage du gain

Réglage automatique du gain

Réglage manuel du gain

Réglage de l’obturateur

Réglage automatique de l’obturateur

Réglage manuel de l’obturateur

Réglage du niveau de luminosité (ND Filter)

À propos du filtre ND

Réglage en mode prédéfini

Réglage automatique en mode variable

Réglage manuel en mode variable

Réglage pour des couleurs naturelles (équilibre des blancs)

Écran de réglage de la balance des blancs

Réglage automatique de la balance des blancs

Réglage manuel de la balance des blancs

Exécution automatique de la balance des blancs

Configuration de l’audio à enregistrer

Écran de configuration audio

Sélection du dispositif d’entrée audio

Réglage automatique du niveau d’enregistrement audio

Réglage manuel du niveau d’enregistrement audio
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Utilisation du menu Direct

Touches personnalisables

Ralenti et accéléré

Enregistrement de la vidéo par intermittence (Interval Rec)

Enregistrement d’images en cache (Picture Cache Rec)

Enregistrement simultané sur les cartes mémoire A et B (2-slot Simul Rec)

Moniteur de signal vidéo

Balises de plan

Compensation de la respiration

Enregistrement du proxy

Présentation de l’enregistrement proxy

Enregistrement d’un proxy

Prise de vue avec l’apparence souhaitée (Look)

Présentation de l’apparence

Sélection d’une apparence

Importation d’une apparence de base souhaitée

Personnalisation d’une apparence (Look)

Enregistrement d’une apparence (Look)

Suppression d’une apparence de base

Prise de vue avec réglage d’apparence en post-production

Prise de vue avec réglage d’apparence en post-production

Application d’un LUT à une sortie HDMI et à une diffusion en continu

Modification d’un LUT

Modification de la distribution de zones sombres et lumineuses dans une image enregistrée

Enregistrement RAW

Enregistrement d’une vidéo au format RAW

Enregistrement en mode ralenti et accéléré d’une vidéo RAW

Ajustement du bokeh (Fonction de contrôle du bokeh)
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Fonctions réseau

Ecran de miniatures

Menu de la caméra et réglages détaillés

Activation/désactivation de la fonction de contrôle du bokeh

Ajustement du degré de bokeh

Enregistrement et chargement des données de configuration

Présentation de l’enregistrement et du chargement des données de configuration

Enregistrement d’un fichier ALL

Chargement d’un fichier ALL

Transfert de fichiers

À propos du transfert de fichiers

Enregistrement d’une destination de transfert de fichiers

Sélection d’un fichier et téléchargement

Téléchargement d’un fichier proxy sur une carte mémoire à partir de l’écran des miniatures

Téléchargement d’un fichier original sur une carte mémoire à partir d’un écran des miniatures

Vérification de l’état du transfert de fichiers

Téléchargement à l’aide d’un FTP sécurisé

Configuration de la diffusion en continu

À propos de la diffusion en continu

Configuration du format pour la diffusion en continu

Configuration du codec vidéo pour la diffusion en continu

Réglage du codec audio pour la diffusion en continu

Démarrage/Arrêt de la diffusion en continu

Ecran de miniatures

Lecture de plans et autres opérations sur les plans

Lecture de plans enregistrés

Opérations sur les plans enregistrés

Configuration du menu de la caméra

Fonctionnement du menu de la caméra
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Fonctionnement du menu de la caméra

Saisie d’une chaîne de caractères

Menu User

User

Menu Edit User

Edit User

Menu Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Menu Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec
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Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Menu Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Menu Pan-Tilt

P/T Acceleration

Menu TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Menu Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker
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Menu Audio

Audio Input

Audio Output

Menu Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Menu Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Menu Network

Wired LAN

File Transfer

Menu Maintenance

Language

Clock Set

Hours Meter

Réglages et valeurs par défaut du menu Shooting
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Menu Web et réglages détaillés

Réglages et valeurs par défaut d’ISO/Gain

Réglages et valeurs par défaut de AGC Limit

Réglages de qualité d’image sauvegardés pour chaque mode de prise de vue

Configuration du menu Web

Opérations du menu Web

Menu Shooting

Focus

Menu Project

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Menu Paint/Look

Base Look

Menu Pan-Tilt

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Menu Monitoring

Output Format

Output Display

Menu Audio
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Audio Input

Audio Output

Menu Technical

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Menu Network

Camera Name

User

Wired LAN

File Transfer

FTP Server 1 à 3

SSL

Referer Check

Brute Force Attack Protection

Menu Stream

Stream

Video Stream

Audio Stream

Menu Maintenance

Language

Accessibility

Clock Set

Reset

Information

System Log
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Connexion de dispositif externe

Annexe

HTTP Access Log

Service

EULA

Software

Connexion des moniteurs externes et des dispositifs d’enregistrement

Connexion d’un RCP/MSU (option)

Connexion d’un RCP/MSU

Connexion un-à-un entre l’appareil et un RCP

Utilisation de l’appareil dans un environnement multi-caméras avec un MSU/logiciel de commande à distance de
la caméra

Listes des fonctions prises en charge

Opération à l’aide d’un pupitre de télécommande RM-IP500 (en option)

À propos des opérations à l’aide du pupitre de télécommande RM-IP500 (en option)

Connexion d’un pupitre de télécommande RM-IP500

Synchronisation avec un dispositif externe

À propos de la synchronisation avec un dispositif externe

Synchronisation de la phase du signal vidéo (Genlock)

Verrouillage du code temporel sur d’autres dispositifs

Connexion d’un microphone externe ou d’un dispositif audio externe

Gestion/Montage de plans à l’aide d’un ordinateur

Sortie d’un signal de fibre optique

Connexion d’un signal tally

Sortie des données de suivi (free-d)

Connexion d’un contrôleur d’objectif

Réglage du zoom à l’aide du contrôleur d’objectif

Précautions d’utilisation

Formats de sortie et limites
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Pour plus d’informations sur la conformité aux lois sur l’accessibilité du Web en France, reportez-vous à la page
suivante.
Accessibilité en France : conformité partielle

5-041-957-23(1) Copyright 2022 Sony Corporation

Dépannage

Avertissements de fonctionnement

Liste des éléments de menu

Éléments enregistrés avec une position prédéfinie

Diagrammes bloc

Mise à jour du logiciel de l’objectif à monture E

Fixation du cache du bouton de déblocage de l’objectif

Licences

Caractéristiques techniques

Marques commerciales

https://helpguide.sony.net/accessibility/france/v1/fr/index.html
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Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Configuration du système

Cet appareil peut être combiné avec des périphériques pour former de nombreuses configurations de système.

Objectif à monture E1.

Adaptateur de monture de type A LA-EA3 / LA-EA42.

Télécommande infrarouge (fournie)3.

Cartes mémoire CFexpress Type A / cartes mémoire SDXC4.

Lecteur de carte CFexpress Type A / lecteur de carte SD5.

Microphone ECM-680S, ECM-678*, ECM-674*6.
Le câble adaptateur XLR EC-0.5X3F5M 3 broches → 5 broches est requis.*

Adaptateur CA (fourni)7.

Moniteur vidéo8.

Pupitre de télécommande RM-IP5009.
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5-041-957-23(1) Copyright 2022 Sony Corporation
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Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Contrôle d’un seul appareil à l’aide de la télécommande infrarouge fournie

Vous pouvez contrôler un seul appareil à distance à l’aide de la télécommande infrarouge fournie.

 Signal vidéo
 Sens du signal

5-041-957-23(1) Copyright 2022 Sony Corporation

Télécommande infrarouge (fournie)1.

Moniteur vidéo2.
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Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Contrôle d’un seul appareil à l’aide d’une tablette ou d’un ordinateur

Vous pouvez connecter une tablette ou un ordinateur à l’appareil, puis contrôler l’appareil à l’aide d’un navigateur Web.

 Signal vidéo
 Signal de télécommande

  Sens du signal

5-041-957-23(1) Copyright 2022 Sony Corporation

Moniteur vidéo1.

Tablette2.

Ordinateur3.

Point d’accès4.
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Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Contrôle d’un seul appareil à l’aide d’un pupitre de télécommande externe

Vous pouvez contrôler l’appareil à distance à l’aide d’un pupitre de télécommande.

 Signal vidéo
 Signal de télécommande

  Sens du signal

5-041-957-23(1) Copyright 2022 Sony Corporation

Moniteur vidéo1.

Pupitre de télécommande RM-IP5002.
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Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Contrôle de plusieurs appareils à l’aide d’un pupitre de télécommande externe

Vous pouvez contrôler jusqu’à 100 appareils à distance à l’aide d’un seul pupitre de télécommande.

 Signal vidéo
 Signal de télécommande
 Signal tally/contact

  Sens du signal

5-041-957-23(1) Copyright 2022 Sony Corporation

Moniteur vidéo1.

Commutateur vidéo2.

Concentrateur Ethernet3.

Pupitre de télécommande RM-IP5004.
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Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vue de face

Cette rubrique décrit l’emplacement et les fonctions des pièces à l’avant de l’appareil.

Astuce

Cette description fait référence à l’illustration de l’appareil sans objectif fixé.

Tête de caméra

Note

Ne soumettez pas la tête de caméra à des chocs importants.

1.

Témoin d’enregistrement/de signalisation
Lorsqu’il est comme un témoin d’enregistrement, le témoin s’allume en rouge lors de l’enregistrement sur une carte
mémoire. Le témoin clignote lorsque l’espace libre restant sur le support d’enregistrement est faible ou lorsqu’une
erreur se produit.

2.
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Pour plus de détails, consultez « Avertissements de fonctionnement ».

Lorsqu’il est configuré comme un témoin de signalisation, le témoin s’allume en rouge ou vert selon le signal tally
externe.

Pour plus de détails, consultez « Connexion d’un signal tally ».
Capteur d’image

Note

Ne touchez pas directement avec vos mains.

3.

Touche de déblocage de l’objectif
Appuyez pour retirer l’objectif.

Pour plus de détails, consultez « Retrait d’un objectif ».

4.

Contacts de signal de l’objectif

Note

Ne touchez pas directement avec vos mains.

5.

Témoin POWER6.

Témoin NETWORK
L’état de l’appareil est indiqué par la combinaison de la couleur de l’affichage de l’état (allumé, clignotant, éteint) du
témoin POWER et du témoin NETWORK.

7.

Témoin POWER Témoin
NETWORK État de l’appareil

Allumé en vert*1
Allumé en vert Sous tension (réseau connecté)

Éteint Sous tension (réseau non connecté)

Clignotant vert Éteint Processus de mise sous tension en cours

Allumé en
orange

Éteint État de veille de l’alimentation électrique

Clignotant jaune Éteint Mise à jour du logiciel en cours

Clignotement
orange lent*2

Clignotement
vert lent*2

L’appareil fonctionne normalement. Pour plus de détails, consultez le journal
du système. Si le problème persiste même après avoir mis l’appareil en
mode veille ou après l’avoir mis hors tension puis à nouveau sous tension,
contactez votre technicien Sony.

Clignotement
orange rapide*3

Clignotement
vert rapide*3

Un dysfonctionnement est survenu dans l’appareil. Contactez votre
technicien Sony.

Clignote en vert lorsqu’une commande est reçue de la télécommande infrarouge fournie.*1

Clignotement lent : clignote une fois par seconde*2

Clignotement rapide : clignote quatre fois par seconde*3

Capteur de télécommande infrarouge
Reçoit le signal de contrôle de la télécommande infrarouge fournie.

8.

Entrée d’air9.
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Rubrique associée

Avertissements de fonctionnement

Connexion d’un signal tally

Retrait d’un objectif

5-041-957-23(1) Copyright 2022 Sony Corporation

Note

N’obstruez pas le flux d’air. Cela pourrait entraîner un dysfonctionnement.
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Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vue arrière

Cette rubrique décrit l’emplacement et les fonctions des pièces à l’arrière de l’appareil.

Rubrique associée

Vue de côté

5-041-957-23(1) Copyright 2022 Sony Corporation

Levier de verrouillage de la tête de caméra
Verrouille le mouvement avant/arrière de la tête de caméra.

Note

Toujours en position de verrouillage lorsque l’objectif n’est pas changé.

Lors du transport de l’appareil, retirez toujours l’objectif et mettez-le en position de verrouillage.

Mettez l’appareil hors tension et verrouillez la tête de caméra à l’horizontale à l’aide du levier de verrouillage de
panoramique/inclinaison avant d’utiliser le levier de verrouillage, pour éviter de vous pincer les doigts. Pour plus de détails
sur le levier de verrouillage de panoramique/inclinaison, consultez « Levier de verrouillage de panoramique/inclinaison »
dans « Vue de côté ».

1.

Base coulissante2.
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Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Bloc de connecteur

Cette rubrique décrit l’emplacement et les fonctions des pièces sur le bloc de connecteur de l’appareil.

Connexion  (terre)
Connectez à la terre en connectant à la borne de mise à la terre d’une prise secteur ou d’une barre de mise à la
terre.

1.

Connecteur DC IN (prise jack CC standard)
Branchez sur un adaptateur CA.

Note

N’utilisez pas d’autre adaptateur CA que celui fourni. Connecter un autre adaptateur peut provoquer un incendie ou un
dysfonctionnement.

2.

Connecteur  LAN (réseau) (RJ-45)
Branchez un câble réseau (catégorie 5e ou supérieure) pour la communication réseau et l’alimentation PoE++*.

État de l’affichage de Speed LED
Indique la vitesse de la connexion réseau.

3.

PoE++ : Power over Ethernet Plus Plus. Conforme à la norme IEEE802.3bt (Type 4 Classe 8). Pour plus de détails sur la connexion,
consultez le mode d’emploi du dispositif d’alimentation.

*
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État de l’affichage Link/ACT LED
Indique l’état de la connexion réseau.

Note

Lorsque vous connectez ce produit à Internet, connectez-le via un système fournissant une fonction de protection, tel qu’un
routeur ou un pare-feu. Si vous vous connectez sans cette protection, des problèmes de sécurité pourraient survenir.

Affichage  Vitesse de connexion

Éteint
Connexion 10 Mbps

Connexion 100 Mbps

Allumé en orange Connexion 1000 Mbps

Affichage  État de connexion

 Éteint Pas de liaison

Clignotant vert Liaison établie, données actives

Allumé en vert Liaison active

Connecteur TC IN
Entrez un signal de code temporel de référence externe.

Pour plus de détails, consultez « Verrouillage du code temporel sur d’autres dispositifs ».

4.

Connecteur HDMI
Émet la vidéo depuis l’appareil comme un signal HDMI.

Pour plus de détails, consultez « Connecteur HDMI (connecteur Type A) » dans « Connexion des moniteurs
externes et des dispositifs d’enregistrement ».

5.

Vis de montage de la plaque de retenue du câble HDMI
Pour empêcher le retrait du câble HDMI, fixez la plaque de retenue du câble HDMI fournie à l’aide de la vis de
montage fournie (M2.6×6), puis fixez le câble HDMI à l’aide d’une attache de câble ou d’un serre-câble.

Pour plus de détails sur la fixation d’une plaque de retenue du câble HDMI, consultez « Raccordement des
câbles ».

6.

Connecteur OPTION
Permet de connecter un signal tally à partir d’un dispositif externe ou d’un contrôleur d’objectif.

Pour plus de détails, consultez « Connexion d’un signal tally » et « Connexion d’un contrôleur d’objectif ».

7.

Serre-câble
Permet de sécuriser le cordon de l’adaptateur CA.

8.

Commutateur RESET
Appuyez pendant au moins 5 secondes à l’aide de la pointe d’un stylo ou d’un dispositif similaire pour réinitialiser les
réglages de l’appareil aux valeurs par défaut.
Vous pouvez sélectionner de réinitialiser les réglages de connexion réseau uniquement ou tous les réglages à l’aide
du commutateur 1 SETUP.

9.

Connecteur de sortie OPTICAL
Émet un signal SDI converti en format optique lorsque le module SFP+ (en option) est connecté.

10.
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Pour plus de détails, consultez « Sortie d’un signal de fibre optique ».
Commutateurs SETUP

Configurez les réglages suivants.
Commutateur 1 : définit les réglages à réinitialiser lorsque le commutateur RESET est enfoncé.

Commutateur 2 : définit si l’alimentation +48 V (alimentation fantôme) est activée ou non lorsque le dispositif
d’entrée audio est connecté. Le réglage est appliqué immédiatement.
Cette fonction est activée lorsque [Audio] > [Audio Input] > [AUDIO IN Select] est réglé sur [MIC] dans le menu de la
caméra.

Note

Régler le commutateur 2 sur la position ON et connecter un microphone qui n’est pas compatible avec une source de +48 V
peut endommager le dispositif connecté. Vérifiez le réglage avant de connecter le dispositif.

Commutateur 3 : active/désactive la communication VISCA over IP. Les réglages sont appliqués lorsque la caméra
est mise sous tension.
Réglez sur la position ON pour utiliser l’appareil lorsqu’il est connecté à un pupitre de télécommande (RM-IP500).

Note

Si le mot de passe administrateur n’a pas été configuré, la communication VISCA over IP est désactivée, quelle que soit le
réglage du commutateur. Pour plus de détails sur la configuration du mot de passe administrateur, consultez « Initialisation
de l’appareil ».

11.

Réglage Description

OFF (par
défaut)

Réinitialise les réglages de connexion réseau uniquement. Les réglages de réseau, de sécurité et
les informations utilisateur (nom d’utilisateur et mot de passe) de l’appareil seront réinitialisés.

ON Réinitialise tous les réglages aux valeurs par défaut.

Réglage Description

OFF (par
défaut)

Pas d’alimentation avec +48 V (alimentation fantôme). Configurez ce réglage lors de l’utilisation d’un
dispositif audio externe (comme une console de mixage), microphone dynamique ou microphone
avec batterie intégrée.

ON
Alimentation avec +48 V (alimentation fantôme) à un microphone compatible avec une alimentation
fantôme connecté au connecteur AUDIO IN (CH-1 ou CH-2).

Réglage Description

OFF (par défaut) Ne répondra pas aux commandes VISCA over IP.

ON Accepte les commandes VISCA over IP.
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Rubrique associée

Verrouillage du code temporel sur d’autres dispositifs

Connexion des moniteurs externes et des dispositifs d’enregistrement

Raccordement des câbles

Connexion d’un signal tally

Connexion d’un contrôleur d’objectif

Sortie d’un signal de fibre optique

Initialisation de l’appareil

Synchronisation de la phase du signal vidéo (Genlock)

Connexion d’un microphone externe ou d’un dispositif audio externe

5-041-957-23(1) Copyright 2022 Sony Corporation

Commutateur 4 : modifie la vitesse d’opération de panoramique/inclinaison envoyées depuis la télécommande
infrarouge. Le réglage est appliqué immédiatement.

Réglage Description

OFF (par défaut) Fonctionne à vitesse normale.

ON Fonctionne à vitesse maximale.

Connecteur SDI OUT
Émet la vidéo depuis l’appareil comme un signal 12G/6G/3G/HD-SDI.
L’appareil peut également être configuré pour la sortie du signal RAW.

Pour plus de détails, consultez « Connecteur SDI OUT (Type BNC) » dans « Connexion des moniteurs externes
et des dispositifs d’enregistrement ».

12.

 Capteur de la télécommande infrarouge (arrière)
Capteur infrarouge de la télécommande infrarouge fournie.

13.

Ventilateur/sortie d’air
Émet de la chaleur depuis l’intérieur de l’appareil.

Note

Ne couvrez pas la sortie d’air. Cela pourrait entraîner un dysfonctionnement.

Notez que la zone à proximité de la sortie d’air peut chauffer.

14.

Connecteur GENLOCK
Permet d’émettre un signal de synchronisation externe.

Pour plus de détails, consultez « Synchronisation de la phase du signal vidéo (Genlock) ».

15.

Connecteur AUDIO IN (Connecteur 5 broches type XLR)
Permet d’émettre le signal d’un microphone externe ou dispositif audio.
Il fonctionne comme un connecteur AUDIO IN CH-1 ou AUDIO IN CH-2.

Pour les détails, consultez « Connexion d’un microphone externe ou d’un dispositif audio externe ».

16.
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Vue de côté

Cette rubrique décrit l’emplacement et les fonctions des pièces sur le côté de l’appareil.

Astuce

Cette description fait référence à l’illustration de l’appareil sans objectif fixé.

Levier de verrouillage de panoramique/inclinaison
Verrouille les mécanismes de panoramique/inclinaison de l’appareil. Utilisez dans les cas suivants.

Lors du transport ou emballage de l’appareil.
Lors de la fixation ou du retrait d’un objectif. Pour plus de détails, consultez « Fixation d’un objectif » ou « Retrait
d’un objectif ».
Lors de l’utilisation d’un objectif qui ne prend pas en charge les opérations de panoramique/inclinaison (comme
les objectifs Sony SEL100400GM / SEL200600G / SEL400F28GM / SEL600F40GM).
Lors du transport de l’appareil, retirez toujours l’objectif et mettez-le en position de verrouillage.

1.
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Rubrique associée

Fixation d’un objectif

Retrait d’un objectif

Insertion des cartes mémoire

Accès à l’application Web depuis un navigateur Web

5-041-957-23(1) Copyright 2022 Sony Corporation

Astuce

Le mouvement de panoramique/inclinaison peut être réglé sur les angles suivants.

Base coulissante2.

Orifices de vis pour dispositifs externes (4 emplacements)
Pour les vis M3 de 6 mm (1/4 po) au maximum.

Note

N’utilisez pas de vis d’une longueur supérieure à 6 mm (1/4 po). Cela pourrait entraîner un dysfonctionnement.

3.

Témoin d’accès A4.

Témoin d’accès B
L’indicateur est allumé ou clignote lorsque le support d’enregistrement est inséré.

Pour plus de détails, consultez « Insertion des cartes mémoire ».

5.

Logement de carte CFexpress Type A / SD (A)6.

Logement de carte CFexpress Type A / SD (B)
Permet d’insérer le support d’enregistrement.

Pour plus de détails, consultez « Insertion des cartes mémoire ».

7.

Code QR pour la connexion réseau
Permet de configurer les réglages initiaux.

Pour plus de détails, consultez « Accès à l’application Web depuis un navigateur Web ».

8.
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Vue du dessus

Cette rubrique décrit l’emplacement et les fonctions des pièces sur le dessus de l’appareil.

Astuce

Cette description fait référence à l’illustration de l’appareil sans objectif fixé.

5-041-957-23(1) Copyright 2022 Sony Corporation

Orifices de vis pour dispositifs externes (2 emplacements)
Compatible avec les vis 1/4-20 UNC pour un trépied.
Longueur maximale de 6 mm (1/4 po).

1.

ɸ (repère d’imageur)
Le repère d’imageur se trouve au même niveau que le capteur d’image.
Pour mesurer la distance entre l’appareil et le sujet de manière précise, utilisez ce repère d’imageur comme point de
référence.

2.
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Vue du dessous

Cette rubrique décrit l’emplacement et les fonctions des pièces sur le dessous de l’appareil.

Astuce

Cette description fait référence à l’illustration de l’appareil sans objectif fixé.

Orifices de vis de montage du support de plafond (6 emplacements, profondeur effective du filetage de
5,5 mm (7/32 po))
Lors du montage de l’appareil au plafond ou sur une étagère dans un emplacement élevé, fixez le support du boîtier
(en option) à la base de l’appareil à l’aide des six vis de montage du support de boîtier dans ces orifices de vis.

Pour plus de détails sur le montage, consultez « Montage à la verticale dans un emplacement élevé et fixe » et
« Montage au plafond ».

1.

Vis de montage de trépied (2 emplacements)
Utilisé lors du montage de l’appareil sur un trépied de caméra (en option, vis 1/4-20 UNC d’une longueur maximale
de 5,5 mm (7/32 po)).

2.
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Rubrique associée

Montage à la verticale dans un emplacement élevé et fixe

Montage au plafond
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Note

N’utilisez pas de vis d’une longueur supérieure à 5,5 mm (7/32 po). Cela pourrait entraîner un dysfonctionnement.
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Support d’objectif

Cette rubrique décrit l’emplacement et les fonctions des pièces du support d’objectif de l’appareil.

Astuce

Cette description fait référence à l’illustration de l’appareil sans objectif fixé.

Tige du support d’objectif (2)
Prend en charge l’objectif.
Peut également être utilisé pour le montage général d’accessoires à tige Ø15.

1.

34



5-041-957-23(1) Copyright 2022 Sony Corporation

Unité de support d’objectif
Le support d’objectif peut glisser vers l’avant/l’arrière selon l’objectif puis être fixé fermement.

2.

Vis de fixation de la base du support d’objectif
Fixez à la base du support d’objectif. Vous pouvez ajuster la vis vers le haut/bas pour qu’elle corresponde à la
hauteur de la base du support d’objectif.

3.

Levier de serrage de la tige du support d’objectif (2 emplacements)
Sécurise la position avant/arrière de l’unité de support d’objectif.

4.

Levier de serrage de la vis de fixation de la base du support d’objectif
Sécurise la position verticale de la vis de fixation de la base du support d’objectif.

Astuce

Si le levier de serrage est difficile à tourner en raison de sa position, relâchez le levier de serrage et tournez-le à un angle qui
facilite l’opération. Une fois dans la position souhaitée, fermez le levier de serrage.

A : levier de serrage de la vis de fixation de la base du support d’objectif
B : levier de serrage de la tige du support d’objectif

Note

Pour empêcher l’unité de support d’objectif d’interférer avec l’opération de panoramique/inclinaison, déplacez l’unité de
support d’objectif contre la tête de caméra lorsque vous n’utilisez pas l’unité de support d’objectif, puis déplacez la vis de
fixation de la base du support d’objectif dans la position la plus haute (la plus proche de l’objectif).

5.
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Emplacement et fonctions des pièces de la télécommande infrarouge (fournie)

Cette rubrique décrit l’emplacement et les fonctions des pièces de la télécommande infrarouge (fournie).

Touche REC● (enregistrement START/STOP)
Appuyez sur cette touche pour démarrer ou arrêter l’enregistrement.

1.

Touche MENU
Appuyez sur cette touche pour afficher ou masquer le menu de la caméra.

2.

Touches de commande GUI
Appuyez sur ces touches pour réaliser des opérations dans le menu de la caméra, dans les dialogues de message
qui incluent des touches et d’autres fonctions d’affichage d’écran.

3.

Touche CANC./BACK
Appuyez sur cette touche pour annuler un réglage ou pour revenir à l’écran précédent du menu de la caméra de
l’appareil.

4.
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Pile de la télécommande infrarouge

La télécommande infrarouge nécessite deux piles AA (LR6).
Insérez les piles dans la télécommande infrarouge comme indiqué dans le schéma suivant.

Touches de commande de panoramique et inclinaison
Appuyez sur les touches fléchées pour commander le panoramique/inclinaison de la caméra. Appuyez sur la touche
HOME pour remettre l’orientation de la caméra vers l’avant.

5.

Touches de commande de positions prédéfinies
Appuyez et maintenez la touche PRESET et appuyez sur les touches de 1 à 3 pour mémoriser l’orientation, le zoom,
le réglage de mise au point de la caméra dans la touche numérotée correspondante.
Appuyez sur une touche numérotée avec les réglages mémorisés pour rappeler l’état enregistré.

6.

Touches de commande de mise au point
Permet d’ajuster la mise au point.
Pour ajuster automatiquement la mise au point, appuyez sur la touche AF.
Pour ajuster manuellement la mise au point, appuyez sur la touche MF, puis appuyez soit sur la touche F (éloigné)
pour une mise au point sur des sujets éloignés, soit sur la touche N (rapproché) pour une mise au point sur des
sujets proches.

7.

Touches personnalisables 1 à 3
Exécute les fonctions attribuées aux touches personnalisables à l’aide du menu de la caméra.
Si vous attribuez la fonction [Direct Menu] à une touche personnalisable, vous pouvez ajuster l’exposition, la balance
des blancs et d’autres réglages à l’aide des touches de commande GUI.

Pour plus de détails sur l’attribution à l’aide du menu de la caméra, consultez « Touches personnalisables ».

Pour plus de détails sur le menu direct, consultez « Utilisation du menu Direct ».

8.

Touche  (alimentation)
Appuyez sur cette touche pour mettre l’appareil sous tension ou pour régler l’alimentation sur l’état de veille.

9.

Touche THUMBNAIL
Affiche l’écran des miniatures montrant les plans enregistrés sur la carte mémoire de l’appareil.

Pour plus de détails sur l’écran des miniatures, consultez « Ecran de miniatures ».

Vous pouvez sélectionner les plans et contrôler la lecture sur l’écran des miniatures à l’aide des touches de
commande GUI.

Pour plus de détails sur la sélection de plans et le contrôle de la lecture, consultez « Lecture de plans
enregistrés » et « Opérations sur les plans enregistrés ».

10.

Touche SLOT SEL (sélection du logement de carte mémoire (A)/(B))
Lorsque deux cartes mémoire sont insérées, appuyez sur la touche pour basculer entre les cartes mémoire pour
l’enregistrement.
Appuyez sur cette touche pendant l’affichage de l’écran des miniatures pour basculer entre les cartes mémoire à
visualiser.

11.

Touche P/T RESET (réinitialisation de panoramique/inclinaison)
Réinitialise les fonctions de panoramique/inclinaison. Appuyez sur la touche lorsque le témoin POWER et le témoin
NETWORK clignotent simultanément ou lorsque [Execute Pan-Tilt Reset] est affiché dans le panneau de commande
du cadrage de l’application Web.

12.

Touches de commande de zoom
Pour effectuer un zoom avant, appuyez sur la touche T (téléobjectif).
Pour effectuer un zoom arrière, appuyez sur la touche W (grand angle).

13.
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Note

N’utilisez pas d’autres piles que celles au manganèse ou alcalines car elles pourraient éclater.

Mettez les piles usagées au rebut conformément aux lois et règlements du pays ou de la région.

Rubrique associée

Touches personnalisables

Utilisation du menu Direct

Ecran de miniatures

Lecture de plans enregistrés

Opérations sur les plans enregistrés

5-041-957-23(1) Copyright 2022 Sony Corporation
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Présentation de l’écran de l’application Web

En connectant une tablette ou un ordinateur, les opérations de panoramique/inclinaison, zoom, enregistrement, lecture
de vidéos enregistrées et configuration de l’appareil sont possibles depuis un navigateur Web (ci-après, cette fonction
s’appelle « application Web »).

Pour plus de détails sur le lancement de l’application Web, consultez « Accès à l’application Web depuis un
navigateur Web ».

Note

L’application Web ne prend pas en charge la sortie audio de la caméra.

Lorsque l’application Web se lance, l’écran d’opération en direct suivant apparaît.

Écran d’opération en direct

Pour plus de détails sur l’écran d’opération en direct, consultez « Structure de l’écran d’opération en direct ».
Les touches et les icônes communes à l’écran d’opération en direct et à l’écran d’opération de lecture sont affichées
en haut de l’écran.
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Pour plus de détails sur les zones communes des écrans, consultez « Structure des zones communes des écrans ».
Vous pouvez commuter entre les écrans en appuyant sur les onglets de commutation de l’écran dans la zone
commune.

Écran d’opération de lecture

Appuyez sur l’onglet [Playback] pour afficher l’écran d’opération de lecture.

Pour plus de détails sur l’écran d’opération de lecture, consultez « Structure de l’écran d’opération de lecture ».

Écran des réglages

Appuyez sur l’onglet [Settings] pour afficher l’écran des réglages (ci-après désigné comme le menu Web).
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Note

Dans le menu Web, les réglages ne sont appliqués que lorsque vous appuyez sur la touche [OK]. Si vous modifiez les réglages
sur une page qui dispose d’une touche [OK], veillez à appuyer sur la touche [OK].

Pour plus de détails sur l’écran des réglages, consultez « Structure de l’écran des réglages ».
Dans ce manuel d’aide, l’écran des réglages de l’application Web est appelé le menu Web.

Rubrique associée
Accès à l’application Web depuis un navigateur Web

Structure de l’écran d’opération en direct

Structure des zones communes des écrans

Structure de l’écran d’opération de lecture

Structure de l’écran des réglages

5-041-957-23(1) Copyright 2022 Sony Corporation
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Structure des zones communes des écrans

Cette rubrique décrit la structure de la zone commune des écrans.

Nom de caméra
Affiche le nom de caméra.
Vous pouvez modifier le nom à l’aide de [Network] > [Camera Name] dans le menu Web.
La couleur d’arrière-plan change selon le signal tally externe.

1.

Commutateur d’alimentation
Lorsque l’appareil est mis sous tension, [Power ON] est affiché. Vous pouvez appuyer sur le commutateur et
sélectionner [Power Standby] pour régler l’alimentation de l’appareil sur l’état de veille.
Lorsque [Power Standby] est affiché, vous pouvez appuyer sur le commutateur et sélectionner [Power ON] pour
allumer l’alimentation de l’appareil.

2.

Onglets de commutation des écrans d’opération
Appuyez sur un onglet pour afficher l’écran d’opération correspondant.
Onglet [Live] : affiche l’écran d’opération en direct.
Onglet [Playback] : affiche l’écran d’opération de lecture.
Onglet [Settings] : affiche l’écran des réglages (menu Web).

3.

Repère de notifications
Lors de la réception d’un message, l’indication de repère change comme indiqué ci-dessous.

 (Notifications activées)
Prenez les actions nécessaires selon le message affiché dans le panneau d’image de la caméra.

Note

Les messages ne sont pas affichés lorsque [Monitoring] > [Output Display] > [HDMI/Stream] est réglé sur [Off] dans le menu
Web. Réglez sur [On] pour vérifier les contenus des messages.

4.

Touche  (État de la caméra)
Appuyez sur la touche pour afficher les informations du signal de l’image enregistrée par la caméra/de l’image de
sortie, les informations sur l’objectif et l’état du contrôleur d’objectif (option) sur un autre écran.

5.
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Lorsqu’une notification liée au contrôleur d’objectif (option) se produit, l’indication change comme indiqué ci-dessous.

Commutateur de verrouillage des opérations sur l’écran
 (Opération déverrouillée) : sélectionnez le commutateur sur la position de gauche pour contrôler les opérations

sur l’écran d’opération en direct et l’écran d’opération de lecture.
 (Opération verrouillée) : sélectionnez le commutateur sur la position de droite pour verrouiller les opérations sur

l’écran d’opération en direct et l’écran d’opération de lecture afin d’empêcher toute mauvaise utilisation accidentelle.

6.
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Structure de l’écran d’opération en direct

Cette rubrique décrit la structure de l’écran d’opération en direct.

Panneau de commande de position prédéfinie
Affiche la position enregistrée d’un préréglage à l’aide d’une miniature. Appuyez deux fois sur la miniature pour
retourner à la position mémorisée dans le préréglage.

Pour plus de détails sur la position prédéfinie, consultez « Sauvegarde/restauration du panoramique/inclinaison,
de la position du zoom et du réglage de mise au point à l’aide de l’application Web ».
Pour plus d’informations sur PTZ Trace, consultez « Enregistrement des opérations de cadrage de la caméra à
l’aide de l’application Web ».

1.

Panneau d’image de la caméra
Affiche l’image de la caméra actuelle et l’état de l’appareil.
Il affiche la même image que la sortie HDMI.
L’état suivant est affiché au-dessus de l’image. Un cadre rouge ou vert s’affiche également autour de l’image selon le
signal tally externe reçu.

2.
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Touche [Display]
Appuyez sur cette touche pour afficher les informations de la caméra sur l’image.
Appuyez à nouveau lorsque les informations de la caméra sont affichées pour les masquer.

En plus des repères, les indicateurs liés à la mise au point automatique et les messages sont affichés selon l’état, et
ils ne peuvent pas être masqués en appuyant sur la touche [Display].

Pour plus de détails sur les informations de la caméra affichée, consultez « Affichage de l’écran de la caméra ».

N° Affichage Description

2-
1

Indicateur de mode de mise au point
Consultez « Indicateur de mode de mise au point » dans
« Affichage de l’écran de la caméra ».

2-
2

Mode d’enregistrement, logement A/B,
indicateur d’intervalle d’enregistrement
Interval Rec

Consultez « Mode d’enregistrement, logement A/B, indicateur
d’intervalle d’enregistrement Interval Rec » dans « Affichage de
l’écran de la caméra ».

2-
3

Indicateur d’état de la diffusion en continu
Affiché pendant la diffusion en continu (uniquement lorsque
[Stream Setting] est réglé sur [RTMP] ou [SRT-Caller]).

2-
4

Indicateur d’état de fonctionnement de la
sortie RAW

Affiche l’état de sortie du signal RAW. Pour plus de détails sur
RAW, consultez « Enregistrement d’une vidéo au format
RAW ».

2-
5

Indicateur de capacité restante du support
Consultez « Indicateur de capacité restante du support » dans
« Affichage de l’écran de la caméra ».

2-
6

Indicateur de position du zoom

Consultez « Indicateur de position du zoom » dans « Affichage
de l’écran de la caméra ».
Lorsqu’un contrôleur d’objectif (option) est connecté, 
s’affiche. Si une erreur se produit dans le contrôleur d’objectif
(option),  s’affiche.

2-
7

Indicateur du mode AE/niveau AE
Consultez « Indicateur du mode AE/niveau AE » dans
« Affichage de l’écran de la caméra ».
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Touche d’arrêt AF de suivi en temps réel
Appuyez sur la touche pour arrêter de suivre un sujet.

Pour plus de détails, consultez « Suivi d’un sujet spécifié (Realtime Tracking AF) ».
Touche d’enregistrement START/STOP
Appuyez sur la touche pour démarrer l’enregistrement. Pendant l’enregistrement, la touche d’enregistrement
START/STOP s’allume en rouge.
Appuyez sur la touche pendant l’enregistrement pour arrêter l’enregistrement.
Vous pouvez régler le commutateur de maintien sur l’état Hold pour empêcher toute utilisation accidentelle de la
touche d’enregistrement START/STOP.

3.

Panneau de configuration de base de la caméra
Affiche les réglages des fonctions de base requis pour la prise de vue sur les touches. Appuyez sur une touche pour
afficher l’écran de configuration correspondant pour chaque fonction dans le panneau de réglage de configuration de
base de la caméra ci-dessous (5).

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Pour plus de détails, reportez-vous à la description de chaque fonction.

4.

Fonction Référence

FPS « Ralenti et accéléré »

ISO/Gain
« Réglage de la sensibilité de base », « Réglage automatique du gain » et « Réglage manuel du
gain » dans « Réglage du gain »

Exposure
Index

« Réglage de la sensibilité de base » et « Modification de la distribution de zones sombres et
lumineuses dans une image enregistrée »

Shutter
« Réglage automatique de l’obturateur » et « Réglage manuel de l’obturateur » dans « Réglage de
l’obturateur »

Iris
« Réglage automatique du diaphragme » et « Réglage manuel du diaphragme » dans « Réglage
du diaphragme »

ND Filter « À propos du filtre ND » dans « Réglage du niveau de luminosité (ND Filter) »
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Fonction Référence

Scene File
« Présentation de l’apparence » et autres rubriques dans « Prise de vue avec l’apparence
souhaitée (Look) »

Base
Look/LUT

« Prise de vue avec réglage d’apparence en post-production »

White
Balance

« Écran de réglage de la balance des blancs »

Panneau de réglage de configuration de base des touches personnalisables/de la caméra
Affiche les touches personnalisables pendant un fonctionnement normal. Appuyez sur les touches du panneau de
configuration de base de la caméra (élément 4) pour afficher les éléments de configuration correspondants. Appuyez
sur la touche [X] ou appuyez à nouveau sur la touche du panneau de configuration de la caméra pour revenir à
l’affichage des touches personnalisables.

Pour les détails sur les touches personnalisables, consultez « Touches personnalisables ».
Pour plus de détails sur le panneau de réglage de configuration de base de la caméra, consultez la description de
chaque fonction.

5.

Panneau de commande de cadrage / panneau de commande GUI
Basculez entre le panneau de commande de cadrage / panneau de commande GUI à l’aide des onglets en haut.
Vous pouvez appuyer sur la touche  (Fermer) en haut à droite de l’écran pour masquer le panneau de commande
afin d’éviter toute opération accidentelle. Si le panneau de commande ne s’affiche pas, appuyez sur la touche 
(Ouvrir) pour l’afficher.
Utilisez le panneau de commande de cadrage pour ajuster le cadrage. Appuyez sur l’onglet  (Panoramique-
inclinaison/zoom) pour afficher le panneau de commande de cadrage.

Pour plus de détails sur le fonctionnement, consultez « Réglage du cadrage ».

Astuce

La manette de commande du panneau de commande du cadrage est affichée comme indiqué ci-dessous lorsque l’opération
de panoramique/inclinaison est désactivée et lorsque l’initialisation de panoramique/inclinaison est requise.

Lorsque l’opération de panoramique/inclinaison est verrouillée à l’aide du levier de verrouillage de panoramique/inclinaison

6.
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Lorsque l’opération de panoramique/inclinaison n’est pas initialisée

Lorsque l’opération de panoramique/inclinaison doit être réinitialisée

Lorsque l’opération de panoramique/inclinaison est désactivée

Lorsque l’opération de panoramique/inclinaison n’est pas initialisée ou doit être réinitialisée, vous pouvez rapidement accéder
à la touche  (Réinitialisation de panoramique/inclinaison) dans le panneau de commande de la caméra en appuyant
sur le message affiché sous la manette de commande.

Utilisez le panneau de commande GUI pour actionner le menu de la caméra, lire un plan et d’autres fonctions.
Appuyez sur l’onglet  (GUI caméra) pour afficher le panneau de commande GUI.
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Pour plus de détails sur le fonctionnement, consultez « Fonctionnement du menu de la caméra » et « Lecture de
plans enregistrés ».

Panneau de commande de la caméra
Utilisez pour configurer les fonctions requises pour faire fonctionner la caméra.
Basculez entre les écrans à afficher à l’aide des onglets en haut.
Vous pouvez appuyer sur la touche  (Fermer) en haut à droite de l’écran pour masquer le panneau de commande
afin d’éviter toute opération accidentelle. Si le panneau de commande ne s’affiche pas, appuyez sur la touche 
(Ouvrir) pour l’afficher.

Pour plus de détails, consultez la description de chaque fonction.

Onglet  (Main)
Affiche les éléments de configuration pour les fonctions fréquemment utilisées.
Les fonctions de curseur supérieur et inférieur peuvent être modifiées en appuyant sur la touche [▼] puis en
sélectionnant dans la liste affichée. Les fonctions suivantes peuvent être sélectionnées.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

Onglet  (Focus)

7.

Affiché selon les réglages de menu.*
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Affiche les éléments de configuration liés à la mise au point.

Onglet  (Audio)

Affiche les éléments de configuration liés à l’audio.

Onglet  (Stream)
Affiche les éléments de configuration liés à la diffusion en continu.
Les éléments affichés varient selon le réglage du format de la diffusion en continu.
Avec le réglage sur [RTMP] ou [SRT-Caller], la diffusion en continu peut être démarrée/arrêtée sur cet écran.

Pour plus de détails, consultez « À propos de la diffusion en continu » et d’autres rubriques dans « Configuration
de la diffusion en continu ».
Les informations d’erreur s’affichent en cas d’échec de la connexion. Pour plus de détails sur les informations
d’erreur, consultez « Avertissements de fonctionnement ».
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Rubrique associée

Sauvegarde/restauration du panoramique/inclinaison, de la position du zoom et du réglage de mise au point à l’aide
de l’application Web

Enregistrement des opérations de cadrage de la caméra à l’aide de l’application Web

Affichage de l’écran de la caméra

Enregistrement d’une vidéo au format RAW

Suivi d’un sujet spécifié (Realtime Tracking AF)

Onglet  (Others)
Affiche les éléments de configuration liés aux autres fonctions.

Appuyer sur la touche [Full Screen Display] permet d’ouvrir un nouvel onglet dans le navigateur Web et d’afficher
l’image du panneau d’image de la caméra en plein écran.
Seul l’affichage de l’image se produit ; la fonction de touche AF et d’autres fonctions ne sont pas disponibles.

Note

L’écran d’opération en direct sur l’onglet original continue de fonctionner. Il est recommandé de fermer l’onglet pour réduire le
nombre de connexions simultanées si aucune opération n’est requise.

Appuyez sur la touche  (Initialiser le contrôleur d’objectif) pour initialiser le contrôleur d’objectif (option
de tiers). Cette touche est activée uniquement lorsque [Technical] > [Lens Controller] > [Zoom] > [Setting] est réglé
sur [On] dans le menu de la caméra.
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Ralenti et accéléré

Réglage de la sensibilité de base

Réglage automatique du gain

Réglage manuel du gain

Modification de la distribution de zones sombres et lumineuses dans une image enregistrée

Réglage automatique de l’obturateur

Réglage manuel de l’obturateur

Réglage automatique du diaphragme

Réglage manuel du diaphragme

À propos du filtre ND

Présentation de l’apparence

Prise de vue avec réglage d’apparence en post-production

Écran de réglage de la balance des blancs

Touches personnalisables

Lecture de plans enregistrés

Fonctionnement du menu de la caméra

À propos de la diffusion en continu

Avertissements de fonctionnement

5-041-957-23(1) Copyright 2022 Sony Corporation
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Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Structure de l’écran d’opération de lecture

Cette rubrique décrit la structure de l’écran d’opération de lecture.

Panneau d’image de la caméra
Affiche l’image de lecture et les informations connexes. Lorsque la lecture est arrêtée, l’écran d’image de la caméra
apparaît.

1.
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1-1 Date et heure de la prise de vue
1-2 Indicateur de l’état de lecture
1-3 Indicateur de format de lecture (taille d’image)
1-4 Indicateur de format de lecture (codec)
1-5 Affichage des noms de plans
1-6 Numéro de plan/nombre total de plans
1-7 Affichage du nom de LUT
1-8 Indicateur d’état de la diffusion en continu
1-9 Indicateur de format de lecture (fréquence d’images et méthode de balayage)
1-10 Indicateur d’apparence d’enregistrement

Panneau de commande de lecture

Affiche les touches de commande de lecture.

Touche [Display]
Appuyez pour basculer entre les affichages d’écran sur l’image.
Touche [Thumbnail]
Affiche les plans enregistrés sur la carte mémoire sur le panneau d’image de la caméra comme miniatures.

2.

Touche Fonction

Touche  (Lecture/Pause) Lit un plan. Pendant la lecture, met en pause le plan.

Touche  (Lecture accélérée avant), Touche
 (Lecture accélérée arrière)

Lit un plan à une vitesse élevée. Lorsque la touche est
enfoncée, la vitesse de lecture change en trois étapes.

Touche  (Suivant), Touche 
(Précédent)

Passe au début du plan ou au plan précédent/suivant.

Touche  (Arrêt) Arrête la lecture.
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Rubrique associée

Ecran de miniatures

Touches personnalisables

Lecture de plans enregistrés

5-041-957-23(1) Copyright 2022 Sony Corporation

Appuyez sur la touche [Thumbnail] durant l’affichage de l’écran des miniatures ferme l’écran des miniatures et revient
à l’affichage de l’image de la caméra.

Pour plus de détails sur l’écran des miniatures, consultez « Ecran de miniatures ».

Touche [Slot Select]
Bascule entre les supports de lecture cible.

Touches personnalisables
Affiche les touches personnalisables attribuées aux fonctions de l’appareil.

Pour les détails sur les touches personnalisables, consultez « Touches personnalisables ».

3.

Panneau de commande GUI
Utilisez le panneau de commande GUI pour actionner le menu de la caméra, lire un plan et d’autres fonctions.

Pour plus de détails sur le fonctionnement, consultez « Fonctionnement du menu de la caméra » et « Lecture de
plans enregistrés ».

4.
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Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Structure de l’écran des réglages

Utilisez l’écran des réglages pour configurer les différents éléments de configuration de l’appareil, y compris les réglages
initiaux, réglages réseau, réglages de prise de vue/lecture, à l’aide du menu Web.

Note

Dans le menu Web, les réglages ne sont appliqués que lorsque vous appuyez sur la touche [OK] en règle générale. Si vous
modifiez les réglages sur une page qui dispose d’une touche [OK], veillez à appuyer sur la touche [OK].

Pour plus de détails sur l’écran des réglages, consultez « Menu Web et réglages détaillés ».

5-041-957-23(1) Copyright 2022 Sony Corporation

56



Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Menu de la caméra

Appuyez sur la touche [Menu] dans le panneau de commande GUI de l’écran d’opération en direct ou de l’écran
d’opération de lecture pour afficher le menu de la caméra dans le panneau d’image de la caméra.

Vous pouvez configurer les réglages requis pour la prise de vue et la lecture à l’aide du menu de la caméra.
Appuyez sur la touche [Menu] lorsque le menu de la caméra est affiché pour masquer le menu de la caméra.
Le menu de la caméra fonctionne à l’aide du panneau de commande GUI.

Pour plus de détails sur le menu de la caméra, consultez « Menu de la caméra et réglages détaillés ».

Note

Lorsque [Monitoring] > [Output Display] > [HDMI/Stream] est réglé sur Off dans le menu Web (désactive la superposition
d’informations sur l’affichage d’écran), le menu de la caméra n’est plus affiché dans le panneau d’image de la caméra.
Néanmoins, notez que les opérations du menu dans le panneau de commande GUI sont toujours actives. Pour éviter toute
opération accidentelle, veillez à ne réaliser aucune opération de menu à l’aide du panneau de commande GUI lorsque
[HDMI/Stream] est réglé sur Off.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Affichage de l’écran de la caméra

Vous pouvez afficher l’état et les réglages de l’appareil superposés sur l’image de sortie de la caméra. Vous pouvez
régler les sorties pour lesquelles l’affichage d’écran est activé à l’aide de [Monitoring] > [Output Display] dans le menu
Web.
Vous pouvez afficher/masquer ces informations en utilisant la touche [Display]. Même masquées, elles s’affichent
lorsque vous effectuez des opérations de menu direct.
Vous pouvez afficher/masquer les éléments individuellement à l’aide de [Monitoring] > [Display On/Off] dans le menu de
la caméra.

Informations affichées sur l’écran pendant la prise de vue

Indicateur de téléchargement/indicateur de fichiers restants

Pour plus de détails sur le transfert de fichiers, consultez « À propos du transfert de fichiers » et d’autres
rubriques dans « Transfert de fichiers ».

1.

Indicateur de zone de mise au point
Affiche la zone de mise au point pour la mise au point automatique.

Pour plus de détails sur la mise au point automatique, consultez « Réglage automatique à l’aide de l’application
Web » et d’autres rubriques dans « Réglage automatique de la mise au point (Auto Focus) ».

2.

Mode d’enregistrement, logement A/B, indicateur d’intervalle d’enregistrement Interval Rec

Pour plus de détails sur l’enregistrement à intervalles, consultez « Enregistrement de la vidéo par intermittence
(Interval Rec) ».

3.

Affichage Signification

●Rec Enregistrement

Stby Veille d’enregistrement
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Indicateur de profondeur de champ4.

Indicateur du mode de numérisation par imageur
Un repère  (défaut de concordance) s’affiche s’il y a un défaut de concordance entre la taille du cercle d’image de
l’objectif et le réglage en vigueur de taille d’image pour le mode de numérisation par imageur.
Lorsque Imager Scan Mode est réglé sur FF, un repère « C » s’affiche dans les modes où l’angle de vue est plus
étroit (recadré).
Le recadrage survient dans les modes suivants.

Lorsque le format d’enregistrement est 3840×2160 et que la fréquence d’images de S&Q Motion est de 100 fps
ou 120 fps
Lorsque [Codec] est réglé sur RAW ou RAW & XAVC-I et que le format de sortie RAW est de 3840×2160
Pour plus de détails sur le mode de numérisation par imageur, consultez « Réglage du mode de numérisation par
imageur » dans « Configuration des opérations de base ».

5.

Indicateur d’état de fonctionnement de la sortie RAW
Affiche l’état de sortie du signal RAW.

Pour plus de détails sur RAW, consultez « Enregistrement d’une vidéo au format RAW ».

6.

Indicateur de fréquence d’images de prise de vue en ralenti et accéléré

Pour plus de détails sur le ralenti et accéléré, consultez « Ralenti et accéléré ».

7.

Indicateur de position de mise au point

Affiche la position de mise au point.

8.

Indicateur de mode de mise au point

AF de détection des visages/yeux

Pour plus de détails sur l’AF de détection des visages/yeux, consultez « Suivi à l’aide de la détection des
visages/yeux (Face/Eye Detection AF) ».

9.

Affichage Signification

Focus Hold Mode Focus Hold

MF Mode MF

AF Mode AF

 (Mode AF de suivi en temps réel) Mode AF de suivi en temps réel

Affichage Signification

 (AF de détection des visages/yeux) Indique que l’AF pour les visages/yeux est actif

 (AF pour les visages/yeux uniquement) Indique que l’AF pour les visages/yeux uniquement est actif

 (visage de suivi enregistré) Indique qu’un visage de suivi a été enregistré

 (AF mis en pause) Indique que l’AF est en pause*

Affiché lorsqu’il n’y a aucun visage de suivi enregistré et aucun visage détecté, ou lorsqu’il y a un visage de suivi enregistré, mais le visage
de la cible de suivi n’est pas détecté.

*
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Indicateur de position du zoom
Affiche la position du zoom dans une plage de 0 (grand angle) à 99 (téléobjectif) (si un objectif prenant en charge
l’affichage de la position du zoom est fixé).
Vous pouvez également changer l’indicateur à un affichage de barre ou un affichage de distance focale à l’aide du
réglage [Technical] > [Lens] > [Zoom Position Display] dans le menu de la caméra.
Les éléments suivants sont ajoutés à l’affichage lorsque Clear Image Zoom est activé.

Pour plus de détails sur le zoom, consultez « Réglage du type de zoom » et d’autres rubriques dans « Réglage
du zoom ».

10.

Affichage Signification

 (Clear Image Zoom activé) Clear Image Zoom est activé

Valeur d’agrandissement Lors de l’utilisation de Clear Image Zoom

Indicateur de mode de stabilisation d’image11.

Indicateur d’état Rec Control de la sortie SDI/sortie HDMI
Affiche le statut de sortie du signal de contrôle REC.

Pour plus de détails, consultez « Connexion des moniteurs externes et des dispositifs d’enregistrement »

12.

Indicateur de mise au point

Pour plus de détails, consultez « Utilisation de la mise au point automatique à prise de vue unique (Push Auto
Focus (AF-S)) » dans « Réglage de la mise au point ».

13.

Indicateur de capacité restante du support
L’icône  (protection) apparaît si une carte mémoire est protégée en écriture.

14.

Indicateur du mode de balance des blancs15.

Affichage Signification

 (ATW) Mode automatique

 (ATW Hold) Mode automatique en pause

W:P Mode prédéfini

W:A Mode de mémoire A

Indicateur de verrouillage externe du code temporel/affichage des données temporelles
Affiche « EXT-LK » en cas de verrouillage sur le code temporel d’un dispositif externe.

Pour plus de détails sur le code temporel, consultez « Spécification des données temporelles ».

16.

Indicateur de filtre ND17.

Affichage Signification

 (A) Mode automatique

 (B) Mode de contrôle du bokeh
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Pour plus de détails sur les filtres ND, consultez « Réglage du niveau de luminosité (ND Filter) ».
Pour plus de détails sur le contrôle du bokeh, consultez « Ajustement du bokeh (Fonction de contrôle du
bokeh) ».

Indicateur de fichier de scène

Pour plus de détails sur les fichiers de scène, consultez « Présentation de l’apparence » et d’autres rubriques
dans « Prise de vue avec l’apparence souhaitée (Look) ».

18.

Indicateur de diaphragme
Affiche la position du diaphragme (valeur F) (si un objectif prenant en charge l’affichage du réglage du diaphragme
est fixé).

Pour plus de détails sur le diaphragme, consultez « Réglage automatique du diaphragme » et « Réglage manuel
du diaphragme ».

19.

Indicateur d’avertissement du niveau de vidéo20.

Indicateur de gain
Affiche la valeur EI en mode Cine EI/Cine EI Quick.

Pour plus de détails sur le gain, consultez « Réglage automatique du gain » et « Réglage manuel du gain ».
Pour plus de détails sur le mode Cine EI/Cine EI Quick, consultez « Réglage du mode de prise de vue » dans
« Configuration des opérations de base ».

21.

Affichage Signification

 (A) Mode automatique

L Mode de préréglage L

 (Mode d’ajustement provisoire) Mode d’ajustement provisoire

 (B) Mode de contrôle du bokeh

Affichage des noms de plans
Affiche le nom du plan en cours d’enregistrement ou à enregistrer ensuite.
S’il clignote, cela signifie qu’il n’y a pas de correspondance entre le dernier plan sur le support d’enregistrement et les
réglages [Camera ID] ou [Reel Number]. Pour plus de détails, reportez-vous à la description [Clip Name Format] >
[Auto Naming].

22.

Indicateur d’obturateur

Pour plus de détails sur l’obturateur, consultez « Réglage automatique de l’obturateur » et « Réglage manuel de
l’obturateur ».

23.

Indicateur du mode AE/niveau AE

Pour plus de détails sur l’exposition automatique (AE), consultez « Réglage du niveau cible pour le réglage
automatique de la luminosité ».

24.

Indicateur de niveau à bulle
Affiche le niveau horizontal en incréments de ±1° à ±15°.

25.

Vumètre audio
Affiche le niveau audio de chaque canal.

26.

Moniteur de signal vidéo27.
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Informations affichées sur l’écran pendant la lecture

Les informations suivantes sont superposées sur l’image de lecture.

Affiche une forme d’onde, un vecteurscope et un histogramme.
La ligne orange indique la valeur définie du repère du niveau de luminosité.
En modes de prise de vue Log, le type de LUT cible du moniteur s’affiche en haut de l’écran.

Pour plus de détails, consultez « Moniteur de signal vidéo ».
Pour plus de détails sur les modes de prise de vue Log, consultez « Réglage du mode de prise de vue » dans
« Configuration des opérations de base ».

Indicateur Base Sensitivity / indicateur Base ISO
En mode Custom, cela affiche la sensibilité de base réglée à l’aide de la touche [ISO/Gain / Exposure Index] dans le
panneau de configuration de base de la caméra ou [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] dans le menu de la
caméra.
En mode de prise de vue Log, cela affiche la sensibilité Base ISO réglée à l’aide de la touche [ISO/Gain / Exposure
Index] dans le panneau de configuration de base de la caméra ou [Shooting] > [ISO/Gain/EI] > [Base ISO] dans le
menu de la caméra.

Pour plus de détails sur la sensibilité de base, consultez « Sélection de la sensibilité de base ».
Pour plus de détails sur les modes de prise de vue Log, consultez « Réglage du mode de prise de vue » dans
« Configuration des opérations de base ».

28.

Indicateur de surveillance de l’apparence
En modes de prise de vue Log, il affiche le réglage Monitor LUT.

Pour plus de détails sur le réglage LUT, consultez « Prise de vue avec réglage d’apparence en post-production »
et les rubriques associées.
Pour plus de détails sur les modes de prise de vue Log, consultez « Réglage du mode de prise de vue » dans
« Configuration des opérations de base ».

29.

Indicateur d’apparence d’enregistrement/Base Look
Affiche le réglage Base Look.
En modes de prise de vue Log, il affiche le signal vidéo à enregistrer sur les cartes mémoire.

Pour plus de détails sur l’apparence de base, consultez « Présentation de l’apparence » dans « Prise de vue
avec l’apparence souhaitée (Look) ».
Pour plus de détails sur les modes de prise de vue Log, consultez « Réglage du mode de prise de vue » dans
« Configuration des opérations de base ».

30.

Indicateur d’état proxy31.

Indicateur de format d’enregistrement (codec)
Affiche le nom du format pour l’enregistrement sur des cartes mémoire.
Réglez le format d’enregistrement (codec) à l’aide de [Project] > [Rec Format] > [Codec] dans le menu Web ou le
menu de la caméra.

32.

Indicateur de format d’enregistrement (fréquence d’images et méthode de balayage)33.

Indicateur du format d’enregistrement (taille d’image)
Affiche la taille d’image pour l’enregistrement sur des cartes mémoire.
Réglez le format d’enregistrement (taille de l’image) à l’aide de [Project] > [Rec Format] > [Codec] dans le menu Web
ou le menu de la caméra.

34.

Indicateur tally
Affiche un cadre rouge ou un cadre vert autour de l’image selon le signal tally externe reçu.

35.
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Rubrique associée

À propos du transfert de fichiers

Réglage automatique à l’aide de l’application Web

Enregistrement de la vidéo par intermittence (Interval Rec)

Configuration des opérations de base

Enregistrement d’une vidéo au format RAW

Ralenti et accéléré

Indicateur de téléchargement/indicateur de fichiers restants1.

Numéro de plan2.

Indicateur d’état de la lecture3.

Indicateur de format de lecture (fréquence d’images et méthode de balayage)4.

Indicateur de format de lecture (taille d’image)5.

Indicateur de format de lecture (codec)6.

Indicateur de support
L’icône  (protection) apparaît si une carte mémoire est protégée en écriture.

7.

Affichage de données temporelles8.

Affichage des noms de plans9.

Indicateur d’aide pour l’affichage gamma10.

Vumètre audio
Affiche le niveau audio de lecture.

11.

Indicateur d’apparence d’enregistrement/Base Look12.

Indicateur tally13.
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Suivi à l’aide de la détection des visages/yeux (Face/Eye Detection AF)

Réglage du type de zoom

Connexion des moniteurs externes et des dispositifs d’enregistrement

Utilisation de la mise au point automatique à prise de vue unique (Push Auto Focus (AF-S))

Spécification des données temporelles

Présentation de l’apparence

Réglage automatique du diaphragme

Réglage manuel du diaphragme

Réglage automatique du gain

Réglage manuel du gain

Réglage automatique de l’obturateur

Réglage manuel de l’obturateur

Réglage du niveau cible pour le réglage automatique de la luminosité

Moniteur de signal vidéo

Prise de vue avec réglage d’apparence en post-production

Clip Name Format

5-041-957-23(1) Copyright 2022 Sony Corporation
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Montage à la verticale dans un emplacement fixe

Cette rubrique décrit le montage de l’appareil sur un bureau ou un trépied.

Remarque sur l’installation
Pour protéger l’objectif et le bloc de connecteur d’objectif de l’appareil, gardez le capuchon et couvercle de l’objectif
fixé jusqu’à ce que vous ayez fixé l’objectif.
Pour éviter une défaillance de l’objectif, ne tenez pas les pièces de l’objectif pendant l’opération.
Pour éviter une défaillance de l’objectif, ne tenez pas la tête de caméra pendant l’opération.

Vérifiez l’espace de montage.

Lors du montage sur un bureau
Montez cet appareil sur une surface plane, prenez en considération l’espace requis pour tourner l’objectif et le câble
à l’arrière de l’appareil.

Note

Montez-le dans un emplacement stable qui n’est pas sujet aux vibrations. Les emplacements sujets aux vibrations peuvent
provoquer des vibrations dans l’image.

Si l’appareil doit être monté sur une surface inclinée, gardez-le à ±15° de l’horizontale et prenez les mesures nécessaires
pour empêcher l’appareil de tomber.

Lors du montage sur un trépied
Fixez le trépied dans l’orifice de vis de montage de trépied en bas.
Utilisez une vis de montage de trépied avec la saillie suivante de la surface de montage et serrez-la avec un
tournevis à main.

A : vis de montage de trépied, 1/4-20 UNC, ISO 1222 (6,35 mm)

1
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Ensuite, fixez l’objectif. Consultez « Fixation d’un objectif », en prenant en compte les informations de « Précautions lors
de la fixation/retrait d’un objectif », « Vérification des commutateurs d’objectif », et « Précautions à prendre lors de
l’utilisation d’un objectif zoom ».

Rubrique associée

Précautions lors de la fixation/retrait d’un objectif

Vérification des commutateurs d’objectif

Précautions à prendre lors de l’utilisation d’un objectif zoom

Fixation d’un objectif

5-041-957-23(1) Copyright 2022 Sony Corporation

B : saillie (4,5 mm à 5,5 mm)

N’utilisez pas les vis de trépied pour le montage de l’appareil dans des emplacements élevés.

Note

Sélectionnez un trépied qui ne bascule pas même lorsque l’objectif tourne.
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Montage à la verticale dans un emplacement élevé et fixe

Cette rubrique décrit la procédure de montage de l’appareil à la verticale dans un emplacement élevé à l’aide du support
de plafond (CIB-PCM1 (en option)).

Pour monter l’appareil dans un emplacement élevé, contactez un professionnel.
Lors du montage dans un emplacement élevé, assurez-vous que la surface de montage et le matériel de montage
(sans les accessoires) peuvent supporter un poids de 200 kg (440 lb 15 oz ) ou plus, puis montez l’appareil comme
décrit dans ce manuel d’aide. Si le montage n’est pas suffisamment solide, l’appareil risque de tomber et de
provoquer des blessures graves.
Fixez le câble métallique antichute fourni au support de plafond CIB-PCM1 (en option) pour empêcher l’appareil de
tomber.
Lorsque l’appareil est monté dans un emplacement élevé, vérifiez au moins une fois par an que le montage reste
bien en place. Réduisez l’intervalle entre les contrôles selon les conditions d’utilisation.

Remarque sur l’installation
Pour protéger l’objectif et le bloc de connecteur de l’objectif de l’appareil, laissez le capuchon de l’objectif et le
couvercle jusqu’à la fixation de l’objectif.
Pour éviter une défaillance de l’objectif, ne tenez pas les pièces de l’objectif pendant l’opération.
Pour éviter une défaillance de l’objectif, ne tenez pas la tête de caméra pendant l’opération.

Vérifiez les accessoires de montage en hauteur et l’espace de montage.

Support de plafond CIB-PCM1 (en option)
Avant de commencer, vérifiez que vous disposez des pièces suivantes.

Support de boîtier (1)
Support de fixation au plafond (1)
Cache du bouton de déblocage de l’objectif (1)
Câble métallique antichute (1)
Vis +PSW M3×8 (9)
Vis en acier inoxydable pour câble métallique antichute +PSW M4×8 (1)

1
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Note

Le câble métallique antichute est conçu pour supporter l’appareil lorsqu’il est suspendu. N’appliquez aucune charge autre
que la charge de l’appareil à celui-ci.

Espace de montage
Référez-vous au dessin suivant lorsque vous déterminez l’emplacement de montage et la direction, en prenant en
considération l’espace requis pour tourner l’objectif et le câble à l’arrière de l’appareil.

A : plage de déplacement de la tête de caméra (par ex. SEL70200GM2 (muni de SEL20TC) : Ø370)
B : support de plafond (orifice sur le côté de la surface de montage (Ø150))
C : orifice d’alignement de montage

Note

Montez-le dans un emplacement stable qui n’est pas sujet aux vibrations. Les emplacements sujets aux vibrations peuvent
provoquer des vibrations dans l’image.

Si l’appareil doit être monté sur une surface inclinée, gardez-le à ±15° de l’horizontale et prenez les mesures nécessaires
pour empêcher l’appareil de tomber.

Faites glisser le levier de verrouillage de panoramique/inclinaison en position LOCK pour verrouiller le
panoramique/inclinaison de la tête de caméra.

2

68



Note

Si le panoramique/inclinaison de la tête de caméra ne se verrouille pas lorsque le levier de verrouillage est en position
LOCK, déplacez la tête de caméra manuellement jusqu’à ce qu’elle se verrouille en position.

Fixez le support de boîtier au bas de l’appareil à l’aide de six vis fournies (M3×8).3
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Utilisez les vis fournies. L’utilisation de vis autres que celles fournies peut endommager le produit ou l’intérieur de
l’appareil.

Fixation du câble métallique antichute au support de boîtier.4
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A : câble métallique fourni　
B : vis cruciforme fournie (M4×8)
C : boucle métallique de câble métallique

Utilisez la vis fournie. L’utilisation d’une vis autre que celle fournie peut réduire l’efficacité de la fonction du câble
métallique.

Fixez le support de plafond sur la surface, comme une étagère, où l’appareil sera monté.5
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A : mur　
B : repère △ (avant de la caméra)
C : orifice pour les câbles de connexion
D : étagère ou autre surface de montage

Fixez le câble métallique antichute à un point à proximité de la surface de montage.

Utilisez une vis à tête à six pans creux M5 (3/16 po) (en option) et fixez-la à un objet à proximité de l’étagère ou de
la surface à laquelle est fixé le support de plafond.

6
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A : câble métallique　
B : vis à tête à six pans creux (M5, 3/16 po)

Alignez l’orifice de vis 〇 à l’avant du support de boîtier avec l’orifice ◇ du support de plafond, insérez
l’appareil et fixez temporairement le support de boîtier dans le support de plafond en tournant l’appareil
dans le sens des aiguilles d’une montre.

7
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A : orifice 〇
B : orifice ◇

Fixez le support de boîtier et le support de plafond à l’aide des trois vis de verrouillage de rotation fournies
(M3×8).

8
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Ensuite, fixez l’objectif. Consultez « Fixation d’un objectif », en prenant en compte les informations de « Précautions lors
de la fixation/retrait d’un objectif », « Vérification des commutateurs d’objectif », et « Précautions à prendre lors de
l’utilisation d’un objectif zoom ».

Note

Après la fixation d’un objectif, vérifiez que l’objectif est bien fixé.
L’objectif ne dispose d’aucune protection contre la chute. Sony peut n’assumer aucune responsabilité résultant d’une chute de
l’objectif de l’appareil.

Rubrique associée
Précautions lors de la fixation/retrait d’un objectif

Vérification des commutateurs d’objectif

Précautions à prendre lors de l’utilisation d’un objectif zoom

Fixation d’un objectif

Vérifiez l’état de montage.

En particulier, vérifiez les éléments suivants. 

Les vis de montage sont correctement fixées.
Le câble métallique antichute est correctement fixé et n’est pas tordu.
L’appareil est monté sur surface plane (sans inclinaison ou oscillation).
L’appareil ne pivote pas librement lorsqu’il est tourné.

9
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Montage au plafond

Cette rubrique décrit la procédure pour le montage de l’appareil au plafond à l’aide de support de plafond (CIB-PCM1 (en
option)).

Pour monter l’appareil au plafond, contactez un installateur professionnel.
Lors du montage sur un plafond, assurez-vous que la surface de montage et le matériel de montage (sans les
accessoires) peuvent supporter un poids de 200 kg (440 lb 15 oz) ou plus, puis montez l’appareil comme décrit dans
ce manuel d’aide. Si le montage n’est pas suffisamment solide, l’appareil risque de tomber et de provoquer des
blessures graves.
Fixez le câble métallique antichute fourni au support de plafond CIB-PCM1 (en option) pour empêcher l’appareil de
tomber.
Lorsque l’appareil est monté sur un plafond, vérifiez au moins une fois par an que le montage reste bien en place.
Réduisez l’intervalle entre les contrôles selon les conditions d’utilisation.

Remarque sur l’installation
Pour protéger l’objectif et le bloc de connecteur de l’objectif de l’appareil, laissez le capuchon de l’objectif et le
couvercle jusqu’à la fixation de l’objectif.
Pour éviter une défaillance de l’objectif, ne tenez pas les pièces de l’objectif pendant l’opération.
Pour éviter une défaillance de l’objectif, ne tenez pas la tête de caméra pendant l’opération.

Vérifiez les accessoires de montage pour plafond et l’espace de montage.

Support de plafond CIB-PCM1 (en option)
Avant de commencer, vérifiez que vous disposez des pièces suivantes.

Support de boîtier (1)
Support de fixation au plafond (1)
Cache du bouton de déblocage de l’objectif (1)
Câble métallique antichute (1)
Vis +PSW M3×8 (9)

1
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Vis en acier inoxydable pour câble métallique antichute +PSW M4×8 (1)

Note

Le câble métallique antichute est conçu pour supporter l’appareil lorsqu’il est suspendu. N’appliquez aucune charge autre
que la charge de l’appareil à celui-ci.

Espace de montage
Référez-vous au dessin suivant lorsque vous déterminez l’emplacement de montage et la direction, en prenant en
considération l’espace requis pour tourner l’objectif et le câble à l’arrière de l’appareil.

A : plage de déplacement de la tête de caméra (par ex. SEL70200GM2 (muni de SEL20TC) : Ø370)
B : support de plafond (orifice sur le côté plafond (Ø150))
C : orifice d’alignement de montage

Note

Montez sur un plafond (tel que le béton) suffisamment résistant.

Pour monter l’appareil sur un plafond suffisamment résistant, fournissez un renforcement suffisant.

Montez-le dans un emplacement stable qui n’est pas sujet aux vibrations. Les emplacements sujets aux vibrations peuvent
provoquer des vibrations dans l’image.

Si l’appareil doit être monté sur une surface inclinée, gardez-le à ±15° de l’horizontale et prenez les mesures nécessaires
pour empêcher l’appareil de tomber.

Le côté opposé à l’orifice △ sur le support de plafond correspond à la direction de prise de vue (côté avant de la caméra).

Faites glisser le levier de verrouillage de panoramique/inclinaison en position UNLOCK pour déverrouiller
le panoramique/inclinaison et tournez la tête de caméra à 180° dans la direction d’inclinaison.

2

Faites glisser le levier de verrouillage de panoramique/inclinaison en position LOCK pour verrouiller le
panoramique/inclinaison de la tête de caméra.

3
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La tête de caméra a tourné de 180°

Note

Si le panoramique/inclinaison de la tête de caméra ne se verrouille pas lorsque le levier de verrouillage est en position
LOCK, déplacez la tête de caméra manuellement jusqu’à ce qu’elle se verrouille en position.

Fixez le support de boîtier au bas de l’appareil à l’aide de six vis fournies (M3×8).4
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Utilisez les vis fournies. L’utilisation de vis autres que celles fournies peut endommager le produit ou l’intérieur de
l’appareil.

Fixez le support de plafond à une plaque de montage (en option), puis fixez la plaque au plafond.5
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A : support de plafond
B : plafond
C : plaque de montage
D : orifice △
Fixez le support selon l’orientation du support de plafond.
Notez que, monté au plafond, l’avant de la caméra est sur le côté opposé du support de plafond par rapport à un
montage vertical normal. Montez correctement en vous référant au schéma indiquant la direction du montage.

A : avant pour montage vertical (orientation de l’orifice △)
B : avant pour montage au plafond

Note

Le matériel de surface de montage est à la charge du client.

Fixez le câble métallique antichute au plafond.6
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A : support de plafond
B : vis à tête à six pans creux (M5, 3/16 po)
C : câble métallique (fourni)
D : plaque de montage
E : plafond

Tirez sur le câble métallique antichute à travers l’orifice dans le centre du support de plafond, puis
attachez-le au support de boîtier.

Acheminez le câble métallique antichute à travers la boucle métallique de câble métallique du support de boîtier et
attachez-le bien au support à l’aide de la vis en acier inoxydable fournie (M4×8).

A : câble métallique fourni
B : vis cruciforme fournie (M4×8)
C : boucle métallique de câble métallique

7
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Utilisez la vis fournie. L’utilisation d’une vis autre que celle fournie peut réduire l’efficacité de la fonction du câble
métallique.

Note

Il est recommandé qu’une personne tienne l’appareil comme indiqué dans le schéma suivant pendant qu’une autre
personne monte l’appareil.

Ne tenez pas la tête de caméra ou le support d’objectif pendant le montage de l’appareil. La chute de l’appareil pourrait
provoquer des dommages ou des blessures.

Lors du montage des câble, faites attention à ce que les connecteurs et les câbles électriques ne soient pas court-circuités
à cause du câble métallique antichute.

Le montage peut supporter une masse suspendue d’un maximum de 8,8 kg (19 lb 6,4 oz) (y compris l’objectif). Pour
empêcher l’appareil de tomber, ne dépassez pas la masse prévue maximale.

Alignez l’orifice de vis (A) sur le support de boîtier avec l’orifice ◇ (B) sur le support de plafond, insérez
l’appareil et tournez-le à environ 60 degrés dans le sens des aiguilles d’une montre de sorte que l’orifice de
vis (A) et l’orifice de vis (C) soient alignés.

8
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A : orifice de vis sur le support de boîtier
B : orifice de vis dans le support de plafond (orifice ◇)
C : orifice de vis
D : plafond
E : plaque de montage

Fixez le support de boîtier et le support de plafond à l’aide des trois vis de verrouillage de rotation fournies
(M3×8).

9
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Ensuite, fixez l’objectif. Consultez « Fixation d’un objectif », en prenant en compte les informations de « Précautions lors
de la fixation/retrait d’un objectif », « Vérification des commutateurs d’objectif », et « Précautions à prendre lors de
l’utilisation d’un objectif zoom ».

Note

Pour utiliser le panoramique/inclinaison correctement lorsque l’appareil est monté au plafond, réglez [Pan-Tilt] > [Direction] >
[Ceiling] sur [On] dans le menu Web.

Après la fixation d’un objectif, vérifiez que l’objectif est bien fixé.
L’objectif ne dispose d’aucune protection contre la chute. Sony peut n’assumer aucune responsabilité résultant d’une chute de
l’objectif de l’appareil.

Rubrique associée

Vérifiez l’état de montage.

En particulier, vérifiez les éléments suivants.

Les vis de montage sont correctement fixées.
Le câble métallique antichute est correctement fixé et n’est pas tordu.
L’appareil est monté sur surface plane (sans inclinaison ou oscillation).
L’appareil ne pivote pas librement lorsqu’il est tourné.

10
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Précautions lors de la fixation/retrait d’un objectif

Vérification des commutateurs d’objectif

Précautions à prendre lors de l’utilisation d’un objectif zoom

Fixation d’un objectif

5-041-957-23(1) Copyright 2022 Sony Corporation
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Précautions lors de la fixation/retrait d’un objectif

Ne laissez pas l’objectif orienté en plein soleil. Les rayons directs du soleil peuvent entrer par l’objectif, se concentrer
dans l’appareil et provoquer un incendie.

Note

Fixez/retirez l’objectif lorsque l’appareil est hors tension.

Un objectif est un composant de précision. Ne placez pas l’objectif sur une surface avec le côté de la monture d’objectif tourné
vers le bas. Fixez le capuchon de la monture d’objectif fourni.

Astuce

Pour plus de détails sur les objectifs pris en charge par l’appareil, contactez votre technicien Sony.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Vérification des commutateurs d’objectif

Les vérifications et réglages suivants sont nécessaires selon le type de l’objectif.

Pour un objectif avec commutateur de mode de mise au point

Réglez le commutateur sur AF/MF ou AF.
Si le commutateur est réglé sur MF ou Full MF, la mise au point peut uniquement être réglée à l’aide de la bague
d’objectif.

Note

Lorsque vous utilisez un objectif à monture A, il se peut que vous ne puissiez pas utiliser le réglage manuel depuis une
télécommande.

Pour un objectif avec commutateur zoom

Réglez le commutateur sur SERVO.
Si le commutateur est réglé sur MANUAL, le zoom peut uniquement être ajusté à l’aide de la bague de zoom. La
commande de zoom depuis l’appareil n’a aucun effet.

Pour un objectif avec commutateur Auto Iris

Réglez le commutateur sur AUTO.
Si le réglage n’est pas sur AUTO, le diaphragme peut uniquement être ajusté grâce à la bague d’objectif. L’utilisation du
diaphragme depuis l’appareil n’a aucun effet.

Pour un objectif avec commutateur de stabilisation d’image

Réglez le commutateur sur OFF.
Si le commutateur est réglé sur ON, un comportement inattendu peut se produire pendant l’opération de
panoramique/inclinaison.

SELP28135G

A : déplacez la bague de mise au point à la position avant (mode AF/MF).
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B : réglez le commutateur ZOOM sur la position SERVO.
C : réglez la bague du diaphragme sur « A » et le commutateur IRIS LOCK sur la position LOCK.
D : réglez le commutateur de stabilisation d’image sur OFF.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Précautions à prendre lors de l’utilisation d’un objectif zoom

Lors de l’utilisation d’un objectif zoom autre qu’un objectif zoom motorisé, la position de zoom peut changer selon
l’environnement de montage. Sécurisez la bague de zoom en position à l’aide de ruban adhésif selon le but de
l’utilisation.

Bande de film plastique : 471 BLA 50 ou équivalent

5-041-957-23(1) Copyright 2022 Sony Corporation
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Fixation d’un objectif

Cette rubrique décrit comment fixer un objectif à monture E ou un objectif à monture A.

Note

Ne transportez pas l’appareil avec l’objectif encore installé.

Lorsque vous utilisez un objectif à monture A, le diaphragme se règle manuellement et la mise au point est paramétrée sur MF.

Faites glisser le levier de verrouillage de panoramique/inclinaison en position LOCK pour verrouiller le
panoramique/inclinaison de la tête de caméra.

Note

Si le panoramique/inclinaison de la tête de caméra ne se verrouille pas lorsque le levier de verrouillage est en position
LOCK, déplacez la tête de caméra manuellement jusqu’à ce qu’elle se verrouille en position.

1

Tournez le levier de serrage pour la vis de fixation de la base du support d’objectif dans le sens contraire
des aiguilles d’une montre pour desserrer le verrou, puis déplacez la vis de fixation de la base du support
d’objectif sur une position qui n’interfère pas avec l’objectif.

2
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A : correct
B : incorrect

Tournez le levier de verrouillage de la tête de caméra dans la direction de la flèche pour déverrouiller la tête
de caméra.

Note

Jusqu’à ce que la tête de caméra soit à nouveau verrouillée, la tête de caméra risque de bouger en raison de son propre
poids. Soutenez la tête de caméra avec votre main en effectuant la tâche.

3

Faites glisser la tête de caméra à la position la plus avancée.4
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Tournez le levier de verrouillage de la tête de caméra dans la direction de la flèche pour verrouiller la tête de
caméra.

Note

Assurez-vous que le levier de verrouillage de la tête de caméra n’entre pas en contact avec d’autres pièces pour éviter
d’interférer avec l’opération d’inclinaison.

5

Retirez le capuchon et le couvercle de l’appareil et de l’objectif.6

Alignez le repère de monture d’objectif (blanc) avec l’appareil, insérez avec précaution l’objectif dans la tête
de caméra, puis tournez l’objectif dans le sens des aiguilles d’une montre jusqu’à entendre le clic de la
position de verrouillage.

A : repères de monture (blancs)

Note

Pour utiliser un objectif à monture A, fixez un adaptateur de monture d’objectif (optionnel) à l’appareil, puis fixez l’objectif à
monture A.

7

Tournez le levier de verrouillage de la tête de caméra dans la direction de la flèche pour déverrouiller la tête
de caméra.

8
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Note

Jusqu’à ce que la tête de caméra soit à nouveau verrouillée, la tête de caméra risque de bouger en raison de son propre
poids. Soutenez la tête de caméra avec votre main en effectuant la tâche.

Maintenez l’équilibre avant/arrière de la tête de caméra pour que la base coulissante soit à l’horizontale.

Si vous utilisez un des objectifs suivants, vous pouvez approximativement équilibrer l’appareil et l’objectif en vous
référant à l’échelle sur la base de la glissière.

9

Position de l’échelle Nom de l’objectif

0,5 SEL70200GM (muni de SEL20TC)

1,7 SEL70200GM

2,0 SEL70200GM2 (muni de SEL20TC)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G
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Note

Utilisez l’échelle de la base de la glissière comme référence pour un équilibrage approximatif.

Lors de la fixation de l’objectif, procédez aux réglages appropriés à l’équilibre pour que l’appareil n’incline pas d’avant en
arrière.

Réglez l’équilibre sur une surface horizontale.

Retirez l’unité de support d’objectif lors de l’utilisation du SELC1635G.

Position de l’échelle Nom de l’objectif

5,0 ou supérieur SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

Tournez le levier de verrouillage de la tête de caméra dans la direction de la flèche pour verrouiller la tête de
caméra.

Note

Assurez-vous que le levier de verrouillage de la tête de caméra n’entre pas en contact avec d’autres pièces pour éviter
d’interférer avec l’opération d’inclinaison.
Méthode de confirmation : faites glisser le levier de verrouillage de panoramique/inclinaison en position UNLOCK, faites
tourner le bloc de caméra manuellement afin qu’il soit tourné vers le haut, et vérifiez qu’il n’est pas en contact avec d’autres
pièces. Si c’est le cas, tournez à nouveau le levier de verrouillage de la tête de caméra dans la direction de la flèche.

10

Tournez les leviers de serrage du support d’objectif dans le sens contraire des aiguilles d’une montre pour
desserrer l’unité de support d’objectif.

11
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A : levier de serrage de la tige du support d’objectif (2 emplacements)
B : unité de support d’objectif

Déplacez l’unité de support d’objectif pour que la base du support d’objectif soit alignée avec la vis de
fixation de la base du support d’objectif, puis tournez la vis dans le sens des aiguilles d’une montre pour
sécuriser la base du support d’objectif.

Note

Assurez-vous que la base du support d’objectif est perpendiculaire à la vis de fixation de la base du support d’objectif, puis
serrez.

12

Tournez le levier de serrage pour la vis de fixation de la base du support d’objectif dans le sens des
aiguilles d’une montre pour verrouiller la vis de fixation de la base du support d’objectif.

A : vis de fixation de la base du support d’objectif
B : orifice de vis de fixation
C : levier de serrage de la vis de fixation de la base du support d’objectif

Astuce

Si le levier de serrage est difficile à tourner en raison de sa position, relâchez le levier de serrage et tournez-le à un angle
qui facilite l’opération. Une fois dans la position souhaitée, fermez le levier de serrage.

13
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Rubrique associée
Étalonnage d’un objectif à monture E

5-041-957-23(1) Copyright 2022 Sony Corporation

A : levier de serrage de la vis de fixation de la base du support d’objectif
B : levier de serrage de la tige du support d’objectif

Tournez les deux leviers de serrage de la tige du support d’objectif dans le sens des aiguilles d’une montre
pour sécuriser l’unité de support d’objectif.

14

Assurez-vous que les deux leviers sont serrés et non lâches, que l’objectif est fixé correctement et que les
commutateurs d’objectif sont réglés correctement.

Si un levier est lâche ou si l’objectif n’est pas fixé correctement, l’objectif risque de tomber et d’être
endommagé.
Lors de l’utilisation d’un objectif zoom motorisé à monture E, l’objectif doit également être étalonné séparément
pour restaurer précisément les positions du zoom stockées dans la caméra comme positions prédéfinies. Pour
plus de détails, consultez « Étalonnage d’un objectif à monture E. »

15
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Retrait d’un objectif

Retirez un objectif en suivant la procédure inverse de celle utilisée pour la fixation de l’objectif.

Note

Saisissez fermement l’objectif à la main pour empêcher qu’il ne tombe.

Si un autre objectif n’est pas immédiatement fixé, replacez toujours le capuchon de boîtier.

Rubrique associée

Fixation d’un objectif

5-041-957-23(1) Copyright 2022 Sony Corporation

Assurez-vous que le panoramique/inclinaison est verrouillé.1

Tournez le levier de serrage pour la vis de fixation de la base du support d’objectif dans le sens contraire
des aiguilles d’une montre pour desserrer le verrou.

2

Retirez la vis de fixation de la base du support d’objectif sur l’unité de support d’objectif et déplacez-la sur
une position qui n’interfère pas avec l’objectif.

3

Déverrouillez la tête de caméra et faites glisser la tête de caméra dans la position la plus avancée.

Pour plus de détails, consultez les étapes 3 à 5 dans « Fixation d’un objectif ».

4

Maintenez le bouton de déblocage de l’objectif enfoncé et tournez l’objectif dans le sens contraire des
aiguilles d’une montre tout en soutenant l’objectif.

5

Avec les repères de monture (blancs) de la caméra et l’objectif aligné, tirez l’objectif vers l’avant.6
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Raccordement des câbles

Cette rubrique décrit les raccordements de câble.

5-041-957-23(1) Copyright 2022 Sony Corporation

Raccordez les câbles nécessaires aux connecteurs sur le panneau arrière.

Pour empêcher le retrait du câble HDMI, retirez la vis de montage de la plaque de retenue du câble HDMI (M2.6×6,
noire) du bloc de connecteur, puis fixez la plaque de retenue du câble HDMI à l’aide de la vis de montage. Fixez le
câble HDMI à la plaque de retenue du câble HDMI à l’aide d’une attache de câble ou d’un serre-câble disponible
dans le commerce.

A : vis de montage de la plaque de retenue du câble HDMI (M2.6×6, noire)
B : attache de câble ou serre-câble disponible dans le commerce
C : plaque de retenue du câble HDMI (fournie)

1
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Connexion de l’appareil à un périphérique réseau via une connexion filaire

Cette rubrique décrit la connexion d’un appareil à un dispositif réseau via une connexion filaire.

5-041-957-23(1) Copyright 2022 Sony Corporation

Connectez l’appareil au dispositif réseau (tel qu’un point d’accès Wi-Fi ou un concentrateur de
commutation) à l’aide d’un câble LAN de catégorie 5e ou supérieure.

1
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Utilisation de l’alimentation CA

Cette rubrique décrit la procédure pour alimenter l’appareil à l’aide de l’alimentation CA.

Faites glisser le levier de verrouillage de panoramique/inclinaison en position LOCK pour verrouiller le
panoramique/inclinaison de la tête de caméra.

1

Connectez l’adaptateur CA (fourni) au connecteur DC IN de l’appareil et branchez le cordon d’alimentation
(fourni) à une source d’alimentation CA.

A : connecteur DC IN
B : cordon d’alimentation
C : adaptateur CA

2

Fixez le cordon d’adaptateur CA à l’aide du serre-câble si vous souhaitez empêcher les cordons de se
débrancher.

Déverrouillez le serre-câble, acheminez le cordon à travers le serre-câble comme indiqué ci-dessous, puis
verrouillez le serre-câble.

3
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Note

N’utilisez pas d’autres adaptateurs CA ou cordons d’alimentation que ceux fournis avec l’appareil. Connecter un autre adaptateur
ou cordon d’alimentation peut provoquer un incendie ou un dysfonctionnement.

Ne connectez pas et n’utilisez pas un adaptateur CA dans un espace confiné, comme par exemple entre un mur et des meubles.

Ne court-circuitez pas les pièces métalliques de la fiche de l’adaptateur CA. Cela pourrait entraîner un dysfonctionnement.

A : serre-câble
B : verrou du serre-câble
C : cordon d’adaptateur CA

Assurez-vous que le témoin POWER à l’avant de l’appareil passe d’un clignotement vert à un vert sans
interruption et que le démarrage est terminé.

Lorsque l’appareil a démarré normalement et s’est connecté au réseau, le témoin NETWORK s’allumera en vert.

Lors de l’utilisation d’un objectif qui ne prend pas en charge l’opération de panoramique/inclinaison, verrouillez
le levier de verrouillage de panoramique/inclinaison et ignorez les étapes suivantes. Pour plus de détails sur les
objectifs qui prennent en charge le panoramique/inclinaison, contactez votre revendeur ou votre technicien
Sony.

4

Faites glisser le levier de verrouillage de panoramique/inclinaison en position UNLOCK pour déverrouiller
le panoramique/inclinaison de la tête de caméra.

5

Réinitialisez le panoramique/inclinaison.

Pour les détails, consultez « Réinitialisation de panoramique/inclinaison ».

6
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Connectez l’adaptateur CA à la source d’alimentation CA la plus proche. Si un problème se produit lors du fonctionnement,
débranchez immédiatement le cordon d’alimentation de la source d’alimentation CA.

Lorsque vous débranchez l’adaptateur CA de l’appareil, saisissez la fiche et tirez-la tout droit. Tirer sur le câble pourrait provoquer
un dysfonctionnement.

Rubrique associée

Réinitialisation de panoramique/inclinaison

5-041-957-23(1) Copyright 2022 Sony Corporation
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Utilisation de l’alimentation PoE++

Lorsque l’appareil est connecté à un dispositif d’alimentation électrique compatible PoE++, l’alimentation est fournie à
l’appareil via un câble réseau disponible dans le commerce.
Cette méthode permet de fournir de l’alimentation à l’appareil sans avoir besoin de câblage d’alimentation électrique
dans des environnements sans alimentation secteur proche de l’emplacement de montage.

Faites glisser le levier de verrouillage de panoramique/inclinaison en position LOCK pour verrouiller le
panoramique/inclinaison de la tête de caméra.

1

Branchez l’appareil et un dispositif d’alimentation électrique compatible PoE++ à l’aide d’un câble réseau
disponible dans le commerce.

A : câble réseau
B : dispositif d’alimentation électrique compatible PoE++

2

Assurez-vous que le témoin POWER à l’avant de l’appareil passe d’un clignotement vert à un vert sans
interruption et que le démarrage est terminé.

Lorsque l’appareil a démarré normalement et s’est connecté au réseau, le témoin NETWORK s’allumera en vert.

3
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Note

L’appareil est conforme à la norme IEEE802.3bt, Type 4, Classe 8. Pour plus de détails sur les dispositifs d’alimentation
électrique compatibles PoE++ vérifiés, contactez votre revendeur ou votre technicien Sony.

L’appareil est conforme à l’authentification logicielle (LLDP), mais il peut être nécessaire de configurer les dispositifs réseau
(conforme à la norme IEEE802.3bt).

Ne branchez pas d’adaptateur CA lors de l’utilisation d’une alimentation électrique PoE++ avec l’authentification logicielle (LLDP)
activée.

Si l’adaptateur CA et le dispositif d’alimentation électrique PoE++ ne sont pas connectés en même temps, l’alimentation est
fournie depuis l’adaptateur CA.

En cas d’alimentation via PoE++, utilisez un câble réseau de catégorie 5e ou supérieure.

Attendez environ 10 secondes après avoir mis de nouveau l’appareil sous tension s’il est alimenté via PoE++.

Lors de l’utilisation d’une alimentation PoE++, connectez la borne de mise à la terre à la terre.

En cas de connexion via l’alimentation PoE++, n’utilisez pas de câblage à l’extérieur.

Rubrique associée

Réinitialisation de panoramique/inclinaison

5-041-957-23(1) Copyright 2022 Sony Corporation

Note

Lorsque l’alimentation est fournie par PoE++, une authentification initiale est effectuée pendant l’intervalle avant la fin du
démarrage.

Lors de l’utilisation d’un objectif qui ne prend pas en charge l’opération de panoramique/inclinaison, verrouillez le levier de
verrouillage de panoramique/inclinaison et ignorez les étapes suivantes. Pour plus de détails sur les objectifs qui prennent
en charge le panoramique/inclinaison, contactez votre revendeur ou votre technicien Sony.

Faites glisser le levier de verrouillage de panoramique/inclinaison en position UNLOCK pour déverrouiller
le panoramique/inclinaison de la tête de caméra.

4

Réinitialisez le panoramique/inclinaison.

Pour les détails, consultez « Réinitialisation de panoramique/inclinaison ».

5
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Réinitialisation de panoramique/inclinaison

Vous pouvez réinitialiser le panoramique/inclinaison, par exemple, lorsque vous remplacez l’objectif à l’aide de la
procédure suivante.

5-041-957-23(1) Copyright 2022 Sony Corporation

Faites glisser le levier de verrouillage de panoramique/inclinaison en position UNLOCK et vérifiez que le
panoramique/inclinaison de la tête de caméra est déverrouillé.

1

Exécutez la fonction de réinitialisation de panoramique/inclinaison.

La réinitialisation de panoramique/inclinaison peut être exécutée depuis la télécommande infrarouge, l’application
Web ou le pupitre de télécommande RM-IP500 (en option).

Opération à l’aide de la télécommande infrarouge : appuyez sur la touche P/T RESET.
Opération à l’aide de l’application Web : appuyez sur la touche  (Réinitialisation de
panoramique/inclinaison) dans l’onglet  (Others) dans le panneau de commande de la caméra sur l’écran
d’opération en direct.
Opération à l’aide de RM-IP500 : consultez le mode d’emploi du RM-IP500.

Note

Exécuter une réinitialisation de panoramique/inclinaison fait tourner la tête de caméra et l’objectif. Vérifiez que l’objectif
n’est pas bloqué avant exécution.

L’appareil dispose d’une fonction qui limite la plage de panoramique/inclinaison, mais cette fonction est désactivée lorsque
l’appareil est mis sous tension ou si la réinitialisation de panoramique/inclinaison est exécutée.

Astuce

Lorsque la réinitialisation de panoramique/inclinaison est terminée, l’appareil revient sur la position pré-exécution.

2
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Accès à l’application Web depuis un navigateur Web

En connectant l’appareil à une tablette ou un ordinateur, vous pouvez utiliser et configurer l’appareil depuis un navigateur
Web.

Vérifiez si votre tablette ou ordinateur prend en charge les opérations de l’application Web.

Note

Si l’environnement requis n’est pas respecté, ou selon l’usage de la tablette/ordinateur, l’affichage vidéo dans le navigateur
Web peut être affecté négativement.

L’application Web de cet appareil utilise JavaScript. Si vous utilisez des logiciels antivirus sur votre tablette/ordinateur, la
page Web peut ne pas s’afficher correctement.

1

Élément Configuration requise

Affichage
1080×810 pixels ou supérieur recommandé
Taille de l’affichage de tablette : 10 pouces
ou plus recommandé

Système d’exploitation et navigateur
Web pris en charge

Windows

OS Windows 10 ou ultérieur

Navigateur
Web

Google Chrome

Mac

OS macOS 10.15 ou ultérieur

Navigateur
Web

Google Chrome
Safari

iPad

OS iPadOS 15 ou ultérieur

Navigateur
Web

Google Chrome
Safari

Android

OS Android 12 ou ultérieur

Navigateur
Web

Google Chrome

Vérifiez que l’appareil, la tablette ou l’ordinateur et les périphériques sont mis sous tension.2

Vérifiez que l’appareil et la tablette ou l’ordinateur sont connectés via Wi-Fi ou connexion en réseau local
filaire LAN.

3

Connectez l’appareil depuis le navigateur Web de votre tablette ou ordinateur.

Connexion à l’aide d’un code QR
Scannez le code QR imprimé sur le cache du support sur le côté de l’appareil à l’aide de la caméra de la tablette.

4
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Note

Si le numéro de port HTTP a changé à partir d’une valeur de 80, saisissez « http://adresse IP de l’appareil » dans la barre
d’adresse.

Lors de la connexion à l’aide d’un code QR ou en saisissant l’URL dans la barre d’adresse du navigateur Web, utilisez un

dispositif qui prend en charge mDNS*.

Astuce

Vous pouvez ensuite accéder à l’appareil rapidement à l’aide de la fonction de marque-page du navigateur Web.

5-041-957-23(1) Copyright 2022 Sony Corporation

Ouvrez le lien affiché sur la tablette.
Le navigateur Web sur la tablette se lance et affiche l’écran de l’application Web de l’appareil.

Connexion par saisie d’une URL dans la barre d’adresse du navigateur Web
Lancez un navigateur Web sur la tablette ou ordinateur et saisissez l’URL imprimée sur le cache du support sur le
côté de l’appareil.
Le navigateur Web affiche l’écran de l’application Web de l’appareil.

Connexion par saisie de l’adresse IP de l’appareil dans la barre d’adresse du navigateur Web
Lancez un navigateur Web sur votre tablette ou ordinateur et saisissez « http://adresse IP de l’appareil » dans la
barre d’adresse.
Le navigateur Web affiche l’écran de l’application Web de l’appareil.

mDNS : un protocole de communication utilisé pour déterminer l’adresse IP d’un nom d’hôte sur un réseau local.*
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Initialisation de l’appareil

Assurez-vous de configurer l’appareil selon la procédure suivante lorsque l’appareil est utilisé pour la première fois.

Astuce

Si la batterie de secours est totalement déchargée, vous devrez configurer la configuration initiale à nouveau.

Branchez l’appareil à une tablette ou à un ordinateur, et lancez l’application Web.

Lorsque l’appareil est utilisé pour la première fois, vous êtes invité à saisir à nouveau un nom d’utilisateur et un mot
de passe dans le navigateur Web. Saisissez les réglages suivants.

Nom d’utilisateur : admin
Mot de passe : (laisser vide)

Suivez les instructions à l’écran pour configurer la configuration initiale.

1

Saisissez le nom d’utilisateur et le mot de passe administrateur (Administrator), puis appuyez sur la touche
[OK].

1 : Saisissez le nom d’utilisateur administrateur.
2 : Réglez le mot de passe administrateur.
3 : Saisissez à nouveau le mot de passe pour le confirmer.

Note

Les caractères suivants peuvent être utilisés dans le nom d’utilisateur et le mot de passe. Le mot de passe doit contenir au
moins une majuscule, une minuscule et un chiffre, et avoir de 8 à 64 caractères de long.

Caractères alphanumériques

2
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L’écran en direct pour les opérations de prise de vue apparaît. Continuez à configurer l’opération de base de l’appareil
selon le mode de fonctionnement.

Astuce

Dans certains cas, par exemple lorsque l’appareil est utilisé en binôme avec une tablette, il peut être plus facile d’utiliser une
adresse IP fixe pour l’appareil.

Symboles (!$%`*+-./<=>?@[]^_{|}~)

Votre navigateur Web se recharge et vous êtes invité à saisir à nouveau le nom d’utilisateur et le mot de passe.

Saisissez le nom d’utilisateur et le mot de passe configurés à l’étape 2.

L’écran de configuration de la langue et de l’horloge apparaît.

3

Spécifiez les éléments suivants et appuyez sur la touche [OK].

[Language]
Sélectionnez la langue à utiliser pour l’application Web et l’affichage de l’écran de la caméra. Le changement de
langue modifiera la langue d’affichage de l’application Web.
[Date & Time Format]
Sélectionnez le format d’affichage de la date et l’heure parmi les options suivantes.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
« yyyy » indique l’année, « mm » indique le mois, « dd » indique le jour, « hh » indique l’heure, « mm » indique la
minute et « ss » indique la seconde.
[12 h/24 h]
Sélectionnez [12 h] (horloge de 12 heures) ou [24 h] (horloge de 24 heures) pour l’affichage de l’heure.
[Time Setting]
Sélectionnez la méthode de réglage de la date/de l’heure.
[Synchronize with PC] : synchronisez avec la date et l’heure de l’ordinateur ou tablette.
[Manual setting] : réglez manuellement. Lorsque cette méthode est sélectionnée, les champs de saisie pour la date
et l’heure apparaissent.
[Time Zone]
Sélectionnez le fuseau horaire.

4
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Pour définir une adresse IP fixe, désactivez d’abord [Network] > [Wired LAN] > [IPv4] > [DHCP] (curseur en position gauche)
dans le menu Web.

Les éléments de configuration relatifs à une adresse IP fixe apparaissent. Configurez les éléments puis appuyez sur la touche
[OK] sur l’écran.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Configuration des opérations de base

Cette rubrique décrit comment configurer l’appareil pour des opérations de base.

Réglage du mode de prise de vue

Vous pouvez sélectionner le mode de prise de vue de l’appareil pour qu’il corresponde au flux de travail.

Mode Custom : permet de créer librement des images pendant la prise de vue.
Modes de prise de vue Log : enregistre le contenu S-Log.

Mode Flexible ISO : les réglages d’exposition sont définis par des réglages de la valeur ISO correspondant à la
scène tournée.
Mode Cine EI /Mode Cine EI Quick : permet de faire fonctionner l’appareil comme une caméra de film (en ne
créant pas complètement les images lors de la prise de vue), les métrages étant développés en post-production.

En mode Cine EI Quick, une sensibilité de base adaptée au réglage d’indice d’exposition est sélectionnée
automatiquement.
Commutez le mode de prise de vue à l’aide de [Project] > [Base Setting] > [Shooting Mode] dans le menu Web ou le
menu de la caméra.

Mode Custom
Vous pouvez sélectionner la norme vidéo.
Commutez à l’aide de [Project] > [Base Setting] > [Target Display] dans le menu Web ou le menu de la caméra.

[SDR(BT.709)] : prise de vue conforme à la norme de diffusion HD
[HDR(HLG)] : prise de vue conforme à la norme de diffusion 4K nouvelle génération

Pour plus de détails, consultez « Présentation de l’apparence » et d’autres sujets dans « Prise de vue avec l’apparence
souhaitée (Look) ».

Modes de prise de vue Log
(Mode Flexible ISO / Mode Cine EI /Mode Cine EI Quick)
En modes de prises de vue Log, vous pouvez sélectionner la gamme de couleurs de base pour les signaux enregistrés
et les signaux de sortie. La gamme de couleurs sélectionnée ici représente la gamme de couleurs de la sortie vidéo
lorsque les réglages [LUT On/Off] sont réglé sur [MLUT Off].
Vous pouvez commuter la gamme de couleurs à l’aide de [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] dans le
menu de la caméra.

[S-Gamut3.Cine/SLog3] : gamme de couleurs facile à ajuster pour le mode de cinéma numérique (DCI-P3).
[S-Gamut3/SLog3] : large gamme de couleurs Sony qui couvre la gamme de couleurs ITU-R BT.2020.

Pour plus de détails, consultez « Prise de vue avec réglage d’apparence en post-production ».
 
Les fonctions prises en charge dans chaque mode de prise de vue sont indiquées dans le tableau suivant.
● : pris en charge, – : non pris en charge

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –
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Astuce

En mode Cine EI Quick et en mode Cine EI, la prise de vue se produit à une sensibilité ISO de base sans l’aide de gain afin de
maximiser la performance du capteur d’image. La luminosité est ajustée à l’aide de l’éclairage et du filtre ND afin d’ajuster la
quantité de lumière qui atteint le capteur d’image.

Réglage de la fréquence du système

Commutez à l’aide de [Project] > [Rec Format] > [Frequency] dans le menu Web ou le menu de la caméra. L’appareil
peut redémarrer automatiquement après avoir commuté, selon la valeur sélectionnée.

Note

Vous ne pouvez pas commuter la fréquence du système pendant l’enregistrement ou la lecture.

Réglage du mode de numérisation par imageur

Vous pouvez régler la taille d’image effective et la résolution du capteur d’image.
Commutez à l’aide de [Project] > [Rec Format] > [Imager Scan Mode] dans le menu Web ou le menu de la caméra.
[FF] : taille plein format.
[S35] : format Super 35mm.

Note

Vous ne pouvez pas commuter le mode Imager Scan pendant l’enregistrement ou la lecture.

Lorsqu’il est réglé sur S35, le format vidéo est limité à 1920×1080.

Réglage du codec

Vous pouvez régler le codec pour l’enregistrement.
Commutez à l’aide de [Project] > [Rec Format] > [Codec] dans le menu Web ou le menu de la caméra.

Note

Vous ne pouvez pas commuter le codec pendant l’enregistrement ou la lecture.

Réglage du format vidéo

Custom Flexible ISO Cine EI Cine EI Quick

AGC ● ● – –

Base Sensitivity ● – – –

Base ISO – ● ● ● (lié à EI)

Exposure Index – – ● ●

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(Base Look exclu)

● – – –
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Vous pouvez régler le format vidéo pour l’enregistrement et le format de sortie pour la sortie de la caméra.

Commutez le format vidéo pour l’enregistrement à l’aide de [Project] > [Rec Format] > [Video Format] dans le menu
Web ou le menu de la caméra.
Commutez la sortie de format vidéo des connecteurs SDI OUT et HDMI OUT à l’aide de [Monitoring] > [Output
Format] dans le menu Web ou le menu de la caméra.

Note

Vous ne pouvez pas commuter le format vidéo pendant l’enregistrement ou la lecture.

Des restrictions peuvent s’appliquer au signal des connecteurs SDI OUT et HDMI OUT, selon le réglage du format vidéo.

Rubrique associée
Présentation de l’apparence

Prise de vue avec réglage d’apparence en post-production

5-041-957-23(1) Copyright 2022 Sony Corporation
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Cartes mémoire prises en charge

L’appareil permet d’effectuer des enregistrements audio et vidéo sur des cartes mémoire CFexpress Type A (disponibles
séparément) ou des cartes mémoire SDXC (disponibles séparément) insérées dans les logements pour carte. Les cartes
mémoire sont également utilisées pour l’enregistrement proxy.

Cartes mémoire CFexpress Type A

Utilisez les cartes mémoire Sony CFexpress Type A* répertoriées dans « Supports d’enregistrement recommandés »
dans l’appareil.
Pour plus de détails sur le fonctionnement avec des supports provenant d’autres fabricants, reportez-vous au mode
d’emploi du support ou consultez les informations du fabricant.

Cartes mémoire SDXC

Utilisez les cartes mémoire SDXC* répertoriées dans « Supports d’enregistrement recommandés » dans l’appareil.

Supports d’enregistrement recommandés

Les conditions de fonctionnement garanti varient en fonction des réglages Rec Format et Recording.

CFexpress Type A
Compatible VPG400
Pris en charge pour tous les formats d’enregistrement de l’appareil.

SDXC
Pris en charge dans les conditions du tableau suivant. « ● » indique que l’opération a été vérifiée, « – » indique que
l’opération n’est pas garantie.

RAW Out & XAVC-I, 4096×2160 classe 300, mode normal

RAW Out & XAVC-I, 3840×2160 Class 300, mode normal

Désignées sous le nom de « cartes CFexpress » dans ce manuel d’aide.*

Désignées sous le nom de « cartes SD » dans ce manuel d’aide.*

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●
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RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (60 fps ou moins)

RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Support vérifié non disponible.

XAVC-I, 4096×2160 Class 300, mode normal

XAVC-I, 4096×2160 Class 300, S&Q (60 fps ou moins)

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●
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XAVC-I, 3840×2160 Class 300, mode normal

XAVC-I, 3840×2160 Class 300, S&Q (60 fps ou moins)

XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Support vérifié non disponible.

XAVC-I, 1920×1080 Class 100, mode normal

XAVC-I, 1920×1080 Class 100, S&Q (60 fps ou moins)

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

24P – – – – – – ●

23.98P – – – – – – ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●
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XAVC-I, 1920×1080 Class 100, S&Q (100 fps, 120 fps)

XAVC-I, 1920×1080 Class 100, S&Q (150 fps, 180 fps)
Support vérifié non disponible.

XAVC-I, 1920×1080 Class 100, S&Q (200 fps, 240 fps)
Support vérifié non disponible.

XAVC-L, 3840×2160 420, mode normal

XAVC-L, 3840×2160 420, S&Q (60 fps ou moins)

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, mode normal

XAVC-L, 1920×1080 HD50, S&Q (60 fps ou moins)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

XAVC-L, 1920×1080 HD35, mode normal

XAVC-L, 1920×1080 HD35, S&Q (60 fps ou moins)

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

120



XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)

5-041-957-23(1) Copyright 2022 Sony Corporation

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Fréquence du système Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Insertion des cartes mémoire

Cette rubrique décrit les précautions lors de l’insertion de cartes mémoire.

Ouvrez le cache du support de la section de logements pour carte.1

Insérez une carte mémoire.

Pour les cartes CFexpress, l’étiquette est orientée vers le haut.

Note

Sur un appareil monté au plafond, l’étiquette est orientée vers le bas.

Pour les cartes SD, l’étiquette est orientée vers le bas.

Note

Sur un appareil monté au plafond, l’étiquette est orientée vers le haut.

L’indicateur d’accès est allumé en rouge, puis passe au vert si la carte est utilisable.

2
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Note

La carte mémoire, le logement de carte mémoire et les données d’images sur la carte mémoire peuvent être endommagés si la
carte est enfoncée de force dans le logement dans le mauvais sens.

Lorsque vous enregistrez sur des supports situés dans les logements de carte CFexpress Type A / SD A et B, insérez dans ces
deux logements des supports recommandés pour l’utilisation avec le format d’enregistrement.

5-041-957-23(1) Copyright 2022 Sony Corporation

Note

Si l’indicateur d’accès clignote en rouge en continu et ne passe pas au vert, éteignez temporairement l’appareil, puis retirez
et réinsérez la carte mémoire.

Fermez le cache du support.3
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Éjection d’une carte mémoire

Ouvrez le cache du support de la section de logements pour carte et appuyez légèrement sur la carte mémoire pour
l’éjecter.

Note

Si l’appareil est arrêté ou la carte mémoire enlevée pendant que le système accède à la carte mémoire, l’intégrité des données
sur la carte ne peut pas être garantie. Toutes les données enregistrées sur la carte peuvent être supprimées. Assurez-vous
toujours que l’indicateur d’accès est vert ou éteint avant d’arrêter l’appareil ou de retirer la carte mémoire.

Si une carte mémoire est retirée immédiatement après l’enregistrement, elle peut être chaude, mais cela n’indique pas un
problème.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Formatage (initialisation) de cartes mémoire

Si une carte mémoire non formatée ou une carte mémoire formatée selon une spécification différente est insérée, le
message « Media Needs to be Formatted » s’affiche sur le panneau d’image de la caméra.
Formatez la carte en utilisant la procédure suivante.

Note

Le formatage d’une carte mémoire efface toutes les données, y compris les données vidéo et les fichiers de configuration
enregistrés.

Des messages peuvent apparaître pendant l’exécution selon la durée du processus de formatage.

En cas d’échec du formatage
Les cartes mémoire non prises en charge par l’appareil ne peuvent pas être formatées.
Un message d’avertissement est affiché. Suivez les instructions pour remplacer la carte par une carte mémoire prise en
charge.

Pour utiliser une carte formatée sur l’appareil dans le logement d’un autre dispositif
Effectuez d’abord une copie de sauvegarde de la carte, puis reformatez la carte dans le dispositif à utiliser.

5-041-957-23(1) Copyright 2022 Sony Corporation

Sélectionnez [TC/Media] > [Format Media] dans le menu de la caméra.1

Sélectionnez Media(A) (logement A) ou Media(B) (logement B), puis sélectionnez la méthode de formatage
(Full Format ou Quick Format).

Un message de confirmation apparaît.
[Full Format] : initialise complètement le support, y compris la zone des données et les informations de gestion des
données.
[Quick Format] : initialise uniquement les informations de gestion des données du support.

2

Sélectionnez [Execute].

Un message s’affiche pendant le formatage et le voyant d’accès est allumé en rouge.
À la fin du formatage, un message d’achèvement apparaît.

3
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Vérification de la durée d’enregistrement restante

Lors d’une prise de vue (enregistrement/veille), vous pouvez surveiller la capacité restante de la carte mémoire dans
chacun des logements à l’aide des indicateurs de capacité restante du support des logements A/B dans le panneau
d’image de la caméra.
Le temps d’enregistrement restant est calculé à partir de la capacité restante du support de chaque logement et du
format d’enregistrement actuel (débit binaire d’enregistrement) et est affiché en unités de minutes.

Synchronisation de remplacement de carte mémoire
Quand le temps d’enregistrement total restant sur les deux cartes mémoire devient inférieur à 5 minutes, le message
« Media Near Full » s’affiche, le témoin d’enregistrement/de signalisation commence à clignoter pour vous avertir.
Remplacez les cartes par un support ayant de l’espace libre.
Si vous poursuivez l’enregistrement jusqu’à écoulement complet de la durée d’enregistrement totale restante, le
message indique dans ce cas « Media Full » et l’enregistrement s’arrête.

Note

Un maximum de 600 plans environ peut être enregistré sur une carte mémoire.

5-041-957-23(1) Copyright 2022 Sony Corporation

126



Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Restauration de cartes mémoire

Si, pour quelque raison que ce soit, une erreur se produit dans une carte mémoire, celle-ci doit être restaurée avant
l’utilisation.
Lorsque vous insérez une carte mémoire qui doit être restaurée, un message apparaît sur le panneau d’image de la
caméra vous demandant si vous souhaitez effectuer la restauration.

Pour restaurer une carte
Sélectionnez [Execute] à l’aide des touches fléchées dans le panneau de commande GUI puis appuyez sur la touche
[Set].
Un message et l’état de progression (%) s’affichent pendant le formatage et l’indicateur d’accès est allumé en rouge.
À la fin de la restauration, un message indiquant la fin de l’opération s’affiche.

En cas d’échec de la restauration
Les cartes mémoire sur lesquelles des erreurs de mémoire se sont produites ne peuvent pas être restaurées. Un
message d’avertissement est affiché. Suivez les instructions pour remplacer la carte mémoire.
Les cartes mémoire sur lesquelles des erreurs de mémoire se sont produites peuvent être utilisables si vous les
reformatez.
Dans certains cas, certains plans peuvent être restaurés et d’autres non. Les plans restaurés peuvent être lus
normalement.

Note

Pour la restauration du support enregistré sur cet appareil, assurez-vous d’utiliser cet appareil.

Il se peut qu’un support enregistré avec un dispositif autre que cet appareil ou avec un autre appareil d’une version différente
(même du même modèle) ne soit pas restauré à l’aide de cet appareil.

Les plans de moins de 2 secondes ne peuvent pas être restaurés.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Démarrage/arrêt de l’enregistrement

Cette rubrique décrit comment démarrer/arrêter l’enregistrement.

Connectez les dispositifs nécessaires et vérifiez que l’alimentation de l’appareil et des périphériques est
branchée.

1

Insérez la/les carte(s) mémoire.2

Vérifiez l’état de l’alimentation de l’appareil en haut à gauche dans l’écran de l’application Web.

Lorsque l’alimentation est activée
Lorsque l’appareil est mis sous tension, [Power ON] s’affiche sur le commutateur d’alimentation en haut de l’écran
de l’application Web.

Le témoin POWER s’allume sur l’avant de l’appareil et l’image de la caméra apparaît sur l’écran d’opération en
direct de l’application Web.

Note

Si le mot de passe administrateur n’est pas configuré, un écran vous invitant à configurer le mot de passe apparaît.
Consultez « Initialisation de l’appareil. »

Lorsque l’alimentation est à l’état de veille
Lorsque l’alimentation de l’appareil est en état de veille, [Power Standby] est affiché sur le commutateur
d’alimentation dans l’application Web.

Dans cet état, appuyez sur le commutateur d’alimentation et sélectionnez [Power ON]. L’appareil se met sous
tension, le témoin POWER s’allume en vert à l’avant de l’appareil, et l’image de caméra apparaît sur l’écran
d’opération en direct de l’application Web.

3
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Pour basculer l’alimentation de l’appareil en état de veille
Appuyez sur le commutateur d’alimentation dans l’application Web et sélectionnez [Power Standby] pour régler
l’alimentation de l’appareil sur l’état de veille.

Astuce

Astuce

Vous pouvez également mettre l’appareil sous tension à l’aide de la touche d’alimentation sur la télécommande infrarouge
fournie.

Appuyez sur la touche d’enregistrement START/STOP.

L’enregistrement démarre et le témoin d’enregistrement/tally (2 emplacements) de l’appareil s’allume.
Pendant l’enregistrement, la touche d’enregistrement START/STOP s’allume. Une icône pour le support
d’enregistrement cible et [●Rec] sont également affichés.

4

Pour arrêter l’enregistrement, appuyez à nouveau sur la touche d’enregistrement START/STOP.

L’enregistrement s’arrête, le témoin d’enregistrement/tally (2 emplacements) de l’appareil s’éteint.
Pendant l’état de veille de l’enregistrement, la touche d’enregistrement START/STOP n’est pas allumée. Une icône
pour le support d’enregistrement cible et [Stby] sont également affichés.

Astuce

Vous pouvez également démarrer/arrêter l’enregistrement à l’aide de la touche d’enregistrement START/STOP de la
télécommande infrarouge fournie.

5
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Vous pouvez également régler l’alimentation sur l’état de veille à l’aide de la touche d’alimentation sur la télécommande
infrarouge fournie.

Rubrique associée
Initialisation de l’appareil

5-041-957-23(1) Copyright 2022 Sony Corporation
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Sélection alternative des cartes mémoire

Lorsque deux cartes mémoire sont insérées, vous pouvez appuyer sur la touche [Slot Select] sur le panneau de
commande de lecture de l’application Web pour basculer entre les cartes mémoire.

Astuce

Vous pouvez également appuyer sur la touche SLOT SEL (Sélection du logement de carte mémoire (A)/(B)) sur la télécommande
infrarouge fournie pour basculer entre les cartes mémoire.

À propos de l’enregistrement relais

Lors de l’enregistrement, l’appareil passe automatiquement à la seconde mémoire juste avant que la capacité restante
sur la première carte atteigne zéro (enregistrement relais). Lorsque vous basculez d’une carte mémoire à l’autre, vous
pouvez poursuivre l’enregistrement continu en remplaçant la carte mémoire pleine par une nouvelle.

Note

Vous ne pouvez pas passer d’une carte mémoire à l’autre en mode de lecture. En outre, la lecture continue d’un plan situé sur
plusieurs supports dans la fente A et la fente B n’est pas prise en charge.

À propos des données enregistrées

Quand vous cessez l’enregistrement, la vidéo, l’audio et les données correspondantes du début à la fin de
l’enregistrement sont sauvegardés sous forme de « plan » unique sur une carte mémoire.

Nom de plan des données enregistrées

Le nom de chaque plan enregistré avec l’appareil est attribué automatiquement à l’aide de [TC/Media] > [Clip Name
Format] dans le menu de la caméra.

Durée maximum d’un plan

Jusqu’à 6 heures par plan.
La durée maximum d’un enregistrement continu est identique à la durée maximum d’un plan. Si la durée
d’enregistrement dépasse la durée maximum d’un plan, un nouveau plan est créé automatiquement et l’enregistrement
se poursuit. Le nouveau plan apparaît comme un plan séparé sur l’écran des miniatures.
Les plans multiples sont enregistrés successivement pendant l’enregistrement relais, mais l’enregistrement s’arrête
automatiquement après environ 24 heures.

Note

N’éjectez pas une carte mémoire pendant que des données y sont en cours d’enregistrement. Lors de l’enregistrement,
remplacez uniquement les cartes mémoire des logements pour lesquels l’indicateur d’accès de logement est éteint.

Quand la capacité restante sur la carte mémoire en cours d’enregistrement descend au-dessous d’une minute et qu’une carte
mémoire enregistrable est insérée dans l’autre logement, un message « Will Switch Slots Soon » s’affiche. Le message disparaît
après l’échange de logement de carte mémoire.

L’enregistrement relais peut ne pas fonctionner si l’enregistrement est lancé alors que la capacité restante de la carte mémoire
est inférieure à une minute. Pour un enregistrement relais correct, vérifiez que la capacité restante de la carte mémoire est
supérieure à une minute avant de commencer l’enregistrement.

Une vidéo créée à l’aide de la fonction d’enregistrement relais de l’appareil ne peut pas être lue sans interruption sur l’appareil.

131



Pour combiner la vidéo créée en utilisant la fonction d’enregistrement relais de l’appareil, utilisez le logiciel « Catalyst Browse ».

5-041-957-23(1) Copyright 2022 Sony Corporation
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Vérification de l’audio

L’audio sort des connecteurs SDI et HDMI de l’appareil. Sélectionnez la combinaison de canaux audio sortant du
connecteur HDMI à l’aide de [Audio] > [Audio Output] > [HDMI/Stream Output CH] dans le menu de la caméra.
CH1/CH2 : combinaison CH1 et CH2
CH3/CH4 : combinaison CH3 et CH4
Lors de la surveillance de l’audio dans l’application Web, utilisez le vumètre audio en bas à droite de l’image de la
caméra.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Spécification des données temporelles

Cette rubrique décrit comment régler les données temporelles.

Réglage du code temporel

Réglez le code temporel à enregistrer à l’aide de [TC/Media] > [Timecode] dans le menu de la caméra.

Réglage des bits utilisateur

Vous pouvez ajouter un nombre hexadécimal à 8 chiffres à l’image enregistrée en tant que bits utilisateur. Vous pouvez
également régler les bits utilisateur sur l’heure actuelle. Réglez à l’aide de [TC/Media] > [Users Bit] dans le menu de la
caméra.

Affichage des données temporelles

Réglez le code temporel à enregistrer à l’aide de [TC/Media] > [TC Display] > [Display Select] dans le menu de la
caméra.
Appuyer sur une touche personnalisable à laquelle [DURATION/TC/U-BIT] est attribué commute l’affichage entre le code
temporel, les bits utilisateur et la durée, dans cet ordre.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Passage en revue de l’enregistrement (Rec Review)

Vous pouvez revoir le dernier plan enregistré sur l’écran (révision d’enregistrement).

Note

Rec Review n’est pas pris en charge si le format vidéo est modifié après l’enregistrement d’un plan.

Réglage de la position de départ de la révision d’enregistrement

Vous pouvez configurer la position de départ de la lecture sur l’un des paramètres suivants à l’aide de [Technical] > [Rec
Review] dans le menu de la caméra.

Les 3 dernières secondes du plan
Les 10 dernières secondes du plan
Début du plan

Astuce

Si vous souhaitez examiner un plan spécifique après avoir enregistré plusieurs plans, appuyez sur la touche [Thumbnail] pour
afficher l’écran des miniatures, et sélectionnez le plan pour lancer la lecture.

Vous pouvez également appuyer sur la touche THUMBNAIL de la télécommande infrarouge fournie pour afficher l’écran des
miniatures.

Méthode de révision d’enregistrement

Attribuez au préalable la fonction de révision d’enregistrement à l’une des touches attribuables dans le panneau de
réglage de la configuration de base.

Pour les détails sur l’attribution, consultez « Touches personnalisables » dans « Fonctions utiles ».

Arrêtez l’enregistrement puis appuyez sur une touche personnalisable à laquelle la fonction Rec Review a été attribuée
pour lancer la lecture du plan précédemment enregistré.
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Le plan est lu jusqu’à la fin, la révision d’enregistrement prend fin et l’appareil revient en mode Stby (veille).

Pour arrêter Rec Review
Appuyez sur une touche personnalisable à laquelle la révision d’enregistrement est attribuée ou appuyez sur la touche
[Cancel/Back].
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Astuce

Vous pouvez également appuyer sur la touche [Cancel/Back] de la télécommande infrarouge fournie pour arrêter la fonction Rec
Review.

Rubrique associée

Touches personnalisables

5-041-957-23(1) Copyright 2022 Sony Corporation

137



Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Écran de réglage du cadrage

Le cadrage est ajusté à l’aide des sections suivantes de l’écran d’opération en direct.

Note

En fonction de l’orientation de la caméra, de la longueur focale de l’objectif et de la position du zoom, une partie de l’appareil ou
des câbles connectés au bloc de connecteur peut être visible. Avant une prise de vue, vérifiez le champ de vision de l’objectif et
la longueur focale que vous utilisez. Vous pouvez également contrôler la plage de panoramique/inclinaison à l’aide de [Pan-Tilt] >
[P/T Range Limit] dans le menu Web. Lorsque l’appareil est mis sous tension ou que la réinitialisation de panoramique/inclinaison
est exécutée, ce réglage de limite de plage est ignoré. Pour plus de détails, consultez [Pan-Tilt] > [P/T Range Limit] dans le menu
Web.

Astuce

Vous pouvez également commander le cadrage à l’aide de la télécommande infrarouge fournie.

5-041-957-23(1) Copyright 2022 Sony Corporation

Panneau de commande de position prédéfinie1.

Onglet  (Main) / onglet  (Others)2.

Panneau de commande du cadrage3.
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Réglage de la direction de la prise de vue à l’aide de l’application Web

Le panoramique correspond à un déplacement horizontal de la caméra, et l’inclinaison à un déplacement vertical de la
caméra.
Vous pouvez ajuster la direction de la prise de vue à l’aide des opérations de panoramique/inclinaison.

Astuce

Si [Execute Pan-Tilt Reset] est affiché sous la manette de commande, une erreur est survenue au niveau de l’information
d’origine de la commande de panoramique/inclinaison de l’appareil. Exécutez la fonction de réinitialisation de
panoramique/inclinaison pour mettre à jour l’information d’origine. Pour les détails, consultez « Réinitialisation de
panoramique/inclinaison ».

Pour replacer la caméra de face
Appuyez sur la touche  (Panoramique/inclinaison initiale) dans l’onglet  (Others) dans le panneau de
commande de la caméra.

Note

En fonction de l’orientation de la caméra, de la longueur focale de l’objectif et de la position du zoom, une partie de l’appareil ou
des câbles connectés au bloc de connecteur peut être visible. Avant une prise de vue, vérifiez le champ de vision de l’objectif et
la longueur focale que vous utilisez. Vous pouvez également contrôler la plage de panoramique/inclinaison à l’aide de [Pan-Tilt] >
[P/T Range Limit] dans le menu Web. Lorsque l’appareil est mis sous tension ou que la réinitialisation de panoramique/inclinaison
est exécutée, ce réglage de limite de plage est ignoré. Pour plus de détails, consultez [Pan-Tilt] > [P/T Range Limit] dans le menu
Web.

Appuyez sur l’onglet  (Panoramique/inclinaison/zoom) dans le panneau de commande du cadrage
pour afficher la manette de commande.

1

Glissez le centre de la manette de commande dans la direction à visualiser tout en surveillant le panneau
d’image de la caméra.

La direction et la vitesse de la caméra changent en fonction de la direction et de l’inclinaison du glissement effectué.
Vous pouvez ajuster le panoramique/l’inclinaison avec plus de précision en appuyant sur les zones autour de la
manette de commande.

2
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Rubrique associée
Réinitialisation de panoramique/inclinaison
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Réglage de la vitesse d’opération de panoramique/inclinaison

Vous pouvez modifier la vitesse d’opération de panoramique/inclinaison à l’aide du curseur [Pan-Tilt Speed] dans le
panneau de commande de la caméra en actionnant la manette de commande dans le panneau de commande du
cadrage.

Note

En cas de présence d’un mur ou d’un autre obstacle dans la plage de mouvement de la caméra, veillez à ce que la caméra et
l’objectif ne s’y heurtent pas pendant l’opération de panoramique/inclinaison.

L’accélération de l’opération de panoramique/inclinaison dépend de caractéristiques physiques, par exemple la répartition du
poids de l’objectif. Vous pouvez modifier le réglage d’accélération à l’aide de [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] dans
le menu Web ou le menu de la caméra.

5-041-957-23(1) Copyright 2022 Sony Corporation

Appuyez sur l’onglet  (Main) dans le panneau de commande de la caméra.1

Sélectionnez le curseur [Pan-Tilt Speed] dans la liste.

Si le curseur [Pan-Tilt Speed] n’est pas affiché, sélectionnez l’une des deux touches de sélection de fonction du
curseur afin d’afficher le curseur.

2

Déplacez le bouton de curseur vers la gauche ou la droite.

Déplacer le bouton vers la gauche permet de diminuer la vitesse d’opération, tandis que déplacer le bouton vers la
droite permet de l’augmenter.

3
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Réglage de l’accélération d’opération de panoramique/inclinaison

Vous pouvez régler l’accélération en neuf niveaux à l’aide de [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] dans le
menu Web ou dans le menu de la caméra. Augmentez la valeur pour des changements de vitesse plus rapide, ou
diminuez la valeur pour des changements de vitesse plus progressifs.
Pour une meilleure réactivité lors de l’opération de panoramique/inclinaison, sélectionnez une valeur dans la plage de 7
à 9.
Pour une meilleure précision de la position au début/à la fin du mouvement vers une position prédéfinie, une valeur dans
la plage de 1 à 6 est recommandée.

Pour plus de détails sur les positions prédéfinies, consultez « Sauvegarde/restauration de la position du
panoramique/inclinaison et du zoom ».

Note

Lorsque la valeur est élevée, la fonction peut ne pas fonctionner correctement si un objectif lourd est utilisé. Vérifiez l’opération
avant son utilisation.

Relation entre le réglage [Ramp Curve] et l’opération de panoramique/inclinaison

Lorsque l’opération de panoramique/inclinaison est actionnée

Lorsqu’une position prédéfinie est rappelée

142



5-041-957-23(1) Copyright 2022 Sony Corporation

143



Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Réglage de la direction de la prise de vue à l’aide de la télécommande infrarouge
fournie

Vous pouvez ajuster la direction de la prise de vue à l’aide des touches d’opération de panoramique/inclinaison de la
télécommande infrarouge fournie.

Pour replacer la caméra de face
Appuyez sur la touche HOME.

Note

En fonction de l’orientation de la caméra, de la longueur focale de l’objectif et de la position du zoom, une partie de l’appareil ou
des câbles connectés au bloc de connecteur peut être visible. Avant une prise de vue, vérifiez le champ de vision de l’objectif et
la longueur focale que vous utilisez. Vous pouvez également contrôler la plage de panoramique/inclinaison à l’aide de [Pan-Tilt] >
[P/T Range Limit] dans le menu Web. Lorsque l’appareil est mis sous tension ou que la réinitialisation de panoramique/inclinaison
est exécutée, ce réglage de limite de plage est ignoré. Pour plus de détails, consultez [Pan-Tilt] > [P/T Range Limit] dans le menu
Web.

5-041-957-23(1) Copyright 2022 Sony Corporation

Appuyez sur les touches fléchées pour commande le panoramique/l’inclinaison.

Appuyez sur la touche fléchée correspondant à la direction à visualiser tout en surveillant l’image de la caméra.
Pour effectuer un mouvement court, appuyez sur la touche fléchée brièvement.
Pour effectuer un mouvement ample, appuyez et maintenez enfoncée la touche fléchée.
Pour effectuer un mouvement diagonal, appuyez et maintenez enfoncée la touche  (flèche vers le haut) ou 
(flèche vers le bas) et appuyez sur la touche  (flèche gauche) ou  (flèche droite).

1
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Réglage du type de zoom

Réglez le type de zoom à l’aide de [Technical] > [Zoom] > [Zoom Type] dans le menu de la caméra.
Le type de zoom peut varier selon le type de l’objectif utilisé.

Note

Clear Image Zoom n’est pas disponible dans les cas suivants.

Lorsque le réglage [Shooting] > [S&Q Motion] > [Setting] est réglé sur On et que le réglage [Frame Rate] dans le menu de la
caméra est supérieur à 60 fps
Lorsque [Project] > [Rec Format] > [Codec] dans le menu de la caméra est réglé sur [RAW] ou sur une option incluant RAW

L’utilisation du commutateur de sélection SERVO/MANUAL sur un objectif réinitialise l’agrandissement de Clear Image Zoom sur
1×.

AF-S n’est pas pris en charge pendant Clear Image Zoom.

Clear Image Zoom

L’appareil est équipé d’une fonction de zoom qui utilise un traitement de signal d’image appelé Clear Image Zoom.
Lorsque Clear Image Zoom est activé, le zoom est pris en charge même pour des objectifs à mise au point fixe. Vous
pouvez aussi l’utiliser pour étendre la plage au-delà de la plage optique sur un objectif zoom motorisé.
Le rapport de zoom maximal avec Clear Image Zoom varie selon la résolution d’enregistrement.

Pour la résolution d’enregistrement QFHD/4K : 1,5×
Pour la résolution d’enregistrement HD : 2×

5-041-957-23(1) Copyright 2022 Sony Corporation

Type d’objectif utilisé
Réglage [Zoom Type]

[Optical Zoom Only] [On(Clear Image Zoom)]

Objectif à mise au point fixe/Objectif à
zoom manuel

L’opération de zoom n’est pas
prise en charge.

Clear Image Zoom est pris en charge.

Objectif zoom motorisé
Le zoom optique n’est pas pris en
charge.

Zoom optique et Clear Image Zoom sont
pris en charge.
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Réglage du zoom à l’aide de l’application Web

Vous pouvez ajuster le zoom de l’appareil à l’aide du zoom optique ou Clear Image Zoom. Cette rubrique décrit comment
effectuer les réglages à l’aide de l’application Web. Pour les détails sur Clear Image Zoom, consultez « Réglage du type
de zoom ».

Note

En fonction de l’orientation de la caméra, de la longueur focale de l’objectif et de la position du zoom, une partie de l’appareil ou
des câbles connectés au bloc de connecteur peut être visible. Avant une prise de vue, vérifiez le champ de vision de l’objectif et
la longueur focale que vous utilisez. Vous pouvez également contrôler la plage de panoramique/inclinaison à l’aide de [Pan-Tilt] >
[P/T Range Limit] dans le menu Web. Lorsque l’appareil est mis sous tension ou que la réinitialisation de panoramique/inclinaison
est exécutée, ce réglage de limite de plage est ignoré. Pour plus de détails, consultez [Pan-Tilt] > [P/T Range Limit] dans le menu
Web.

La vitesse de zoom et la précision réelles varient selon l’objectif. Vérifiez l’opération avant utilisation.

Astuce

Vous pouvez contrôler le zoom d’un objectif à zoom manuel en utilisant un contrôleur d’objectif (option) compatible avec cet
appareil. Pour plus de détails, consultez « Connexion d’un contrôleur d’objectif » et « Réglage du zoom à l’aide du contrôleur
d’objectif ».

Rubrique associée

Réglage du type de zoom

Connexion d’un contrôleur d’objectif

Réglage du zoom à l’aide du contrôleur d’objectif

Appuyez sur l’onglet  (Panoramique/inclinaison/zoom) dans le panneau de commande du cadrage
pour afficher le panneau de commande de panoramique/inclinaison.

1

Déplacez le bouton de curseur [Zoom] dans la direction [T] (téléobjectif) ou la direction [W] (grand angle)
pour ajuster le zoom.

La vitesse de zoom varie selon le mouvement du curseur.

2
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Réglage de la vitesse d’opération du zoom

Vous pouvez modifier la vitesse d’opération du curseur de [Zoom] dans le panneau de commande du cadrage à l’aide du
curseur [Zoom Speed] dans le panneau de commande de la caméra.

Note

La vitesse de zoom et la précision réelles varient selon l’objectif. Vérifiez l’opération avant utilisation.

5-041-957-23(1) Copyright 2022 Sony Corporation

Appuyez sur l’onglet  (Main) dans le panneau de commande de la caméra.1

Sélectionnez le curseur [Zoom Speed] dans la liste.

Si le curseur [Zoom Speed] n’est pas affiché, sélectionnez l’une des deux touches de sélection de fonction du
curseur afin d’afficher le curseur.

 

2

Déplacez le bouton de curseur [Zoom Speed] vers la gauche ou la droite.

Déplacer le bouton vers la gauche permet de diminuer la vitesse d’opération, tandis que déplacer le bouton vers la
droite permet de l’augmenter.

3
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Réglage du zoom à l’aide de la télécommande infrarouge fournie

Vous pouvez ajuster le zoom de l’appareil à l’aide du zoom optique ou Clear Image Zoom. Cette rubrique décrit comment
effectuer les réglages à l’aide de la télécommande infrarouge fournie. Pour les détails sur Clear Image Zoom, consultez
« Réglage du type de zoom ».

Note

En fonction de l’orientation de la caméra, de la longueur focale de l’objectif et de la position du zoom, une partie de l’appareil ou
des câbles connectés au bloc de connecteur peut être visible. Avant une prise de vue, vérifiez le champ de vision de l’objectif et
la longueur focale que vous utilisez. Vous pouvez également contrôler la plage de panoramique/inclinaison à l’aide de [Pan-Tilt] >
[P/T Range Limit] dans le menu Web. Lorsque l’appareil est mis sous tension ou que la réinitialisation de panoramique/inclinaison
est exécutée, ce réglage de limite de plage est ignoré. Pour plus de détails, consultez [Pan-Tilt] > [P/T Range Limit] dans le menu
Web.

Astuce

Vous pouvez contrôler le zoom d’un objectif à zoom manuel en utilisant un contrôleur d’objectif (option) compatible avec cet
appareil. Pour plus de détails, consultez « Connexion d’un contrôleur d’objectif » et « Réglage du zoom à l’aide du contrôleur
d’objectif ».

Rubrique associée

Réglage du type de zoom

Connexion d’un contrôleur d’objectif

Réglage du zoom à l’aide du contrôleur d’objectif

Appuyez sur la touche zoom pour ajuster le zoom.

Appuyez sur la touche T (téléobjectif) ou W (grand angle) tout en surveillant l’écran pour ajuster le zoom.
Pour effectuer un zoom avant, appuyez sur la touche T.
Pour effectuer un zoom arrière, appuyez sur la touche W.

1
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Étalonnage d’un objectif à monture E

L’étalonnage corrige les différences dans la position de zoom dues aux différences entre chaque objectif lors de
l’utilisation d’un objectif zoom motorisé à monture E.
Pour calculer la position du zoom avec précision, étalonnez votre objectif pour corriger les différences individuelles dues
à l’objectif à l’aide de la procédure suivante.

Données d’étalonnage
Les données d’étalonnage de cinq objectifs au maximum peuvent être sauvegardées sur l’appareil. Les données les
plus anciennes seront écrasées lors de l’étalonnage d’un 6e objectif ou des objectifs suivants.
Vous pouvez vérifier si les données d’étalonnage sont disponibles pour l’objectif utilisé en appuyant sur la touche 
(État de la caméra) disponible depuis la zone commune de l’écran de l’application Web et en sélectionnant [Lens] >
[Calibration Data].

5-041-957-23(1) Copyright 2022 Sony Corporation

Si l’objectif possède un commutateur SERVO/MANUAL, réglez-le sur la position SERVO.

Note

L’objectif ne pourra pas recevoir d’instructions de zoom de l’appareil si le commutateur est réglé sur MANUAL.

1

Lancez l’étalonnage à l’aide de [Technical] > [Lens] > [Lens Calibration] dans le menu de la caméra.

Durant l’étalonnage, l’objectif zoom se déplace automatiquement et est mesuré.

2
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Sauvegarde/restauration du panoramique/inclinaison, de la position du zoom et du
réglage de mise au point à l’aide de l’application Web

Vous pouvez sauvegarder/restaurer le panoramique/inclinaison, la position du zoom et le réglage de mise au point et les
rappeler si nécessaire à l’aide de l’application Web (fonction de position prédéfinie).

Pour les détails sur les éléments pouvant être sauvegardés/restaurés, consultez « Éléments enregistrés avec une
position prédéfinie ».

Note

Il n’est pas possible de sauvegarder une position prédéfinie si le rapport Clear Image Zoom dépasse 1×.

Si le réglage [Pan-Tilt] > [P/T Direction] > [Ceiling] dans le menu Web est modifié, toutes les positions prédéfinies sauvegardées
sont supprimées.

Réglez le mode d’assistance PTZ sur [Pos.] dans la liste déroulante située en haut du panneau de
commande des positions prédéfinies.

1

Déterminez la position que vous souhaitez sauvegarder à l’aide des opérations de panoramique/inclinaison
et de zoom.

2

Appuyez sur la touche [+] dans le panneau de commande des positions prédéfinies.

L’image de la position sauvegardée s’affiche dans le panneau de commande des positions prédéfinies.

Astuce

Si le panneau de commande des positions prédéfinies ne s’affiche pas, appuyez sur la touche  (Ouvrir) pour l’afficher.

Les positions sont sauvegardées dans une séquence commençant par [Preset1].

3
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Pour annuler l’opération de restauration d’une position prédéfinie
Appuyez sur la touche  (Annuler la restauration) affichée sur le panneau de commande des positions prédéfinies
pendant l’opération de restauration des positions prédéfinies pour annuler l’opération de restauration. Utilisez la manette
de commande et le curseur [Zoom] pour ajuster le cadrage.

Si une séquence de préréglages en contient des inutilisés, les positions seront sauvegardées dans les préréglages
commençant par ceux inutilisés. Par exemple, si des positions prédéfinies sont sauvegardées dans [Preset1] et [Preset3]
mais pas dans [Preset2], les prochaines positions prédéfinies seront sauvegardées dans [Preset2] puis [Preset4].

Il est possible de sauvegarder jusqu’à 100 positions prédéfinies.

Vous pouvez renommer chaque position prédéfinie. Pour plus de détails, consultez « Renommage des positions prédéfinies
à l’aide de l’application Web ».

Restaurez une position sauvegardée.

Appuyez deux fois sur la miniature de la position que vous souhaitez restaurer dans le panneau de commande des
positions prédéfinies pour restaurer la position correspondante.

Astuce

Vous pouvez également restaurer une position en appuyant sur l’image, en appuyant sur la touche  (Menu de position
prédéfinie) qui apparaît et en sélectionnant [Recall].

La vitesse de transition d’une position sauvegardée est déterminée par le réglage [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] >
[Pan-Tilt Speed for Common] dans le menu Web quand la position a été sauvegardée. Vous pouvez également modifier la
vitesse de transition après la sauvegarde. Pour plus de détails, consultez « Modification de la vitesse de transition
(panoramique-inclinaison/zoom/mise au point) lors de la restauration d’une position prédéfinie ».

Le degré de modification de la position panoramique/inclinaison lors du déplacement vers une position prédéfinie peut être
ajusté à l’aide des réglages de vitesse de transition et [Ramp Curve]. Pour plus de détails, consultez « Modification de la
vitesse de transition (panoramique-inclinaison/zoom/mise au point) lors de la restauration d’une position prédéfinie » et
« Réglage de l’accélération d’opération de panoramique/inclinaison ».

Si un autre préréglage est rappelé pendant la lecture d’un préréglage, le fonctionnement du premier préréglage rappelé
s’arrête et l’opération du préréglage rappelé par la suite commence.

Note

Si la température de l’environnement a changé de manière significative entre le moment où une position prédéfinie a été
sauvegardée et le moment où elle est lue, une déviation du cadrage peut se produire.

Pendant la restauration d’une position prédéfinie, vous ne pouvez pas effectuer d’autres opérations que la restauration ou
l’annulation de la position prédéfinie.

4
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Rubrique associée

Éléments enregistrés avec une position prédéfinie

Renommage des positions prédéfinies à l’aide de l’application Web

Modification de la vitesse de transition (panoramique-inclinaison/zoom/mise au point) lors de la restauration d’une
position prédéfinie

Réglage de l’accélération d’opération de panoramique/inclinaison

5-041-957-23(1) Copyright 2022 Sony Corporation

154



Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Renommage des positions prédéfinies à l’aide de l’application Web

Vous pouvez renommer les positions prédéfinies sauvegardées.

5-041-957-23(1) Copyright 2022 Sony Corporation

Réglez le mode d’assistance PTZ sur [Pos.] dans la liste déroulante située en haut du panneau de
commande des positions prédéfinies.

1

Appuyez sur la position prédéfinie que vous souhaitez renommer.

La touche  (Menu de position prédéfinie) apparaît en haut à droite de l’image.

2

Appuyez sur la touche  (Menu de position prédéfinie) et sélectionnez [Rename] dans le menu affiché.3

Saisissez un nouveau nom de préréglage.4
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Remplacement d’une position prédéfinie sauvegardée par une nouvelle position à
l’aide de l’application Web

Vous pouvez remplacer une position prédéfinie sauvegardée par une nouvelle position.
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Réglez le mode d’assistance PTZ sur [Pos.] dans la liste déroulante située en haut du panneau de
commande des positions prédéfinies.

1

Déterminez la position que vous souhaitez sauvegarder à l’aide des opérations de panoramique/inclinaison
et de zoom.

2

Appuyez sur l’image de la position que vous souhaitez remplacer dans le panneau de commande des
positions prédéfinies.

La touche  (Menu de position prédéfinie) apparaît en haut à droite de l’image.

3

Appuyez sur la touche  (Menu de position prédéfinie) et sélectionnez [Replace] dans le menu affiché.

Une nouvelle position remplace l’actuelle.

4
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Suppression d’une position prédéfinie sauvegardée à l’aide de l’application Web

Vous pouvez supprimer les positions prédéfinies sauvegardées.
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Réglez le mode d’assistance PTZ sur [Pos.] dans la liste déroulante située en haut du panneau de
commande des positions prédéfinies.

1

Appuyez sur l’image de position que vous souhaitez supprimer dans le panneau de commande des
positions prédéfinies.

La touche  (Menu de position prédéfinie) apparaît en haut à droite de l’image.

2

Appuyez sur la touche  (Menu de position prédéfinie) et sélectionnez [Delete] dans le menu affiché.

La position sauvegardée est supprimée.

3
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Synchronisation de l’opération de panoramique/inclinaison et de l’opération de
zoom/mise au point lors de la restauration d’une position prédéfinie

Vous pouvez synchroniser l’opération de panoramique/inclinaison et l’opération de zoom lors de la restauration d’une
position prédéfinie sauvegardée pour un cadrage plus fluide.

Astuce

Vous pouvez spécifier au préalable les réglages utilisés pour l’enregistrement d’une position prédéfinie. Réglez [Pan-Tilt] > [P/T
Preset] > [Default] > [Zoom Sync] sur [On] dans le menu Web.

Lorsque [Pan-Tilt] > [P/T Preset] > [Speed Select] est réglé sur [Common], toutes les positions prédéfinies seront restaurées à la
vitesse définie à l’aide de [Pan-Tilt] > [P/T Preset] > [Common Speed].

Une fois le mouvement de zoom terminé, la caméra se déplace vers la position de mise au point sauvegardée.

Réglez le mode d’assistance PTZ sur [Pos.] dans la liste déroulante située en haut du panneau de
commande des positions prédéfinies.

1

Appuyez sur l’image correspondant à la position prédéfinie pour laquelle vous souhaitez modifier la vitesse
de transition.

La touche  (Menu de position prédéfinie) apparaît en haut à droite de l’image.

2

Appuyez sur la touche  (Menu de position prédéfinie) et sélectionnez [Edit…] dans le menu affiché.

L’écran de configuration de la position définie sélectionnée apparaît.

3

Faites glisser le commutateur [Zoom Sync] vers la droite pour activer la fonction et appuyez sur la touche
[OK].

La prochaine fois qu’une position sauvegardée sera restaurée, la caméra se déplacera à la vitesse configurée.

4
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Une fois le mouvement terminé, [AF Transition Speed] revient à son réglage d’origine.
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Modification de la vitesse de transition (panoramique-inclinaison/zoom/mise au point)
lors de la restauration d’une position prédéfinie

Vous pouvez modifier la vitesse de transition (opération de panoramique/inclinaison, opération de zoom, opération de
mise au point) lors de la restauration d’une position prédéfinie sauvegardée.

Astuce

Lorsque [Pan-Tilt] > [P/T Preset] > [Speed Select] est réglé sur [Common], toutes les positions seront restaurées à la vitesse
définie à l’aide de [Pan-Tilt] > [P/T Preset] > [Common Speed].

Une fois le mouvement de zoom terminé, la caméra se déplace vers la position de mise au point sauvegardée.

Réglez [Pan-Tilt] > [P/T Preset] > [Speed Select] sur [Separate] dans le menu Web.1

Réglez le mode d’assistance PTZ sur [Pos.] dans la liste déroulante située en haut du panneau de
commande des positions prédéfinies.

2

Appuyez sur l’image correspondant à la position prédéfinie pour laquelle vous souhaitez modifier la vitesse
de transition.

La touche  (Menu de position prédéfinie) apparaît en haut à droite de l’image.

3

Appuyez sur la touche  (Menu de position prédéfinie) et sélectionnez [Edit…] dans le menu affiché.

L’écran de configuration de la position définie sélectionnée apparaît.

4

Réglez les vitesses de transition (panoramique-inclinaison/zoom/mise au point) que vous souhaitez
modifier à l’aide des curseurs ou saisissez les valeurs directement et appuyez sur la touche [OK].

La prochaine fois qu’une position sauvegardée sera restaurée, la caméra se déplacera à la vitesse configurée.

5
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Une fois le mouvement terminé, [AF Transition Speed] revient à son réglage d’origine.
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Sauvegarde/restauration de la position du panoramique/inclinaison et du zoom à
l’aide de la télécommande infrarouge fournie

Vous pouvez sauvegarder le panoramique/inclinaison et la position du zoom et les rappeler si nécessaire à l’aide de la
télécommande infrarouge fournie.

Rubrique associée
Modification de la vitesse de transition (panoramique-inclinaison/zoom/mise au point) lors de la restauration d’une
position prédéfinie

Ajustez le panoramique/inclinaison et le zoom de la caméra.1

Réglez le mode d’assistance PTZ sur [Pos.] dans la liste déroulante en haut du panneau de commande des
positions prédéfinies dans l’application Web.

2

Appuyez et maintenez enfoncée la touche PRESET et appuyez sur l’une des touches 1 à 3.

La position est sauvegardée.

3

Restaurez une position sauvegardée.

Appuyez sur l’une des touches 1 à 3 pour restaurer la position prédéfinie.

Astuce

La vitesse de transition lors de la restauration d’une position prédéfinie est déterminée par la valeur sauvegardée [Pan-Tilt]
> [P/T Preset] > [Pan-Tilt Speed] dans le menu Web. Vous pouvez modifier la vitesse de transition après la sauvegarde
d’une valeur. Pour plus de détails, consultez « Modification de la vitesse de transition (panoramique-inclinaison/zoom/mise
au point) lors de la restauration d’une position prédéfinie ».

4

162



5-041-957-23(1) Copyright 2022 Sony Corporation

163



Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Enregistrement des opérations de cadrage de la caméra à l’aide de l’application Web

Vous pouvez enregistrer les opérations de cadrage de la caméra à l’aide de l’application Web.

Ajustez la position de départ de l’opération de la caméra.1

Réglez le mode d’assistance PTZ sur [Trace] dans la liste déroulante située en haut du panneau de
commande des positions prédéfinies.

2

Appuyez sur la touche [+] dans le panneau de commande des positions prédéfinies.

Une miniature est ajoutée et la caméra passe en état de veille d’enregistrement.

Astuce

3
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Astuce

Le temps d’enregistrement restant s’affiche en haut du panneau d’image de la caméra pendant l’enregistrement.

Note

Les opérations de cadrage enregistrées seront supprimées si vous passez au montage au plafond

La commutation de fréquence du système peut supprimer les opérations de cadrage enregistrées.

L’opération de zoom n’est pas enregistrée lorsqu’un contrôleur d’objectif est connecté.

La durée maximale d’enregistrement d’une seule opération de cadrage est de 3 minutes. L’enregistrement s’arrête
automatiquement lorsque la durée d’enregistrement atteint 3 minutes.

L’enregistrement d’une opération de cadrage ne peut pas être lancé si le rapport Clear Image Zoom est supérieur à 1×.

Si la caméra est pilotée par un autre dispositif pendant l’enregistrement d’une opération de cadrage, les opérations de l’autre
dispositif seront également enregistrées. Pour plus de détails sur les opérations d’enregistrement à l’aide d’une télécommande de
tiers, contactez le fabricant correspondant.

Les réglages de mise au point et de qualité d’image ne sont pas enregistrés par cette fonction.

Vous pouvez appuyer sur la touche  (Fermer) de la miniature pour quitter l’état de veille d’enregistrement et revenir au
fonctionnement normal.

Commencez l’opération de cadrage à l’aide de la manette de commande et du curseur [Zoom].

L’enregistrement commence à l’instant où l’opération de cadrage commence.

4

Appuyez sur la touche  (Arrêter l’enregistrement) sur la miniature pour arrêter l’enregistrement.5
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Les opérations de panoramique/inclinaison/zoom enregistrées lors de l’enregistrement d’une opération de cadrage ne peuvent
pas être reproduites exactement pendant la lecture du cadrage.

Si, après avoir enregistré une opération de cadrage, vous définissez la limite de la plage de panoramique/inclinaison à l’aide de
[Pan-Tilt] > [P/T Range Limit] dans le menu Web, la limite de la plage de panoramique/inclinaison ne sera pas appliquée pendant
la lecture du cadrage. Si vous souhaitez utiliser une opération de cadrage et la fonction de limite de la plage de
panoramique/inclinaison ensemble, réglez la limite de la plage de panoramique/inclinaison avant d’enregistrer l’opération de
cadrage.

Les opérations de cadrage enregistrées ne peuvent pas être lues lorsque la sortie vidéo RAW est sélectionnée.

Les opérations de cadrage enregistrées ne peuvent pas être lues lorsque le signal vidéo n’est pas émis par le connecteur de
sortie SDI.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Lecture des opérations de cadrage de la caméra à l’aide de l’application Web

Vous pouvez lire une opération de cadrage de la caméra enregistrée à l’aide de l’application Web.

Réglez le mode d’assistance PTZ sur [Trace] dans la liste déroulante située en haut du panneau de
commande des positions prédéfinies.

1

Sélectionnez une miniature contenant l’opération de cadrage que vous souhaitez lire.

La touche  (Préparer) apparaît sur la miniature.

2

Appuyez sur la touche  (Préparer).

La caméra se déplace vers la position de départ de l’opération de cadrage et passe à l’état de veille de lecture.

3

Appuyez sur la touche  (Lecture) sur la miniature.4
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Astuce

En état de veille de lecture et pendant la lecture, vous pouvez annuler la lecture et revenir au fonctionnement normal en
effectuant l’une des opérations suivantes.

Appuyez sur la touche  (Arrêt) sur la miniature ou dans le panneau de commande des positions prédéfinies.
Actionnez la manette de commande.
Actionnez le curseur [Zoom].

Le temps de lecture écoulé s’affiche en haut du panneau d’image de la caméra pendant la lecture.

Note

Un comportement inattendu peut se produire si le réglage Clear Image Zoom varie entre l’enregistrement et la lecture des
opérations de cadrage.

La lecture de l’opération de zoom n’est pas prise en charge lorsqu’un contrôleur d’objectif est connecté. L’utilisation du zoom
arrêtera la lecture des opérations de cadrage.

Pendant la lecture de l’opération de cadrage, la modification de la limite de la plage de panoramique/inclinaison à l’aide de [Pan-
Tilt] > [P/T Range Limit] dans le menu Web n’a aucun effet. Réglez la limite de la plage de panoramique/inclinaison avant
d’enregistrer une opération de cadrage.

5-041-957-23(1) Copyright 2022 Sony Corporation

La lecture de cadrage commence.
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Suppression des opérations de cadrage enregistrées par la caméra à l’aide de
l’application Web

Vous pouvez supprimer les opérations de cadrage enregistrées par la caméra à l’aide de l’application Web.

5-041-957-23(1) Copyright 2022 Sony Corporation

Réglez le mode d’assistance PTZ sur [Trace] dans la liste déroulante située en haut du panneau de
commande des positions prédéfinies.

1

Sélectionnez une miniature contenant l’opération de cadrage que vous souhaitez supprimer.

La touche  (menu Trace) apparaît sur la miniature.

2

Appuyez sur la touche  (menu Trace).

Le menu apparaît.

3

Sélectionnez [Delete] dans le menu affiché.

L’opération de cadrage sélectionnée est supprimée.

4
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Enregistrement des opérations de cadrage de la caméra à l’aide de la télécommande
infrarouge fournie

Vous pouvez enregistrer les opérations de cadrage de la caméra à l’aide de la télécommande infrarouge fournie.

Pour plus de détails sur la lecture d’une opération de cadrage enregistrée, consultez « Lecture des opérations de
cadrage de la caméra à l’aide de la télécommande infrarouge fournie ».

Note

La durée maximale d’enregistrement d’une seule opération de cadrage est de 3 minutes. L’enregistrement s’arrête
automatiquement lorsque la durée d’enregistrement atteint 3 minutes.

Si la caméra est pilotée par un autre dispositif pendant l’enregistrement d’une opération de cadrage, l’opération de l’autre
dispositif sera également enregistrée comme faisant partie de l’opération de cadrage.

Si la qualité d’image est ajustée pendant l’enregistrement d’une opération de cadrage, ce changement n’est pas enregistré.

Rubrique associée

Lecture des opérations de cadrage de la caméra à l’aide de la télécommande infrarouge fournie

5-041-957-23(1) Copyright 2022 Sony Corporation

Accédez à l’écran d’opération en direct de l’application Web.1

Réglez le mode d’assistance PTZ sur [Trace] dans la liste déroulante située en haut du panneau de
commande des positions prédéfinies.

2

Réglez la position de départ de l’opération de la caméra à l’aide de la télécommande infrarouge.3

Appuyez et maintenez enfoncée la touche PRESET et appuyez sur l’une des touches POSITION1 à 3.

La caméra passe à l’état de veille d’enregistrement.

4

Effectuez l’opération de cadrage que vous souhaitez enregistrer.5

Pour terminer l’enregistrement, appuyez et maintenez enfoncée la touche PRESET, et appuyez sur la touche
POSITION sélectionnée à l’étape 4.

6
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Lecture des opérations de cadrage de la caméra à l’aide de la télécommande
infrarouge fournie

Vous pouvez lire une opération de cadrage de la caméra à l’aide de la télécommande infrarouge fournie.

Note

L’utilisation de la fonction panoramique/inclinaison/zoom de la caméra arrêtera la lecture.

Rubrique associée

Enregistrement des opérations de cadrage de la caméra à l’aide de la télécommande infrarouge fournie
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Accédez à l’écran d’opération en direct de l’application Web.1

Réglez le mode d’assistance PTZ sur [Trace] dans la liste déroulante située en haut du panneau de
commande des positions prédéfinies.

2

Sélectionnez et appuyez sur l’une des touches POSITION1 à 3 pour laquelle une opération de cadrage a été
enregistrée.

Le panoramique, l’inclinaison et le zoom de la caméra se déplacent vers la position de départ de la lecture.

3

Une fois que la caméra s’est déplacée vers la position de départ de la lecture, appuyez à nouveau sur la
même touche POSITION.

La lecture commence.

4
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Écran de réglage de la mise au point

La mise au point est ajustée depuis les sections suivantes de l’écran d’opération en direct.

5-041-957-23(1) Copyright 2022 Sony Corporation

Panneau d’image de la caméra
Vous pouvez ajuster la mise au point en touchant l’image de la caméra. Vous pouvez désactiver l’opération tactile
dans l’application Web en désactivant le commutateur [Touch Focus] dans l’onglet  (Focus) dans le panneau de
commande de la caméra.

1.

Panneau de commande de la caméra – onglet  (Focus)2.

Panneau de commande GUI3.
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Réglage manuel à l’aide de l’application Web

Vous pouvez ajuster la mise au point manuellement, par exemple, dans les cas suivants.

Sujets partiellement assombris par des gouttelettes d’eau
Sujets avec un contraste faible par rapport à l’arrière-plan
Sujets plus éloignés que les sujets proches

Note

La mise au point manuelle ne peut pas être contrôlée à partir de l’application Web lorsque l’opération de zoom est en cours.

Astuce

Vous pouvez également utiliser la mise au point automatique lorsque le réglage manuel est la méthode principale d’utilisation.
Pour les détails, consultez « Réglage manuel de la cible de mise au point automatique (AF Assist) à l’aide de l’application Web ».

Rubrique associée

Vérification des commutateurs d’objectif

Réglage manuel de la cible de mise au point automatique (AF Assist) à l’aide de l’application Web

5-041-957-23(1) Copyright 2022 Sony Corporation

Si l’objectif est pourvu d’un commutateur de sélection de mise au point, réglez le commutateur sur la
position « AF/MF » ou « AF ».

Note

Si le commutateur est réglé sur la position « Full MF » ou « MF », la mise au point de l’objectif ne peut pas être réalisée
depuis l’appareil. Consultez « Pour un objectif avec commutateur de mode de mise au point » dans « Vérification des
commutateurs d’objectif ».

1

Faites glisser le commutateur [Auto Focus] à la position de gauche dans le panneau de commande de la
caméra pour désactiver la mise au point automatique.

Le mode de mise au point manuelle est activé.

 (MF)

2

Réglez à l’aide du curseur situé en bas de l’onglet  (Focus).3
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Réglage manuel à l’aide de la télécommande infrarouge fournie

Vous pouvez ajuster la mise au point manuellement avec la télécommande infrarouge fournie.

Astuce

Vous pouvez également utiliser la mise au point automatique lorsque le réglage manuel est la méthode principale d’utilisation.
Pour plus de détails, consultez « Mise au point manuelle pendant la mise au point automatique à l’aide de la télécommande
infrarouge fournie ».

Rubrique associée

Mise au point manuelle pendant la mise au point automatique à l’aide de la télécommande infrarouge fournie

5-041-957-23(1) Copyright 2022 Sony Corporation

Appuyez sur la touche MF de la télécommande infrarouge.1

Ajustez la mise au point manuellement à l’aide des touches F (éloigné) et N (rapproché).

Pour effectuer la mise au point sur un sujet éloigné, appuyez sur la touche F.
Pour effectuer la mise au point sur un sujet proche, appuyez sur la touche N.

2
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Mise au point en spécifiant une position de mise au point (mise au point sur un point)

En mode de mise au point manuelle, vous pouvez spécifier la position à laquelle vous souhaitez ajuster la mise au point
dans le panneau d’image de la caméra.

Note

La fonction mise au point sur un point ne fonctionne pas si l’objectif est réglé pour la mise au point manuelle.

Astuce

En mode de mise au point sur un point, vous pouvez appuyer sur une touche personnalisable attribuée avec [Push AF/MF] pour
arrêter temporairement la mise au point sur un point et activer la mise au point automatique pendant que la touche est enfoncée.
La mise au point repasse en mode manuel quand vous relâchez la touche.

5-041-957-23(1) Copyright 2022 Sony Corporation

Réglez [Shooting] > [Focus] > [Touch Function in MF] sur [Spot Focus] dans le menu Web ou le menu de la
caméra.

1

Faites glisser le commutateur [Touch Focus] dans l’onglet  (Focus) à la position de droite pour l’activer.2

Faites glisser le commutateur [Auto Focus] de l’onglet  (Focus) à la position de gauche pour le
désactiver.

3

Spécifiez la position de mise au point.

Le repère de mise au point sur un point apparaît et l’image est ajustée pour se mettre au point sur cette position.

Exemple de spécification de position par opération tactile

4

175



Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Utilisation temporaire de la mise au point automatique (Push Auto Focus (AF))

En mode de mise au point manuelle, vous pouvez ajuster la mise au point temporairement à l’aide de la mise au point
automatique en appuyant sur la touche [Push AF/MF] pour effectuer la mise au point automatique pendant que la touche
est enfoncée.
Ceci est utile lorsque vous voulez régler lentement la mise au point d’un sujet à un autre lors de la mise au point
manuelle.

Note

La fonction de mise au point automatique par pression ne fonctionne pas si l’objectif est réglé pour la mise au point manuelle.

Astuce

La même opération est possible avec une touche personnalisable à laquelle vous avez attribué [Push AF/MF].

5-041-957-23(1) Copyright 2022 Sony Corporation

Réglez [Shooting] > [Focus] > [Push AF Mode] sur [AF] dans le menu de la caméra.1

Faites glisser le commutateur [Auto Focus] de l’onglet  (Focus) à la position de gauche pour le
désactiver.

2

Appuyez sur la touche [Push AF/MF].

La mise au point automatique est activée lorsque la touche est enfoncée.

La mise au point repasse en mode manuel quand vous relâchez la touche de mise au point automatique par
pression.

3
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Utilisation de la mise au point automatique à prise de vue unique (Push Auto Focus
(AF-S))

Vous pouvez appuyer sur la touche [Push AF/MF] en mode de mise au point manuelle pour effectuer automatiquement la
mise au point à vitesse élevée.
Cette fonction est pratique lorsque vous effectuez la mise au point sur un sujet avant la prise de vue.

Note

Réglez [Shooting] > [Focus] > [Push AF Mode] sur [Single-shot AF(AF-S)] dans le menu Web ou le menu de
la caméra.

1

Spécifiez la position pour laquelle vous souhaitez ajuster la mise au point à l’aide de [Shooting] > [Focus] >
[Focus Area (AF-S)] dans le menu de la caméra.

Astuce

Vous pouvez changer la position en appuyant sur la touche personnalisable à laquelle vous avez attribué [Focus Setting]
pour afficher un cadre orange autour de la zone de mise au point et en sélectionnant une position par opération tactile.

2

Faites glisser le commutateur [Auto Focus] de l’onglet  (Focus) à la position de gauche pour le
désactiver.

3

Appuyez sur la touche [Push AF/MF].

Si vous relâchez la touche avant la fin de la mise au point, la mise au point automatique par pression s’arrêtera.

Durant la mise au point automatique par pression, l’état de la mise au point est indiqué par l’indicateur de mise au
point.
On : la mise au point reste sur la position de mise au point.
Clignotant : hors mise au point. Puisque la mise au point de l’appareil ne sera pas automatique, modifiez les
réglages de composition et de mise au point pour réaliser la mise au point.
La mise au point repasse en mode manuel quand vous relâchez la touche.

4
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La fonction de mise au point automatique par pression ne fonctionne pas si l’objectif est réglé pour la mise au point manuelle.

Le cadre de la zone de mise au point n’est pas masqué lorsque vous utilisez la touche [Display].

Pendant Clear Image Zoom, la position du cadre [Focus Area (AF-S)] ne peut pas être définie. Pendant l’opération de mise au
point automatique par pression, l’opération AF donne également la priorité à la partie centrale.

Astuce

La même opération est possible avec une touche personnalisable à laquelle vous avez attribué [Push AF/MF].

Vous pouvez également attribuer [Push AF Mode] à une touche personnalisable.

Vous pouvez également attribuer [Focus Area (AF-S)] à une touche personnalisable.

Vous pouvez afficher/masquer le cadre de la zone de mise au point à l’aide de [Monitoring] > [Display On/Off] > [Focus Area Ind.
(AF-S)] dans le menu de la caméra.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Réglage automatique à l’aide de l’application Web

L’appareil utilise l’AF à détection de phase pour une mise au point ultra rapide et l’AF de contraste pour une mise au
point ultra précise.
La combinaison de ces deux méthodes AF permet une mise au point automatique à vitesse rapide et haute précision.

Note

Un objectif prenant en charge la mise au point automatique est requis.

Vous risquez de ne pas obtenir une bonne précision selon les conditions de prise de vue.

La mise au point ne peut pas être ajustée automatiquement sur un objectif à monture A.

Astuce

En mode de mise au point automatique, vous pouvez ajuster Focus à l’aide du curseur de mise au point dans le panneau de
commande de la caméra. Pour les détails, consultez « Réglage manuel de la cible de mise au point automatique (AF Assist) à
l’aide de l’application Web ».

Rubrique associée
Vérification des commutateurs d’objectif

Réglage manuel de la cible de mise au point automatique (AF Assist) à l’aide de l’application Web
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Si l’objectif est pourvu d’un commutateur de sélection de mise au point, réglez le commutateur sur la
position « AF/MF » ou « AF ».

Note

Si le commutateur est réglé sur la position « Full MF » ou « MF », la mise au point de l’objectif ne peut pas être réalisée
depuis l’appareil. Consultez « Pour un objectif avec commutateur de mode de mise au point » dans « Vérification des
commutateurs d’objectif ».

1

Faites glisser le commutateur [Auto Focus] à la position de droite dans le panneau de commande de la
caméra pour l’activer.

Le mode de mise au point automatique est activé.

 (AF)

2
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Réglage automatique à l’aide de la télécommande infrarouge fournie

Vous pouvez ajuster la mise au point automatiquement à l’aide de la télécommande infrarouge fournie.

Note

Vous pouvez également utiliser la mise au point automatique lorsque le réglage manuel est la méthode principale d’utilisation.
Pour plus de détails, consultez « Mise au point manuelle pendant la mise au point automatique à l’aide de la télécommande
infrarouge fournie ».

Rubrique associée

Mise au point manuelle pendant la mise au point automatique à l’aide de la télécommande infrarouge fournie
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Appuyez sur la touche AF de la télécommande infrarouge.

La mise au point sur le sujet est ajustée automatiquement.

1
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Réglage de la zone/position de mise au point automatique (zone de mise au point)

Vous pouvez régler la zone cible pour la mise au point automatique et ajuster la mise au point dans cette zone.

Appuyez sur la touche [Menu] dans le panneau de commande GUI pour ouvrir le menu de la caméra.1

Réglez la zone cible pour la mise au point automatique à l’aide de [Shooting] > [Focus] > [Focus Area] dans
le menu de la caméra.

[Wide] :
Recherche un sujet dans un grand angle de l’image lors de la mise au point. Aucune image ne s’affiche.

[Zone] :
Recherche automatiquement une position de mise au point dans la zone spécifiée.
Après la sélection, spécifiez la position à l’aide des touches fléchées dans le panneau de commande GUI.

Vous pouvez revenir à la position centrale en maintenant enfoncée la touche [Set].
[Flexible Spot] :
Effectue la mise au point sur une position spécifique dans l’image.

2
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Note

Le cadre de la zone de mise au point n’est pas masqué lorsque vous utilisez la touche [Display] dans le panneau d’image de la
caméra.

Pendant Clear Image Zoom, la zone de mise au point est réglée sur [Wide] (fixe).

Astuce

Vous pouvez afficher/masquer le cadre de la zone de mise au point à l’aide de [Monitoring] > [Display On/Off] > [Focus Area
Indicator] dans le menu de la caméra.

5-041-957-23(1) Copyright 2022 Sony Corporation

Après la sélection, spécifiez la position à l’aide des touches fléchées dans le panneau de commande GUI.

Vous pouvez revenir à la position centrale en maintenant enfoncée la touche [Set].
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Modification rapide de la zone de mise au point (Réglage de mise au point)

Vous pouvez changer rapidement la position et la taille de la zone de mise au point automatique lors de la prise de vue
en attribuant [Focus Setting] à une touche personnalisable.

Pour les détails sur les touches personnalisables, consultez « Touches personnalisables ».

L’opération varie selon le réglage de la zone de mise au point.

Lorsque [Shooting] > [Focus] > [Focus Area] est réglé sur [Flexible Spot] ou [Zone] depuis le
menu de la caméra

Vous pouvez modifier la position de la zone de mise au point en appuyant sur la touche personnalisable à laquelle
vous avez attribué [Focus Setting] et en ajustant à l’aide des touches fléchées dans le panneau de commande GUI.
Vous pouvez recentrer la position de la zone de mise au point lorsque vous ajustez la position en appuyant sur la
touche [Set].
Vous pouvez modifier la taille de la zone de mise au point en maintenant enfoncée la touche personnalisable à
laquelle vous avez attribué [Focus Setting]. Après avoir modifié la taille, vous pouvez changer la position de la zone
de mise au point en appuyant sur la touche [Set]. Lorsque vous avez terminé, appuyez sur une touche
personnalisable à laquelle vous avez attribué [Focus Setting] pour revenir à l’écran d’origine.

Lorsque [Shooting] > [Focus] > [Focus Area] est réglé sur [Wide] dans le menu de la caméra

Vous pouvez uniquement modifier la taille de la zone de mise au point en maintenant enfoncée la touche personnalisable
à laquelle vous avez attribué [Focus Setting]. Vous pouvez également changer la position en modifiant d’abord le type
sur [Flexible Spot] ou [Zone].

Astuce

Lorsque [Shooting] > [Focus] > [Push AF Mode] est réglé sur [Single-shot AF(AF-S)] dans le menu de la caméra et que le
commutateur [Auto Focus] est réglé sur la position off (mode de mise au point manuelle), il est possible de modifier la position de
la zone de mise au point [Focus Area (AF-S)].

Le cadre de la zone de mise au point est affiché en orange lorsque la position de la zone de mise au point peut être modifiée.

Rubrique associée
Touches personnalisables

5-041-957-23(1) Copyright 2022 Sony Corporation
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Déplacement du cadre de la zone de mise au point par opération tactile (zone de mise
au point tactile)

Vous pouvez modifier la position de la zone de mise au point en appuyant sur une touche personnalisable à laquelle
vous avez attribué [Focus Setting] pour faire passer l’affichage de la zone de mise au point en orange, puis déplacer le
cadre de la zone de mise au point par opération tactile dans le panneau d’image de la caméra.
Touchez l’écran pour déplacer la zone de mise au point, avec la zone de mise au point centrée sur la position touchée.
Faites glisser sur l’écran pour déplacer la zone de mise au point à la position tracée par votre doigt.

Astuce

Vous pouvez activer/désactiver la zone de mise au point tactile dans l’écran de prise de vue à l’aide de la touche personnalisable
à laquelle vous avez attribué [Focus Setting].

Touchez n’importe quelle position.

La position touchée correspondra au centre de la zone de mise au point.

1

Faire glisser pour déplacer la zone de mise au point, en suivant la position de votre doigt.2
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Note

Si vous touchez une position ou faites glisser la zone de mise au point vers une position qui dépasse la plage de réglage, la zone
de mise au point est réglée sur le bord supérieur/inférieur/gauche/droit de la plage de réglage.

Cette fonction n’est pas disponible dans les circonstances suivantes.

Lorsque le commutateur [Touch Focus] est désactivé dans le panneau de commande de la caméra
Lorsque le cadre de zone de mise au point est affiché en gris ou n’est pas affiché du tout

5-041-957-23(1) Copyright 2022 Sony Corporation
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Réglage de l’opération de mise au point automatique par pression (vitesse de
transition AF, sensibilité de changement de sujet AF)

Vous pouvez ajuster l’opération de mise au point automatique par pression en changeant la vitesse de transition et la
sensibilité de changement de sujet.

Réglage de la vitesse de transition AF

Vous pouvez régler la vitesse d’entraînement de la mise au point pour les cas où le sujet change à l’aide de la touche
[AF Transition Speed] dans le panneau de commande de la caméra.

Sélectionnez la vitesse dans une plage de [Speed 1] (lent) à [Speed 7] (rapide) par incréments de 1. Appuyez sur la
touche < pour diminuer la valeur (plus lent) ou la touche > pour augmenter la valeur (plus rapide).
Lors d’un réglage sur une vitesse basse, la mise au point se déplace en douceur lorsque le sujet à mettre au point
change, ce qui permet la prise de vue avec une expression d’image excellente.
Lors d’un réglage sur une vitesse élevée, la mise au point change rapidement de sujet. Dans l’exemple ci-dessous, la
mise au point change rapidement du bâtiment en arrière-plan à la personne marchant en avant-plan. La mise au point
passe immédiatement sur le sujet entrant dans le cadre, rendant ce réglage idéal pour la prise de vue documentaire
nécessitant une mise au point rapide.

Sensibilité de changement de sujet AF

Vous pouvez régler la sensibilité de changement de sujet à l’aide de la touche [AF Subj. Shift Sens.] dans le panneau de
commande de la caméra.
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Sélectionnez la sensibilité par incréments de 1 dans une plage de [Sens 1] (verrouillage activé) à [Sens 5] (dynamique).
Appuyez sur la touche < pour augmenter la valeur (changement lent) ou la touche > pour diminuer la valeur
(changement rapide).
Lors d’un réglage sur une faible sensibilité, la mise au point ne change pas immédiatement même si un autre sujet passe
devant le sujet de la mise au point.

Lors d’un réglage sur une sensibilité élevée, la mise au point change pour donner la priorité au sujet en mouvement au
premier plan.

Astuce

Si [AF Speed/Sens.] est attribué à une touche personnalisable, les barres de niveau pour ajuster les valeurs s’affichent dans le
panneau d’image de la caméra dans l’ordre suivant à chaque fois que vous appuyez sur la touche, ce qui vous permet de
modifier la vitesse de transition AF et les réglages de sensibilité de changement de sujet AF.
Vitesse de transition AF → Sensibilité de changement de sujet AF → Aucun affichage…

5-041-957-23(1) Copyright 2022 Sony Corporation
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Réglage manuel de la cible de mise au point automatique (AF Assist) à l’aide de
l’application Web

Après avoir changé et ajusté manuellement la mise au point, vous pouvez passer du contrôle de mise au point à la mise
au point automatique pour un réglage précis de la mise au point.

Note

Dans l’état d’assistance AF, déplacer la mise au point devient difficile, quel que soit le réglage [Shooting] > [Focus] > [AF Subj.
Shift Sens.] dans le menu de la caméra.

L’état d’assistance AF est annulé par ce qui suit.

Lorsque le sujet mis au point à l’aide du curseur [Focus] n’est plus visible
Lors du passage à la mise au point manuelle
Lors du démarrage de l’AF de suivi en temps réel

Astuce

Réglez [Shooting] > [Focus] > [AF Assist] sur [On] dans le menu de la caméra.1

Réglez [Shooting] > [Focus] > [AF Assist Control] sur [On] dans le menu Web.2

Faites glisser le commutateur [Auto Focus] à la position de droite dans le panneau de commande de la
caméra pour l’activer.

Le mode de mise au point automatique est activé.

3

Réglez la cible de mise au point à l’aide du curseur [Focus] dans le panneau de commande de la caméra.

[Near] : effectuez la mise au point sur un sujet proche.
[Far] : effectuez la mise au point sur un sujet éloigné.

Dans l’état d’assistance AF, un sujet à une distance configurée avec le curseur [Focus] sera automatiquement mis
au point.

4
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L’état d’assistance AF peut être annulé rapidement en utilisant une touche personnalisable attribuée avec [Push AF/MF].

L’AF de suivi en temps réel s’arrête quand le curseur [Focus] est utilisé.

En mode Face/Eye Only AF, la mise au point automatique se fait sur le visage le plus proche de la position de mise au point du
curseur [Focus].

5-041-957-23(1) Copyright 2022 Sony Corporation
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Mise au point manuelle pendant la mise au point automatique à l’aide de la
télécommande infrarouge fournie

Lorsque [Shooting] > [Focus] > [AF Assist] est réglé sur [On] dans le menu de la caméra, vous pouvez utiliser les
touches F (éloigné) et N (rapproché) sur la télécommande infrarouge fournie, même pendant la mise au point
automatique pour ajuster la mise au point sur un sujet.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Utilisation de la mise au point manuelle lors de la mise au point automatique (Mise au
point manuelle par pression)

Appuyez sur la touche [Push AF/MF] en mode de mise au point automatique pour effectuer manuellement la mise au
point lorsque la touche est enfoncée. La mise au point repasse en mode automatique quand vous relâchez la touche.
Ceci vous permet d’arrêter temporairement la mise au point automatique et de l’effectuer manuellement lorsqu’un
élément n’étant pas le sujet de la prise de vue passe devant le sujet.

Astuce

La même opération est possible avec une touche personnalisable à laquelle vous avez attribué [Push AF/MF].

5-041-957-23(1) Copyright 2022 Sony Corporation
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Suivi à l’aide de la détection des visages/yeux (Face/Eye Detection AF)

L’appareil peut détecter les visages et les yeux des personnes en tant que cible à suivre et ensuite ajuster la mise au
point sur les visages et les yeux au sein de la zone de mise au point.
Lorsque des visages sont détectés, des cadres de détection des visages/yeux gris sont affichés. Lorsque la mise au
point automatique est possible, les cadres deviennent blancs et le suivi démarre. Lorsque des yeux sont détectés et que
la mise au point est ajustée, le cadre de détection des visages/yeux s’affiche sur les yeux. Lorsque plusieurs personnes
sont détectées, le sujet principal est déterminé de manière automatique.
Cette fonction est uniquement disponible lorsque le mode de mise au point est le mode AF ou pendant la mise au point
automatique par pression.

Astuce

Lorsque vous réglez la zone de mise au point sur [Zone] ou [Flexible Spot] et que les visages ou les yeux chevauchent la zone de
mise au point spécifiée, les cadres de détection des visages/yeux deviennent blancs et l’appareil effectue la mise au point sur ces
visages/yeux.

Lorsque vous utilisez la mise au point automatique par pression (AF-S), les cadres de détection des visages/yeux pour les
visages/yeux ciblés par la mise au point deviennent verts.

Réglage à l’aide de la touche [Face/Eye Detection AF] dans le panneau de commande de la
caméra

Appuyez sur la touche [Face/Eye Detection AF] et définissez l’opération AF de détection des visages/yeux.

[Face/Eye Only AF] : la caméra détecte les visages/yeux des sujets (personnes), et la mise au point et le suivi se font
uniquement sur leurs visages/yeux. Tant qu’aucun visage ou œil n’est détecté, l’AF est temporairement arrêté et l’icône

 (pause de la mise au point automatique en mode AF uniquement sur les visages/yeux) s’affiche. Ce mode est utile
lorsque souhaitez réaliser une mise au point automatique et un suivi uniquement sur les visages/yeux.
[Face/Eye Priority AF] : la caméra détecte les visages/yeux des sujets (personnes) et la mise au point/le suivi se fait en
priorité sur les visages/yeux. Si aucun visage ou œil n’est détecté, la mise au point repasse en mode AF (réglage par
défaut).
[AF] : la fonction de détection des visages/yeux AF est désactivée.

Note

Durant la mise au point automatique par pression, [Face/Eye Priority AF] est activé même si [Face/Eye Only AF] est actuellement
sélectionné.
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Lorsque le commutateur [Auto Focus] est réglé sur la position off, la fonction AF de détection des visages/yeux est désactivée
(sauf pendant l’opération de mise au point automatique par pression).

Si vous mettez le caméscope hors tension alors que [Face/Eye Only AF] est sélectionné, le mode passe automatiquement à
[Face/Eye Priority AF] lorsque le caméscope est ensuite mis sous tension.

Astuce

Vous pouvez sélectionner l’opération AF de détection des visages/yeux à l’aide de [Shooting] > [Focus] > [Face/Eye Detection
AF] dans le menu de la caméra.

Pour masquer les cadres de détection des visages/yeux
Vous pouvez afficher/masquer les cadres de détection de visages/yeux à l’aide de [Monitoring] > [Display On/Off] >
[Face/Eye Detection Frame] dans le menu de la caméra.

Note

Les cadres verts de détection des visages/yeux s’affichent pour les visages et les yeux ciblés par la mise au point à l’aide de la
mise au point automatique par pression (AF-S), et ils ne sont pas masqués par l’utilisation de la touche [Display] ni quand
[Face/Eye Detection Frame] est réglé sur [Off].

Pour commuter l’opération AF de détection des visages/yeux à l’aide d’une touche personnalisable
Attribuez [Face/Eye Detection AF] à une touche personnalisable. Vous pouvez alors commuter l’opération AF de
détection des visages/yeux dans l’ordre [Face/Eye Priority AF], [Face/Eye Only AF] et [AF] à chaque pression de la
touche.

Réglage à l’aide du menu direct

Vous pouvez également sélectionner l’opération AF de détection des visages/yeux à l’aide du menu direct.

Pour plus de détails sur le menu direct, consultez « Utilisation du menu Direct ».

Rubrique associée

Utilisation du menu Direct

5-041-957-23(1) Copyright 2022 Sony Corporation
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Suivi d’un sujet spécifié (Realtime Tracking AF)

Vous pouvez maintenir la mise au point sur un sujet en spécifiant le sujet par une opération tactile ou en sélectionnant un
cadre de détection des visages dans le panneau de commande de la caméra.
Lorsqu’un sujet est sélectionné, un cadre de suivi blanc s’affiche et le suivi démarre.

Astuce

Le suivi se produit dans la zone d’image entière, indépendamment du réglage de la zone de mise au point.

Lorsque [Shooting] > [Focus] > [Touch Function in MF] est réglé sur [Tracking AF] dans le menu Web ou le menu de la caméra,
l’AF de suivi en temps réel est pris en charge même lorsque le mode de mise au point est le mode MF.

Les actions suivantes se produisent pour la cible de suivi, en fonction du réglage du mode de fonctionnement AF de
détection des visages/yeux.

[Face/Eye Only AF] ou [Face/Eye Priority AF] : mise au point et suivi du sujet spécifié.
Si la cible de suivi est une personne et un visage/des yeux sont détectés, la caméra effectue la mise au point sur ce
visage/ces yeux.
Lorsque le visages/les yeux d’une cible de suivi sont détectés, le visage de la cible de suivi est enregistré. Une fois qu’il
est enregistré, une  (icône de visage de suivi enregistré) s’affiche.

Note

Si l’AF de suivi est démarré lors de la mise au point manuelle, le visage de la cible de suivi n’est pas enregistré.

[AF] : à utiliser pour la mise au point et le suivi d’un sujet spécifié. La détection des visages/yeux ne se produit pas,
même si la cible de suivi est une personne.

Note

La fonction AF de suivi en temps réel ne fonctionne pas si l’objectif est réglé pour la mise au point manuelle.

Démarrage de l’AF de suivi en temps réel

Lorsqu’un sujet spécifique est spécifié comme cible de suivi, le suivi de cette cible démarre.
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Pour spécifier par une opération tactile
Faites glisser le commutateur [Touch Focus] sur l’onglet  (Focus) dans le panneau de commande de la caméra à la
position de droite pour l’activer, puis appuyez sur le sujet cible pour le suivre dans n’importe lequel des états suivants.

Durant la mise au point manuel ou durant la mise au point manuelle par pression, et lorsque [Shooting] > [Focus] >
[Touch Function in MF] est réglé sur [Tracking AF] dans le menu Web ou le menu de la caméra
Durant la mise au point automatique ou durant la mise au point automatique par pression (AF)

Pour spécifier par sélection de cadre de détection des visages
Déplacez le curseur de sélection de visage (soulignement orange) sur le sujet cible pour le suivre à l’aide des touches
fléchées dans le panneau de commande GUI, et appuyez sur la touche [Set].

A : cadres de détection de visage (gris)
B : cadre de suivi
C : curseur de sélection de visage (orange)

Note

Lors de la mise au point manuelle, le suivi ne peut pas être démarré par la sélection de cadre de détection des visages.

Astuce

Vous pouvez également changer de cible à suivre lors de l’AF de suivi en temps réel.

Arrêt de l’AF de suivi en temps réel

Appuyez sur la touche  (arrêt AF de suivi en temps réel).

Astuce

L’AF de suivi en temps réel s’arrêtera dans les cas suivants :

Lorsque le commutateur [Auto Focus] ou la commande AUTO/MANUAL sur l’objectif est commuté
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Lorsque le mode de mise au point est modifié
Lorsque l’aide pour AF est exécutée
Lorsque le réglage de la zone de mise au point ou l’action de l’AF de détection des visages/yeux est modifié
Lorsqu’une touche personnalisable attribuée avec [Push AF/MF] est enfoncée
Lorsque la cible de suivi n’est pas comprise dans l’écran de prise de vue ou que le sujet est flou pendant quelques secondes

Lorsqu’un visage de suivi est enregistré (lorsque l’icône  (visage de suivi enregistré) s’affiche), l’AF de suivi en temps réel
reprend lorsque le visage de suivi enregistré entre dans la zone d’image. Pour effacer le visage de suivi, arrêtez l’AF de suivi en
temps réel comme indiqué ci-dessus.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Écran de réglage de la luminosité

Vous pouvez ajuster la luminosité en ajustant le diaphragme, le gain, la vitesse d’obturateur, ainsi qu’en ajustant le
niveau de luminosité à l’aide des filtres ND dans les panneaux de commande de l’écran d’opération en direct de
l’application Web. Vous pouvez également ajuster la luminosité automatiquement.

Note

Le gain ne peut pas être ajusté lorsque [Shooting Mode] est réglé sur [Cine EI Quick] ou [Cine EI]. De même, la luminosité ne
peut pas être ajustée automatiquement en utilisant la vitesse d’obturation lorsque le réglage est sur [Cine EI Quick] ou [Cine EI].
L’ajustement automatique de la luminosité à l’aide du diaphragme et du filtre ND est pris en charge.

Astuce

Panneau de commande de la caméra – onglet  (Main)1.

Panneau de configuration de base de la caméra
Affiche l’état de réglage des fonctions de base requises pour la prise de vue sur les touches. Appuyez sur une touche
pour afficher l’écran de configuration correspondant pour chaque fonction dans le panneau de réglage de
configuration de base de la caméra ci-dessous.

2.

Panneau de réglage de configuration de base de la caméra
Affiche le panneau de réglage pour les éléments de configuration sélectionnés dans le panneau de configuration de
base de la caméra.

3.
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Cine EI est un mode pour la prise de vue à une sensibilité de base sans utiliser le gain afin de maximiser la performance du
capteur d’image. La luminosité est ajustée à l’aide de l’éclairage et du filtre ND afin d’ajuster la quantité de lumière qui atteint le
capteur d’image. Pour plus de détails sur Exposure Index (EI), consultez « Modification de la distribution de zones sombres et
lumineuses dans une image enregistrée ».

Rubrique associée

Modification de la distribution de zones sombres et lumineuses dans une image enregistrée

5-041-957-23(1) Copyright 2022 Sony Corporation
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Réglage de la sensibilité de base

Vous pouvez régler la sensibilité de base avant de commencer à ajuster la luminosité.

Lorsque [Shooting Mode] est réglé sur [Custom]

Appuyez sur la touche [ISO/Gain] dans le panneau de configuration de base de la caméra et réglez [Base Sensitivity]
dans le panneau de réglage ISO/Gain sur [High] ou [Low].
Sélectionnez [Low] dans des conditions d’éclairage normales et sélectionnez [High] dans des conditions d’éclairage
faibles.
Écran lorsque [AGC] est désactivé

Écran lorsque [AGC] est activé

Lorsque [Shooting Mode] est réglé sur [Flexible ISO] ou [Cine EI]

Appuyez sur la touche [Base ISO/Exposure Index] dans le panneau de configuration de base de la caméra et réglez
[Base ISO] dans le panneau de réglage Base ISO/Exposure Index sur [ISO 12800] ou [ISO 800].
Sélectionnez [ISO 800] dans des conditions d’éclairage normales et sélectionnez [ISO 12800] dans des conditions
d’éclairage faibles.
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Astuce

Vous pouvez également régler ceci sur l’onglet  (Main) dans le panneau de commande de la caméra.

Peut également être réglé à l’aide de [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] ou [Base ISO] dans le menu de la caméra.

Vous pouvez également attribuer [Base ISO/Sensitivity] à une touche personnalisable.

En mode de prise de vue [Cine EI Quick], la sensibilité de base est automatiquement réglée en fonction du réglage de l’indice
d’exposition.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Réglage du niveau cible pour le réglage automatique de la luminosité

Le niveau cible pour le réglage de la luminosité se règle à l’aide du curseur [AE Level] dans le panneau de commande
de la caméra.

5-041-957-23(1) Copyright 2022 Sony Corporation

Appuyez sur l’onglet  (Main) dans le panneau de commande de la caméra.

Si le curseur [AE Level] n’est pas affiché, sélectionnez l’une des deux touches de sélection de fonction du curseur
et sélectionnez le curseur [AE Level] dans la liste.

Le curseur [AE Level] apparaît.

1

Réglez le niveau cible à l’aide du curseur.

Déplacez le bouton du curseur sur la gauche pour rendre l’image plus sombre. Déplacez le bouton du curseur sur
la droite pour rendre l’image plus lumineuse.

Astuce

Peut également être réglé à l’aide de [Shooting] > [Auto Exposure] > [Level] dans le menu de la caméra.

2
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Réglage automatique du diaphragme

Vous pouvez ajuster la luminosité automatiquement en fonction du sujet. Un objectif compatible est requis.

Note

Le diaphragme peut être ajusté automatiquement sur un objectif monté en A.

Astuce

Vous pouvez également attribuer [Auto Iris] à une touche personnalisable.

5-041-957-23(1) Copyright 2022 Sony Corporation

Si un objectif avec commutateur Auto Iris est fixé, placez le commutateur sur AUTO.1

Appuyez sur la touche [Iris] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [Iris] devient orange.

Le panneau de réglage de Iris apparaît.

2

Faites glisser le commutateur [Auto] à la position de droite pour l’activer.

Le diaphragme passe en mode de réglage automatique. La valeur de réglage automatique du diaphragme s’affiche
sur le côté droit du commutateur.

3
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Réglage manuel du diaphragme

Vous pouvez ajuster la luminosité manuellement.

Pour ajuster le diaphragme automatiquement et temporairement
Vous pouvez également appuyer sur la touche [Push Auto] dans le panneau de réglage de Iris pour ajuster le
diaphragme automatiquement lorsque la touche est enfoncée.

Si un objectif avec commutateur Auto Iris est fixé, placez le commutateur sur AUTO.

Note

Quand le commutateur Auto Iris de l’objectif est réglé sur MANUAL, les fonctions [Auto Iris] et [Push Auto Iris] de l’appareil
n’ont aucun effet. Les réglages manuels du diaphragme sur l’appareil n’ont aucun effet.

1

Appuyez sur la touche [Iris] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [Iris] devient orange.

Le panneau de réglage de Iris apparaît.

2

Faites glisser le commutateur [Auto] à la position de gauche pour le désactiver.

Le diaphragme commute sur le mode de réglage manuel.

3

Ajustez le diaphragme à l’aide du curseur [Iris] ou des touches de réglage [Iris].

Astuce

Les paramètres du curseur et de la touche de réglage sont liés.

Vous pouvez également attribuer le diaphragme au curseur dans l’onglet  (Main) dans le panneau de commande de la
caméra.

4
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Astuce

Appuyez sur la touche personnalisable à laquelle la fonction [Push Auto Iris] est attribuée pour ajuster le diaphragme
automatiquement lorsque la touche est enfoncée.
Le diaphragme revient en mode manuel quand vous relâchez la touche.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Réglage automatique du gain

Vous pouvez ajuster la luminosité automatiquement à l’aide du réglage du gain lorsque [Shooting Mode] est réglé sur
[Custom] ou [Flexible ISO].

5-041-957-23(1) Copyright 2022 Sony Corporation

Réglez [Project] > [Shooting Mode] sur [Custom] dans le menu Web ou le menu de la caméra.1

Appuyez sur la touche [ISO/Gain] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [ISO/Gain] devient orange.

Le panneau de réglage de ISO/Gain apparaît.

2

Faites glisser le commutateur [AGC] à la position de droite pour l’activer.

Le gain commute sur le mode de réglage automatique. La valeur du gain ajusté automatiquement s’affiche sur le
côté droit du commutateur.

Astuce

Vous pouvez également effectuer la même action en réglant [Shooting] > [Auto Exposure] > [AGC] sur [On] dans le menu
de la caméra.

Vous pouvez également attribuer [AGC] à une touche personnalisable.

3
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Réglage manuel du gain

Vous pouvez ajuster la luminosité manuellement à l’aide du réglage du gain lorsque [Shooting Mode] est réglé sur
[Custom] ou [Flexible ISO].
Vous pouvez surveiller le gain lorsque vous souhaitez ajuster l’exposition tout en utilisant un réglage de diaphragme fixe
ou lorsque vous souhaitez éviter que le gain n’augmente à cause de l’AGC.

Pour ajuster le gain manuellement et temporairement
Vous pouvez également ajuster le gain temporairement en attribuant [ISO/Gain] à une touche de sélection de fonction du
curseur dans l’onglet  (Main) dans le panneau de commande de la caméra et à l’aide du curseur.
Cela est utile lorsque vous souhaitez régler l’exposition d’un seul incrément sans changer la profondeur de champ.
Le résultat du réglage retourne à la valeur prédéfinie configurée à l’aide de [ISO/Gain<L>] après avoir effectué l’une des
opérations suivantes.

Réglez [Project] > [Shooting Mode] sur [Custom] dans le menu Web ou le menu de la caméra.1

Appuyez sur la touche [ISO/Gain] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [ISO/Gain] devient orange.

Le panneau de réglage de ISO/Gain apparaît.

2

Faites glisser le commutateur [AGC] à la position de gauche pour le désactiver.

Le gain commute sur le mode de réglage manuel.

3

Ajustez le gain à l’aide du curseur [ISO/Gain] ou des touches de réglage [ISO/Gain].

Astuce

Les paramètres du curseur et de la touche de réglage sont liés.

4
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Changer les éléments de réglage ISO/Gain
Commuter la sensibilité de base
Régler le commutateur AGC sur la position ON
Mettre en veille l’alimentation de l’appareil

Pour ajuster le gain manuellement et temporairement à l’aide d’une touche personnalisable
Appuyez sur la touche personnalisable à laquelle la fonction [Push AGC] est attribuée pour ajuster le gain
automatiquement lorsque la touche est enfoncée.
Le gain revient en mode manuel quand vous relâchez la touche.
Le résultat du réglage retourne à la valeur prédéfinie configurée à l’aide de [ISO/Gain<L>] après avoir effectué l’une des
opérations suivantes.

Changer les éléments de réglage ISO/Gain
Commuter la sensibilité de base
Régler le commutateur AGC sur la position ON
Mettre en veille l’alimentation de l’appareil

Note

Cette fonction ne peut pas être exécutée lorsque [Shooting] > [Iris] > [Bokeh Control] est réglé sur [On] dans le menu de la
caméra.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Réglage automatique de l’obturateur

Vous pouvez ajuster l’obturateur automatiquement en réponse à la luminosité de l’image.

5-041-957-23(1) Copyright 2022 Sony Corporation

Appuyez sur la touche [Shutter] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [Shutter] devient orange.

Le panneau de réglage de Shutter apparaît.

1

Appuyez sur la touche [Shutter Type] et sélectionnez [Auto] dans la liste.

Astuce

Vous pouvez également effectuer la même action en réglant [Shooting] > [Auto Exposure] > [Auto Shutter] sur [On] dans le
menu de la caméra.

Vous pouvez également attribuer [Auto Shutter] à une touche personnalisable.

2
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Réglage manuel de l’obturateur

Vous pouvez ajuster l’obturateur manuellement.

Appuyez sur la touche [Shutter] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [Shutter] devient orange.

Le panneau de réglage de Shutter apparaît.

1

Appuyez sur la touche [Shutter Type] et sélectionnez [Speed] dans la liste.2

Ajustez l’obturateur à l’aide du curseur [Speed] ou des touches de réglage [Speed].

Pour ajuster la durée d’exposition afin qu’elle corresponde à l’intervalle d’image, sélectionnez [Off] à l’étape 2. Vous
pouvez également régler une valeur fixe à l’aide de [ECS] (fréquence) ou l’ajuster automatiquement à l’aide de
[Auto].
Exemple : réglage à l’aide de [ECS] (fréquence)

Astuce

Les paramètres du curseur et de la touche de réglage sont liés.

Pour utiliser [Angle] au lieu de [Speed] ou [Off], réglez [Shooting] > [Shutter] > [Mode] sur [Angle] dans le menu de la
caméra.

3
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À propos du filtre ND

Lorsque l’éclairage est trop fort, vous pouvez régler la luminosité appropriée en changeant le filtre ND.
Lorsque vous filmez un sujet lumineux, une fermeture trop importante du diaphragme peut provoquer un flou de
diffraction, qui crée une image commençant à perdre sa netteté (phénomène typique des caméras). Vous pouvez
supprimer cet effet pour obtenir de meilleurs résultats de prise de vue en utilisant le filtre ND.
Cet appareil comporte les modes de filtre ND suivants.
Mode prédéfini

Consultez « Réglage en mode prédéfini ».

Mode variable (réglage automatique)

Consultez « Réglage automatique en mode variable ».

Mode variable (réglage manuel)

Consultez « Réglage manuel en mode variable ».

Rubrique associée

Réglage en mode prédéfini

Réglage automatique en mode variable

Réglage manuel en mode variable

5-041-957-23(1) Copyright 2022 Sony Corporation
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Réglage en mode prédéfini

Vous pouvez sélectionner trois valeurs de transmittance de filtre ND au préalable et les commuter rapidement lors de la
prise de vue.

Astuce

Lorsqu’une touche personnalisable à laquelle est attribué [ND Filter Position] est enfoncée, le filtre ND change suivant la
séquence [Clear] → [Preset1] → [Preset2] → [Preset3] → [Clear].

5-041-957-23(1) Copyright 2022 Sony Corporation

Réglez [Shooting] > [ND Filter] > [Mode] sur [Preset] dans le menu de la caméra.1

Appuyez sur la touche [ND Filter] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [ND Filter] devient orange.

Le panneau de réglage de ND Filter apparaît.

2

Appuyez sur la touche [ND Filter] et sélectionnez l’un des éléments suivants dans la liste.

[Clear] : pas de filtre ND.
[Preset1] : transmittance définie par [Shooting] > [ND Filter] > [Preset1] dans le menu de la caméra.
[Preset2] : transmittance définie par [Shooting] > [ND Filter] > [Preset2] dans le menu de la caméra.
[Preset3] : transmittance définie par [Shooting] > [ND Filter] > [Preset3] dans le menu de la caméra.

Lorsqu’un des réglages de [Preset1] à [Preset3] est sélectionné pour le filtre ND, la valeur de transmittance est
affichée à côté du nom du filtre ND.

3
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Réglage automatique en mode variable

Vous pouvez activer l’ajustement d’exposition automatique à l’aide du filtre ND.

Note

Lorsque le filtre ND est basculé sur ou depuis [Clear] lors de la prise de vue, le cadre de filtre ND s’affiche sur l’image et le son de
fonctionnement est inclus dans l’audio.

Astuce

Vous pouvez également attribuer [Auto ND Filter] à une touche personnalisable et appuyer sur la touche pour commuter entre
[Auto] et [Manual].
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Réglez [Shooting] > [ND Filter] > [Mode] sur [Variable] dans le menu de la caméra.1

Appuyez sur la touche [ND Filter] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [ND Filter] devient orange.

Le panneau de réglage de ND Filter apparaît.

2

Appuyez sur la touche [ND Filter] et sélectionnez [Auto] dans la liste.

La valeur de transmittance du filtre ND réglé automatiquement s’affiche à côté de la touche [ND Filter].

3
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Réglage manuel en mode variable

Vous pouvez effectuer un ajustement manuel de l’exposition à l’aide du filtre ND.

Pour ajuster automatiquement et temporairement
Vous pouvez attribuer [Push Auto ND] à une touche personnalisable, et activer de manière temporaire Auto ND Filter
lorsque la touche est enfoncée. Le filtre ND automatique sera de nouveau réglé sur off si vous relâchez la touche.
Réglez le filtre ND sur [Manual].

Note

Lorsque le filtre ND est basculé sur ou depuis [Clear] lors de la prise de vue, le cadre de filtre ND s’affiche sur l’image et le son de
fonctionnement est inclus dans l’audio.

Réglez [Shooting] > [ND Filter] > [Mode] sur [Variable] dans le menu de la caméra.1

Appuyez sur la touche [ND Filter] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [ND Filter] devient orange.

Le panneau de réglage de ND Filter apparaît.

2

Appuyez sur la touche [ND Filter] et sélectionnez [Manual] dans la liste.3

Ajustez la transmittance du filtre ND à l’aide du curseur [ND Filter] ou des touches de réglage [ND Filter].

Astuce

Les paramètres du curseur et de la touche de réglage sont liés.

Vous pouvez également ajuster le filtre ND sur l’onglet  (Main) dans le panneau de commande de la caméra.

4
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Astuce

Vous pouvez également attribuer [ND Filter Position] à une touche personnalisable et appuyer sur la touche pour commuter entre
[Manual] et [Clear].

Vous pouvez également appuyer sur la touche [Push Auto] dans le panneau de réglage de ND Filter pour activer Auto ND Filter
lorsque la touche est enfoncée.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Écran de réglage de la balance des blancs

Vous pouvez ajuster la balance des blancs à l’aide de l’écran d’opération en direct pour obtenir une balance des blancs
qui rend l’image plus naturelle.

5-041-957-23(1) Copyright 2022 Sony Corporation

Panneau de configuration de base de la caméra1.

Panneau de réglage de configuration de base de la caméra
Affiche le panneau de réglage pour les éléments de configuration sélectionnés dans le panneau de configuration de
base de la caméra.

2.
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Réglage automatique de la balance des blancs

Vous pouvez obtenir une balance des blancs ajustée à tout moment à l’aide de ATW (balance des blancs à suivi
automatique).
Lorsque ATW est activé, la balance des blancs est automatiquement ajustée quand la température de couleur de la
source de lumière change.

Note

L’ATW ne peut pas être utilisé lorsque [Shooting Mode] est réglé sur [Cine EI] ou [Cine EI Quick].

Il peut ne pas être possible de s’ajuster sur la couleur appropriée à l’aide d’ATW, en fonction des conditions d’éclairage et de
sujet.
Exemples :

Quand une couleur unique domine le sujet, comme par exemple le ciel, la mer, la terre ou des fleurs.
Quand la température de couleur est extrêmement élevée ou faible.

Si la vitesse de suivi automatique de l’ATW est lente ou que l’effet approprié ne peut pas être obtenu, appuyez sur la touche [WB
SET] pour utiliser la balance des blancs automatique.

Astuce

Vous pouvez sélectionner la vitesse de réaction lors du mode ATW parmi cinq incréments (1, 2, 3, 4, 5) à l’aide de [Shooting] >
[White Setting] > [ATW Speed] dans le menu de la caméra. Plus le nombre est bas, plus la vitesse de réponse sera rapide.

Vous pouvez geler le réglage de la balance des blancs actuel en attribuant la fonction [ATW Hold] à une touche personnalisable
et en appuyant sur la touche personnalisable pour mettre temporairement le mode ATW en pause pendant le mode ATW.

Appuyez sur la touche [White Balance] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [White Balance] devient orange.

Le panneau de réglage de White Balance apparaît.

1

Appuyez sur la touche [White Mode] et sélectionnez [ATW] dans la liste.2
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Réglage manuel de la balance des blancs

Vous pouvez ajuster manuellement la balance des blancs.

Appuyez sur la touche [White Balance] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [White Balance] devient orange.

Le panneau de réglage de White Balance apparaît.

1

Appuyez sur la touche [White Mode] et sélectionnez l’un des éléments suivants dans la liste.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Réglez la balance des blancs à l’aide des curseurs ou des touches de réglage.

Astuce

Les paramètres du curseur et de la touche de réglage sont liés.

La différence entre [Memory A(T/T)] et [Memory A(R/B)] est que l’axe d’ajustement est différent, mais les résultats
d’ajustement sont liés.

Pour [Memory A(T/T)]
Ce mode ajuste la balance des blancs sauvegardée dans la mémoire A en ajustant la température de couleur
(Temp) et Tint.

3
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Vous pouvez régler la température de couleur par incréments de 20 K dans une plage de 2000 K à 5600 K. Vous
pouvez définir les valeurs supérieures à 5600 K à des intervalles égaux à la quantité de changement de couleur
(mired) de 5580 K à 5600 K.
Appuyer sur la touche [Reset] sur le côté droit de [Temp] ou [Tint] restaure le réglage correspondant à la valeur par
défaut.
Pour [Memory A(R/B)]
Ce mode ajuste la balance des blancs sauvegardée dans la mémoire A en ajustant R Gain et B Gain.
Appuyer sur la touche [Reset] restaure le réglage de gain correspondant à la valeur par défaut.
Pour [Preset]
Ce mode ajuste la température de couleur sur une valeur préréglée.
Vous pouvez régler la valeur par incrément à 100 K.
En mode prédéfini, vous pouvez également attribuer [Preset White Select] à une touche personnalisable, et
appuyer sur la touche pour passer à une valeur prédéfinie préconfigurée.
[Custom] : 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick] : 3200 K → 4300 K → 5500 K → 3200 K…
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Exécution automatique de la balance des blancs

En mode de mémoire A, la balance des blancs à sauvegarder est ajustée automatiquement.

Appuyez sur la touche [White Balance] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [White Balance] devient orange.

Le panneau de réglage de White Balance apparaît.

1

Appuyez sur la touche [White Mode] et sélectionnez [Memory A(T/T)] ou [Memory A(R/B)] dans la liste.

[Memory A(T/T)]

[Memory A(R/B)]

2

Placez une feuille de papier blanc (ou tout autre objet) dans un lieu présentant la même source et les
mêmes conditions de lumière que le sujet, puis effectuez un zoom avant sur le papier pour montrer la zone
blanche sur l’écran.

3

Réglez la luminosité.

Ajustez le diaphragme à l’aide de la procédure indiqué dans « Réglage manuel du diaphragme ».

4

Appuyez sur la touche [WB SET] sur le panneau de réglage de la balance des blancs.

[Memory A(T/T)]

5
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Note

Si l’ajustement échoue, un message d’erreur s’affiche sur l’écran pendant environ trois secondes. Si le message d’erreur persiste
après plusieurs tentatives de réglage de l’équilibre des blancs, contactez votre technicien Sony.

Astuce

Vous pouvez également l’utiliser en mode ATW. Vous pouvez l’utiliser lorsque vous souhaitez ajuster rapidement la balance des
blancs pendant l’opération ATW. Après ajustement, le mode revient à l’opération ATW normale.

Rubrique associée

Réglage manuel du diaphragme

5-041-957-23(1) Copyright 2022 Sony Corporation

[Memory A(R/B)]

Si la balance des blancs automatique est utilisée en mode mémoire, le résultat du réglage automatique est
sauvegardé dans la mémoire A.
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Écran de configuration audio

Vous pouvez configurer le niveau audio à enregistrer par l’appareil à l’aide de l’écran d’opération en direct de
l’application Web. Configurez les commutateurs sur le bloc de connecteur de l’appareil et configurez l’audio à l’aide du
menu de la caméra ou du menu Web.

5-041-957-23(1) Copyright 2022 Sony Corporation

Panneau de commande de la caméra – onglet  (Audio)1.
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Sélection du dispositif d’entrée audio

Réglez les commutateurs suivants en fonction du dispositif connecté au connecteur AUDIO IN.

Note

L’audio n’est pas enregistré en mode Interval Rec ou en mode Slow & Quick Motion.

5-041-957-23(1) Copyright 2022 Sony Corporation

Lorsqu’un microphone est connecté, réglez le commutateur SETUP 2 sur le bloc de connecteur à l’arrière
de l’appareil.

CH-1 et CH-2 ont des réglages communs.

1

Réglage Description

OFF (par
défaut)

Sélectionnez lorsque vous utilisez un microphone dynamique ou d’un microphone alimenté par
batterie. Éteint l’alimentation fantôme +48 V et définit l’entrée LINE ou MIC comme source audio
CH-1 et CH-2.

ON
Sélectionnez lorsque vous utilisez un microphone compatible avec une alimentation fantôme
+48 V. Allume l’alimentation fantôme +48V et définit le microphone compatible avec l’alimentation
fantôme comme source audio CH-1 et CH-2.

Réglez le type de dispositif connecté à l’aide de [Audio] > [Audio Input] > [AUDIO IN Select] dans le menu
de la caméra.

2

Sélectionnez l’entrée audio à l’aide de [Audio] > [Audio Input] > [CH1 Input Select] sur [CH4 Input Select]
dans le menu Web ou le menu de la caméra.

3
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Réglage automatique du niveau d’enregistrement audio

Réglez le canal pour lequel vous souhaitez ajuster le niveau d’enregistrement audio automatiquement sur [Auto] sur la
page [Audio] dans le menu Web, ou à l’aide de [Audio] > [Audio Input] > [CH1 Level Control] sur [CH4 Level Control]
dans le menu de la caméra.
Les canaux spécifiés pour le réglage automatique sont indiqués par une icône  (Auto) à côté des canaux
correspondants dans l’onglet  (Audio) de l’écran d’opération en direct.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Réglage manuel du niveau d’enregistrement audio

Vous pouvez ajuster le niveau d’enregistrement audio manuellement.

5-041-957-23(1) Copyright 2022 Sony Corporation

Réglez le canal pour lequel vous souhaitez ajuster le niveau d’enregistrement audio manuellement sur
[Manual] sur la page [Audio] du menu Web, ou à l’aide de [Audio] > [Audio Input] > [CH1 Level Control] sur
[CH4 Level Control] dans le menu de la caméra.

1

Appuyez sur l’onglet  (Audio) dans le panneau de commande de la caméra.2

Sur l’écran [Audio] du panneau de commande de la caméra, réglez le niveau d’enregistrement audio à l’aide
du curseur ou des touches de réglage pour le canal dont vous souhaitez régler le niveau d’enregistrement
audio manuellement.

Note

Les canaux pour lesquels une icône  (Auto) s’affiche sont réglés automatiquement. Les modifications des valeurs à l’aide
du curseur ou des touches ne sont pas appliquées à l’audio enregistré.

Astuce

Les paramètres du curseur et de la touche de réglage de chaque rangée sont liés.

Vous pouvez vérifier le niveau d’entrée audio en temps réel à l’aide de l’affichage du vumètre audio sur l’écran de prise de
vue.

3
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Utilisation du menu Direct

Vous pouvez vérifier l’état et les réglages de l’appareil affichés en superposition sur l’image de la caméra et sélectionnez
et changez les réglages à l’aide des touches de commande GUI ou de la télécommande infrarouge.
Les éléments suivants peuvent être configurés.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
Valeur de [ND Filter]
[Auto Iris]
Valeur de [Iris]
[AGC]
Valeur de [Gain]
Valeur de [ISO]
[Exposure Index]
[Shutter Type]
[Auto Shutter]
Valeur de [Shutter]
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] et [Frame Rate]

Astuce

Vous pouvez également exécuter la même fonction à l’aide d’une touche attribuable et du panneau de commande GUI de
l’application Web.

Appuyez sur une touche personnalisable à laquelle est attribuée [Direct Menu] sur la télécommande
infrarouge.

La touche [Direct Menu] est attribuée à la touche personnalisable 1 par défaut.
Sur l’écran, vous pouvez uniquement sélectionner avec le curseur orange les éléments pouvant être configurés à
l’aide du menu direct.

1

Déplacez le curseur sur l’élément que vous souhaitez régler à l’aide des touches fléchées dans le panneau
de commande GUI et appuyez sur la touche [Set].

Un menu s’affiche ou l’élément s’affiche sur un arrière-plan blanc.

2

Sélectionnez un réglage à l’aide des touches fléchées et appuyez sur la touche [Set].

Le menu ou l’arrière-plan blanc disparaît et le nouveau réglage s’affiche avec un curseur orange.
Appuyez à nouveau sur la touche personnalisable à laquelle la fonction [Direct Menu] est affectée ou attendez
3 secondes sans réaliser d’action pour quitter le menu direct.

3
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Touches personnalisables

Il y a dix touches personnalisables dans l’application Web de l’appareil auxquelles vous pouvez attribuer des fonctions.
Les touches personnalisables sont affichées sur l’écran des opérations en direct et sur l’écran d’opération de lecture.

Note

La liste des touches personnalisables ne s’affiche pas lors de la configuration des réglages dans le panneau d’opération de base
de la caméra de l’écran d’opération en direct. Pour terminer l’opération, appuyez sur la touche [X] en haut à droite sur le panneau
de réglage.

Les fonctions suivantes sont attribuées aux touches par défaut.
Touche 1 : [Direct Menu]
Touche 2 : [Focus Setting]
Touche 3 : [Rec Review]

Les touches de 1 à 3 sont équivalentes aux touches numérotées sur la télécommande infrarouge fournie.

Touche 4 : [Push Auto ND]
Touche 5 : [Crop Select]
Touche 6 : [Marker]
Touche 7 : [Video Signal Monitor]
Touche 8 : [Clip Flag OK]
Touche 9 : [Color Bars]
Touche Focus Hold : [Focus Hold]

La touche Focus Hold est équivalente à la touche Focus Hold sur un objectif à monture E.

Pour changer une fonction de touche
Utilisez [Project] > [Assignable Button] dans le menu de la caméra.
Lorsque vous changer une attribution, l’affichage de la liste des touches personnalisables change.
Pour plus de détails sur les fonctions des touches personnalisables, consultez « Assignable Button » dans « Menu de la
caméra et réglages détaillés ».

Rubrique associée
Assignable Button
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Ralenti et accéléré

Quand le format d’enregistrement est réglé sur les valeurs suivantes, vous pouvez spécifier différentes valeurs pour la
fréquence d’images de prise de vue et la fréquence d’images de lecture.
Le tableau suivant indique les fréquences d’images configurables.

Fréquence de système : 59.94/50/29.97/25/23.98, mode Imager Scan : FF

Fréquence de système : 59.94/50/29.97/25/23.98, mode Imager Scan : S35

Fréquence de système : 24, mode Imager Scan : FF

Note

Le mode Slow & Quick Motion ne peut pas être réglé pendant l’enregistrement, la lecture ou pendant l’affichage de l’écran de
miniatures.

L’enregistrement audio n’est pas pris en charge en mode ralenti et accéléré.

La fonction de diaphragme automatique et la fonction d’obturation automatique sont désactivées en mode Slow & Quick Motion.

La mise au point automatique présente les limites suivantes en mode Slow & Quick Motion.

Limites dues au modèle d’objectif, à la fréquence du système et à la fréquence d’images de prise de vue

Codec Format vidéo Fréquences d’images configurables

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Codec Format vidéo Fréquences d’images configurables

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Codec Format vidéo Fréquences d’images configurables

XAVC-I 4096×2160P 1–60
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La fonction de mise au point automatique est temporairement désactivée si le diaphragme est réglé sur F18 ou plus.

Pour plus de détails sur RAW, consultez « Enregistrement d’une vidéo au format RAW ».

Rubrique associée

Enregistrement d’une vidéo au format RAW

5-041-957-23(1) Copyright 2022 Sony Corporation

Objectif Sony Fréquence du système AF disponible

Autre que SEL16F28 – 7 fps ou plus pris en charge

SEL16F28

59.94/29.97/23.98 30, 60, 120, 240 fps pris en charge

50,00/25,00 25, 50, 100, 200 fps pris en charge

24,00 Non pris en charge
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Enregistrement de la vidéo par intermittence (Interval Rec)

La fonction d’enregistrement à intervalles vous permet de capturer de la vidéo par intermittence dans la mémoire interne
de l’appareil. Cette fonction est un moyen efficace pour la prise de vue de sujets en mouvement lent.
Lorsque vous commencez l’enregistrement, l’appareil enregistre automatiquement un nombre spécifié d’images (Number
of Frames) à un intervalle de temps spécifié (Interval Time).

A : intervalle de prise de vue (Interval Time)
B : nombre d’images dans une prise (Number of Frames)

Note

Il est possible d’utiliser une seule fonction d’enregistrement spéciale, tel que l’enregistrement en mode Interval Rec.

Si un autre mode d’enregistrement spécial est activé alors que Interval Rec est en cours d’utilisation, ce dernier est
automatiquement annulé.

Le mode Interval Rec est automatiquement activé après avoir modifié les réglages système tel que le format vidéo.

Les réglages Interval Rec ne peuvent pas être modifiés pendant l’enregistrement ou la lecture ou lorsque l’écran de miniatures
s’affiche.

Limitations pendant l’enregistrement
L’audio n’est pas enregistré.
Le passage en revue de l’enregistrement (Rec Review) n’est pas possible.

Si l’appareil est mis hors tension pendant l’enregistrement
Lorsque la source d’alimentation électrique de l’appareil est réglée sur l’état de veille, l’accès au support s’effectue
pendant plusieurs secondes pour enregistrer les images sauvegardées dans la mémoire jusqu’à ce moment, puis
l’appareil se met automatiquement en état de veille.
Si le cordon d’alimentation CC est débranché, l’alimentation est coupée à partir de l’adaptateur CA ou que
l’alimentation électrique PoE++ est déconnectée, alors les données prises jusqu’à ce point peuvent être perdues
(maximum 10 secondes). Veuillez faire preuve de prudence.

Réglage du nombre d’images et de l’intervalle entre les prises
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Réglez [Project] > [Interval Rec] > [Setting] sur [On] dans le menu Web, et réglez [Number of Frames] et [Interval Time].
L’appareil quitte le mode Interval Rec lorsqu’il est mis hors tension mais les réglages [Number of Frames] et [Interval
Time] sont maintenus. Vous n’aurez pas besoin de les régler de nouveau la fois suivante lorsque vous effectuez une
prise de vue en mode Interval Rec.

Astuce

Ceci peut également être réglé à l’aide de [Project] > [Interval Rec] dans le menu de la caméra.

Démarrage de la prise de vue

Appuyez sur la touche d’enregistrement START/STOP pour démarrer l’enregistrement. « Int●Rec » et « Int●Stby »
apparaissent alternativement.

Arrêt de la prise de vue

Arrêtez l’enregistrement.
A la fin de la prise de vue, les données vidéo enregistrées dans la mémoire à ce point sont enregistrées sur le support.
Pour quitter le mode Interval Rec, effectuez l’une des actions suivantes.

Mettez en veille la source d’alimentation électrique de l’appareil.
En mode veille de l’enregistrement, réglez [Project] > [Interval Rec] > [Setting] sur [Off].

De même, le mode Interval Rec est automatiquement activé lorsque l’appareil est redémarré.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Enregistrement d’images en cache (Picture Cache Rec)

La fonction Picture Cache Rec vous permet de tourner des vidéos à posteriori lorsque vous démarrez l’enregistrement
en maintenant une mémoire cache interne d’une durée déterminée lors de la prise de vue.

Réglage de la taille du cache

Réglez [Project] > [Picture Cache Rec] > [Setting] sur [On] dans le menu Web, et réglez la taille du cache à l’aide de
[Cache Size].

Note

La fonction Picture Cache Rec ne peut pas être utilisée en combinaison avec la fonction Interval Rec, l’enregistrement simultané
sur 2 fentes ou l’enregistrement proxy. Lorsque Picture Cache Rec est réglé sur On, ces autres modes d’enregistrement spécial
sont réglés sur Off.

Le mode Picture Cache Rec ne peut pas être sélectionné lorsqu’un enregistrement ou Rec Review est en cours.

Lorsque Picture Cache Rec est réglé sur On, le code temporel est enregistré en mode [Free Run], même s’il est réglé sur
[Regen] ou [Rec Run].

Le réglage [Output Format] ne peut pas être configuré en mode Picture Cache Rec. Si cela se produit, réglez temporairement
Picture Cache Rec sur Off, puis modifiez le réglage.

Astuce

La durée du cache peut être plus courte, selon le format d’enregistrement. Vérifiez le temps affiché dans [Project] > [Picture
Cache Rec] > [Cache Rec Time] dans le menu Web.

Ceci peut également être réglé à l’aide de [Project] > [Picture Cache Rec] dans le menu de la caméra.

Vous pouvez également commuter [Picture Cache Rec] entre On et Off à l’aide d’une touche personnalisable.

Démarrage de Picture Cache Rec

Lorsque [Picture Cache Rec] est réglé sur On, « ●Cache » (● vert) apparaît.
Lorsque vous appuyez sur la touche d’enregistrement START/STOP, l’enregistrement démarre et la vidéo est inscrite sur
les cartes mémoire, en commençant par la vidéo stockée dans la mémoire cache.

Note

Si vous modifiez le format d’enregistrement ou le look de base, la vidéo dans la mémoire cache stockée jusqu’à présent est
effacée, et la mise en cache d’une nouvelle vidéo démarre. Ainsi, il est impossible d’enregistrer des images en mode
d’enregistrement de cache d’image avant le changement de format, même si vous commencez immédiatement à enregistrer
après avoir changé le format.

Réglage [Cache Size] Durée de cache (approximative)

[Short] 5 secondes

[Medium] 10 secondes

[Long] 20 secondes

[Max] Valeur maximale pour chaque format d’enregistrement

235



Si Picture Cache Rec est réglé sur On ou Off immédiatement après avoir inséré une carte mémoire, les données de cache
peuvent ne pas être enregistrées sur la carte.

La vidéo est stockée dans la mémoire cache lorsque la fonction Picture Cache Rec est réglée sur On. La vidéo précédant le
réglage de la fonction sur On n’est pas mise en cache.

La vidéo n’est pas stockée dans la mémoire cache tant qu’une carte mémoire est en cours d’accès, comme lors de la lecture, de
la fonction Rec Review ou de l’affichage de l’écran des miniatures. Il est impossible d’enregistrer des vidéos en mode
d’enregistrement de cache d’image pendant cet intervalle.

Annulation de Picture Cache Rec

Réglez [Project] > [Picture Cache Rec] > [Setting] sur [Off] dans le menu Web ou appuyez sur une touche
personnalisable attribuée avec la fonction [Picture Cache Rec].

5-041-957-23(1) Copyright 2022 Sony Corporation
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Enregistrement simultané sur les cartes mémoire A et B (2-slot Simul Rec)

Vous pouvez enregistrer simultanément sur la carte mémoire A et la carte mémoire B en réglant [Project] > [Simul Rec] >
[Setting] sur [On] dans le menu Web ou le menu de la caméra.

Enregistrement séparé sur la carte mémoire A et la carte mémoire B

Vous pouvez démarrer/arrêter l’enregistrement vers chaque carte mémoire indépendamment à l’aide des touches
d’enregistrement START/STOP ou de la touche [2nd Rec START/STOP] de l’onglet  (Others).
Par défaut, les deux touches sont réglées pour démarrer/arrêter simultanément l’enregistrement vers les deux cartes
mémoire A et B.
Lorsque les touches sont réglées pour contrôler l’enregistrement de différentes cartes mémoire, le contrôle de
démarrage/arrêt d’enregistrement [SDI/HDMI Rec Control] suit l’état d’enregistrement du logement A.

Changement de réglage

Réglez les paramètres suivants à l’aide de [Project] > [Simul Rec] > [Rec Button Set] dans le menu de la caméra.

5-041-957-23(1) Copyright 2022 Sony Corporation

Réglage [Rec
Button Set] Touches et cartes mémoire

Rec Button : <Slot
A> <Slot B>
2nd Rec Button :
<Slot A> <Slot B>

Démarrez/arrêtez simultanément l’enregistrement vers les cartes mémoire A et B à l’aide de
l’une des touches.

Rec Button : <Slot
A>
2nd Rec Button :
<Slot B>

La touche d’enregistrement START/STOP démarre/arrête l’enregistrement vers la carte mémoire
A, et la touche [2nd Rec START/STOP] de l’onglet  (Others) démarre/arrête l’enregistrement
vers la carte mémoire B.

Rec Button : <Slot
B>
2nd Rec Button :
<Slot A>

La touche d’enregistrement START/STOP démarre/arrête l’enregistrement vers la carte mémoire
B, et la touche [2nd Rec START/STOP] de l’onglet  (Others) démarre/arrête l’enregistrement
vers la carte mémoire A.
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Moniteur de signal vidéo

Vous pouvez régler le type de signal vidéo à afficher dans le panneau d’image de la caméra sous forme d’onde,
vecteurscope ou histogramme à l’aide de [Monitoring] > [Video Signal Monitor] > [Setting] dans le menu de la caméra.
La ligne orange indique les valeurs réglées de [Level Marker 1] et [Level Marker 2].
Vous pouvez également attribuer la fonction [Video Signal Monitor] à une touche personnalisable .

Affichage de la cible de surveillance
En modes de prises de vue Log, les informations du réglage Color Gamut ou du réglage Monitor LUT s’affichent en haut
à droite du moniteur de signal vidéo pour indiquer la cible du moniteur.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Balises de plan

Vous pouvez ajouter une balise de plan [OK] à un plan en appuyant sur une touche personnalisable attribuée avec la
fonction [Clip Flag OK] et en sélectionnant [Add OK].
Vous pouvez supprimer une balise de plan [OK] en appuyant deux fois sur la touche et en sélectionnant [Delete Clip
Flag].

Astuce

En outre, vous pouvez ajouter une balise de plan à l’aide de [Thumbnail] > [Set Clip Flag] dans le menu de la caméra.

L’écran des miniatures peut être affiché selon le type de balise de plan (écran des miniatures de plans filtré). Pour plus de détails,
consultez « Opérations sur les plans enregistrés » dans « Ecran de miniatures ».

Rubrique associée

Opérations sur les plans enregistrés

5-041-957-23(1) Copyright 2022 Sony Corporation
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Compensation de la respiration

Vous pouvez définir si vous souhaitez effectuer une compensation de la respiration pour l’objectif à l’aide de [Technical] >
[Lens] > [Breathing Compensation] dans le menu de la caméra.
Cette fonction corrige le phénomène qui modifie l’angle de vue lorsque la position de mise au point varie.
Lorsque la compensation de la respiration est exécutée, une partie de l’image est recadrée électroniquement pour
maintenir un angle de vue constant afin que le phénomène de respiration n’apparaisse pas.

Note

Lorsque la compensation de la respiration est activée, l’angle de vue et la qualité d’image peuvent être légèrement modifiés.

Selon l’objectif, il peut être impossible de corriger la modification de l’angle de vue lorsque la compensation de la respiration est
activée.

La compensation n’est pas possible lorsqu’un objectif qui ne prend pas en charge la compensation de la respiration est fixé.

Cette fonction est réglée sur Off (fixe) dans les cas suivants.

Lorsque [Technical] > [Lens] > [Distortion Comp.] est réglé sur [Off] dans le menu de la caméra
Lorsque [Shooting] > [S&Q Motion] > [Setting] > est réglé sur [On] dans le menu Web ou le menu de la caméra
Lorsque [Project] > [Rec Format] > [Codec] > est réglé sur [RAW] ou [RAW & XAVC-I] dans le menu Web ou le menu de la
caméra

5-041-957-23(1) Copyright 2022 Sony Corporation
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Présentation de l’enregistrement proxy

Cette fonction vous permet d’enregistrer des données proxy à faible résolution en même temps que l’enregistrement
d’une vidéo de données d’origine haute résolution.

Pour plus de détails sur les cartes mémoire compatibles, le formatage des cartes mémoire et la vérification de la
capacité restante, consultez « Cartes mémoire prises en charge » dans « Préparation des cartes mémoire ».

À propos du fichier enregistré
L’extension du nom de fichier est « .mp4 ».
Le code temporel est enregistré simultanément aussi.

Destination de stockage du fichier enregistré
Le fichier enregistré est stocké dans le répertoire suivant.

À propos du nom de fichier
Le nom de fichier comprend le nom de plan enregistré sur la carte mémoire et un suffixe « S03 ».
Pour les noms de plan, consultez [TC/Media] > [Clip Name Format] dans le menu de la caméra.

Rubrique associée

Cartes mémoire prises en charge

5-041-957-23(1) Copyright 2022 Sony Corporation

Support d’enregistrement Chemin d’accès

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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Enregistrement d’un proxy

Vous pouvez démarrer l’enregistrement lorsque l’enregistrement proxy est activé.

Pour arrêter la prise de vue
Arrêtez l’enregistrement.

Pour régler le canal audio pour l’enregistrement proxy
Réglez le canal audio pour l’enregistrement de données proxy à l’aide de [Project] > [Proxy Rec] > [Audio Channel] dans
le menu de la caméra.

5-041-957-23(1) Copyright 2022 Sony Corporation

Réglez [Project] > [Proxy Rec] > [Setting] sur [On] dans le menu Web ou le menu de la caméra.1

Insérez une carte mémoire dans un logement de carte CFexpress Type A/SD.

Pour les cartes CFexpress, insérez avec l’étiquette orientée vers le haut.
Pour les cartes SD, insérez avec l’étiquette orientée vers le bas.

Note

Proxy Rec ne peut pas être réglé sur On en même temps que S&Q Motion ou Interval Rec. Lorsque Proxy Rec est réglé
sur On, ces autres modes d’enregistrement sont obligatoirement réglés sur Off.

2

Appuyez sur la touche d’enregistrement START/STOP.

L’enregistrement proxy démarre.

Note

Si l’appareil est arrêté ou la carte mémoire enlevée pendant que le système accède à la carte mémoire, l’intégrité des
données sur la carte ne peut pas être garantie.
Toutes les données enregistrées sur la carte mémoire peuvent être supprimées. Assurez-vous toujours que l’indicateur
d’accès de la carte mémoire est éteint avant d’arrêter l’appareil ou d’enlever la carte mémoire.

Assurez-vous que la carte mémoire ne s’éjecte pas quand vous l’insérez ou la retirez.

3
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Présentation de l’apparence

Lorsque l’appareil est en mode Custom, vous pouvez ajouter des réglages de noir, de matrice et d’autres paramètres
pour créer une « apparence » basée sur l’apparence de base.

De plus, vous pouvez sélectionner rapidement une autre apparence en enregistrant différentes combinaisons de
réglages dans des fichiers de scène.
L’appareil est fourni avec sept apparences prédéfinies au total.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Sélection d’une apparence

Cette rubrique décrit comment sélectionner une apparence.

Vérifiez que [Project] > [Base Setting] > [Shooting Mode] est réglé sur [Custom] dans le menu Web ou le
menu de la caméra.

Astuce

En mode [Custom], la touche [ISO/Gain] et la touche [Scene File] sont affichées dans le panneau de configuration de base
de la caméra.

1

Appuyez sur la touche [Scene File] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [Scene File] devient orange.

Le panneau de réglage de Scene File apparaît.

2

Appuyez sur la touche [Scene File] dans le panneau de réglage et sélectionnez un fichier de scène avec
l’apparence souhaitée dans la liste.

Les préréglages suivants sont configurés par défaut.

Astuce

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Scene file 1 [S-Cinetone] [HLG Live]

Scene file 2 [Standard] [HLG Natural]

Scene file 3 [Still] (Non enregistré)

Scene file 4 [ITU709] (Non enregistré)

Scene file 5 [709tone] (Non enregistré)

Fichiers de scène 6 à 16 (Non enregistré) (Non enregistré)
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Vous pouvez également sélectionner une apparence à l’aide de [Paint/Look] > [Scene File] > [Recall] dans le menu de la
caméra. Vous pouvez également rappeler une apparence prédéfinie à l’aide de [Scene File] > [Preset Recall].

Note

Le préréglage du fichier scène 5 est réglé sur [709tone] avec la version de logiciel 2.0 ou ultérieure. Il est affiché lorsque
[Maintenance]> [Reset] > [Factory Default] dans le menu Web est exécuté.
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Importation d’une apparence de base souhaitée

Vous pouvez importer un fichier 3D LUT, créé sur un ordinateur ou un autre appareil, comme apparence de base.
Jusqu’à 16 fichiers peuvent être importés.
Format de fichier : fichier CUBE (*.cube) pour un 3D LUT 17 grid ou 33 grid créé avec Catalyst Browse, RAW Viewer ou
DaVinci Resolve* (de Blackmagic Design Pty. Ltd.).

Gamme de couleurs d’entrée/gamma : [S-Gamut3.Cine/S-Log3] ou [S-Gamut3/S-Log3]

Vérifié avec Resolve V9.0, V10.0 et V11.0.*

Sauvegardez le fichier 3D LUT sur le dispositif exécutant l’application Web.1

Ouvrez [Paint/Look] > [Base Look] dans le menu Web.

Une liste d’apparences de base enregistrées apparaît.

2

Appuyez sur la touche [Import] dans la rangée où vous souhaitez importer le fichier.

La boîte de dialogue de sélection de fichier apparaît.

3

Sélectionnez le fichier 3D LUT préparé.

Le fichier 3D LUT importé devient l’apparence de base de l’appareil.

4

Sélectionnez le fichier 3D LUT importé à l’aide de [Paint/Look] > [Base Look] > [Select] dans le menu de la
caméra.

5

Configurez [Paint/Look] > [Base Look] > [Input] et [Output] dans le menu de la caméra pour qu’il
corresponde aux attributs du fichier 3D LUT importé.

6
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Pour ajuster la sous-exposition
Si vous constatez une tendance à la sous-exposition lorsque l’exposition automatique est sélectionnée alors que vous
utilisez l’apparence de base importée, réglez l’apparence à l’aide de [Paint/Look] > [Base Look] > [AE Level Offset] dans
le menu Web.

Note

L’importation d’un fichier 3D LUT n’affecte pas l’image. Chargez le fichier 3D LUT importé à l’aide de [Paint/Look] > [Base Look] >
[Select] dans le menu de la caméra.

Si vous ne réglez pas correctement [Input], vous n’obtiendrez pas l’apparence appropriée.

Les réglages des éléments de menu [Input], [Output] et [AE Level Offset] sont appliqués à l’apparence de base sélectionnée à
l’aide de [Select]. Si vous importez plusieurs fichiers 3D LUT, sélectionnez chaque fichier 3D LUT à l’aide de [Select], puis
configurez [Input], [Output] et [AE Level Offset] individuellement pour chaque fichier.

Les réglages [Input], [Output], et [AE Level Offset] configurés sont sauvegardés pour chaque fichier 3D LUT.

Les options de sélection d’apparence de base/LUT pour les fichiers 3D LUT importés sont communes à [SDR(BT.709)],
[HDR(HLG)] et modes de prise de vue Log, mais la conversion de la gamme de couleurs et du gamma n’est pas effectuée en
fonction de ces modes.

Les fichiers 3D LUT ne sont pas supprimés lorsque [Maintenance] > [Reset] > [All Reset (except for Network Settings)] est
exécuté dans le menu Web.

Une icône  (erreur de pièce jointe du fichier 3D LUT) affichée devant [Base Look Name] indique que les fichiers 3D LUT ne
peuvent pas être joints aux plans enregistrés dans les modes de prise de vue Log. Importez à nouveau le fichier 3D LUT.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Personnalisation d’une apparence (Look)

Vous pouvez personnaliser l’apparence en fonction de l’apparence de base à l’aide de curseurs [Master Black], [R Black]
et [B Black] dans le panneau de réglage Scene File dans le panneau de configuration de base de la caméra et
[Paint/Look] > [Matrix] et d’autres éléments de configuration dans le menu de la caméra.
Raccordez l’appareil à un téléviseur ou à un moniteur, puis réglez la qualité d’image tout en observant l’image sur le
téléviseur ou le moniteur.

1 : curseur/touches de réglage [R Black]
2 : curseur/touches de réglage [B Black]
3 : curseur/touches de réglage [Master Black]

Note

Lorsque vous importez un fichier 3D LUT et l’appliquez à l’image, l’apparence souhaitée définie dans le fichier 3D LUT n’est pas
obtenue si [Paint/Look] > [Matrix] et des réglages autres que les réglages d’apparence de base sont modifiés dans le menu de la
caméra.

Vous pouvez réinitialiser tous les réglages personnalisés à l’aide de [Paint/Look] > [Reset Paint Settings] > [Reset without Base
Look] dans le menu de la caméra.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Enregistrement d’une apparence (Look)

Vous pouvez sauvegarder l’apparence actuelle en tant que fichier de scène dans la mémoire interne à l’aide de
[Paint/Look] > [Scene File] > [Store] dans le menu de la caméra.
Vous pouvez rapidement rappeler l’apparence actuelle à l’aide du panneau de réglage Scene File ou à l’aide des
opérations de menu direct.

Note

Si vous sélectionnez une autre apparence sans enregistrer l’apparence actuelle, l’apparence actuelle est supprimée.

Astuce

Vous pouvez écraser les fichiers de scène prédéfinis. Pour restaurer un fichier de scène prédéfini, chargez l’apparence à
restaurer à l’aide de [Paint/Look] > [Scene File] > [Preset Recall] dans le menu de la caméra, puis sauvegardez le fichier de à
l’aide de [Scene File] > [Store].

Pour supprimer une apparence sauvegardée
Vous pouvez supprimer un fichier de scène sauvegardé dans la mémoire interne à l’aide de [Paint/Look] > [Scene File] >
[Delete] dans le menu de la caméra.

Astuce

Une fois supprimé, le paramètre n’apparaît plus dans le panneau de réglage Scene File, ni dans le menu direct.

5-041-957-23(1) Copyright 2022 Sony Corporation

249



Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Suppression d’une apparence de base

Vous pouvez supprimer individuellement les fichiers 3D LUT importés à l’aide de [Paint/Look] > [Base Look] > [Delete]
dans le menu de la caméra.
Vous pouvez supprimer tous les fichiers 3D LUT importés à l’aide de [Paint/Look] > [Base Look] > [Delete All] dans le
menu de la caméra.

Note

Avant de supprimer, vérifiez que l’apparence de base n’est pas utilisée par un fichier de scène. Si vous supprimez une apparence
de base en cours d’utilisation, l’apparence des fichiers de scène correspondants sera incorrecte.

Les fichiers 3D LUT importés ne sont pas supprimés lorsque [Maintenance] > [Reset] > [All Reset (except for Network Settings)]
est exécuté dans le menu Web.

Une apparence de base supprimée ne peut plus être utilisée comme LUT en modes de prise de vue Log.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Prise de vue avec réglage d’apparence en post-production

Lorsque vous utilisez l’appareil en modes de prise de vue Log*1 et enregistrez uniformément les gradations des zones
sombres aux zones lumineuses, vous pouvez effectuer des réglages précis, par exemple restaurer localement les
gradations des zones sombres et des zones lumineuses, en post-production.
Toutefois, lorsque vous visionnez les images enregistrées sur un moniteur classique, le contraste d’ensemble est faible,
ce qui complique les réglages de mise au point et d’exposition.
Vous pouvez appliquer un LUT à la cible de moniteur sur l’appareil pour faciliter divers réglages lors de la prise de vue.
Vous pouvez également appliquer le LUT utilisé lors de la prise de vue automatique lors de la lecture pour vérifier
rapidement le résultat final.
Les LUT sont appliqués par les systèmes suivants. Cependant, vous ne pouvez appliquer qu’un seul LUT.

Sortie SDI
Sortie HDMI et diffusion en continu
Plan proxy enregistré sur un support d’enregistrement
Plan (principal) haute résolution enregistré sur un support d’enregistrement

5-041-957-23(1) Copyright 2022 Sony Corporation

Terme générique pour le mode Flexible ISO / mode Cine EI / mode Cine EI Quick*1
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Application d’un LUT à une sortie HDMI et à une diffusion en continu

Vous pouvez appliquer un LUT à une sortie HDMI et à une diffusion en continu.

Note

L’image dans le panneau d’image de la caméra de l’application Web est également incluse dans l’image de diffusion en continu.

Astuce

Ceci peut également être réglé à l’aide de [Shooting] > [LUT On/Off] > [HDMI/Stream] dans le menu de la caméra.

La sortie SDI peut être réglée de la même façon.

Pour une vidéo sur un support d’enregistrement, vous pouvez régler ceci à l’aide de [Shooting] > [LUT On/Off] > [Internal Rec] et
[Proxy] dans le menu de la caméra.

Une icône  (erreur de pièce jointe du fichier 3D LUT) affichée devant [Base Look/LUT] indique que les fichiers 3D LUT ne
peuvent pas être joints aux plans enregistrés dans les modes de prise de vue Log. Importez à nouveau le fichier 3D LUT.
Cette icône s’affiche également lorsque la pièce jointe échoue en raison d’une congestion temporaire du traitement.

Vérifiez que [Project] > [Base Setting] > [Shooting Mode] est réglé sur [Flexible ISO], [Cine EI] ou [Cine EI
Quick] dans le menu Web ou le menu de la caméra.

Astuce

En modes de prise de vue Log, la touche [Base ISO/Exposure Index] et la touche [Base Look/LUT] sont affichées dans le
panneau de configuration de base de la caméra.

1

Appuyez sur la touche [Base Look/LUT] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [Base Look/LUT] devient orange.

Le panneau de réglage de Base Look/LUT apparaît.

2

Sélectionnez [HDMI/Stream] > [MLUT].3
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Modification d’un LUT

Vous pouvez changer le LUT à appliquer.

Astuce

L’appareil propose [s709], [709(800%)] et [S-Log3] comme LUT prédéfinis.

Vous pouvez aussi importer et appliquer un fichier 3D LUT. Pour plus de détails, consultez « Importation d’une apparence de
base souhaitée » et « Suppression d’une apparence de base ».

Ceci peut également être réglé à l’aide de [Paint/Look] > [Base Look] > [Select] dans le menu de la caméra.

Rubrique associée
Importation d’une apparence de base souhaitée

Suppression d’une apparence de base

5-041-957-23(1) Copyright 2022 Sony Corporation

Appuyez sur la touche [Base Look/LUT] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [Base Look/LUT] devient orange.

Le panneau de réglage de Base Look/LUT apparaît.

1

Appuyez sur la touche [Base Look/LUT] et sélectionnez l’apparence de base à appliquer.2
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Modification de la distribution de zones sombres et lumineuses dans une image
enregistrée

En modes de prise de vue Cine EI et Cine EI Quick, vous pouvez modifier la distribution des zones sombres et des
zones lumineuses si, par exemple, vous souhaitez donner la priorité aux teintes des zones sombres par rapport aux
zones lumineuses, en changeant Exposure Index dans la sensibilité de base.

Appuyez sur la touche [Base Look/LUT] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [Base Look/LUT] devient orange.

Le panneau de réglage de Base Look/LUT apparaît.

1

Sélectionnez [HDMI/Stream] > [MLUT].

Un LUT est appliqué à la sortie HDMI et à la diffusion en continu.

2

Appuyez sur la touche [Base ISO/Exposure Index] dans le panneau de configuration de base de la caméra.

Le cadre de la touche [Base ISO/Exposure Index] devient orange.

Le panneau de réglage de Base ISO/Exposure Index apparaît.

3

Réglez l’index d’exposition selon la distribution de zones sombres et lumineuses souhaitée à l’aide du
curseur [Exposure Index] ou des touches de réglage [Exposure Index].

Pour [Cine EI]

Pour [Cine EI Quick]

4
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Astuce

Ceci peut également être réglé à l’aide de [Shooting] > [ISO/Gain/EI] > [Exposure Index] dans le menu de la caméra.

La sortie SDI peut être utilisée de la même façon.

La deuxième valeur numérique du réglage indique combien d’incréments d’informations de luminosité sont attribués aux zones
lumineuses (luminosité supérieure à 18% de gris). Les zones plus lumineuses que cela sont surexposées.
Exemple : dans « 400EI/5.0E » des incréments de 5,0 sont attribués au côté lumineux.

Vous pouvez également vous servir de ceci comme d’un guide pour vérifier la teinte des zones sombres et lumineuses pendant la
prise de vue. N’oubliez pas de revenir à la valeur originale EI après avoir vérifié l’exposition. En outre, en mode Cine EI Quick,
veillez à éviter tout effet négatif sur la sensibilité de base.

5-041-957-23(1) Copyright 2022 Sony Corporation

La sensibilité de base est réglée automatiquement en fonction de l’indice d’exposition spécifié.

Ajustez l’éclairage et/ou le filtre ND pour que la sortie de l’image de la caméra de [HDMI/Stream] ait
l’exposition appropriée.

5
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Enregistrement d’une vidéo au format RAW

Vous pouvez enregistrer la sortie du signal vidéo RAW du connecteur SDI OUT de l’appareil sur un enregistreur externe
compatible.
Les formats de sortie RAW pris en charge sont indiqués ci-dessous.

Fréquence du système [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Branchez un enregistreur RAW externe sur le connecteur SDI OUT de l’appareil.1

Réglez [Project] > [Base Setting] > [Shooting Mode] sur [Cine EI], [Cine EI Quick] ou [Flexible ISO] dans le
menu Web ou le menu de la caméra.

2

Réglez l’angle de vue (FF uniquement) à l’aide de [Project] > [Rec Format] > [Imager Scan Mode] dans le
menu Web ou dans le menu de la caméra.

3

Réglez [Project] > [Rec Format] > [Codec] sur [RAW] dans le menu Web ou le menu de la caméra.

La sélection de [RAW & XAVC-I] permet d’enregistrer simultanément la vidéo sur l’enregistreur RAW externe et la
vidéo sur les cartes mémoire dans l’appareil.

4

Réglez la résolution à l’aide de [Project] > [Rec Format] > [RAW Output Format] dans le menu Web ou le
menu de la caméra.

5

Vérifiez que l’enregistreur externe est activé, puis appuyez sur la touche d’enregistrement START/STOP sur
l’écran d’opération en direct.

L’état d’enregistrement d’une vidéo RAW est indiqué par une icône dans le panneau d’image de la caméra.

6
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Note

Lorsque l’enregistrement est démarré sur un enregistreur externe sans utiliser la touche d’enregistrement START/STOP sur
l’écran d’opération en direct, il est possible que les plans ne soient pas correctement enregistrés.

5-041-957-23(1) Copyright 2022 Sony Corporation

Note

Le signal de contrôle d’enregistrement est émis par le connecteur SDI OUT de l’appareil, mais il n’est pas possible d’obtenir
l’état de l’enregistreur externe. En conséquence, l’appareil pourrait indiquer qu’un enregistrement vidéo RAW est en cours
alors que l’enregistreur externe n’enregistre pas réellement. Vérifiez l’indicateur sur l’enregistreur externe pour connaître
l’état de fonctionnement réel.
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Enregistrement en mode ralenti et accéléré d’une vidéo RAW

Vous pouvez enregistrer une vidéo RAW en mode ralenti et accéléré.

Pour plus de détails sur les fréquence d’images prises en charge pour la prise de vue, consultez « Ralenti et
accéléré ».

Rubrique associée
Ralenti et accéléré

5-041-957-23(1) Copyright 2022 Sony Corporation
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Activation/désactivation de la fonction de contrôle du bokeh

Vous pouvez facilement ajuster le degré de bokeh en liant le filtre ND et le gain à l’opération du diaphragme.

Activation/désactivation de la fonction de contrôle du bokeh

Cette fonction ne peut être activée que lors de l’ajustement manuel de l’exposition. Réglez le filtre ND sur le mode
Variable, puis réglez le diaphragme, le gain, l’obturateur et le filtre ND sur l’ajustement manuel.
Vous pouvez activer/désactiver la fonction du contrôle de bokeh à l’aide de [Shooting] > [Iris] > [Bokeh Control] dans le
menu de la caméra.
Lorsque la fonction de contrôle du bokeh est réglée sur On, une icône  (B) s’affiche sur les indicateurs de filtre ND et
de gain.

Note

Cette fonction est activée uniquement sur les objectifs à monture E qui peuvent communiquer avec l’appareil.

L’effet maximal de cette fonction peut être obtenu en utilisant un objectif à monture E de Sony.

La fonction de contrôle du bokeh est réglée sur Off lorsque l’une des opérations suivantes se produit.

Lorsque l’appareil est mis hors tension
Lorsque le diaphragme, le gain, l’obturateur ou le filtre ND est réglé sur Auto
Lorsque le mode de prise de vue est commuté
Lorsque le filtre ND est réglé sur le mode d’effacement ou mode prédéfini
Lorsque l’objectif est retiré
Lorsque l’appareil redémarre, par exemple, après une commutation de la fréquence

Astuce

Vous pouvez également attribuer la fonction [Bokeh Control] à une touche personnalisable et commuter la fonction de contrôle du
bokeh entre On et Off en utilisant la touche.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Ajustement du degré de bokeh

Effectuez les réglages des étapes 2 à 4 si nécessaire.

Note

L’apparence peut varier en fonction de la vitesse de fonctionnement, de l’objectif, des réglages de prise de vue et du sujet, et la
luminosité peut également changer. Il est fortement recommandé d’effectuer un test de la caméra avant la prise de vue.

La luminosité peut changer lorsque le sens de fonctionnement du diaphragme change, comme par exemple lors de l’ouverture du
diaphragme après sa fermeture ou lors de la fermeture du diaphragme après son ouverture. Dans ce cas, ajustez un peu plus
que nécessaire au préalable, puis revenez un peu en arrière, vérifiez la luminosité, puis commencez la prise de vue. Par
exemple, si vous voulez ouvrir le diaphragme à une ouverture F8 et rendre l’arrière-plan flou, fermez d’abord le diaphragme au-
delà de F8, puis revenez à F8, vérifiez la luminosité et commencez la prise de vue.

Effectuez les opérations de contrôle du bokeh lentement. Si vous devez accélérer l’opération, essayez d’ajuster progressivement
tout en vérifiant les changements apportés à l’image.

Astuce

Lorsque la fonction de contrôle du bokeh est réglée sur On, le filtre ND et le gain fonctionnent ensemble pour compenser les
changements d’exposition dus à l’ajustement du diaphragme, ce qui vous permet de changer le degré de bokeh.

Le contrôle du bokeh est d’abord lié au filtre ND en réponse à l’opération du diaphragme. Lorsque le filtre ND ne peut plus être
changé, le gain est lié.

En mode MF, il est recommandé d’ouvrir d’abord le diaphragme, puis d’ajuster la mise au point.

Si vous utilisez le filtre ND automatique au lieu de la fonction de contrôle du bokeh, le filtre ND automatique suit le changement
de luminosité du sujet.

Affichage pendant l’opération de liaison du gain
Lorsque la fonction de contrôle du bokeh est réglée sur On, le gain peut changer lorsque le diaphragme est ajusté.
Lorsque la liaison du gain est active et que le gain change, un message s’affiche en haut de l’écran et l’icône  (B) sur
l’indicateur de gain clignote.

Réglez la fonction de contrôle du bokeh sur On.1

Ouvrez entièrement le diaphragme.2

Réglez le filtre ND sur 1/128.3

Réglez le gain sur 0 dB et utilisez l’éclairage pour obtenir l’exposition adéquate.4

Ajustez la mise au point.5

Ajustez le diaphragme.

Le degré de bokeh change.

6

261



5-041-957-23(1) Copyright 2022 Sony Corporation

262



Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Présentation de l’enregistrement et du chargement des données de configuration

Vous pouvez sauvegarder les réglages d’un appareil comme donnée de configuration à l’aide de l’application Web. Ceci
vous permet de rappeler rapidement un ensemble de réglages de menu approprié à la situation actuelle.
Avec cet appareil, vous pouvez sauvegarder presque tous les réglages des fonctions de l’appareil, autres que la
remarque suivante, comme un fichier ALL (fichier avec tous les réglages).

Note

Les réglages de fonction réseau et informations d’authentification ne sont pas sauvegardés. Pour plus de détails sur les éléments
sauvegardés, consultez « Liste des éléments de menu ».

Rubrique associée

Liste des éléments de menu

5-041-957-23(1) Copyright 2022 Sony Corporation
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Enregistrement d’un fichier ALL

Cette rubrique décrit comment sauvegarder un fichier ALL.

5-041-957-23(1) Copyright 2022 Sony Corporation

Ouvrez [Project] > [All File] dans le menu Web.1

Appuyez sur la touche [Save All File] > [Save].

Le navigateur Web téléchargera momentanément un fichier nommé all-file.ALL.

2

Spécifiez un emplacement et un nom de fichier pour le fichier all-file.ALL téléchargé, puis sauvegardez le
fichier.

Pour plus de détails sur les opérations, consultez le mode d’emploi de votre dispositif.

3
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Chargement d’un fichier ALL

Cette rubrique décrit comment charger un fichier ALL.

Note

L’appareil redémarrera automatiquement après avoir chargé les données de configuration. Après le redémarrage, rechargez la
page dans le navigateur Web.

5-041-957-23(1) Copyright 2022 Sony Corporation

Ouvrez [Project] > [All File] dans le menu Web.1

Appuyez sur la touche [Load All File] > [Load].

La boîte de dialogue d’ouverture de fichier s’affiche sur le dispositif exécutant l’application Web.

2

Ouvrez le fichier que vous souhaitez charger.

Pour plus de détails sur les opérations, consultez le mode d’emploi de votre dispositif.

3

Lorsque l’écran de confirmation du nom du fichier de chargement s’affiche, appuyez sur la touche [OK].4

Lorsque l’écran de résultat de l’exécution apparaît, appuyez sur la touche [OK].5

Attendez que l’appareil redémarre, puis connectez-vous à nouveau à l’application Web.6
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À propos du transfert de fichiers

Vous pouvez télécharger un fichier proxy ou un fichier original enregistré sur l’appareil vers un serveur sur Internet ou un
serveur sur un réseau local.

Note

Lorsque le commutateur d’alimentation est réglé sur l’état de veille, les transferts de fichiers sont suspendus bien que l’appareil
soit toujours sous tension.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Enregistrement d’une destination de transfert de fichiers

Vous pouvez enregistrer un serveur de destination de transfert avant de commencer un transfert de fichier.

Sélectionnez [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (ou [Server
Settings2], [Server Settings3]) dans le menu Web.

Astuce

Le nom de l’option de sélection changera en fonction de [Display Name] configuré à l’étape suivante.

1

Configurez les éléments suivants pour [Network] > [FTP Server 1] sur [FTP Server 3] dans le menu Web.

[Display Name]
Saisissez le nom du serveur à afficher dans la liste des tâches de transfert lors de la sélection d’un serveur de
destinations de transfert.
[Service]
Affiche le type de serveur.
[FTP] : serveur FTP
[Host Name]
Saisissez l’adresse et le nom d’hôte du serveur.
[Port]
Saisissez le numéro de port du serveur pour effectuer la connexion.
[User Name]
Saisissez le nom d’utilisateur.
[Password]
Saisissez le mot de passe.
[Passive Mode]
Activez/désactivez le mode passivité.
[Destination Directory]
Saisissez le nom de répertoire sur le serveur de destination.

Note

Si des caractères non valides sur le serveur de destination sont saisis dans [Destination Directory], les fichiers seront
transférés dans le répertoire original de l’utilisateur. Les caractères non valides varient en fonction du serveur.

[Using Secure Protocol]
Indiquez si exécuter ou non le transfert sur FTP sécurisé.
[Root Certificate]
Chargez/effacez un certificat.
[Load] : charge un certificat CA. Charge des certificats au format PEM.
[Clear] : efface un certificat CA.
[None] : vous ne pouvez ni charger ni effacer un certificat.

Note

Réglez l’horloge de l’appareil sur l’heure correcte avant de charger un certificat CA.

Lors de l’enregistrement en XAVC-I 4096×2160P/3840×2160P 59.94/50P, [Load] ne peut pas être sélectionné.

2
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[Root Certificate Status] : affiche l’état de chargement du certificat.
[Reset] : réinitialise les réglages Server Settings aux réglages par défaut.

268



Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Téléchargement d’un fichier proxy sur une carte mémoire à partir de l’écran des
miniatures

Vous pouvez télécharger des fichiers proxy sur une carte mémoire individuellement à partir de l’écran des miniatures.

Note

Un maximum de 200 tâches de transfert peuvent être enregistrées.

5-041-957-23(1) Copyright 2022 Sony Corporation

Appuyez sur la touche [Thumbnail] sur l’écran d’opération en direct de l’application Web.

L’affichage passe de l’image de la caméra à l’écran des miniatures.

1

Sélectionnez [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] dans le menu de la caméra.

Pour transférer l’ensemble des fichiers proxy simultanément, sélectionnez [Transfer Clip (Proxy)] > [All Clips].
Les plans peuvent être transférés de l’écran des miniatures ou de l’écran des miniatures de plans filtrés.

2

Sélectionnez le plan que vous souhaitez transférer à l’aide de la touche [Set], et appuyez sur la touche
[Menu].

Un écran de confirmation de transfert apparaît.

3

Sélectionnez [Execute].

Le fichier proxy correspondant au plan sélectionné est enregistré comme tâche de transfert et le téléchargement
commence.
Si l’enregistrement de la tâche de transfert réussit, l’écran des résultats du transfert s’affiche.

4

Appuyez sur la touche [OK].5
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Téléchargement d’un fichier original sur une carte mémoire à partir d’un écran des
miniatures

Vous pouvez télécharger un fichier original sur une carte mémoire à partir d’un écran des miniatures.

Note

Un maximum de 200 tâches de transfert peuvent être enregistrées.
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Appuyez sur la touche [Thumbnail] sur l’écran d’opération en direct de l’application Web.

L’affichage passe de l’image de la caméra à l’écran des miniatures.

1

Sélectionnez [Thumbnail] > [Transfer Clip] > [Select Clip] dans le menu de la caméra.

Pour transférer l’ensemble des fichiers originaux simultanément, sélectionnez [Transfer Clip] > [All Clips].
Les plans peuvent être transférés de l’écran des miniatures ou de l’écran des miniatures de plans filtrés.

2

Sélectionnez le plan que vous souhaitez transférer à l’aide de la touche [Set], et appuyez sur la touche
[Menu].

Un écran de confirmation de transfert apparaît.

3

Sélectionnez [Execute].

Le fichier original du plan sélectionné est enregistré comme tâche de transfert et le téléchargement commence.
Si l’enregistrement de la tâche de transfert réussit, l’écran des résultats du transfert s’affiche.

4

Appuyez sur la touche [OK].5
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Vérification de l’état du transfert de fichiers

Vous pouvez vérifier l’état du transfert de fichiers en sélectionnant [Network] > [File Transfer] > [View Job List] dans le
menu de la caméra.

Note

Un maximum de 200 tâches de transfert peuvent être enregistrées.

Les tâches de transfert sont conservées lorsque l’appareil est commuté sur l’état de veille, mais jusqu’à 10 minutes de
progression récente peuvent être perdues si l’alimentation est désactivée par tout autre moyen.

Si une erreur se produit lors du transfert de fichiers, le transfert d’un plan ayant le même nom qu’un plan transféré peut ne pas se
poursuivre en fonction des paramètres et de l’état du serveur de destination du transfert. Si cela se produit, vérifiez les
paramètres et l’état du serveur de destination du transfert.

Astuce

Si [Network] > [File Transfer] > [Auto Upload (Proxy)] est réglé sur [On] dans le menu de la caméra et qu’une connexion réseau
existe, les fichiers proxy sont automatiquement téléchargés sur le serveur spécifié à l’aide de [Default Upload Server] à la fin de
l’enregistrement.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Téléchargement à l’aide d’un FTP sécurisé

Vous pouvez télécharger des fichiers cryptés à l’aide de FTPS en mode Explicit (FTPES) pour la connexion avec le
serveur de fichiers de destination.
Pour un transfert FTP sécurisé, réglez [Using Secure Protocol] sur [On] dans le serveur du fichier de destination puis
chargez un certificat.

Pour plus de détails sur la configuration, consultez « Enregistrement d’une destination de transfert de fichiers ».

Rubrique associée

Enregistrement d’une destination de transfert de fichiers
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À propos de la diffusion en continu

L’appareil peut diffuser simultanément la vidéo et l’audio qui est émis par le connecteur HDMI.

Note

Pour utiliser la diffusion en continu comme vidéo principale, réglez [Monitoring] > [Output Display] > [SDI] sur [On] et
[HDMI/Stream] sur [Off] dans le menu Web, et surveillez l’état de la caméra sur un moniteur SDI.

Si un moniteur connecté au connecteur HDMI ne prend pas en charge le format de sortie HDMI configuré à l’aide du menu
[Monitoring] dans le menu Web ou menu de la caméra, l’image de la caméra ne sera pas émise à l’application Web. La vidéo en
continu ne peut pas non plus être émise.

La résolution de la diffusion en continu ne peut pas être supérieure à la résolution du signal de sortie HDMI.

L’image peut être déformée selon les réglages de codec lorsqu’elle est visionnée par plusieurs utilisateurs.

L’appareil prend en charge les méthodes de diffusion en continu suivantes. Les codecs vidéo disponibles pour la
sélection sont indiqués entre parenthèses.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Configurez le réglage du format de la diffusion en continu, le réglage du codec vidéo et le réglage du codec audio dans
cet ordre.

● : Activé, – : Désactivé

Astuce

L’image dans le panneau d’image de la caméra de l’application Web est également un système de diffusion en continu.

Format de diffusion en continu
Réglage de codec

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Application Web – – ● –

RTMP peut être sélectionné lorsque [Stream] > [Audio Stream] est réglé sur [On] dans le menu Web.*1

Lorsque la fréquence de système est de 59.94 ou 50 et que le format de sortie HDMI est de 3840×2160 ou supérieur, la sortie video 2 n’est pas
disponible.

*2
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Configuration du format pour la diffusion en continu

Réglez le format pour la diffusion en continu à l’aide de [Stream] > [Stream] > [Stream Setting] > [Setting] dans le menu
Web.

Lorsque [Setting] est réglé sur [RTSP]

Dans la diffusion en continu RTSP, l’image d’une seule caméra peut être vue simultanément par cinq utilisateurs au
maximum.
Vous pouvez configurer jusqu’à deux modes de codec vidéo.
[Port Number]
Règle le numéro de port à utiliser pour la diffusion en continu RTSP. La valeur par défaut est 554.
Changer les réglages redémarrera le serveur RTSP.
[Time Out]
Indique le délai d’attente de la commande Keep-Alive pour la diffusion en continu RTSP. Le délai d’attente peut être
configuré dans une plage de 0 à 600 secondes. La valeur par défaut est de 60 secondes.
Lorsqu’il est réglé sur 0 seconde, le délai d’attente en raison de la commande Keep-Alive ne se produit pas.
[Authentication]
Définit si l’authentification est requise ou non.
[Video Port Number 1], [Video Port Number 2]
Indique le numéro de port de communication des données d’image à utiliser pour la monodiffusion en continu RTSP. La
valeur par défaut pour Video Port Number 1 est 51000. La valeur par défaut pour Video Port Number 2 est 53000.
Spécifiez un numéro pair compris entre 1024 et 65534. Le numéro configuré ici et le numéro impair suivant, obtenu en
ajoutant 1, deviennent les deux numéros de ports utilisés pour les communications et le contrôle des données d’image.
[Video Port Number 1] et [Video Port Number 2] correspondent à [Stream] > [Video Stream] > [Video Stream 1] et [Video
Stream 2].
[Audio Port Number]
Spécifie le numéro de port de communication des données audio utilisé pour la monodiffusion en continu RTSP. La
valeur par défaut est 57000. Spécifiez un numéro pair compris entre 1024 et 65534. Le numéro configuré ici et le numéro
impair suivant, obtenu en ajoutant 1, deviennent les deux numéros de ports utilisés pour les communications et le
contrôle des données audio.

Lorsque [Setting] est réglé sur [RTMP]

Le mode de codec vidéo qui peut être utilisé pour RTMP est H.264 uniquement. Pour utiliser RTMP, [Stream] > [Audio
Stream] doit être réglé sur [On] dans le menu Web.
[Server URL]
Définit l’URL de destination du téléchargement en amont. Spécifiez une chaîne de caractères commençant par
« rtmp:// » ou « rtmps:// ».
[Stream Key]
Saisissez la clé de flux obtenue du site que vous utilisez. Appuyer sur la touche [Clear] effacera la saisie.

Note

Faites preuve de prudence lorsque vous manipulez la clé de flux. Si la clé du flux est connue d’un tiers, il existe un risque
d’usurpation du flux.

[Root Certificate]
Importe le certificat racine requis pour la diffusion continue utilisant le protocole RTMPS. Pour importer le certificat
racine, appuyez sur la touche [Load] et sélectionnez un certificat racine. Appuyez sur la touche [OK] dans la boîte de
dialogue de sélection de fichier pour importer le fichier sélectionné dans l’appareil. S’il existe un certificat racine importé
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dans l’appareil, le certificat racine sera mis à jour. Pour supprimer un certificat racine importé, appuyez sur la touche
[Delete] sur l’écran de configuration. L’état du certificat racine s’affiche dans [Root Certificate Status].

Note

Importez le certificat racine requis par le service de diffusion en continu.

Lorsque [Setting] est réglé sur [SRT-Caller] ou [SRT-Listener]

Le mode codec vidéo est uniquement H.264.
[Destination]
Affiché lorsque le mode de diffusion en continu est réglé sur [SRT-Caller]. Définit l’URL de destination de la connexion.
[Port Number]
Affiché lorsque le mode de diffusion en continu est réglé sur [SRT-Listener]. Définit le numéro de port sur lequel écouter.
La valeur par défaut est 4201.
[Latency]
Définit la latence dans une plage de 20 ms à 8000 ms. La valeur par défaut est 120.
[TTL]
Définit une valeur TTL dans une plage de 1 à 255. La valeur par défaut est 64.
[Encryption]
Sélectionne la méthode de cryptage. Sélectionne Off, AES128, ou AES256. La valeur par défaut est Off.
[Passphrase]
Définit la phrase secrète utilisée pour le cryptage. Appuyer sur la touche [Clear] réinitialisera la phrase secrète
configurée.
[ARC]
Pour activer la fonction de contrôle de débit adaptatif, réglez sur On.
Lorsque la fonction de contrôle de débit adaptatif est activée, les interruptions de l’image causés par l’encombrement des
lignes de communication peuvent être réduites.

Lorsque [Setting] est réglé sur [NDI|HX]

L’appareil est conforme à NDI|HX version 2 de NewTek.
Pour utiliser NDI|HX, une clé de licence doit être achetée.
Achat d’une clé de licence
Achetez-la sur l’URL NewTek suivante.
https://www.newtek.com/ndihx/products/upgrade/

Note

Téléchargez le dernier pilote NDI|HX et installez-le dans un produit NewTek.

Pour plus de détails sur l’enregistrement et l’opération de NDI|HX, consultez le mode d’emploi du produit NewTek.

[License]
Affiche les informations de licence pour une licence activée.
[Source Name]
Affiche le nom de source.
[Group]
Pour activer la fonction de groupement NDI, réglez sur On.
[Group Name] : définit le nom du groupe NDI. Plusieurs réglages peuvent être configurés en étant séparés par une
virgule.
[Discovery Server 1], [Discovery Server 2]
Définit le serveur de découverte NDI 1 et serveur de découverte NDI 2.
[Reliable UDP Mode]
Pour activer le mode Reliable UDP, réglez sur On.
[Multicast Mode]
Pour activer la multidiffusion en continu, réglez sur On.
[Multicast Prefix] : définit le préfixe pour utiliser la multidiffusion en continu.
[Multicast Netmask] : définit le masque de réseau déterminant la plage d’adresses de multidiffusion.
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[Multicast TTL] : définit la valeur TTL pour la multidiffusion en continu dans une plage de 1 à 256. La valeur par défaut est
3.
[Multi-TCP Mode]
Pour activer le mode Multi-TCP, réglez sur On.
[Unicast UDP Mode]
Pour activer le mode Unicast UDP, réglez sur On.

À propos des services tiers et du logiciel
Certaines conditions d’utilisation peuvent s’appliquer.

La disposition de services et de mises à jour du logiciel peut être interrompue ou prendre fin sans préavis.
La description des services et du logiciel est sujet à modification sans préavis.
Un abonnement et un enregistrement séparés peuvent être nécessaires.

Sony n’assumera pas de responsabilité concernant toute réclamation par les utilisateurs ou une tiers partie en raison de
l’utilisation de services et du logiciel d’autres entreprises.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Configuration du codec vidéo pour la diffusion en continu

Réglez le codec vidéo à l’aide de [Stream] > [Video Stream] dans le menu Web.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Vous pouvez configurer jusqu’à trois modes de codec d’image. Configurez les réglages suivants séparément pour
chaque mode d’image.
[Video Stream 3] est utilisé pour l’affichage du panneau d’image de la caméra de l’application Web.

Note

Lorsque [Stream] > [Stream Setting] > [Setting] est réglé sur [RTMP], [SRT-Caller] ou [SRT-Listener], certains réglages [Video
Stream 1], [Video Stream 2] et [Video Stream 3] ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode]) ont des valeurs par
défaut.

[Codec 1], [Codec 2], [Codec 3]
Sélectionnez [H.264], [H.265] ou [Off]. Notez que [Codec 1] ne peut pas être réglé sur [Off]. De même, [Codec 3] est
réglé sur [JPEG] (fixe).

Note

Les symptômes suivants peuvent se produire selon la combinaison de plusieurs réglages, tels que la taille d’image, la fréquence
d’images et le débit binaire de [Codec 1], [Codec 2] et [Codec 3].

Augmentation de la latence de vidéo.
Saut d’image pendant la lecture vidéo.
Audio intermittent.
Réponse lente de la caméra à différentes commandes.
Réponse lente de la caméra aux opérations d’un pupitre de télécommande.
Affichage lent de l’écran du moniteur et des opérations de configuration.

Si vous rencontrez ces symptômes, réduisez les valeurs de la taille d’image, de la fréquence d’images et les paramètres du débit
binaire, ou modifiez les valeurs d’autres paramètres de configuration pour résoudre le problème.

Lorsque [Stream] > [Stream Setting] > [Setting] est réglé sur [RTMP], [SRT-Caller] ou [SRT-Listener], [Codec 1] est réglé sur
[H.264] (fixe). [Codec 2] est réglé sur [Off] (fixe).

Lorsque la taille d’image ou la fréquence du système de la sortie HDMI est modifiée, [Codec 2] est réglé sur [Off].

[Size 1], [Size 2], [Size 3]
Sélectionne la taille d’image à diffuser depuis la caméra.
Les options de taille d’image disponibles varient en fonction de la taille d’image de la sortie HDMI.

Note

Lorsque la taille d’image ou que la fréquence du système de la sortie HDMI est modifiée, la taille d’image maximale sera
sélectionnée.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Règle la fréquence d’images de l’image.
Les unités « fps » indiquent le nombre d’images diffusées par seconde.
Les options de fréquence d’images disponibles varient en fonction de la taille d’image de la sortie HDMI.
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Note

Lorsque la taille d’image ou que la fréquence du système de la sortie HDMI est modifiée, la fréquence d’image maximale sera
sélectionnée.

[I-Picture Mode 1], [I-Picture Mode 2]
Règle la méthode pour spécifier l’intervalle d’insertion d’image I pour H.264 et H.265 depuis [Time] et [Frame].
Impossible de régler pour [Codec 3].
[Time] : règle l’intervalle d’insertion d’image I comme une durée.
[Frame] : règle l’intervalle d’insertion d’image I en nombre d’images.
[I-Picture Interval 1], [I-Picture Interval 2]
Règle l’intervalle d’insertion d’image I en unités de secondes. Règle une valeur d’une plage de 1 à 5 secondes. La valeur
par défaut est de 1 seconde.
Impossible de régler pour [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Règle l’intervalle d’insertion d’image I pour H.264 et H.265 en nombre d’images dans une plage de 15 à 300. La valeur
par défaut est de 300 images.
Impossible de régler pour [Codec 3].
[Profile 1], [Profile 2]
Règle le profil du codec d’image H.264 ou H.265.
[H.264] : sélectionnez le profil [high], [main] ou [baseline].
[H.265] : sélectionnez le profil [main] ou [main10]. Lorsque deux codecs vidéo sont activés, seule l’option de sélection du
profil [main] est disponible.
L’efficacité de la compression d’image augmente dans l’ordre [high], [main] et [baseline]. Sélectionnez un profil pris en
charge par votre système.
Lorsque [H.265] est réglé sur [main10], l’opération est dans [main10] lorsque la sortie HDMI est YCrCb ou dans [main]
lorsque la sortie HDMI est RGB.
Impossible de régler pour [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Sélectionnez [CBR] ou [VBR].
Pour maintenir un débit binaire constant, sélectionnez [CBR]. Pour maintenir une qualité d’image, sélectionnez [VBR].
Impossible de régler pour [Codec 3].

Note

La fréquence d’images et le débit binaire actuellement en diffusion en continu peuvent différer des valeurs réglées, selon la taille
d’image, le contexte de prise de vue, l’environnement réseau et d’autres facteurs.

Lorsque [Stream] > [Stream Setting] > [Setting] est réglé sur [RTMP], [SRT-Caller] ou [SRT-Listener], [Bit Rate Compression
Mode 1] est réglé sur [CBR] (fixe).

[Bit Rate 1], [Bit Rate 2]
Vous pouvez configurer le débit binaire par flux vidéo lorsque [Bit Rate Compression Mode] est réglé sur [CBR]. Régler
un débit binaire élevé vous permet de diffuser en continu une qualité d’image élevée.
Impossible de régler pour [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Règle la qualité d’image dans une plage de 1 à 10. Une valeur de 10 définit la meilleure qualité d’image. La valeur par
défaut est 6.
Pour [Quality 1] et [Quality 2], vous pouvez régler la qualité d’image H.264 en réglant [Bit Rate Compression Mode] sur
[VBR] et [Codec] sur [H.264]. Vous pouvez configurer la qualité d’image H.265 en réglant [Bit Rate Compression Mode]
sur [VBR] et [Codec] sur [H.265].

5-041-957-23(1) Copyright 2022 Sony Corporation
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Réglage du codec audio pour la diffusion en continu

Réglez le codec audio à l’aide de [Stream] > [Audio Stream] dans le menu Web.
[Setting]
Pour activer la diffusion audio en continu, réglez sur On.

Note

Pour sélectionner RTMP, réglez toujours sur On au préalable.

[Codec]
Sélectionne le type de codec à utiliser pour la diffusion audio en continu.
[AAC (256kbps)] : sélectionnez pour privilégier la qualité du son.
[AAC (128kbps)] : sélectionnez pour privilégier la capacité des données.
Ce réglage n’a aucun effet sur le plan enregistré par l’appareil ou sur le signal audio intégré dans le signal de sortie
HDMI/SDI.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Démarrage/Arrêt de la diffusion en continu

Pour [RTSP], [SRT-Listener] et [NDI|HX]

L’appareil attend une demande de diffusion en continu.
Lancez une application client pour visionner la diffusion en continu et accédez à l’URL indiquée dans le tableau suivant.
Saisissez les valeurs pour le nom d’utilisateur et le mot de passe qui sont configurés dans l’appareil.

<Camera_address> : adresse IP de l’appareil
<Port> : port d’écoute configuré à l’aide de [Port Number]

Note

La lecture dans toutes les applications ou dispositifs n’est pas garantie.

Pour [RTMP] et [SRT-Caller]

Appuyez sur la touche [Stream now] sur l’onglet  (Stream) de l’écran d’opération en direct pour démarrer la diffusion
en continu. La touche passe à [Stop stream] et l’icône [Stream] apparaît en haut du panneau d’image de la caméra.
Appuyez sur la touche [Stop stream] pendant la diffusion en continu pour l’arrêter. La touche revient à [Stream now] et
l’icône [Stream] en haut du panneau d’image de la caméra disparaît.

Note

La lecture dans toutes les applications ou dispositifs n’est pas garantie.

5-041-957-23(1) Copyright 2022 Sony Corporation

Format de diffusion en continu URL

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX Consultez le mode d’emploi du dispositif client compatible NDI|HX.
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Ecran de miniatures

Lorsque vous appuyez sur la touche [Thumbnail] sur l’écran d’opération de lecture ou la touche THUMBNAIL sur la
télécommande infrarouge, les plans enregistrés sur la carte mémoire sont affichés dans le panneau d’image de la
caméra. Cet affichage dans le panneau d’image de la caméra est désigné sous le nom d’écran des miniatures.
Vous pouvez sélectionner un plan dans l’écran de miniatures et démarrer la lecture de ce plan.
Appuyez sur la touche [Thumbnail] durant l’affichage de l’écran des miniatures ferme l’écran des miniatures et revient à
l’affichage de l’image de prise de vue.

Note

Seuls les plans enregistrés au format d’enregistrement actuellement sélectionné sont affichés dans l’écran de miniatures. Si un
plan enregistré que vous vous attendiez à voir n’est pas affiché, vérifiez le format d’enregistrement. Gardez ceci à l’esprit avant
de formater (initialiser) le support.

Disposition de l’écran

La miniature d’un plan sélectionné est affichée sur un arrière-plan orange.
Les informations du plan sélectionné sont affichées au bas de l’écran.
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Carte mémoire sélectionnée
Une icône de verrouillage s’affiche si la carte mémoire est protégée en écriture.

1.

Numéro de plan/nombre total de plans2.

Miniature (image d’index)
Affiche l’image d’index d’un plan. Lorsqu’un plan est enregistré, sa première image est automatiquement définie
comme image d’index.
Les informations du plan/de l’image sont affichées sous la miniature. Vous pouvez changer les informations affichées
à l’aide de [Thumbnail] > [Customize View] > [Thumbnail Caption] dans le menu de la caméra.

3.

Nom de plan
Affiche le nom du plan sélectionné.

4.

Format d’enregistrement
Affiche le format de fichier du plan sélectionné.

5.

Informations d’enregistrement spécial
Affiche le mode d’enregistrement uniquement si le plan a été enregistré à l’aide d’un mode d’enregistrement spécial.
Pour les plans en ralenti et accéléré, la fréquence d’images est affichée à droite.

6.

Durée du plan7.

Date de création8.
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Lecture de plans enregistrés

Lorsque l’appareil est en mode de veille d’enregistrement (Stby), vous pouvez lire les plans enregistrés.
Cette rubrique décrit comment lire les plans enregistrés à l’aide du panneau de commande GUI.

Insérez la carte mémoire à lire.1

Appuyez sur la touche [Thumbnail].

Les miniatures des plans apparaissent.

2

Utilisez les touches fléchées dans le panneau de commande GUI pour déplacer le curseur vers la miniature
du plan que vous souhaitez lire.

3
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Note

Il peut y avoir une interruption temporaire de l’image ou une image fixe entre les plans. Vous ne pouvez pas utiliser l’appareil
durant cette période.

Note

Les plans ne peuvent pas être sélectionnés par une opération tactile.

Appuyez sur la touche [Set] dans le panneau de commande GUI.

La lecture commence au début du plan sélectionné.

4

Utilisez le panneau de commande de lecture.

Astuce

Vous pouvez également contrôler l’opération à l’aide du panneau de commande GUI.

Lecture : appuyez sur la touche [Set].
Pause de lecture : appuyez sur la touche [Set] pendant la lecture. Appuyez de nouveau sur la molette pour revenir à la
lecture normale.
Passe au début du plan/du plan suivant : appuyez sur la touche gauche/droite.
Lecture accélérée avant/arrière : appuyez et maintenez enfoncée les touches gauche/droite. La lecture revient à vitesse
normale lorsque vous relâchez la touche.
Arrêt de lecture : appuyez sur la touche [Cancel/Back].

5

Touche Fonction

Touche  (Lecture/Pause) Lit un plan. Pendant la lecture, met en pause le plan.

Touche  (Lecture accélérée avant), Touche
 (Lecture accélérée arrière)

Lit un plan à une vitesse élevée. Lorsque la touche est
enfoncée, la vitesse de lecture change en trois étapes.

Touche  (Précédent), Touche 
(Suivant)

Passe au début du plan ou au plan précédent/suivant.

Touche  (Arrêt)
Permet d’arrêter la lecture et de passer à l’écran de prise de
vue.
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Lorsque vous sélectionnez un plan dans l’écran de miniatures et commencez la lecture, il peut y avoir une déformation
temporaire de l’image au début du plan. Pour voir le début du plan sans déformation, mettez la lecture en pause, appuyez sur la
touche  (Précédent) pour revenir au début du plan, et redémarrez la lecture.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Opérations sur les plans enregistrés

Sur l’écran des miniatures, vous pouvez utiliser des plans ou vérifier les propriétés d’un plan à l’aide du menu
[Thumbnail] dans le menu de la caméra.
Appuyez sur la touche [Menu] sur l’écran d’opération de lecture pour afficher le menu de la caméra dans le panneau
d’image de la caméra.
Vous pouvez effectuer les opérations suivantes à l’aide du menu [Thumbnail] dans le menu de la caméra.

287



Astuce

Vous pouvez également appuyer sur la touche [Menu] sur l’écran d’opération en direct pour afficher le menu de la caméra.

Opérations à l’aide du menu [Thumbnail] dans le menu de la caméra
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Sélectionnez une fonction à utiliser à l’aide des touches fléchées dans le panneau de commande GUI et appuyez sur la
touche [Set].
Appuyez sur la touche [Cancel/Back] pour retourner à l’écran précédent.

Note

Certains éléments ne peuvent pas être sélectionnés, selon l’état lorsque le menu a été affiché.

Éléments de menu destinés aux opérations sur les plans

Le menu [Thumbnail] dans le menu de la caméra comprend les éléments de menu suivants liés aux opérations sur les
plans.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Pour plus de détails sur chaque élément de menu, consultez « Menu [Thumbnail] ».

Pour afficher l’écran de propriétés de plans
Sélectionnez [Thumbnail] > [Display Clip Properties] dans le menu de la caméra pour afficher l’écran de propriétés de
plan.
Appuyez sur la touche  (Précédent) ou la touche  (Suivant) pour passer au plan précédent/suivant.

Pour ajouter des balises de plan
Vous pouvez ajouter des balises (repères OK, NG ou KP) aux plans pour filtrer l’affichage des plans en fonction des
balises.
Sélectionnez la miniature du plan auquel vous souhaitez ajouter la balise de plan, puis sélectionnez la balise de plan
[Thumbnail] > [Set Clip Flag] dans le menu de la caméra.

Astuce

Vous pouvez également utiliser une touche personnalisable à laquelle la fonction de balise de plan est attribuée pour ajouter des
balises de plan.

Pour afficher l’écran des miniatures de plan filtré
Sélectionnez [Thumbnail] > [Filter Clips] dans le menu de la caméra et sélectionnez un type de balise de plan pour
afficher uniquement les plans qui possèdent la balise spécifiée.
Pour afficher tous les plans, sélectionnez [All].
Vous pouvez également appuyer sur la touche [Display] pour trier l’affichage des miniatures selon les balises.

Pour supprimer des plans
Vous pouvez supprimer des plans de cartes mémoire.
Sélectionnez [Thumbnail] > [Delete Clip] > [Select Clip] ou [All Clips] dans le menu de la caméra.

Réglage Balise de plan ajoutée

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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[Select Clip] : supprime le plan sélectionné. Il est possible de sélectionner plusieurs plans.
[All Clips] : supprime tous les plans affichés.

Pour modifier des informations affichées sur l’écran des miniatures
Vous pouvez modifier les informations de plans/images affichées sous la miniature.
Sélectionnez [Thumbnail] > [Customize View] > [Thumbnail Caption] dans le menu de la caméra et sélectionnez les
informations à afficher.
[Date Time] : affiche la date et l’heure à laquelle le plan a été créé et modifié pour la dernière fois.
[Time Code] : affiche le code temporel.
[Duration] : affiche la durée du plan.
[Sequential Number] : affiche un numéro séquentiel sur chaque miniature.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Configuration du menu de la caméra

Lorsque vous appuyez sur la touche [Menu] dans le panneau de commande GUI ou la touche MENU sur la
télécommande infrarouge, le menu de la caméra pour configurer les réglages requis pour la prise de vue et la lecture est
affiché sur le panneau d’image de la caméra.

Le menu se compose des menus suivants.

Configuration du menu

Menu [User]
Contient des éléments de menu configurés par l’utilisateur.
Peut être modifié à l’aide de [Edit User Menu].
Menu [Edit User]
Contient des éléments de menu pour modifier le menu [User].
Menu [Shooting]
Contient des réglages liés à la prise de vue.
Menu [Project]
Contient des réglages de base du projet.
Menu [Paint/Look]
Contient des réglages liés à la qualité d’image.
Menu [Pan-Tilt]
Contient les réglages liés au panoramique/inclinaison.
Menu [TC/Media]
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Contient des réglages liés aux codes temporels et au support d’enregistrement.
Menu [Monitoring]
Contient des réglages liés à la sortie vidéo et à l’affichage de l’écran.
Menu [Audio]
Contient des réglages liés à l’audio.
Menu [Thumbnail]
Contient des réglages liés à l’affichage de miniatures.
Menu [Technical]
Contient des réglages liés aux éléments techniques.
Menu [Network]
Contient des réglages liés aux réseaux.
Menu [Maintenance]
Contient des réglages liés aux appareils, par exemple l’horloge et la langue.

Configuration et hiérarchie du menu de la caméra

Niveau 1 Niveau 2

User
(Réglages par défaut)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Niveau 1 Niveau 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix
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Niveau 1 Niveau 2

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR
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Niveau 1 Niveau 2

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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Fonctionnement du menu de la caméra

Lorsque vous appuyez sur la touche [Menu] dans le panneau de commande GUI ou la touche MENU sur la
télécommande infrarouge, le menu de la caméra pour configurer les réglages requis pour la prise de vue et la lecture est
affiché sur le panneau d’image de la caméra.
Ce menu fonctionne à l’aide des touches dans le panneau de commande GUI.

Touche [Menu] : appuyez pour afficher le menu de la caméra. Appuyez à nouveau lorsque le menu de la caméra est
affiché pour le masquer.
Touches fléchées : appuyez sur les touches fléchées pour déplacer le curseur vers le haut/bas/la gauche/droite dans le
menu de la caméra pour sélectionner des éléments ou des réglages de menu.
Touche [Set] : appuyez pour appliquer l’élément sélectionné.
Touche [Cancel/Back] : appuyez pour revenir au menu précédent. Toute modification incomplète est annulée.

Note

Certains éléments ne peuvent pas être sélectionnés, selon l’état lorsque le menu a été affiché.

Réglage d’éléments de menu

Déplacez le curseur sur l’élément que vous souhaitez régler à l’aide des touches fléchées dans le panneau de
commande GUI et appuyez sur la touche [Set] pour appliquer les réglages.

La zone de sélection d’élément de menu affiche jusqu’à huit lignes. Si les options disponibles pour un élément ne
peuvent pas être affichées en même temps, faites défiler l’affichage en déplaçant le curseur vers le haut/bas.
Pour les sous-éléments avec une grande plage de réglages (par exemple −99 à +99), la zone des réglages n’est pas
affichée. Le paramètre actuel est mis en surbrillance pour indiquer que la valeur peut être changée.
Le fait de sélectionner [Execute] pour une fonction permet d’exécuter la fonction correspondante.
Le fait de sélectionner un élément qui nécessite confirmation avant exécution cache temporairement le menu et
affiche un message de confirmation. Vérifiez le message, puis sélectionnez l’exécution ou l’annulation de la fonction.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Saisie d’une chaîne de caractères

Quand vous sélectionnez un élément, tel qu’un nom de fichier, qui exige la saisie de caractères, l’écran de saisie de
caractères s’affiche.

5-041-957-23(1) Copyright 2022 Sony Corporation

Appuyez sur les touches fléchées dans le panneau de commande GUI pour sélectionner le type de
caractère et appliquer le réglage.

[ABC] : lettres majuscules
[abc] : lettres minuscules
[123] : caractères numériques
[!#$] : caractères spéciaux

1

Sélectionnez un caractère et appuyez sur la touche [Set] pour appliquer le réglage.

Le curseur passe au champ suivant.
[Space] : saisit une espace au niveau du curseur.
[←] [→] : permet de déplacer la position du curseur.
[BS] :permet de supprimer le caractère à gauche du curseur (espacement arrière).

2

Lorsque vous avez terminé, appuyez sur la touche [Done] pour appliquer le réglage.

La chaîne de caractères est confirmée et l’écran de saisie de caractères disparaît.

3
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User

Cette rubrique décrit la fonction et les réglages des éléments de chaque menu.

Note

Vous pouvez ajouter et supprimer des éléments de menu dans le menu [User] à l’aide du menu [Edit User]. Jusqu’à 20 éléments
peuvent être configurés.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Description

Base Setting Élément Project > Base Setting

Focus Élément Shooting > Focus

S&Q Motion Élément Shooting > S&Q Motion

LUT On/Off Élément Shooting > LUT On/Off

Simul Rec Élément Project > Simul Rec

Proxy Rec Élément Project > Proxy Rec

Interval Rec Élément Project > Interval Rec

Picture Cache Rec Élément Project > Picture Cache Rec

Assignable Button Élément Project > Assignable Button

Scene File Élément Project > Scene File

Base Look Élément Paint/Look > Base Look

P/T Acceleration Élément Pan-Tilt > P/T Acceleration

Clip Name Format Élément TC/Media > Clip Name Format

Format Media Élément TC/Media > Format Media

Video Signal Monitor Élément Monitoring > Video Signal Monitor

Marker Élément Monitoring > Marker

Zoom Élément Technical > Zoom

Lens Élément Technical > Lens

Edit User Menu Affiche le menu Edit User.
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Edit User

Le menu [Edit User] est affiché au niveau supérieur quand [Edit User Menu] est sélectionné dans le menu [User].

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de
sous-éléments

Réglage
par défaut Description

Add Item
Ajouter un élément au menu
[User]

– –
Ajoute un élément de menu de niveau 2 au menu
[User].

Customize Reset
Réinitialiser les éléments dans
le menu [User]

– –
Restaure les éléments de menu enregistré dans le
menu [User] aux réglages par défaut.

Élément de menu de niveau
2 sélectionné pendant la
modification

Delete –
Supprime l’élément de menu de niveau
2 enregistré du menu [User].

Move –
Réorganise les éléments de menu enregistrés du
menu [User].

Edit Sub Item –
Modifie (enregistrer/supprimer) les sous-éléments
de menu de niveau 3 enregistrés dans le menu
[User].
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ISO/Gain/EI

Définit les réglages de gain.

Élément Réglage de sous-éléments Réglage par défaut Description

Mode ISO/dB dB
Sélectionne le mode de
réglage du gain.

ISO/Gain<L>

Pour plus de détails sur les réglages,
consultez « Réglages et valeurs par
défaut d’ISO/Gain ».

– Règle la valeur prédéfinie de
gain <L>.

Exposure
Index<L>

Lorsque Base ISO est réglé sur ISO
800 :
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Lorsque Base ISO est réglé sur ISO
12800 :
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Lorsque Base ISO est
réglé sur ISO 800 :
800EI / 6.0E
Lorsque Base ISO est
réglé sur ISO 12800 :
12800EI / 6.0E

Définit la valeur de Exposure
Index<L>.

Shockless
Gain

On / Off Off
Active/désactive la fonction
Shockless gain.

Base
Sensitivity

High / Low Low
Règle la sensibilité de base
pour le mode Custom.
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Réglages et valeurs par défaut d’ISO/Gain
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Élément Réglage de sous-éléments Réglage par défaut Description

Base ISO ISO 12800 / ISO 800 ISO 800
Règle la sensibilité ISO de
base pour le mode Cine
EI/Flexible ISO.
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ND Filter

Règle les valeurs prédéfinies pour le filtre ND.
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Élément Réglage de sous-éléments Réglage par défaut Description

Mode Preset / Variable Variable Sélectionne le mode filtre ND.

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/4 Règle la valeur prédéfinie 1 pour le filtre ND.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/16 Règle la valeur prédéfinie 2 pour le filtre ND.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/64 Règle la valeur prédéfinie 3 pour le filtre ND.
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Shutter

Règle le fonctionnement de l’obturateur électronique.
Utilisé pour filmer de manière nette des sujets se déplaçant rapidement.

Élément Réglage de sous-éléments Réglage par
défaut Description

Mode Speed / Angle Speed

Permet de sélectionner le mode
pour régler la vitesse d’obturateur
en secondes (Speed) ou comme
un angle d’obturateur (Angle).

Shutter
Speed
On/Off

On / Off Off

Définit si, lorsque le mode Speed
est sélectionné, la durée
d’exposition suit la valeur de
[Shutter Speed] ou est réglée pour
l’exposition totale.

Shutter
Speed

64F à 1/8000
Les réglages disponibles varient en fonction de
la fréquence d’images du format vidéo
sélectionné.
59.94P : 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
50P : 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F
/ 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
29.97P : 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
25P : 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F
/ 2F / 1/25 / 1/33 / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
24P/23.98P : 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 1/60 /
1/96 / 1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000

59.94P :
1/60
50P : 1/50
29.97P : 1/30
25P : 1/25
24P/23.98P :
1/24

Règle la vitesse d’obturateur
lorsque le mode Speed est
sélectionné.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 2F /
360.0° / 300.0° / 270.0° / 240.0° / 216.0° /
210.0° / 180.0° / 172.8° / 150.0° / 144.0° /
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 30.0° /
22.5° / 11.25° / 5.6°

180.0°
Règle l’angle d’obturateur lorsque
le mode Angle est sélectionné.

ECS On/Off On / Off Off
Permet d’activer/de désactiver la
fonction d’atténuation de balayage
étendue.
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Élément Réglage de sous-éléments Réglage par
défaut Description

ECS
Frequency

23.99 à 8000
Les réglages disponibles varient en fonction de
la fréquence d’images du format
d’enregistrement sélectionné.

59.94P :
60.00
50P : 50.00
29.97P :
30.00
23.98P :
23.99
25P : 25.02
24P : 24.02

Règle la fréquence d’ECS quand
Mode est réglé sur ECS.
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Iris

Définit les réglages du diaphragme.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

Bokeh
Control

On / Off Off
Active/désactive la fonction de contrôle du
bokeh.
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Auto Exposure

Définit les réglages d’ajustement de l’exposition automatique.

Élément Réglage de sous-éléments Réglage
par défaut Description

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 /
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 /
±0 / −0.25 / −0.5 / −0.75 / −1.0 / −1.25 /
−1.5 / −1.75 / −2.0 / −2.25 / −2.5 / −2.75 /
−3.0

±0
Règle le niveau de luminosité pour
l’exposition détectée de manière
automatique.

Mode Backlight / Standard / Spotlight Standard

Règle le mode de fonctionnement du
réglage d’exposition automatique.
Backlight : mode Backlight (mode qui
atténue l’obscurité d’un sujet lorsque le sujet
est rétroéclairé)
Standard : mode Standard
Spotlight : mode Spotlight (mode qui
atténue les blancs écrêtés lorsque le sujet
est éclairé par la lumière d’un spot)

Speed −99 à +99 ±0
Règle la vitesse de réglage du réglage
d’exposition automatique.

AGC On / Off Off
Active/désactive la fonction AGC
(commande de gain automatique).

AGC Limit

Pour plus de détails sur les réglages,
consultez « Réglages et valeurs par
défaut de AGC Limit ».

– Règle le gain maximum de la fonction AGC.

AGC Point F2.8 / F4 / F5.6 F2.8

Règle la valeur F-stop du diaphragme là où
démarre l’opération de commande de gain
automatique lorsque la fonction AGC est
réglée sur On.

Auto
Shutter

On / Off Off
Active/désactive la fonction de commande
d’obturateur automatique.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Règle la vitesse d’obturateur la plus rapide
de la fonction d’obturateur automatique.

A.SHT Point F5.6 / F8 / F11 / F16 F11
Règle la valeur F-stop du diaphragme là où
démarre l’opération de commande
d’obturateur automatique.

Clip High
light

On / Off Off

Active/désactive la fonction qui ignore les
zones les plus lumineuses pour fournir une
réponse plus plate avec une luminance
élevée.
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Élément Réglage de sous-éléments Réglage
par défaut Description

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Règle la plage d’intégrateur de lumière pour
l’ajustement automatique de l’exposition en
fonction de la luminosité du sujet. (Non
disponible en cas de réglage manuel de la
pose)

Detect
Window
Indication

On / Off Off
Active/désactive l’indication de la plage
d’intégrateur de lumière.

Custom
Width

40 à 999 500
Permet de régler la largeur de la plage
d’intégrateur de lumière.

Custom
Height

70 à 999 500
Permet de régler la hauteur de la plage
d’intégrateur de lumière.

Custom H
Position

−479 à +479 ±0
Permet de régler la position horizontale de la
plage d’intégrateur de lumière.

Custom V
Position

−464 à +464 ±0 Permet de régler la position verticale de la
plage d’intégrateur de lumière.
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White

Définit les réglages de la balance des blancs.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de
sous-éléments

Réglage par
défaut Description

Preset
White

2000K à
15000K

3200K Règle la valeur prédéfinie de la balance des blancs.

Color
Temp <A>

2000K à
15000K

3200K

Règle la température de couleur de la balance des blancs stockée
dans la mémoire A.

Note

Comme Color Temp est écrêté à 2000K et 15000K pendant l’opération
R Gain/B Gain, il n’est pas possible d’afficher la valeur correcte de
Color Temp pour la valeur R Gain/B Gain.

Tint<A> −99 à +99 ±0

Permet de régler la valeur de teinte de la balance des blancs stockée
dans la mémoire des blancs A.

Note

Comme Tint est écrêté à ±99 pendant l’opération R Gain/B Gain, il
n’est pas possible d’afficher la valeur correcte de teinte pour la valeur
R Gain/B Gain.

R Gain
<A>

−99.0 à +99.0 ±0.0
Règle la valeur de gain R de la balance des blancs stockée dans la
mémoire A.

B Gain
<A>

−99.0 à +99.0 ±0.0
Règle la valeur de gain B de la balance des blancs stockée dans la
mémoire A.
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White Setting

Ajuste les réglages de la balance des blancs.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

Shockless
White

Off / 1 / 2 / 3 2

Règle la vitesse de réaction de la balance des blancs en cas de
commutation du mode de balance des blancs.
Off : commute instantanément.
1 à 3 : plus la valeur est élevée, plus la commutation est lente.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Règle la vitesse de réaction en mode ATW.
La vitesse de réaction la plus rapide est 1, la vitesse de
réaction la plus lente est 5.
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Offset White

Définit les réglages de correction de la balance des blancs.
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Élément Réglage de
sous-éléments

Réglage par
défaut Description

Offset White <A> On / Off Off
Permet de choisir d’ajouter (On) ou non (Off) une valeur de
décalage à la balance des blancs dans la mémoire A.

Offset Color
Temp<A>

−99 à +99 ±0
Règle la correction de température de couleur à ajouter à la
balance des blancs dans la mémoire A quand [Offset White
<A>] est réglé sur On.

Offset Tint<A> −99 à +99 ±0
Règle la correction de valeur Tint à ajouter à la balance des
blancs dans la mémoire A quand [Offset White <A>] est réglé
sur On.

Offset
White<ATW>

On / Off On
Permet de choisir d’ajouter (On) ou de ne pas ajouter (Off) une
valeur de correction à la balance des blancs ATW.

Offset Color
Temp<ATW>

−99 à +99 ±0
Règle la correction de température de couleur à ajouter à la
balance des blancs ATW quand [Offset White<ATW>] est réglé
sur On.

Offset Tint<ATW> −99 à +99 ±0 Règle la correction de valeur Tint à ajouter à la balance des
blancs ATW quand [Offset White<ATW>] est réglé sur On.
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Focus

Définit les réglages de mise au point.

Élément Réglage de sous-
éléments

Réglage par
défaut Description

AF
Transition
Speed

1(Slow) / 2 / 3 / 4 /
5 / 6 / 7(Fast)

5
Permet de régler la vitesse d’entraînement de la mise au point
pour le changement de sujet lors de la mise au point
automatique.

AF Subj.
Shift Sens.

1(Locked On) / 2 /
3 / 4 /
5(Responsive)

5(Responsive)
Permet de régler la sensibilité de la mise au point en cas de
changement de sujet pendant la mise au point automatique.

Focus Area
Wide / Zone /
Flexible Spot

Wide

Règle la zone cible pour la mise au point automatique et la
mise au point automatique par pression (AF).

Consultez « Réglage automatique de la mise au point
(Auto Focus) » et « Réglage de la zone/position de mise
au point automatique (zone de mise au point) ».

Wide : recherche un sujet dans un grand angle de l’image lors
de la mise au point.
Zone : recherche automatiquement un point de mise au point
dans la zone spécifiée.
Flexible Spot : effectue la mise au point sur une position
spécifique dans l’image.

Focus Area
(AF-S)

Flexible Spot Flexible Spot
Règle la zone cible pour la mise au point automatique par
pression (AF-S).

Face/Eye
Detection
AF

Face/Eye Only AF /
Face/Eye Priority
AF / Off

Face/Eye
Priority AF

Active/désactive la détection des visages AF.

Consultez « Suivi à l’aide de la détection des visages/yeux
(Face/Eye Detection AF) ».

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Règle le mode de mise au point automatique par pression.

Touch
Function in
MF

Tracking AF / Spot
Focus

Tracking AF
Définit l’opération lorsque l’image de la caméra est touchée
sur l’écran d’opération en direct de l’application Web en mode
MF.

AF Assist On / Off On

Lors d’un réglage sur On, il est possible d’écraser
temporairement la mise au point automatique et d’effectuer la
mise au point manuellement.

Consultez « Réglage manuel de la cible de mise au point
automatique (AF Assist) à l’aide de l’application Web » et
« Mise au point manuelle pendant la mise au point
automatique à l’aide de la télécommande infrarouge
fournie. »
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Réglage de la zone/position de mise au point automatique (zone de mise au point)

Suivi à l’aide de la détection des visages/yeux (Face/Eye Detection AF)

Réglage manuel de la cible de mise au point automatique (AF Assist) à l’aide de l’application Web

Mise au point manuelle pendant la mise au point automatique à l’aide de la télécommande infrarouge fournie

5-041-957-23(1) Copyright 2022 Sony Corporation

312



Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

S&Q Motion

Définit les réglages du mode Slow & Quick Motion (consultez « Ralenti et accéléré »).

Rubrique associée
Ralenti et accéléré
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Élément Réglage de sous-éléments Réglage par
défaut Description

Setting On / Off Off
Active/désactive le mode d’enregistrement ralenti et
accéléré.

Frame
Rate

1fps à 60fps / 100fps / 120fps /
150fps / 180fps / 200fps /
240fps

–

Règle la fréquence d’images pour la prise de vue au
ralenti et accéléré.

Note

Les réglages disponibles varient en fonction de la
fréquence du système, du codec et du format vidéo
sélectionnés.
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LUT On/Off

Définit les réglages LUT.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

SDI MLUT On / MLUT Off MLUT Off
Sélectionne si appliquer ou non Monitor LUT à la
sortie vidéo SDI.

HDMI/Stream MLUT On / MLUT Off MLUT Off
Sélectionne si appliquer ou non Monitor LUT à la
sortie vidéo HDMI et de diffusion en continu.

Proxy MLUT On / MLUT Off MLUT Off
Sélectionne si appliquer ou non Monitor LUT à la
vidéo d’enregistrement proxy.

Internal Rec MLUT On / MLUT Off MLUT Off
Sélectionne si appliquer ou non Monitor LUT à la
vidéo d’enregistrement principal.

LUT On/Off
Button Target

SDI / HDMI/Stream /
SDI & HDMI/Stream

HDMI/Stream
Sélectionne la sortie de la cible contrôlée par une
touche personnalisable à laquelle est attribué LUT
On/Off.
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Noise Suppression

Définit les réglages de suppression de bruit.

Astuce

Les réglages [Setting(Custom)] et [Level(Custom)] sont reflétés dans le réglage [Target Display].
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

Setting(Custom) On / Off On
Active/désactive la fonction de suppression de bruit
en mode Custom.

Level(Custom) Low / Mid / High Mid
Permet de régler le niveau de suppression de bruit
en mode Custom.

Setting (Cine EI/Flex.
ISO)

On / Off Off
Active/désactive la fonction de suppression de bruit
en modes de prise de vue Log.

Level (Cine EI/Flex.
ISO)

Low / Mid / High Mid
Règle le niveau de suppression de bruit en modes de
prise de vue Log.
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Flicker Reduce

Définit les réglages de correction de scintillement.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Mode Auto / On / Off Off Règle le mode de correction de scintillement.

Frequency 50Hz / 60Hz 60Hz
Règle la fréquence de la source d’alimentation qui fournit
l’éclairage qui cause le scintillement.
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SteadyShot

Définit les réglages de stabilisation d’image.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de
sous-éléments

Réglage par
défaut Description

Setting
Active / Standard
/ Off

Off

Règle la fonction de stabilisation d’image.

Note

Activé lorsqu’un objectif compatible est fixé.

Lors d’un réglage sur Active ou Standard, un comportement inattendu
peut se produire pendant l’opération de panoramique/inclinaison.
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Base Setting

Définit les réglages de base.

Rubrique associée

Configuration des opérations de base

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Shooting
Mode

Custom / Flexible ISO /
Cine EI Quick / Cine EI

Custom

Règle le mode de prise de vue.

Consultez « Réglage du mode de prise de vue »
dans « Configuration des opérations de base ».

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Règle la gamme de couleurs de l’enregistrement/la
sortie en mode Custom.
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Rec Format

Définit les réglages du format d’enregistrement.

Réglages [RAW Output Format]

Les valeurs par défaut sont affichées en gras.
Les conditions dans lesquelles le réglage [RAW Output Format] ne peut pas être défini ont été omises.

Réglages [Video Format]

Élément Réglage de sous-éléments Réglage
par défaut Description

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 Sélectionne la fréquence du système.

Imager Scan
Mode

FF / S35 FF Sélectionne la taille de l’imageur.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Règle le codec d’enregistrement/de lecture de
plan.

Note

Lorsque [Imager Scan Mode] est réglé sur
[S35], [RAW] et [RAW & XAVC-I] ne peuvent
pas être sélectionnés.

RAW Output
Format

Les réglages disponibles varient en
fonction du réglage [Frequency].

Consultez « Réglages [RAW
Output Format] » ci-dessous.

–

Définit la taille de l’image RAW à émettre vers
un enregistreur RAW externe.

Note

Lorsque [Codec] est réglé sur [RAW & XAVC-
I], le réglage [Video Format] change en lien
avec le réglage [RAW Output Format].

Video
Format

Les réglages disponibles varient
selon les réglages [Frequency],
[Imager Scan Mode] et [Codec].

Consultez « Réglages [Video
Format] » ci-dessous.

– Règle la taille de l’image et le débit binaire.

Frequency Imager Scan Mode Codec Réglage

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Les valeurs par défaut sont affichées en gras.

5-041-957-23(1) Copyright 2022 Sony Corporation

Frequency Imager Scan Mode Codec Réglage

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Cine EI/Flex.ISO Set

Définit les modes de prise de vue Log (consultez « Réglage du mode de prise de vue » dans « Configuration des
opérations de base »).

Rubrique associée

Configuration des opérations de base

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments Réglage par défaut Description

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

Règle la gamme de couleurs pour les modes de
prise de vue Log ([Flexible ISO], [Cine EI Quick],
[Cine EI]).

Embed
LUT File

On / Off On
Active/désactive l’enregistrement des
métadonnées du fichier 3D LUT (fichier CUBE).
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Simul Rec

Définit les réglages du mode d’enregistrement simultané sur 2 fentes (consultez « Enregistrement simultané sur les
cartes mémoire A et B (2-slot Simul Rec) »).

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-éléments Réglage par défaut Description

Setting On / Off Off
Active/désactive la fonction
d’enregistrement simultané sur
2 fentes.

Rec
Button
Set

Rec Button : <Slot A> <Slot B> 2nd Rec
Button : <Slot A> <Slot B> / Rec Button :
<Slot A> 2nd Rec Button : <Slot B> / Rec
Button : <Slot B> 2nd Rec Button : <Slot A>

Rec Button : <Slot A>
<Slot B> 2nd Rec
Button : <Slot A>
<Slot B>

Assigne les touches
d’enregistrement utilisées pour
contrôler chaque support
d’enregistrement.
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Proxy Rec

Définit les réglages du mode d’enregistrement proxy (consultez « Enregistrement du proxy »).

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Setting On / Off Off Active/désactive le mode d’enregistrement proxy.

Audio
Channel

CH1/CH2 / CH3/CH4 CH1/CH2
Sélectionne le canal audio pour enregistrer les
données proxy.
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Interval Rec

Définit les réglages du mode d’enregistrement à intervalle (consultez « Enregistrement de la vidéo par intermittence
(Interval Rec) »).

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-éléments Réglage par défaut Description

Setting On / Off Off

Active/désactive le mode
d’enregistrement à intervalle. (Le
réglage de ce mode sur On met
tous les autres modes spéciaux sur
Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (sec)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (heure)

1

Définit l’intervalle entre les
enregistrements en mode
d’enregistrement Interval Rec
(lorsque Interval Rec est réglé sur
On).

Number
of Frames

1frame / 2frames / 3frames / 6frames
/ 9frames / 12frames
Les réglages disponibles varient en
fonction de la fréquence d’images du
format vidéo sélectionné.
59.94P/50P : 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P : 1frame /
3frames / 6frames / 9frames

59.94P/50P : 2frames
29.97P/25P/24P/23.98P :
1frame

Définit le nombre d’images à
enregistrer par prise en mode
d’enregistrement Interval Rec
(lorsque Interval Rec est réglé sur
On).
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Picture Cache Rec

Définit les réglages du mode d’enregistrement de cache d’image (consultez « Enregistrement d’images en cache (Picture
Cache Rec) »).

Rubrique associée

Enregistrement d’images en cache (Picture Cache Rec)

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de
sous-éléments

Réglage par
défaut Description

Setting On / Off Off Active/désactive la fonction de cache d’image.

Cache Size
Short / Medium /
Long / Max

Max
Règle le temps pour l’accumulation d’images dans la mémoire de
cache d’image (temps d’enregistrement de cache d’image).

Cache Rec
Time

– –
Affiche le temps pour l’accumulation d’images dans la mémoire de
cache d’image (temps d’enregistrement de cache d’image).
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SDI/HDMI Rec Control

Définit les réglages de contrôle d’enregistrement SDI/HDMI.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de
sous-éléments

Réglage
par défaut Description

Setting
Off / SDI/HDMI
Remote I/F /
Parallel Rec

Off

Définit le contrôle de démarrage/d’arrêt d’enregistrement d’un dispositif
externe connecté via le signal de sortie SDI/HDMI.
Off : ne pas utiliser la télécommande.
SDI/HDMI Remote I/F : contrôle d’arrêt/de démarrage d’enregistrement
d’un dispositif externe connecté, quand aucun support n’est inséré dans
l’appareil. Pas de synchronisation avec la précision d’images pour le
support de l’appareil.
Parallel Rec : contrôle d’arrêt/de démarrage d’enregistrement d’un
dispositif externe connecté, quand un support est inséré dans l’appareil.
Synchronisation avec la précision d’images pour le support de l’appareil.

Note

Pour le contrôle à l’aide du signal de sortie HDMI, réglez [TC/Media] >
[HDMI TC Out] > [Setting] sur [On] dans le menu de la caméra.
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Assignable Button

Règle les attributions de fonction des touches personnalisables (<1> à <9>) et [Focus Hold Button].
Les fonctions suivantes peuvent être attribuées.
[Off] : aucune attribution de fonction.
[Base ISO/Sensitivity] : commute la sensibilité de base du capteur d’image.
[AGC] : active/désactive la fonction AGC.
[Push AGC] : active la fonction AGC tant que la touche est enfoncée.
[ND Filter]

En mode variable : règle la transmittance du filtre ND. Appuyez et maintenez enfoncé pour commuter entre
Clear/Manual/Auto.
En mode prédéfini : appuyer et maintenir enfoncé pour commuter le préréglage.

[ND Filter Position] : commute les filtres ND.
[Auto ND Filter] : active/désactive la fonction de filtre ND automatique.
[Push Auto ND] : active la fonction de filtre ND automatique tant que la touche est enfoncée.
[Auto Iris] : active/désactive la fonction de diaphragme.
[Push Auto Iris] : active la fonction de diaphragme automatique tant que la touche est enfoncée.
[Bokeh Control] : active/désactive la mode de contrôle du bokeh.
[Auto Shutter] : active/désactive la fonction d’obturation automatique.
[AE Level/Mode] : ajuste le niveau AE. Maintenir enfoncé pour changer de mode AE.
[Backlight] : commute entre Backlight et Standard.
[Spotlight] : commute entre Spotlight et Standard.
[Preset White Select] : commute la valeur de mode prédéfinie de la balance des blancs.
[ATW] : active/désactive la fonction ATW.
[ATW Hold] : met la fonction ATW en pause.
[AF Speed/Sens.] : commute le réglage de la vitesse de transition AF et le réglage de la sensibilité de changement de
sujet AF.
[Focus Setting] : règle la zone de mise au point.
[Face/Eye Detection AF] : commute les réglages de l’AF de détection des visages/yeux.
[Push AF Mode] : change le réglage du mode Push AF.
[Push AF/MF] : en mode de mise au point MF, active AF tant que la touche est enfoncée. En mode de mise au point AF,
active MF tant que la touche est enfoncée.
[Focus Hold] : en mode de mise au point AF, la mise au point est fixée tant que la touche est enfoncée.
[S&Q Motion] : active/désactive la fonction d’enregistrement ralenti et accéléré. Règle la fréquence d’images de prise de
vue si elle est maintenue enfoncée.
[LUT On/Off] : active/désactive la fonction LUT. La cible de commutation est réglée à l’aide de [Shooting] > [LUT On/Off]
> [LUT On/Off Button Target].
[SteadyShot] : commute entre Active, Standard, et Off.
[Crop Select] : commute Imager Scan Mode. La commutation est activée dans la plage sans changer le format
d’enregistrement.
[Rec] : démarre/arrête l’enregistrement.
[Picture Cache Rec] : active/désactive le mode d’enregistrement de cache d’image.
[Rec Review] : active/désactive la fonction du passage en revue de l’enregistrement.
[Clip Flag OK] : exécute Add OK. Appuyez deux fois pour exécuter Delete Clip Flag.
[Clip Flag NG] : exécute Add NG. Appuyez deux fois pour exécuter Delete Clip Flag.
[Clip Flag Keep] : exécute Add KEEP. Appuyez deux fois pour exécuter Delete Clip Flag.
[Slot Select] : commute entre les logements de mémoire (A) et (B).
[Color Bars] : active/désactive les barres de couleur.
[DURATION/TC/U-BIT] : commute entre Time Code, Users Bit, et Duration.
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[Display] : active/désactive les indicateurs de l’écran.
[Lens Info] : commute l’indicateur de profondeur de champ.
[Video Signal Monitor] : commute le moniteur de signal vidéo (tel que le moniteur de forme d’onde).
[Marker] : active/désactive la fonction de repère.
[Thumbnail] : affiche/quitte l’écran des miniatures.
[Auto Upload (Proxy)] : active/désactive le transfert automatique de fichiers proxy.
[Direct Menu] : affiche/quitte le menu direct.
[User Menu] : affiche/quitte le menu User.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Scene File

Définit les réglages liés aux fichiers de scène (consultez « Prise de vue avec l’apparence souhaitée (Look) »).

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-éléments Réglage
par défaut Description

Recall – –

Charge un fichier de scène stocké dans la
mémoire interne et applique les réglages
en tant que réglages de qualité d’image
actuels.

Store – –
Enregistre l’état de qualité d’image actuel
sous forme de fichier de scène dans la
mémoire interne.

Delete – –
Supprime un fichier de scène stocké dans
la mémoire interne.

Preset
Recall

Lorsque Shooting Mode est réglé sur
Custom et Target Display est réglé sur
SDR(BT.709) : S-Cinetone / Standard / Still /
ITU709 / 709tone
Lorsque Shooting Mode est réglé sur
Custom et Target Display est réglé sur
HDR(HLG) : HLG Live / HLG Natural

–
Applique les réglages de qualité d’image
prédéfinis (non réinscriptibles) en tant que
réglages de qualité d’image actuels.
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Base Look

Définit les réglages liés à l’apparence de base.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-éléments Réglage par défaut Description

Select

Lorsque Shooting Mode est réglé sur
Custom et Target Display est réglé sur
SDR(BT.709) : S-Cinetone / Standard /
Still / ITU709 / 709tone / User1 à User16
Lorsque Shooting Mode est réglé sur
Custom et Target Display est réglé sur
HDR(HLG) : HLG Live / HLG Natural /
User1 à User16
Lorsque Shooting Mode est réglé sur
les modes de prise de vue Log : s709 /
709(800) / S-Log3 / User1 à User16

Lorsque Shooting Mode est
réglé sur Custom et Target
Display est réglé sur
SDR(BT.709) : S-Cinetone
Lorsque Shooting Mode est
réglé sur Custom et Target
Display est réglé sur
HDR(HLG) : HLG Live
Lorsque Shooting Mode est
réglé sur les modes de prise
de vue Log : s709

Permet de sélectionner
une apparence de base.

Delete – –
Supprime l’apparence de
base sélectionnée.

Delete All – –
Supprime toutes les
apparences de base.

Input
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3

Définit la gamme d’entrée
de l’apparence de base
sélectionnée à l’aide de
[Select].

Output BT.709 / HLG BT.709

Définit la gamme de
couleurs de sortie de
l’apparence de base
sélectionnée à l’aide de
[Select].

AE Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /
5/3EV / 2EV

0EV

Définit la valeur de
référence d’exposition de
l’apparence de base
sélectionnée à l’aide de
[Select].

330



Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Reset Paint Settings

Réinitialise les réglages du menu [Paint/Look], à l’exclusion de l’apparence de base.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Reset without
Base Look

Execute / Cancel –
Réinitialise les réglages du menu [Paint/Look], à
l’exclusion de l’apparence de base.
Execute : exécute la fonction.
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Black

Définit les réglages des noirs.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-éléments Réglage par défaut Description

Master Black −99.0 à +99.0 ±0.0 Règle le niveau de noir maître.

R Black −99.0 à +99.0 ±0.0 Règle le niveau de noir R.

B Black −99.0 à +99.0 ±0.0 Règle le niveau de noir B.
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Knee

Définit les réglages de correction de courbe.
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Élément Réglage de sous-éléments Réglage par défaut Description

Setting

Lorsque Target Display
est réglé sur
SDR(BT.709) : On / Off / ---
Lorsque Target Display
est réglé sur HDR(HLG) :
On / Off / ---

Lorsque Target Display est
réglé sur SDR(BT.709) : Off
Lorsque Target Display est
réglé sur HDR(HLG) : Off

Active/désactive la fonction de correction de
courbe.

Note

Activé uniquement lorsque [Base Look] >
[Select] est réglé sur [Standard],
[ITU709], [709tone], [HLG Live] ou [HLG
Natural].

Auto
Knee

Lorsque Target Display
est réglé sur
SDR(BT.709) : On / Off / ---
Lorsque Target Display
est réglé sur HDR(HLG) :
On / Off / ---

Lorsque Target Display est
réglé sur SDR(BT.709) : On
Lorsque Target Display est
réglé sur HDR(HLG) : Off

Active/désactive la fonction de coude
automatique.

Note

Activé uniquement lorsque [Base Look] >
[Select] est réglé sur [Standard], [ITU709]
ou [709tone].

Point 75% à 109% 90% Règle le point de courbe.

Slope −99 à +99 ±0 Règle la pente de courbe.
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Detail

Définit les réglages d’ajustement des détails.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage
par défaut Description

Setting On / Off On Active/désactive la fonction de détails.

Level −7 à +7 ±0 Règle le niveau de détail.

Manual
Setting

On / Off / --- Off Active/désactive la fonction de réglage manuel des détails.

H/V Ratio −2 à +2 ±0

Règle l’équilibre entre les détails horizontaux (H) et verticaux (V)
pour le réglage manuel des détails.

Note

Cet élément varie selon la version du logiciel.*1

B/W
Balance

Type1 / Type2 /
Type3 / Type4 /
Type5

Type3
Définit l’équilibre entre les détails de noir (B) pour les zones de
faible luminance et les détails de blanc (W) pour les zones de forte
luminance pour le réglage manuel des détails.

Limit 0 à 7 7
Règle le niveau de limite de détails pour le réglage manuel des
détails.

Crispening 0 à 7 0 Règle le niveau de netteté pour le réglage manuel des détails.

High Light
Detail

0 à 4 0
Règle le niveau des détails des zones de forte luminance pour le
réglage manuel des détails.

Dans la version 1.00 du logiciel, l’élément de menu est [V/H Balance]. Dans la version du logiciel 1.10 ou plus récente, l’élément de menu est
[H/V Ratio]. La plage de réglage reste inchangée de −2 à 0 à +2, toutefois, l’effet sur la qualité de l’image est différent.
Version 1.00 du logiciel : plus la valeur réglée est élevée, plus il y a de détails horizontaux (H).
Version 1.10 du logiciel ou plus récente : plus la valeur réglée est élevée, plus il y a de détails verticaux (V).
Après la mise à jour de la version du logiciel 1.00 à la version 1.10 ou plus récente, les [All File], [Scene File], et les autres réglages sont
conservés mais avec une polarité inversée (la qualité de l’image est conservée).
Si vous avez enregistré l’élément de menu [V/H Balance] dans le menu [User], il sera automatiquement remplacé par l’élément de menu [H/V
Ratio] dans le menu [User] après la mise à jour du logiciel.

*1
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Matrix

Définit les réglages de correction de matrice.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

User Matrix On / Off Off
Active ou désactive la fonction de correction de
matrice utilisateur.

User Matrix
Level

−99 à +99 ±0 Ajuste la saturation de couleur de l’image entière.

User Matrix
Phase

−99 à +99 ±0
Ajuste la nuance de couleur (phase) de l’image
entière.

User Matrix R-
G

−99 à +99 ±0
Règle une matrice utilisateur R-V définie par
l’utilisateur.

User Matrix R-B −99 à +99 ±0
Règle une matrice utilisateur R-B définie par
l’utilisateur.

User Matrix G-
R

−99 à +99 ±0
Règle une matrice utilisateur V-R définie par
l’utilisateur.

User Matrix G-B −99 à +99 ±0
Règle une matrice utilisateur V-B définie par
l’utilisateur.

User Matrix B-R −99 à +99 ±0
Règle une matrice utilisateur B-R définie par
l’utilisateur.

User Matrix B-G −99 à +99 ±0
Règle une matrice utilisateur B-V définie par
l’utilisateur.
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Multi Matrix

Définit les réglages de correction de matrice multiple.
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Élément Réglage de sous-éléments Réglage par
défaut Description

Setting On / Off Off
Active/désactive la fonction de correction de
matrice multiple.

Reset Execute / Cancel –
Réinitialise la teinte et la saturation de chaque
couleur d’axe aux valeurs par défaut.

Axis
B / B+ / MG− / MG / MG+ / R / R+ / YL−
/ YL / YL+ / G− / G / G+ / CY / CY+ / B−

B Sélectionne l’axe.

Hue −99 à +99 ±0
Règle la teinte de la couleur utilisée pour la
correction de matrice multiple.

Saturation −99 à +99 ±0
Règle la saturation de la couleur utilisée pour
la correction de matrice multiple.
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P/T Acceleration

Définit les réglages liés à l’accélération des opérations de panoramique/inclinaison.
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Élément Réglage de
sous-éléments

Réglage par
défaut Description

Ramp
Curve

1 à 9 8
Sélectionne l’accélération/décélération pour les opérations de
panoramique/inclinaison. Plus le chiffre est élevé, plus l’accélération
est élevée.
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Timecode

Définit les réglages de code temporel.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

Mode
Preset / Regen /
Clock

Preset

Règle le mode de fonctionnement du code temporel.
Preset : commence à fonctionner à partir d’une valeur
prédéfinie.
Regen : commence à fonctionner à partir du code temporel de
la fin du plan précédent.
Clock :utilise l’horloge interne comme code temporel.

Run Rec Run / Free Run Rec Run
Rec Run : fonctionne uniquement en cours d’enregistrement.
Free Run : fonctionne en permanence, quelle que soit
l’opération d’enregistrement.

Setting – –
Règle le code temporel sur une valeur arbitraire.
Set : règle la valeur.

Reset Execute / Cancel –
Réinitialise le code temporel sur 00:00:00:00.
Execute : exécute la fonction.

TC
Format

DF / NDF DF
Règle le format de code temporel.
DF : mode temps réel
NDF : mode temps non réel
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TC Display

Définit les réglages d’affichage des données temporelles.
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Élément Réglage de sous-éléments Réglage par
défaut Description

Display
Select

Timecode / Users Bit /
Duration

Timecode
Commute l’affichage des données
temporelles.
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Users Bit

Définit les réglages liés aux bits d’utilisateur.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

Mode Fix / Time Fix

Règle le mode de bit d’utilisateur.
Fix : utilise une valeur fixe arbitraire dans les bits d’utilisateur.
Time : utilise l’heure, les minutes et les secondes actuelles
dans les bits d’utilisateur.

Setting – – Règle les bits d’utilisateur sur une valeur arbitraire.
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HDMI TC Out

Définit les réglages liés à la sortie du code temporel lors de l’utilisation de HDMI.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Setting On / Off Off
Règle s’il faut envoyer le code temporel vers des dispositifs à
d’autres fins à l’aide de la sortie HDMI.
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Clip Name Format

Configure les réglages relatifs à l’attribution d’un nom et à la suppression de plan.
Lorsque [Auto Naming] est réglé sur [Cam ID + Reel#], les quatre premiers caractères des noms de plan sont déterminés
pour chaque support d’enregistrement. Lorsqu’un nouveau support d’enregistrement est inséré, ou lorsque le dernier
plan sur le support d’enregistrement ne correspond pas aux réglages [Camera ID] ou [Reel Number], le nom de plan
clignote pour vous en informer.
Lorsque [Auto Naming] est réglé sur [Title], vous pouvez utiliser une chaîne de caractères arbitraire comme première
partie des noms de plan.

Élément Réglage de sous-
éléments

Réglage
par défaut Description

Auto
Naming

Cam ID + Reel# / Title

Sélectionne le format d’attribution de nom de plan.
Cam ID + Reel# : ID caméra + numéro de bobine +numéro
de prise de vue + date + chaîne aléatoire
Title : chaîne arbitraire spécifiée par [Title Prefix] + numéro
de plan

Camera ID A à Z A

Règle l’ID caméra utilisé lors de la génération de noms de
plan.

Note

Configurable uniquement lorsque [Auto Naming] est réglé
sur [Cam ID + Reel#].

Reel
Number

001 à 999 001

Définit la partie du numéro de bobine utilisé lors de la
génération des noms de plan.

Note

Configurable uniquement lorsque [Auto Naming] est réglé
sur [Cam ID + Reel#].

Camera
Position

C / L / R C

Définit la première partie de caractères du numéro de
bobine utilisé lors de la génération des noms de plan.

Note

Configurable uniquement lorsque [Auto Naming] est réglé
sur [Cam ID + Reel#].
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Pour définir [Title Prefix]

Rubrique associée

Saisie d’une chaîne de caractères

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage
par défaut Description

Title Prefix

nnn_ (nnn correspond aux
3 derniers chiffres du
numéro de série)
(Affichage de 7 caractères
max.)

nnn

Règle la partie de titre (4 à 46 caractères) du nom de plan.
Ouvre un écran de saisie de chaîne de caractères.

Pour plus de détails sur le réglage des titres et l’écran de
saisie de caractères, consultez « Pour définir le titre » ci-
dessous et « Saisie d’une chaîne de caractères ».

Note

Configurable uniquement lorsque [Auto Naming] est réglé
sur [Title].

Number
Set

0001 à 9999 0001

Règle le suffixe numérique à 4 chiffres du nom de plan.

Note

Configurable uniquement lorsque [Auto Naming] est réglé
sur [Title].

Sélectionnez le caractère à insérer à la position du curseur dans la zone [Title Prefix] depuis la zone de
sélection des caractères à l’aide des touches fléchées dans le panneau de commande GUI (le caractère est
mis en surbrillance), puis appuyez sur la touche [Set] dans le panneau de commande GUI.

Le caractère sélectionné est inséré et le curseur se déplace vers la droite.

1

Recommencez l’étape 1 pour définir le titre.

Utilisez [BS] selon les besoins.

2

Après avoir défini le titre, appuyez sur la touche [Done] pour fermer l’écran de saisie de caractères.

Pour plus de détails sur l’opération dans l’écran de saisie de caractères, consultez « Saisie d’une chaîne de
caractères. »

Les caractères suivants peut être sélectionnés.
!#$%()+,-.;=@[ ]^_~ espace
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Update Media

Met à jour le fichier de gestion sur les cartes mémoire (consultez « Restauration de cartes mémoire »).

Rubrique associée

Restauration de cartes mémoire

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Media(A) Execute / Cancel –
Met à jour le fichier de gestion sur la carte mémoire dans le
logement A.
Execute : exécute la fonction.

Media(B) Execute / Cancel –
Met à jour le fichier de gestion sur la carte mémoire dans le
logement B.
Execute : exécute la fonction.
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Format Media

Formate (initialise) les cartes mémoire (consultez « Formatage (initialisation) de cartes mémoire »).

Rubrique associée

Formatage (initialisation) de cartes mémoire

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-éléments Réglage par
défaut Description

Media(A)
Full Format / Quick Format /
Cancel

–
Formate la carte mémoire insérée dans le
logement A.

Media(B)
Full Format / Quick Format /
Cancel

–
Formate la carte mémoire insérée dans la
logement B.
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Media Life

Affiche la durée de vie restante des cartes mémoire.

Note

Nécessite des cartes mémoire qui prennent en charge l’affichage de la durée de vie restante.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Media(A) – –
Affiche la durée de vie restante de la carte mémoire dans le
logement A.

Media(B) – –
Affiche la durée de vie restante de la carte mémoire dans le
logement B.
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Output Format

Définit les réglages du format de sortie.

Rubrique associée

Formats de sortie et limites

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-éléments Réglage par
défaut Description

SDI Pour plus de détails sur les réglages, consultez
« Formats de sortie et limites ».

– Règle la résolution de sortie
SDI et HDMI.HDMI –
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Display On/Off

Définit les réglages de l’élément d’affichage.
Pour afficher un élément d’affichage, sélectionnez On. Pour masquer un élément d’affichage, sélectionnez Off.

Élément Réglage de sous-éléments Réglage par défaut

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On
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Élément Réglage de sous-éléments Réglage par défaut

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Video Signal Monitor

Définit les réglages du moniteur de signal vidéo.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-éléments Réglage par
défaut Description

Setting
Off / Waveform / Vector /
Histogram

Off Règle le type de moniteur de signal vidéo.

Level Marker
1

0% à 109% 70%
Règle le niveau du marqueur du niveau de
luminance 1.

Level Marker
2

0% à 109% 100%
Règle le niveau du marqueur du niveau de
luminance 2.
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Marker

Définit les réglages d’affichage de repère.

Élément Réglage de sous-éléments Réglage par
défaut Description

Setting On / Off On Active/désactive l’affichage de tous les repères.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White Sélectionne la couleur du signal de repère.

Center
Marker

1 / 2 / 3 / 4 / Off Off Sélectionne le repère central.

Safety Zone On / Off Off Active/désactive le repère de la zone de sécurité.

Safety Area 80% / 90% / 92.5% / 95% 90%
Sélectionne la taille du repère de la zone de
sécurité (en tant que pourcentage de la taille
totale de l’écran).

Aspect
Marker

Line / Mask / Off Off Sélectionne le type de repère de format.

Aspect
Mask

0 à 15 12
Règle le niveau du signal vidéo en dehors du
repère.

Aspect
Safety Zone

On / Off Off Active/désactive le repère de la zone de sécurité
de format.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
Sélectionne la taille du repère de la zone de
sécurité de format (en tant que pourcentage de la
taille totale de l’écran).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9
/ 17:9 / 1.66:1 / 1.85:1 / 2.35:1 /
2.39:1 / Custom

2.39:1 Règle le mode en affichant le repère de format.

Custom
Aspect Ratio

Permet de saisir une valeur
arbitraire.

01.00:01.00

Règle le rapport d’aspect sur une valeur
arbitraire.

Note

Activé lorsque [Aspect Select] est réglé sur
[Custom].

Guide
Frame

On / Off Off Active/désactive l’affichage du cadre guide.

100%
Marker

On / Off Off Active/désactive le repère 100%.
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Élément Réglage de sous-éléments Réglage par
défaut Description

User Box On / Off Off
Active/désactive l’affichage du repère de cadre
utilisateur.

User Box
Width

3 à 479 240
Règle la largeur du repère de cadre utilisateur
(distance du centre aux bords gauche et droit).

User Box
Height

3 à 269 135
Règle la hauteur du repère de cadre utilisateur
(distance du centre aux bords haut et bas).

User Box H
Position

−476 à +476 0 Définit la position horizontale du centre du repère
de cadre utilisateur.

User Box V
Position

−266 à +266 0
Définit la position verticale du centre du repère de
cadre utilisateur.
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Audio Input

Définit les réglages d’entrée audio.

Élément Réglage de sous-
éléments

Réglage
par défaut Description

AUDIO IN
Select

MIC / LINE MIC
Sélectionne le type de dispositif connecté au connecteur AUDIO
IN.

Phantom
Power +48V

On / Off Off Affiche l’état de l’alimentation fantôme +48 V.

CH1 Input
Select

AUDIO IN CH1
AUDIO IN
CH1

Affiche la source d’entrée pour l’enregistrement sur le canal 1.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN
CH2

Commute la source d’entrée pour l’enregistrement sur le canal
2.

CH3 Input
Select

Off / AUDIO IN CH1
AUDIO IN
CH1

Commute la source d’entrée pour l’enregistrement sur le canal
3.

CH4 Input
Select

Off / AUDIO IN CH1
/ AUDIO IN CH2

AUDIO IN
CH2

Commute la source d’entrée pour l’enregistrement sur le canal
4.

AUDIO IN
CH1 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Règle le niveau d’enregistrement de référence pour l’entrée du
microphone XLR à partir de AUDIO IN CH1.

AUDIO IN
CH2 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Règle le niveau d’enregistrement de référence pour l’entrée du
microphone XLR à partir de AUDIO IN CH2.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
Sélectionne le niveau d’entrée de référence lorsque [AUDIO IN
Select] est réglé sur LINE.

Reference
Level

−20dB / −18dB /
−16dB / −12dB /
EBUL

−20dB
Sélectionne le niveau d’enregistrement du signal de tonalité de
référence de 1 kHz.

CH1 Wind
Filter

On / Off Off
Active/désactive le filtre de réduction anti-vent pour
l’enregistrement sur le canal 1.

CH2 Wind
Filter

On / Off Off
Active/désactive le filtre de réduction anti-vent pour
l’enregistrement sur le canal 2.

CH3 Wind
Filter

On / Off Off
Active/désactive le filtre de réduction anti-vent pour
l’enregistrement sur le canal 3.

CH4 Wind
Filter

On / Off Off Active/désactive le filtre de réduction anti-vent pour
l’enregistrement sur le canal 4.

CH1 Level
Control

Auto / Manual Auto
Sélectionne l’ajustement automatique ou l’ajustement manuel
du niveau d’entrée audio l’enregistrement sur le canal 1.
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Élément Réglage de sous-
éléments

Réglage
par défaut Description

CH2 Level
Control

Auto / Manual Auto
Sélectionne l’ajustement automatique ou l’ajustement manuel
du niveau d’entrée audio l’enregistrement sur le canal 2.

CH3 Level
Control

Auto / Manual Auto
Sélectionne l’ajustement automatique ou l’ajustement manuel
du niveau d’entrée audio l’enregistrement sur le canal 3.

CH4 Level
Control

Auto / Manual Auto
Sélectionne l’ajustement automatique ou l’ajustement manuel
du niveau d’entrée audio l’enregistrement sur le canal 4.

CH1 Input
Level

0 à 99 49 Règle le niveau d’entrée pour l’enregistrement du canal 1.

CH2 Input
Level

0 à 99 49 Règle le niveau d’entrée pour l’enregistrement du canal 2.

CH3 Input
Level

0 à 99 49 Règle le niveau d’entrée pour l’enregistrement du canal 3.

CH4 Input
Level

0 à 99 49 Règle le niveau d’entrée pour l’enregistrement du canal 4.

Master Input
Level

0 à 99 99 Règle le niveau d’entrée audio maître.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
Sélectionne la caractéristique du limiteur pour les forts signaux
d’entrée lors du réglage manuel du niveau d’entrée audio.

CH1&2 AGC
Mode

Mono / Stereo Stereo
Règle le mode de réglage automatique de niveau pour le canal
d’enregistrement 1 et canal 2. Lors d’un réglage sur Stereo,
AGC est relié entre les canaux.

CH3&4 AGC
Mode

Mono / Stereo Stereo
Règle le mode de réglage automatique de niveau pour le canal
d’enregistrement 3 et canal 4. Lors d’un réglage sur Stereo,
AGC est relié entre les canaux.

AGC Spec
−6dB / −9dB /
−12dB / −15dB /
−17dB

−6dB Sélectionne la caractéristique AGC.

1kHz Tone on
Color Bars

On / Off Off

Active/désactive le signal de tonalité de référence de 1 kHz lors
de l’affichage des barres de couleur.

Note

Lors d’un réglage sur [On], le signal de tonalité de référence de
1 kHz est réglé pour l’enregistrement sur le canal 3 et canal 4,
même si [CH3 Input Select] et [CH4 Input Select] sont réglés sur
[Off].
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Audio Output

Définit les réglages de sortie audio.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Règle la combinaison des canaux audio pour
HDMI/la sortie en diffusion continu.
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Display Clip Properties

Affiche l’écran de propriétés de plans.
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Élément Réglage de sous-éléments Réglage par défaut Description

Display Clip Properties – – Affiche l’écran de propriétés de plans.
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Set Clip Flag

Définit les réglages de balise de plan.
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Élément Réglage de sous-éléments Réglage par défaut Description

Add OK – – Ajoute une balise OK.

Add NG – – Ajoute une balise NG.

Add KEEP – – Ajoute une balise KEEP.

Delete Clip Flag – – Supprime toutes les balises.
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Lock/Unlock Clip

Définit les réglages de protection de plan.
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Élément Réglage de sous-éléments Réglage par défaut Description

Select Clip – – Sélectionne et verrouille/déverrouille un plan.

Lock All Clips – – Verrouille tous les plans.

Unlock All Clips – – Déverrouille tous les plans.
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Delete Clip

Supprime les plans.
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Élément Réglage de sous-éléments Réglage par défaut Description

Select Clip – – Supprime le plan sélectionné.

All Clips – – Supprime tous les plans.
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Transfer Clip

Transfère des plans.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

Select
Clip

– – Transfert les plans sélectionnés.

All Clips – –

Transfert tous les plans.

Note

Un maximum de 200 tâches de transfert peuvent être
enregistrées.
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Transfer Clip (Proxy)

Transfère des plans proxy.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

Select
Clip

– –
Transfère les plans proxy correspondant aux plans
sélectionnés.

All Clips – –

Transfère les plans proxy correspondant à tous les plans.

Note

Un maximum de 200 tâches de transfert peuvent être
enregistrées.
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Filter Clips

Définit les réglages des plans à afficher.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

OK – – Affiche uniquement les plans comportant une balise OK.

NG – – Affiche uniquement les plans comportant une balise NG.

KEEP – –
Affiche uniquement les plans comportant une balise
KEEP.

None – –
Affiche uniquement les plans ne comportant pas de
balise.

All – –
Affiche tous les plans, que des balises soient présentes
ou non.
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Customize View

Bascule l’affichage de l’écran de miniatures.
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Élément Réglage de sous-éléments Réglage par
défaut Description

Thumbnail
Caption

Date Time / Time Code / Duration /
Sequential Number

Time Code
Commute l’information affichée sous
les miniatures.
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Color Bars

Définit les réglages de barres de couleur.
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Élément Réglage de sous-éléments Réglage par défaut Description

Setting On / Off Off Active/désactive les barres de couleur.

Type ARIB / 100% / 75% / SMPTE ARIB Sélectionne le type de barres de couleur.
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Genlock

Configure l’affichage de l’état genlock (consultez « Synchronisation de la phase du signal vidéo (Genlock) »).

Rubrique associée

Synchronisation de la phase du signal vidéo (Genlock)

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-éléments Réglage par
défaut Description

Reference
Internal / External(HD) /
External(SD)

–
Affiche le type de signal de référence
genlock.
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Tally

Définit les réglages du témoin d’enregistrement/de signalisation (consultez « Connexion d’un signal tally »).

Rubrique associée
Connexion d’un signal tally

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de
sous-éléments

Réglage par
défaut Description

Tally Lamp
Brightness

High / Low / Off High
Définit la luminosité du témoin d’enregistrement/de
signalisation.

G Tally Lamp Enable / Disable Enable Active/désactive le témoin de signalisation G.

Tally Control External / Internal Internal

Sélectionne la cible pour accepter les informations de contrôle
du témoin d’enregistrement/de signalisation de l’appareil.
External : contrôle de signalisation depuis l’extérieur de la
caméra.
Internal : contrôle via l’opération d’enregistrement de la
caméra.
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Rec Review

Définit les réglages du passage en revue de l’enregistrement (consultez « Passage en revue de l’enregistrement (Rec
Review) »).

Rubrique associée

Passage en revue de l’enregistrement (Rec Review)

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Setting 3s / 10s / Clip 3s
Définit le temps pour la lecture de plans venant d’être enregistrés
pour la révision de l’enregistrement.
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Zoom

Définit les réglages de zoom (« Réglage du zoom »).

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-éléments Réglage par défaut Description

Zoom Type Optical Zoom Only / On(Clear Image Zoom) Optical Zoom Only Définit le type de zoom.
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Lens

Définit les réglages liés aux objectifs.

Rubrique associée

Compensation de la respiration

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Lens Calibration Execute / Cancel –

Exécute la fonction qui corrige les différences dans la
position du zoom en raison de différences dans les
objectifs individuels lors de l’utilisation d’un objectif
zoom motorisé.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Règle la direction du fonctionnement de la bague de
zoom.

Note

Activé uniquement lors de l’utilisation d’un objectif à
monture E prenant en charge le changement de
direction de la bague de zoom.

Shading
Compensation

Auto / Off Auto Définit la compensation automatique d’ombrage.

Chroma
Aberration
Comp.

Auto / Off Auto
Définit la compensation automatique d’aberrations
chromatiques.

Distortion Comp. Auto / Off Auto Définit la compensation automatique de distorsion.

Breathing
Compensation

Auto / Off Off
Définit la compensation de la respiration de l’objectif.

Consultez « Compensation de la respiration ».

Distance Display Meter / Feet Meter
Configure les unités d’affichage pour les informations
d’objectif et la position de mise au point.

Zoom Position
Display

Focal Length /
Number / Bar Focal Length Définit le format d’affichage de position de zoom.
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APR

Exécute l’APR.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

APR Execute / Cancel –

Exécute l’APR (restauration automatique des pixels) pour
l’ajustement automatique du capteur d’images.
Execute : exécute la fonction.

Note

Fixez toujours le capuchon de l’objectif avant d’exécuter l’APR.
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Wired LAN

Définit les réglages liés aux connexions LAN filaires.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

HTTP Port – 80 Affiche le port d’accès HTTP.

Detail
Settings

– – Affiche les propriétés de la connexion par LAN filaire.

DHCP
On / Off

On Affiche si DHCP est activé (On) ou désactivé (Off).

IP Address –
Affiche l’adresse IP de l’appareil lorsque [DHCP] est réglé
sur [Off].

Subnet Mask –
Affiche le masque de sous-réseau de l’appareil lorsque
[DHCP] est réglé sur [Off].

Gateway –
Affiche la passerelle par défaut lorsque [DHCP] est réglé
sur [Off].

DNS Auto
On / Off

On Affiche le réglage d’acquisition automatique DNS.
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File Transfer

Définit les réglages liés aux transferts de fichiers (consultez « À propos du transfert de fichiers »).

Rubrique associée

À propos du transfert de fichiers

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de
sous-éléments

Réglage
par défaut Description

Auto Upload
(Proxy)

On / Off Off Active/désactive le téléchargement automatique de fichiers proxy.

Default
Upload
Server

Server
Settings1 à 3 >
Display Name

–

Sélectionne le serveur de téléchargement pour les fichiers. Le
serveur sélectionné ici devient la destination de téléchargement
automatique pour les fichiers proxy et la destination de
téléchargement pour les fichiers à partir de l’écran des miniatures.
Affiche les réglages [Display Name] configuré dans [Server Settings1
à 3].

Clear
Completed
Jobs

Execute /
Cancel

–
Supprime de la liste les tâches de transfert terminées.
Execute : exécute la fonction.

Clear All
Jobs

Execute /
Cancel

–
Supprime de la liste toutes les tâches de transfert.
Execute : exécute la fonction.

View Job List – – Affiche la liste des tâches de transfert.
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Language

Règle la langue d’affichage.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-éléments Réglage par défaut Description

Select – –
Règle la langue d’affichage.
Set : règle la valeur.
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Clock Set

Définit les réglages de l’horloge interne.

Note

Lorsque ce réglage est modifié dans le menu de la caméra, mettez l’appareil hors tension puis redémarrez-le. Un comportement
inattendu peut se produire si la mise en veille est effectuée à l’aide de la télécommande infrarouge ou de l’application Web.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Time
Zone

UTC − 12:00 à UTC +
14:00

–
Règle le décalage horaire par rapport au temps universel,
par incréments de 30 minutes.

Date
Mode

YYMMDD / MMDDYY /
DDMMYY

YYMMDD

Sélectionne le format d’affichage pour les dates.
YYMMDD : année, mois, jour
MMDDYY : mois, jour, année
DDMMYY : jour, mois, année

12H/24H 12H / 24H 24H
Sélectionne le format d’affichage de l’horloge.
12H : mode 12 heures
24H : mode 24 heures

Date – –
Règle la date actuelle.
Set : règle la valeur.

Time – –
Règle l’heure actuelle.
Set : règle la valeur.
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Hours Meter

Affiche la durée de fonctionnement cumulée.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Hours(System) – –
Affiche les heures d’utilisation cumulées (ne peut pas
être réinitialisé).

Hours(Reset) – –
Affiche les heures d’utilisation cumulées (peut être
réinitialisé).

Reset Execute / Cancel –
Réinitialise la durée de fonctionnement cumulée à 0.
Execute : exécute la fonction.
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Réglages et valeurs par défaut d’ISO/Gain

La plage des valeurs par défaut et des réglages [ISO/Gain<L>] varient en fonction des réglages [Mode], [Base Look] >
[Select] et [Base Sensitivity].
Les valeurs par défaut dans les tableaux sont affichées en gras.

Lorsque [Mode] est réglé sur [ISO]

Lorsque [Base Look] > [Select] est réglé sur [S-Cinetone], [Standard], [ITU709], [709tone] ou [Still]

Lorsque [Base Look] > [Select] est réglé sur [HLG Live] ou [HLG Natural]

Lorsque [ISO/Gain/EI] > [Base Sensitivity] est réglé
sur [Low]

Lorsque [ISO/Gain/EI] > [Base Sensitivity] est réglé
sur [High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Lorsque [Base Look] > [Select] est réglé sur [User1] à [User16]

Lorsque [Mode] est réglé sur [dB]

Une valeur dans une plage de −3dB à +30dB par incrément de 1dB peut être configurée.
La valeur par défaut est 0dB.

5-041-957-23(1) Copyright 2022 Sony Corporation

Lorsque [ISO/Gain/EI] > [Base Sensitivity] est réglé
sur [Low]

Lorsque [ISO/Gain/EI] > [Base Sensitivity] est réglé
sur [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Lorsque [ISO/Gain/EI] > [Base Sensitivity] est réglé
sur [Low]

Lorsque [ISO/Gain/EI] > [Base Sensitivity] est réglé
sur [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Réglages et valeurs par défaut de AGC Limit

La plage des valeurs par défaut et des réglages du menu [AGC Limit] varient en fonction des réglages [Mode], [Base
Look] > [Select] et [Base Sensitivity].
Les valeurs par défaut dans les tableaux sont affichées en gras.

Lorsque [Mode] est réglé sur [ISO]

Lorsque [Base Look] > [Select] est réglé sur [S-Cinetone], [Standard], [ITU709], [709tone] ou [Still]

Lorsque [Base Look] > [Select] est réglé sur [HLG Live] ou [HLG Natural]

Lorsque [ISO/Gain/EI] > [Base Sensitivity] est réglé
sur [Low]

Lorsque [ISO/Gain/EI] > [Base Sensitivity] est réglé
sur [High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Lorsque [Base Look] > [Select] est réglé sur [User1] à [User16]

Lorsque [Mode] est réglé sur [dB]

Sélectionnez entre 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
La valeur par défaut est 15dB.

5-041-957-23(1) Copyright 2022 Sony Corporation

Lorsque [ISO/Gain/EI] > [Base Sensitivity] est réglé
sur [Low]

Lorsque [ISO/Gain/EI] > [Base Sensitivity] est réglé
sur [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Lorsque [ISO/Gain/EI] > [Base Sensitivity] est réglé
sur [Low]

Lorsque [ISO/Gain/EI] > [Base Sensitivity] est réglé
sur [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Réglages de qualité d’image sauvegardés pour chaque mode de prise de vue

L’état actuel des éléments de configuration liés à la qualité d’image est sauvegardé pour chacun des modes de prise de
vue suivants. Lorsque vous changez de mode de prise de vue, les réglages correspondants qui sont sauvegardés pour
le mode de prise de vue cible sont appliqués.

Affichage cible en Mode Custom SDR(BT.709)
Affichage cible en Mode Custom HDR(HLG)
Prise de vue Log (Cine EI, Cine EI Quick, Flexible ISO)

Les éléments de configuration relatifs à la qualité d’image qui sont sauvegardés pour chaque mode de prise de vue sont
indiqués dans les tableaux suivants.
« Oui » indique les réglages sauvegardés et « Non » indique les réglages non sauvegardés. « Oui » sur plusieurs
colonnes indique des réglages communs.

Élément

Mode de prise de vue

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Menu
Shooting

ISO/Gain/EI

ISO/Gain Oui1) Oui Non

Exposure Index Non Non Oui Oui

Base Sensitivity Oui Non

Base ISO Non Oui4) Non3) Oui4)

White
Preset White Oui Oui

Autre que ci-dessus Oui

White Setting Oui

Offset White Oui Non

LUT On/Off Non Oui

Noise
Suppression

Setting(Custom) Oui Oui Non

Level(Custom) Oui Oui Non

Setting (Cine
EI/Flex. ISO)

Non Oui

Level (Cine EI/Flex.
ISO)

Non Oui
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Élément

Mode de prise de vue

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Menu
Paint/Look

Base Look

Select Oui Oui Oui

Input2) Oui

Output2) Oui

AE Level Offset2) Oui

Black Oui Oui Non

Knee
Auto Knee Oui Non Non

Autre que ci-dessus Oui Oui Non

Detail Oui Oui Non

Matrix Oui Oui Non

Multi Matrix Oui Oui Non

Les réglages de sensibilité ISO distincts sont sauvegardés pour SDR(BT.709) et HDR(HLG) en mode Custom.1)

Les réglages sont sauvegardés pour chaque Base Look, et ne dépendent pas du mode de prise de vue.2)

La sensibilité ISO de base change en lien avec l’indice d’exposition.3)

Valeur de réglage commune en modes de prise de vue Flexible ISO et Cine EI.4)
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Configuration du menu Web

Appuyez sur l’onglet de commutation de l’écran d’opération [Settings] pour afficher l’écran des réglages.
Utilisez l’écran des réglages pour configurer les différents éléments de configuration de l’appareil, y compris les réglages
initiaux, réglages réseau, réglages de prise de vue/lecture, à l’aide du menu Web.

Le menu se compose des menus suivants.

Configuration et hiérarchie des menus

Niveau 1 Description niveau 1 Niveau 2

Shooting Contient des réglages liés à la prise de vue. Focus
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Niveau 1 Description niveau 1 Niveau 2

Project Contient des réglages de base du projet.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Contient des réglages liés à la qualité d’image. Base Look

Pan-Tilt Contient les réglages liés au panoramique/inclinaison.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring Contient des réglages liés à la sortie vidéo et à l’affichage de l’écran.
Output Format

Output Display

Audio Contient des réglages liés à l’audio. Audio

Technical Contient des réglages liés aux éléments techniques.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network Contient des réglages liés aux réseaux.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack
Protection
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Note

[Accessibility] est uniquement disponible pour les modèles destinés à l’Amérique du Nord.

5-041-957-23(1) Copyright 2022 Sony Corporation

Niveau 1 Description niveau 1 Niveau 2

Stream Contient des réglages liés à la diffusion en continu.

Stream

Video Stream

Audio Stream

Maintenance Contient des réglages liés aux appareils, par exemple l’horloge et la
langue.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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Opérations du menu Web

Appuyez sur l’onglet de commutation de l’écran d’opération [Settings] pour afficher l’écran des réglages et configurer les
différents éléments de configuration de l’appareil, y compris les réglages initiaux, réglages réseau, réglages de prise de
vue/lecture, à l’aide du menu Web.
Configurez les réglages dans le menu Web sur une tablette par opération tactile ou sur un ordinateur par opération de la
souris.
Appuyez sur le menu relatif aux éléments que vous souhaitez configurer pour afficher les éléments de configuration et
leurs réglages.

Méthode de configuration

Sélection des valeurs

Menu (niveau 1)1.

Menu (niveau 2)2.

Réglages3.

385



Appuyez sur la touche radio pour sélectionner un élément. La touche radio d’un élément sélectionné s’affiche en orange.

Élément On/Off

Appuyez sur le commutateur pour activer/désactiver l’élément. Le commutateur apparaît en orange lorsque l’élément est
activé et en blanc s’il est désactivé.

Sélection de valeurs à partir d’une liste

Appuyez sur la touche de la liste déroulante et sélectionnez un élément dans la liste affichée.

Sélection d’une valeur numérique

Appuyez sur < ou > pour modifier la valeur numérique. Si la valeur numérique est soulignée, vous pouvez également
saisir une valeur numérique directement.

Entrée d’un nombre/caractère

Configuration sur un autre écran
Appuyez sur la touche pour effectuer les opérations de configuration sur un autre écran.

Message d’assistance

Des informations vous aidant à configurer certains réglages et des messages pertinents sont affichés.

Sauvegarde d’un réglage

Lorsque vous avez terminé de configurer un réglage, appuyez sur la touche [OK] pour le sauvegarder.
Appuyez sur la touche [Cancel] pour ignorer les modifications apportées à un réglage et le faire revenir au réglage
précédent.
Appuyez sur la touche [Reload] pour mettre à jour l’affichage de l’écran.
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Note

Si vous appuyez sur la touche [Reload] avant d’avoir sauvegardé un réglage, les modifications apportées au réglage seront
ignorées.

Si vous changez de page avant d’avoir sauvegardé un réglage, les modifications apportées au réglage seront ignorées.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Focus

Définit les réglages de mise au point.

Rubrique associée

Réglage manuel de la cible de mise au point automatique (AF Assist) à l’aide de l’application Web

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de
sous-éléments

Réglage
par défaut Description

Push AF
Mode

AF / Single-
shot AF(AF-S)

AF Règle le mode de mise au point automatique par pression.

Touch
Function in
MF

Tracking AF /
Spot Focus

Tracking AF
Règle l’opération lorsque l’écran d’image de la caméra est touchée
en mode MF.

AF Assist
Control

On / Off On

Lors d’un réglage sur [On], vous pouvez utiliser le curseur de mise au
point depuis l’application Web pendant la mise au point automatique
pour ajuster la position de la mise au point.

Pour les détails, consultez « Réglage manuel de la cible de mise
au point automatique (AF Assist) à l’aide de l’application Web ».

Note

Cet élément n’est activé que lorsque [AF Assist] est réglé sur [On]
dans le menu de la caméra.
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Base Setting

Définit les réglages de base.

Rubrique associée

Configuration des opérations de base

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-éléments Réglage par
défaut Description

Shooting
Mode

Custom / Flexible ISO / Cine
EI Quick / Cine EI

Custom

Règle le mode de prise de vue.

Consultez « Mode de prise de vue » dans
« Configuration des opérations de base ».

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Règle la gamme de couleurs de l’enregistrement/la
sortie en mode Custom.
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Rec Format

Définit les réglages du format d’enregistrement.

Réglages [RAW Output Format]

Élément Réglage de sous-éléments Réglage
par défaut Description

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94

Sélectionne la fréquence du système.

Note

Si la fréquence est modifiée, la caméra
redémarrera. Après le redémarrage,
rechargez la page dans le navigateur Web.

Imager Scan
Mode

FF / S35 FF Sélectionne la taille de l’imageur.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Règle le codec d’enregistrement/de lecture de
plan.

Note

Lorsque [Imager Scan Mode] est réglé sur
[S35], [RAW] et [RAW & XAVC-I] ne peuvent
pas être sélectionnés.

RAW Output
Format

Les réglages disponibles varient en
fonction du réglage [Frequency].

Consultez « Réglages [RAW
Output Format] » ci-dessous.

–

Définit la taille de l’image RAW à émettre vers
un enregistreur RAW externe.

Note

Lorsque [Codec] est réglé sur [RAW & XAVC-
I], le réglage [Video Format] change en lien
avec le réglage [RAW Output Format].

Video
Format

Les réglages disponibles varient
selon les réglages [Frequency],
[Imager Scan Mode] et [Codec].

Consultez « Réglages [Video
Format] » ci-dessous.

– Définit la taille de l’image.

Frequency Imager Scan Mode Codec Réglage

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Les valeurs par défaut sont affichées en gras.
Les conditions dans lesquelles le réglage [RAW Output Format] ne peut pas être défini ont été omises.

Réglages [Video Format]

Les valeurs par défaut sont affichées en gras.
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Frequency Imager Scan Mode Codec Réglage

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Simul Rec

Définit les réglages du mode d’enregistrement simultané sur 2 fentes (consultez « Enregistrement simultané sur les
cartes mémoire A et B (2-slot Simul Rec) »).

Rubrique associée

Enregistrement simultané sur les cartes mémoire A et B (2-slot Simul Rec)
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

Setting On / Off Off
Active/désactive la fonction d’enregistrement simultané et définit
le support de destination d’enregistrement.

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B Affiche l’attribution des touches d’enregistrement pour chaque
support d’enregistrement.
Réglez [Project] > [Simul Rec] > [Rec Button Set] dans le menu
de la caméra.

2nd Rec
Button

Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B
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Proxy Rec

Définit les réglages du mode d’enregistrement proxy (consultez « Enregistrement du proxy »).
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Élément Réglage de sous-éléments Réglage par défaut Description

Setting On / Off Off Active/désactive le mode d’enregistrement proxy.
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Interval Rec

Définit les réglages du mode d’enregistrement à intervalle (consultez « Enregistrement de la vidéo par intermittence
(Interval Rec) »).

Rubrique associée

Enregistrement de la vidéo par intermittence (Interval Rec)
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Élément Réglage de sous-éléments Réglage par défaut Description

Setting On / Off Off

Active/désactive le mode
d’enregistrement à intervalle. (Le
réglage de ce mode sur On met
tous les autres modes spéciaux sur
Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (sec)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (heure)

1

Définit l’intervalle entre les
enregistrements en mode
d’enregistrement Interval Rec
(lorsque Interval Rec est réglé sur
On).

Number
of Frames

1frame / 2frames / 3frames / 6frames
/ 9frames / 12frames
Les réglages disponibles varient en
fonction de la fréquence d’images du
format vidéo sélectionné.
59.94P/50P : 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P : 1frame /
3frames / 6frames / 9frames

59.94P/50P : 2frames
29.97P/25P/24P/23.98P :
1frame

Définit le nombre d’images à
enregistrer par prise en mode
d’enregistrement Interval Rec
(lorsque Interval Rec est réglé sur
On).
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Picture Cache Rec

Définit les réglages du mode d’enregistrement de cache d’image (consultez « Enregistrement d’images en cache (Picture
Cache Rec) »).

Rubrique associée

Enregistrement d’images en cache (Picture Cache Rec)
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Élément Réglage de
sous-éléments

Réglage par
défaut Description

Setting On / Off Off Active/désactive la fonction de cache d’image.

Cache Size
Short / Medium /
Long / Max

Max
Règle le temps pour l’accumulation d’images dans la mémoire de
cache d’image (temps d’enregistrement de cache d’image).

Cache Rec
Time

– –
Affiche le temps pour l’accumulation d’images dans la mémoire de
cache d’image (temps d’enregistrement de cache d’image).
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All File

Effectue les opérations de fichier ALL (consultez « Enregistrement et chargement des données de configuration »).
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Élément Réglage de
sous-éléments

Réglage par
défaut Description

Load All
File

– –

Charge un fichier ALL sur l’appareil depuis le dispositif exécutant
l’application Web.

Note

Lorsqu’un fichier ALL est chargé dans l’appareil, celui-ci redémarrera.
Après le redémarrage, rechargez la page dans le navigateur Web.

Save All
File – –

Sauvegardez les réglages de l’appareil sur le dispositif exécutant
l’application Web en tant que fichier ALL.
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Base Look

Il est possible de charger une apparence de base sur l’appareil.
Une liste des apparences de base s’affiche à l’écran. L’apparence de base actuellement appliquée est indiquée par un
symbole ● à gauche du numéro de l’apparence de base.

[No.] : numéro de l’apparence de base
[Base Look Name] : nom de l’apparence de base
[Input] : signal d’entrée de l’apparence de base
[Output] : signal de sortie de l’apparence de base
[AE Level Offset] : valeur de décalage de la référence d’exposition de l’apparence de base

Pour ajouter une apparence de base
Appuyez sur la touche [Import] pour importer une nouvelle apparence de base. Suivez les instructions qui s’affichent à
l’écran.
Après l’importation, réglez les valeurs appropriées pour [Input], [Output], et [AE Level Offset]. Pour plus de détails,
consultez « Importation d’une apparence de base souhaitée ».

Rubrique associée
Importation d’une apparence de base souhaitée
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P/T Speed

Définit les réglages liés à la vitesse de panoramique/inclinaison.
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Élément
Réglage de

sous-
éléments

Réglage par
défaut Description

Speed
Step

Normal /
Extended

Extended

Définit le nombre de pas de vitesse d’entraînement de
panoramique/inclinaison.
Normal : la vitesse peut être réglée à l’aide d’une échelle à 24 niveaux.
Utilisez ce réglage pour assurer la compatibilité avec les caméras
télécommandées Sony existantes.
Extended : la vitesse peut être réglée à l’aide d’une échelle à 50
niveaux.

Speed
Mode

Normal / Slow Normal

Définit le mode de vitesse d’entraînement de panoramique/inclinaison.
Activé uniquement lorsque [Speed Step] est réglé sur [Normal].
Normal : fonctionne sur la plage à vitesse normale (de minimum à
maximum (60 degrés/seconde)).
Slow : fonctionne sur la plage à vitesse réduite (de minimum à
maximum (40 degrés/seconde)).
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P/T Acceleration

Définit les réglages liés à la vitesse de panoramique/inclinaison.
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Élément Réglage de
sous-éléments

Réglage par
défaut Description

Acceleration 1 à 9 8
Sélectionne l’accélération/décélération pour les opérations de
panoramique/inclinaison. Plus le chiffre est élevé, plus l’accélération
est élevée.
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P/T Range Limit

Définit les réglages liés à la limitation de la plage de panoramique/inclinaison.
Réglez les limites de la plage d’opération de panoramique/inclinaison à l’aide de l’écran suivant.

Note

Lorsque l’appareil est mis sous tension ou que la réinitialisation de panoramique/inclinaison est exécutée, ce réglage de limite de
plage est ignoré. Cette fonction ne peut pas être utilisée pour éviter des obstacles près de l’appareil.

Réglez le commutateur [Setting] sur la position On.

La fonction de limitation de la plage d’opération de panoramique/inclinaison devient active.

1

Vérifiez l’image à l’aide des commandes de panoramique/inclinaison de la caméra.2

Pour régler les positions auxquelles limiter l’opération, appuyez sur les touches [Left], [Right], [Up], [Down]
> [Set Current Value] aux positions désirées.

[Left] : côté gauche de la caméra
[Right] : côté droit de la caméra
[Up] : côté supérieur de la caméra

3
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Note

Les positions de la caméra en dehors des positions limites ne peuvent pas être sauvegardées comme préréglage.

Si le réglage [Pan-Tilt] > [P/T Direction] > [Ceiling] est modifié, les réglages de positions limites retourneront à leurs valeurs par
défaut.

Ce réglage ne peut pas être changé durant la lecture, l’affichage d’une miniature, lors d’une erreur de panoramique/inclinaison,
lorsque panoramique/inclinaison n’est pas initialisé ou est bloqué.
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[Down] : côté inférieur de la caméra

Les positions limites sont définies et affichées sous forme de valeurs numériques (angle).
Pour annuler une limite, appuyez sur la touche [Reset] une fois sur sa position.

Appuyez sur la touche [OK].

Le fonctionnement de panoramique/inclinaison devra rester entre les positions limites configurées.

4
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P/T Direction

Définit les réglages liés à la direction de panoramique/inclinaison.

Note

À l’application d’un réglage [Ceiling] modifié, toutes les positions prédéterminées sont effacées étant donné que les coordonnées
panoramique/inclinaison sont inversées.

La plage d’entraînement panoramique/inclinaison change comme indiqué dans le schéma suivant en fonction du réglage
[Ceiling].

A : lorsque [Ceiling] est réglé sur [Off]
B : lorsque [Ceiling] est réglé sur [On]
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Élément
Réglage de

sous-
éléments

Réglage
par défaut Description

Ceiling On / Off Off
Lorsque l’appareil est monté sur un bureau, réglez sur [Off]. Lorsque
l’appareil est monté au plafond, réglez sur [On]. Lorsque [Ceiling] est
réglé sur [On], [Pan Direction] est automatiquement réglé sur [Opposite].

Pan
Direction

Normal /
Opposite

Normal
Définit la direction d’entraînement de panoramique. Lorsque le réglage
est modifié, la direction d’entraînement s’inverse.

Tilt
Direction

Normal /
Opposite

Normal
Définit la direction d’entraînement d’inclinaison. Lorsque le réglage est
modifié, la direction d’entraînement s’inverse.
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P/T Preset

Définit les réglages liés aux préréglages de la caméra.

Pan-Tilt
Définit la vitesse pour les préréglages.

Default
Définit les valeurs par défaut qui sont configurées lorsqu’une position prédéfinie est sauvegardée.
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Élément Réglage de
sous-éléments

Réglage par
défaut Description

Pan-Tilt Speed
Setting Way

Separate /
Common

Separate
Définit si les vitesses préréglées sont configurées séparément ou
à l’aide d’un réglage commun.

Pan-Tilt Speed
for Common

1 à 50 50

Définit la vitesse commune aux préréglages.

Note

Une valeur de lecture maximale de 24 s’applique si une valeur de
25 ou plus est configurée lorsque [Pan-Tilt] > [P/T Speed] >
[Speed Step] est réglé sur [Normal].

Élément Réglage de
sous-éléments

Réglage par
défaut Description

Pan-Tilt Speed
for Separate

1 à 50 50
Définit la vitesse des préréglages lorsque la méthode de
sélection de la vitesse des préréglages est réglée sur [Separate].

Zoom Sync On / Off On
Définit si l’opération de panoramique/inclinaison et l’opération de
zoom sont synchronisées lors de la restauration d’une position
prédéfinie.

Zoom Speed 0 à 32767 32767 Définit la vitesse de zoom.

Focus Recall On / Off On Définit si les réglages de mise au point sont restaurés.

MF Speed 0 à 32767 32767 Définit la vitesse de mise au point pour la mise au point manuelle.
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Output Format

Définit les réglages du format de sortie.

Rubrique associée

Formats de sortie et limites
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Élément Réglage de sous-éléments Réglage par
défaut Description

SDI Pour plus de détails sur les réglages, consultez
« Formats de sortie et limites ».

– Règle la résolution de sortie
SDI et HDMI.HDMI –

404



Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Output Display

Définit des réglages liés aux signaux de sortie.
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Élément Réglage de
sous-éléments

Réglage
par défaut Description

SDI On / Off Off Définit si le menu et l’état sont intégrés dans le signal de sortie SDI.

HDMI/Stream On / Off On

Définit si le menu et l’état sont intégrés dans le signal de sortie
HDMI.

Note

Ce réglage s’applique également à l’image du signal de sortie HDMI,
à l’image de sortie de diffusion en continu et à l’image du panneau
d’image de la caméra de l’application Web.
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Audio Input

Définit les réglages liés aux entrées audio CH1 à CH4.

Règle le niveau d’entrée audio maître. Le niveau d’entrée audio maître s’applique aux canaux 1 à 4.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

Level
Control

Auto / Manual Auto
Sélectionne l’ajustement automatique ou l’ajustement
manuel du niveau d’entrée audio.

Level 0 à 99 49 Définit le niveau d’entrée.

Input
Select

AUDIO IN CH1 / AUDIO
IN CH2 / Off

CH1 et CH3 :
AUDIO IN CH1
CH2 et CH4 :
AUDIO IN CH2

Sélectionne la source d’entrée audio.

Note

CH1 est réglé sur [AUDIO IN CH1] (fixe).

Wind Filter On / Off Off Active/désactive la filtre de réduction du bruit du vent.

Élément Réglage de sous-éléments Réglage par défaut Description

Master 0 à 99 99 Définit le niveau d’entrée maître.
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Audio Output

Définit les réglages liés à la sortie audio.

Note

Ce réglage s’applique également à l’audio de la sortie en diffusion en continu.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Règle la combinaison des canaux audio pour
HDMI/la sortie en diffusion continu.
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Tracking Data Output

Définit les réglages relatifs à la sortie des informations de suivi (conformes au protocole free-d).
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Élément Réglage de
sous-éléments

Réglage par
défaut Description

Transfer Mode
Off / Always / On
Demand

Off Sélectionne la méthode de sortie des informations de suivi.

Camera ID 0 à 255 255 Règle l’ID de l’appareil.

Destination
Address

Adresse IPv4 –
Lorsque [Transfer Mode] est réglé sur [Always], ce réglage
définit l’adresse IP de destination des informations de suivi.

Destination
Port

1024 à 65534 40000
Lorsque [Transfer Mode] est réglé sur [Always], ce réglage
définit le numéro de port de destination des informations de
suivi.

Listen Port 1024 à 65534 40000
Lorsque [Transfer Mode] est réglé sur [On Demand], ce réglage
définit le numéro de port pour écouter les demandes des
clients.
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Tally

Définit les réglages du témoin d’enregistrement/de signalisation (consultez « Connexion d’un signal tally »).

Rubrique associée

Connexion d’un signal tally
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Élément Réglage de
sous-éléments

Réglage par
défaut Description

Tally Lamp
Brightness

High / Low / Off High
Définit la luminosité du témoin d’enregistrement/de
signalisation.

G Tally Lamp Enable / Disable Enable Active/désactive le témoin de signalisation G.

Tally Control External / Internal Internal
Sélectionne la cible pour accepter les informations de contrôle
du témoin d’enregistrement/de signalisation de l’appareil.
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IR Remote

Définit les réglages liés à la télécommande infrarouge.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

Setting On / Off On
Active/désactive le fonctionnement de l’appareil depuis la
télécommande infrarouge.
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RCP/MSU

Configure un réglage quand un RCP/MSU (option) est connecté.
Pour plus de détails, reportez-vous à « Connexion d’un RCP/MSU (option) ».

Note

Configurez les réglages sur le RCP/MSU si besoin.

Un MSU est nécessaire pour un système multi-caméras.

Lors de l’utilisation de plusieurs appareils MSU, réglez un appareil MSU comme maître et réglez les autres appareils MSU
comme clients.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

CNS Mode
Off / Bridge / MCS
/ PC Control

Off Permet de régler le mode de connexion pour le RCP/MSU.

Master IP
Address

Adresse IPv4 0.0.0.0
Permet de régler l’adresse IP de l’appareil maître lors de la
création d’un système multi-caméras sur le réseau local.

Camera No.
Camera No. (1 à
96)

1
Permet de régler un nombre unique de caméras dans le système
lors de la création d’un système multi-caméras sur le réseau
local.
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Lens Controller

Définit les réglages d’un contrôleur d’objectif connecté (option).
Pour plus de détails, consultez « Connexion d’un contrôleur d’objectif ».

Note

Lorsque [Setting] est modifié, l’appareil redémarrera. Rechargez la page dans le navigateur Web.
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Élément
Réglage de

sous-
éléments

Réglage
par défaut Description

Setting On / Off Off Permet d’utiliser ou non le contrôleur d’objectif (option).

Mode 0 à 15 0

Définit le mode de fonctionnement du contrôleur d’objectif (option).
Les valeurs comprises dans une plage entre 0 et 15 sont disponibles, mais
les valeurs réelles pouvant être sélectionnées varient en fonction du
contrôleur d’objectif (option). Pour plus de détails, consultez le mode
d’emploi du contrôleur d’objectif.

Reverse On / Off Off Inverse le sens de rotation du contrôleur d’objectif (option).

Initialize – – Initialise le contrôleur d’objectif (option).
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Camera Name

Définit les réglages liés au nom de la caméra (nom de l’appareil).

Jusqu’à huit (0 à 8) des caractères suivants peuvent être saisis pour Camera Name.
Caractères alphanumériques
Symboles (espace !#$`*+-./;<=>?@[\]^_`{|})
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Élément Réglage de sous-éléments Réglage par défaut Description

Camera Name – FR7 Attribue un nom de caméra.
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User

Définit les réglages relatifs à l’accès de l’appareil par l’utilisateur.

Réglages liés aux utilisateurs administrateurs (Administrator) (requis)

Réglages liés aux utilisateurs généraux (User 1 à User 9) (en option)

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

User Name – admin Définit le nom d’utilisateur.

Current
Password

– –
Lorsque vous changez le mot de passe, saisissez le
mot de passe actuel.

New Password – – Saisissez le nouveau mot de passe.

Re-Type
Password

– –
Saisissez encore le nouveau mot de passe pour
confirmation.

Élément Réglage de sous-
éléments

Réglage par
défaut Description

User Name – – Définit le nom d’utilisateur.

Current
Password

– –
Lorsque vous changez le mot de passe, saisissez le
mot de passe actuel.

New Password – – Saisissez le nouveau mot de passe.

Re-Type
Password – –

Saisissez encore le nouveau mot de passe pour
confirmation.
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Wired LAN

Status
Affiche l’état du réseau.

IPv4
Définit les réglages liés au réseau IPv4.

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Host Name – – Affiche le nom de l’hôte.

MAC Address – – Affiche l’adresse MAC de l’appareil.

Ethernet Status – –
Affiche la vitesse de communication
actuelle.

IP Address – – Affiche l’adresse IP de l’appareil.

Subnet Mask – –
Affiche le masque de sous-réseau de
l’appareil.

Gateway – –
Affiche la passerelle IPv4 par défaut de
l’appareil.

Primary DNS Server – –
Affiche le serveur DNS primaire de
l’appareil.

Secondary DNS
Server – –

Affiche le serveur DNS secondaire de
l’appareil.

IPv6 Address 1 – – Affiche l’adresse IPv6 1 de l’appareil.

IPv6 Address 2 – – Affiche l’adresse IPv6 2 de l’appareil.

IPv6 Gateway – –
Affiche la passerelle IPv6 par défaut de
l’appareil.

Link-local IPv6
Address

– –
Affiche l’adresse de lien local IPv6 de
l’appareil.

Élément Réglage de sous-
éléments

Réglage par
défaut Description

DHCP On / Off On Active/désactive la fonction [DHCP].

IP Address – – Définit l’adresse IPv4 lorsque [DHCP] est réglé sur Off.

Subnet
Mask

– –
Définit le masque de sous-réseau lorsque [DHCP] est
réglé sur Off.
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IPv6
Définit les réglages liés au réseau IPv6.

Common
Définit les réglages liés aux réseaux IPv4/IPv6.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

Gateway – –
Définit la passerelle par défaut IPv4 lorsque [DHCP] est
réglé sur Off.

Élément Réglage de
sous-éléments

Réglage par
défaut Description

Obtain an IP Address
Automatically

On / Off On
Active/désactive l’acquisition automatique de l’adresse
IPv6.

IP Address – –
Définit l’adresse IPv6 lorsque [Obtain an IP Address
Automatically] est réglé sur Off.

Prefix Length – – Définit le préfixe lorsque [Obtain an IP Address
Automatically] est réglé sur Off.

Gateway – –
Définit la passerelle par défaut IPv6 lorsque [Obtain
an IP Address Automatically] est réglé sur Off.

Élément Réglage de sous-
éléments

Réglage par
défaut Description

HTTP Port 80, 1024 à 65534 80 Définit le numéro de port HTTP.

DNS Auto On / Off On
Définit si obtenir ou non les adresses DNS depuis le
serveur DHCP.

Primary DNS
Server

Adresse IPv4/IPv6 –
Définit le serveur DNS primaire par défaut lorsque
[DNS Auto] est réglé sur Off.

Secondary DNS
Server

Adresse IPv4/IPv6 –
Définit le serveur DNS secondaire par défaut lorsque
[DNS Auto] est réglé sur Off.
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File Transfer

Définit les réglages liés aux transferts de fichiers.
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Élément Réglage de
sous-éléments

Réglage
par défaut Description

Auto
Upload
(Proxy)

On / Off Off Active/désactive le téléchargement automatique de fichiers proxy.

Default
Upload
Server

Server
Settings1 à 3 >
Display Name

Server
Settings1

Sélectionne le serveur de téléchargement pour les fichiers. Le serveur
sélectionné ici devient la destination de téléchargement automatique
pour les fichiers proxy et la destination de téléchargement pour les
fichiers à partir de l’écran des miniatures.
Affiche les réglages [Display Name] configuré dans [Server Settings1 à
3].
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FTP Server 1 à 3

Définit les réglages liés aux transferts de fichiers FTP.
Les réglages sont communs aux FTP Server 1 à 3.
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

Display Name – –
Règle le nom d’affichage indiqué dans le menu de
configuration de destination de transfert.

Service – – Permet d’afficher le type de serveur.

Host Name – – Règle le nom d’hôte du serveur de destination de transfert.

Port 21, 990, 1024 à
65534

21 Règle le numéro de port du serveur de destination de
transfert.

User Name – –
Règle le nom d’utilisateur pour l’authentification de la
connexion au serveur de destination de transfert.

Password – –
Règle le mot de passe d’authentification de la connexion au
serveur de destination de transfert.

Passive Mode On / Off Off Active/désactive le mode passivité.

Destination
Directory

– – Définit le nom du répertoire de destination de transfert.

Using Secure
Protocol

On / Off Off
Définit l’utilisation (On) ou non (Off) d’un transfert FTP
sécurisé.

Root Certificate – –

Charge le certificat racine pour un transfert FTP sécurisé.
Appuyez sur la touche [Load] et sélectionnez un certificat
racine sur l’écran affiché.
Appuyez sur la touche [Delete] pour supprimer le certificat
racine chargé.

Root Certificate
Status

– – Affiche l’état de chargement du certificat racine.

Reset – –
Réinitialise les réglages [Server Settings] aux valeurs par
défaut.
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SSL

Définit les réglages liés aux SSL.

SSL
Active/désactive la fonction SSL.

SSL Server Authentication
Définit les réglages liés à l’authentification du serveur SSL.

Élément Réglage de sous-éléments Réglage par
défaut Description

Function
Disable / Enable / Enable (Allow HTTP connection for
some clients)

Disable
Active/désactive la fonction
SSL.

Élément Réglage de sous-
éléments

Réglage
par défaut Description

Certificate
Options

Use a self-signed
certificate (For test use) /
Use an external certificate

–
Définit la méthode d’installation du certificat du
serveur SSL.

Status – –
Affiche la validité du certificat du serveur SSL lorsque
[Certificate Options] est réglé sur [Use a self-signed
certificate (For test use)].

Issuer DN – –
Affiche le nom unique de l’émetteur du certificat du
serveur SSL lorsque [Certificate Options] est réglé sur
[Use a self-signed certificate (For test use)].

Subject DN – –
Affiche le nom unique du sujet du certificat du serveur
SSL lorsque [Certificate Options] est réglé sur [Use a
self-signed certificate (For test use)].

Available Period – –
Affiche la période de validité du certificat du serveur
SSL lorsque [Certificate Options] est réglé sur [Use a
self-signed certificate (For test use)].

Extended Key
Usage

– –
Affiche la méthode d’utilisation de la clé étendue
lorsque [Certificate Options] est réglé sur [Use a self-
signed certificate (For test use)].

Delete – –
Cette touche s’affiche lorsque [Certificate Options] est
réglé sur [Use a self-signed certificate (For test use)].
Supprime le certificat du serveur SSL installé.

Import – –
Installe un certificat externe du serveur SSL depuis
une liste lorsque [Certificate Options] est réglé sur
[Use an external certificate].
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Élément Réglage de sous-
éléments

Réglage
par défaut Description

Private Key
Password

– –
Définit le mot de passe pour les informations de clé
privée du certificat du serveur SSL lorsque [Certificate
Options] est réglé sur [Use an external certificate].

Reset – –
Cette touche supprime le mot de passe de la clé
privée pour en saisir un nouveau.

Self-Signed
Certificate
Generation

– –
Appuyez sur la touche [Generate] pour générer un
certificat auto-signé lorsque [Certificate Options] est
réglé sur [Use a self-signed certificate (For test use)].
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Referer Check

Définit les réglages liés à la vérification de Referer.

Exception List
Définit les réglages liés à la liste des exceptions de la vérification de Referer.

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Setting On / Off On
Active/désactive la fonction de vérification de
Referer.

Élément Réglage de
sous-éléments

Réglage par
défaut Description

No. 1 à 10 – Définit le nombre d’exceptions de la liste.

Host
Name

– – Définit le nom d’hôte de l’exception.

Port
Number – – Définit le numéro de port de l’exception.

Set – –
Appuyez pour enregistrer l’exception configurée dans la liste des
exceptions.

Delete – –
Sélectionnez l’exception que vous souhaitez supprimer et appuyez
sur la touche pour supprimer l’exception sélectionnée de la liste des
exceptions.
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Brute Force Attack Protection

Définit les réglages liés à la protection contre les attaques violentes.

Lorsqu’un attaquant est détecté, la liste d’informations des attaquants s’affiche.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de
sous-éléments

Réglage par
défaut Description

Setting On / Off On Active/désactive la fonction [Brute Force Attack Protection].

Count 3 à 100 8
Définit le nombre de tentatives considéré comme une attaque.
Activé lorsque [Setting] est réglé sur On.

Release
Mode Always / Timer Timer

Définit les conditions de libération.
Activé lorsque [Setting] est réglé sur On.
Always : ne pas supprimer de la liste des attaquants.
Timer : supprimer de la liste des attaquants à la fin du temps de
libération déterminé à l’aide de [Release Time].

Release
Time

30 à 86400 s 60

Définit le temps de libération.
Activé lorsque [Setting] est réglé sur On.
Lorsque Release Mode est réglé sur [Timer], les informations sont
supprimées de la liste des attaquants à la fin du temps de libération.
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Stream

Définit les réglages de la diffusion en continu (consultez « À propos de la diffusion en continu »).

Stream Setting
Définit les réglages liés au protocole de diffusion en continu.

Note

Pour utiliser RTMP, réglez [Stream] > [Audio Stream] > [Setting] sur [On] au préalable.

RTSP
Les éléments suivants sont affichés lorsque [Stream Setting] est réglé sur [RTSP].
Définit les réglages liés à la diffusion en continu RTSP.

RTMP
Les éléments suivants sont affichés lorsque [Stream Setting] est réglé sur [RTMP].
Définit les réglages liés à la diffusion en continu RTMP.

Élément Réglage de sous-éléments Réglage par
défaut Description

Setting
RTSP / RTMP / SRT-Caller / SRT-Listener /
NDI|HX / Off

RTSP
Sélectionne le protocole de diffusion en
continu.

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Port Number 554, 1024 à 65534 554 Définit le numéro de port RTSP.

Time Out 0 à 600 60
Définit le délai d’attente de la commande Keep Alive pour
la diffusion en continu RTSP.

Authentication On / Off On Active/désactive la fonction d’authentification RTSP.

Video Port
Number 1

1024 à 65534 51000
Définit le numéro de port pour l’envoi de la vidéo 1 pour la
monodiffusion en continu RTSP.

Video Port
Number 2

1024 à 65534 53000
Définit le numéro de port pour l’envoi de la vidéo 2 pour la
monodiffusion en continu RTSP.

Audio Port
Number

1024 à 65534 57000
Définit le numéro de port depuis lequel envoyer l’audio
pour la monodiffusion en continu RTSP.

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Server URL – –
Définit l’URL de destination de la connexion RTMP ou
RTMPS.
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SRT
Les éléments suivants sont affichés lorsque [Stream Setting] est réglé sur [SRT-Caller] ou [SRT-Listener].
Définit les réglages liés à la diffusion en continu SRT.

NDI|HX
Les éléments suivants sont affichés lorsque [Stream Setting] est réglé sur [NDI|HX].
Définit les réglages liés à NDI|HX.

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Stream Key – – Définit la clé de flux obtenue du côté serveur RTMP.

Root
Certificate

– –

Charge le certificat racine nécessaire à la connexion avec
le serveur RTMP.
Appuyez sur la touche [Load] et sélectionnez un certificat
racine sur l’écran affiché.
Appuyez sur la touche [Delete] pour supprimer le certificat
racine chargé.
L’état est affiché dans [Root Certificate Status].

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Destination – –
Définit l’URL de destination de connexion lorsque l’appareil
fonctionne en tant qu’encodeur (appelant).

Port
Number

1024 à 65534 4201
Définit le numéro de port pour recevoir lorsque l’appareil
fonctionne en tant que décodeur (auditeur).

Latency 20 à 8000 ms 120 Définit la latence.

TTL 1 à 255 64 Définit la valeur TTL.

Encryption
Off / AES128 /
AES256

Off
Active/désactive le cryptage et définit la méthode de
cryptage.

Passphrase
0 ou chaîne de 10 à
79 caractères

0
Définit la phrase secrète utilisée pour le cryptage.
Appuyez sur Reset pour effacer la phrase secrète saisie.

ARC On / Off On Active/désactive la fonction Adaptive Rate Control.

Élément Réglage de sous-
éléments

Réglage par
défaut Description

License – – Affiche l’état d’installation de la clé de licence NDI.

Source Name – – Affiche le nom de la source NDI.

Group On / Off Off Active/désactive la fonction de groupe NDI.

Group Name – –
Affiché lorsque la fonction de groupe NDI est réglée sur
On.
Définit le nom du groupe.

Discovery
Server 1

– – Définit le serveur 1 NDI discovery.
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À propos de la diffusion en continu
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

Discovery
Server 2

– – Définit le serveur 2 NDI discovery.

Multicast Mode On / Off Off Active/désactive la multidiffusion en continu.

Multicast Prefix 239.255.0.0 239.255.0.0
Affiché lorsque [Multicast Mode] est réglé sur On.
Définit le préfixe pour utiliser la multidiffusion en
continu.

Multicast
Netmask

255.255.0.0 255.255.0.0
Affiché lorsque [Multicast Mode] est réglé sur On.
Définit le masque de réseau déterminant la plage
d’adresses de multidiffusion.

Multicast TTL 1 à 256 3
Affiché lorsque [Multicast Mode] est réglé sur On.
Définit la valeur TTL pour la multidiffusion en continu.

Multi-TCP
Mode

On / Off Off Active/désactive le mode Multi-TCP.

Unicast UDP
Mode

On / Off On Active/désactive le mode Unicast UDP.
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Video Stream

Définit les réglages liés aux codecs vidéo de la diffusion en continu.

Video Stream 1
Définit les réglages liés au codec vidéo 1.

Élément Réglage de sous-éléments Réglage par
défaut Description

Codec 1 H.264 / H.265 H.264 Définit le codec de l’image 1.

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080
Définit la taille d’image de l’image
1.

Frame Rate 1

Pour plus de détails concernant la
fréquence d’images prise en charge,
consultez « Configuration du codec vidéo
pour la diffusion en continu ».

–
Définit la fréquence d’images de
l’image 1.

I-Picture Mode 1 Time / Frame Time

Définit l’intervalle d’insertion
d’image IDR-Frame pour l’image
1 en unités de temps ou nombres
de trames.

I-Picture Interval
1

1 / 2 / 3 / 4 / 5 s 1

Affiché lorsque [I-Picture Mode 1]
est réglé sur Time.
Définit l’intervalle d’insertion IDR-
Frame pour H.264 et H.265 en
unités de temps.

I-Picture Ratio 1 15 à 300 images 30

Affiché lorsque [I-Picture Mode 1]
est réglé sur Frame.
Définit l’intervalle d’insertion IDR-
Frame pour H.264 et H.265 en
nombre de trames.

Profile 1
H.264 : high / main / baseline
H.265 : main / main10 H.264 : high Définit le profil H.264 ou H.265.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Définit le mode de compression
du débit binaire de l’image 1.

Bit Rate 1
512 / 768 / 1000 / 2000 / 3000 / 4000 / 5000 /
6000 / 7000 / 8000 / 16000 / 24000 / 32000 /
50000 / 64000 / 80000 kbps

16000

Affiché lorsque [Bit Rate
Compression Mode 1] est réglé
sur On.
Définit la valeur cible du débit
binaire lorsque le mode de
compression du débit binaire est
réglé sur CBR.
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Video Stream 2
Définit les réglages liés au codec vidéo 2.

Élément Réglage de sous-éléments Réglage par
défaut Description

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Définit la qualité H.264 ou H.265.

Élément Réglage de sous-éléments Réglage par
défaut Description

Codec 2 H.264 / H.265 / Off Off Définit le codec de l’image 2.

Size 2
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 / 512×270

1920×1080
Définit la taille d’image de l’image
2.

Frame Rate 2

Pour plus de détails concernant la
fréquence d’images prise en charge,
consultez « Configuration du codec vidéo
pour la diffusion en continu ».

–

Affiché lorsque [Codec 2] n’est
pas réglé sur Off.
Définit la fréquence d’images de
l’image 2.

I-Picture Mode 2 Time / Frame Time

Affiché lorsque [Codec 2] n’est
pas réglé sur Off.
Définit l’intervalle d’insertion
d’image IDR-Frame pour l’image
2 en unités de temps ou nombres
de trames.

I-Picture Interval
2

1 / 2 / 3 / 4 / 5 s 1

Affiché lorsque [Codec 2] n’est
pas réglé sur Off et [I-Picture
Mode 2] est réglé sur [Time].
Définit l’intervalle d’insertion IDR-
Frame pour H.264 et H.265 en
unités de temps.

I-Picture Ratio 2 15 à 300 images 30

Affiché lorsque [Codec 2] n’est
pas réglé sur Off et [I-Picture
Mode 2] est réglé sur [Frame].
Définit l’intervalle d’insertion IDR-
Frame pour H.264 et H.265 en
nombre de trames.

Profile 2
H.264 : high / main / baseline
H.265 : main

– Définit le profil H.264 ou H.265.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Affiché lorsque [Codec 2] n’est
pas réglé sur Off.
Définit le mode de compression
du débit binaire de l’image 2.
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Video Stream 3
Définit les réglages liés au codec vidéo 3.

Rubrique associée

Configuration du codec vidéo pour la diffusion en continu

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-éléments Réglage par
défaut Description

Bit Rate 2
512 / 768 / 1000 / 2000 / 3000 / 4000 / 5000 /
6000 / 7000 / 8000 / 16000 / 24000 / 32000 /
50000 / 64000 / 80000 kbps

8000

Affiché lorsque [Codec 2] n’est
pas réglé sur Off et [Bit Rate
Compression Mode 2] est réglé
sur [On].
Définit la valeur cible du débit
binaire lorsque le mode de
compression du débit binaire est
réglé sur CBR.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Affiché lorsque [Codec 2] est
réglé sur H.264 et [Bit Rate
Compression Mode 2] est réglé
sur Off.
Définit la qualité H.264 ou H.265.

Élément Réglage de sous-éléments Réglage par
défaut Description

Codec 3 JPEG JPEG
Définit le codec de
l’image 3.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Définit la taille d’image
de l’image 3.

Frame
Rate 3

Pour plus de détails concernant la fréquence d’images prise
en charge, consultez « Configuration du codec vidéo pour la
diffusion en continu ».

–
Définit la fréquence
d’images de l’image 3.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Définit la qualité.
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Audio Stream

Définit les réglages liés aux codecs audio de la diffusion en continu.
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Élément Réglage de sous-éléments Réglage par
défaut Description

Setting On / Off Off Active/désactive l’audio de la diffusion en continu.

Codec
AAC (128kbps) / AAC
(256kbps)

AAC (128kbps)
Affiché lorsque [Setting] est réglé sur On.
Définit le codec audio pour la diffusion en
continu.
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Language

Règle la langue d’affichage.

Note

Les langues disponibles peuvent varier selon le pays ou la région.
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Élément Réglage de sous-éléments Réglage par défaut Description

Language – – Règle la langue d’affichage.
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Accessibility

Définit les réglages liés à la lecture audio (texte en paroles).

Note

Cette fonction est uniquement disponible pour les modèles vendus en Amérique du Nord. La fonction lecteur d’écran ne peut être
utilisée que lorsque la langue est définie sur anglais (à la date de sortie).

Active la fonction lecteur d’écran du navigateur Web sur le dispositif exécutant l’application Web.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-éléments Réglage par
défaut Description

Screen
Reader

On / Off Off 
Active/désactive la fonction de lecteur d’écran dans le
panneau d’image de la caméra de l’application Web.

Speech
Rate

Slow2 / Slow1 / Normal /
Fast1 / Fast2 / Fast3 / Fast4

Normal
Définit la vitesse de la fonction de lecteur d’écran.
Un extrait test est lu à haute voix à la vitesse
configurée.

Speech
Volume

1 à 15 7
Définit le volume de la fonction de lecteur d’écran de
l’application Web.
Un extrait test est lu à haute voix au volume configuré.
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Clock Set

Définit les réglages de l’horloge interne.
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Élément Réglage de sous-éléments Réglage par
défaut Description

Current Date
& Time

– –
Affiche l’heure actuelle configurée sur
l’appareil.

PC Clock – –
Affiche l’heure actuelle de la tablette ou de
l’ordinateur utilisée pour la configuration.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-yyyy
hh:mm:ss / dd-mm-yyyy hh:mm:ss

yyyy-mm-dd
Définit le format d’affichage pour la date et
l’heure.

12 h / 24 h 12 h / 24 h 24 h
Définit le format d’affichage de l’heure sur 12
heures ou 24 heures.

Time Setting
Keep current setting / Synchronize
with PC / Manual setting /
Synchronize with NTP

–
Définit la méthode de configuration pour la
date et l’heure.

yy-mm-dd
hh:mm:ss

yy : 19 à 37
mm : 01 à 12
dd : 01 à 31
hh : 00 à 23
mm : 00 à 59
ss : 00 à 59 (secondes)

–
Affiché lorsque [Time Setting] est réglé sur
Manual setting.
Définit la date et de l’heure manuellement.

NTP Auto On / Off Off

Affiché lorsque [Time Setting] est réglé sur
Synchronize with NTP.
Définit si obtenir ou non l’adresse IP du
serveur NTP depuis le serveur DHCP.

NTP Server Adresse ou nom d’hôte IPv4/IPv6 –

Affiché lorsque [Time Setting] est réglé sur
[Synchronize with NTP] et [NTP Auto] est
réglé sur Off.
Spécifie le serveur NTP utilisé pour la
synchronisation temporelle.

Time Zone UTC − 12:00 à UTC + 14:00 – Sélectionne le fuseau horaire.
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Reset

Initialise l’appareil.

Reboot
Redémarre l’appareil.

Reset
Réinitialise les réglages de l’appareil.

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Reboot Execute –

Redémarre l’appareil.
Execute : exécute la fonction.

Note

Après le redémarrage, rechargez la page dans le
navigateur Web.

Élément Réglage de
sous-éléments

Réglage par
défaut Description

All Reset (except for
Network Settings)

Execute –

Réinitialise les réglages de l’appareil (sauf les réglages
réseau).
Execute : exécute la fonction.

Note

Les apparences de base et les fichiers LUT ne sont pas
supprimés.

Network Reset Execute –

Réinitialise les réglages réseau de l’appareil.
Execute : exécute la fonction.

Note

Après l’exécution de Network Reset, l’appareil
redémarrera. Après le redémarrage, rechargez la page
dans le navigateur Web.
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Élément Réglage de
sous-éléments

Réglage par
défaut Description

Factory Default Execute –

Réinitialise les réglages de l’appareil à leur état par défaut.
Execute : exécute la fonction.

Note

Après l’exécution de Factory Default, l’appareil
redémarrera. Après le redémarrage, rechargez la page
dans le navigateur Web.
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Information

Affiche les informations relatives à la caméra et à l’objectif. Permet également de mettre à jour le logiciel.

Camera
Affiche les informations de la caméra et les mises à jour du logiciel.

Lens
Affiche les informations de l’objectif et les mises à jour du logiciel.

Élément Réglage de
sous-éléments

Réglage par
défaut Description

Model
Name

– – Affiche le nom de modèle de la caméra.

Serial
Number

– – Affiche le numéro de série de la caméra.

Version
Number – – Affiche la version du logiciel de la caméra.

Version Up – –

Appuyez sur la touche [Choose File] et suivez les instructions qui
s’affichent à l’écran pour mettre à jour le logiciel de la caméra.

Note

Après la mise à jour, l’appareil redémarrera. Après le redémarrage,
rechargez la page dans le navigateur Web.

Élément Réglage de
sous-éléments

Réglage par
défaut Description

Model
Name

– – Affiche le nom de modèle de l’objectif.

Serial
Number

– – Affiche le numéro de série de l’objectif.

Version
Number

– – Affiche la version du logiciel de l’objectif.
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Rubrique associée

Mise à jour du logiciel de l’objectif à monture E
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Élément Réglage de
sous-éléments

Réglage par
défaut Description

Version Up – –

Appuyez sur la touche [Choose File] et suivez les instructions qui
s’affichent à l’écran pour mettre à jour le logiciel de l’objectif.

Pour plus de détails, consultez « Mise à jour du logiciel de
l’objectif à monture E ».

Note

Après la mise à jour de l’objectif, l’appareil redémarrera. Après le
redémarrage, rechargez la page dans le navigateur Web.
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System Log

Définit les réglages liés au journal système.

Le journal obtenu s’affichera comme indiqué ci-dessous.

Rubrique associée

Mise à jour du logiciel de l’objectif à monture E
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Élément Réglage de sous-
éléments

Réglage par
défaut Description

Log Level
Critical, Warning & Info /
Critical & Warning /
Critical

Critical,
Warning &
Info

Définit le niveau pour ajouter une archive au journal
système.

Log Size 200 à 1024 1024
Définit la taille du journal à sauvegarder dans le journal
système.

Download
as File

– –
Appuyez sur la touche [Download] et sauvegardez le
journal système sur une tablette ou un ordinateur depuis
l’écran affiché.
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HTTP Access Log

Définit les réglages liés au journal d’accès HTTP.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément Réglage de sous-
éléments

Réglage par
défaut Description

Log Level
Critical, Warning & Info /
Critical & Warning /
Critical

Critical,
Warning &
Info

Définit le niveau pour ajouter une archive au journal
d’accès HTTP.

Log Size 200 à 1024 1024
Définit la taille du journal à sauvegarder dans le journal
d’accès HTTP.

Download
as File

– –
Appuyez sur la touche [Download] et sauvegardez le
journal d’accès HTTP sur une tablette ou un ordinateur
depuis l’écran affiché.
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Service

Obtient les informations de dispositif concernant l’appareil. À utiliser en cas de contact avec votre technicien Sony.

5-041-957-23(1) Copyright 2022 Sony Corporation

Élément
Réglage de

sous-
éléments

Réglage
par défaut Description

I agree to
download device
information.

– –

Cochez ici pour autoriser l’obtention des informations de
dispositif, et appuyez sur la touche [OK].
Appuyez sur la touche [Download] affichée. Le navigateur Web
téléchargera momentanément un fichier nommé
deviceinformation.dat.

Note

Après le téléchargement, l’appareil redémarrera. Redémarrez
l’appareil manuellement s’il ne redémarre pas automatiquement.
Après le redémarrage, rechargez la page dans le navigateur
Web.
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EULA

Affiche le contrat de licence d’utilisateur final (EULA).

5-041-957-23(1) Copyright 2022 Sony Corporation
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Software

Affiche la licence du logiciel.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Connexion des moniteurs externes et des dispositifs d’enregistrement

Pour afficher les images enregistrées/lues sur un moniteur externe, réglez le type de sortie vidéo pour le moniteur
externe et utilisez un câble approprié pour le moniteur à raccorder.
Vous pouvez également raccorder un enregistreur externe et enregistrer le signal de sortie venant de l’appareil.
Vous pouvez afficher les mêmes informations visibles depuis le panneau d’image de la caméra, telles que les
informations d’état et les menus, sur un moniteur externe. Définissez le type de système souhaité pour l’affichage de
l’écran dans On à l’aide de [Monitoring] > [Output Display] dans le menu Web.

Note

Si un moniteur connecté au connecteur HDMI ne prend pas en charge le format de sortie HDMI configuré à l’aide du menu
[Monitoring] dans le menu Web ou menu de la caméra, l’image de la caméra ne sera pas émise à l’application Web. La vidéo en
continu ne peut pas non plus être émise.

Vous pouvez régler [Output Display] > [SDI] et [HDMI/Stream] sur [Off], mais il sera alors impossible d’utiliser le menu de la
caméra et les fonctions liées à l’affichage de l’écran. De plus, les notifications d’erreur de l’appareil seront limitées aux témoins
(allumés ou clignotants) de l’appareil et à l’affichage des marques de notification en haut à droite de l’application Web. Pour
consultez l’état détaillé, réglez [Output Display] sur [On].

Astuce

[Output Display] > [SDI] est réglé sur [Off] et [HDMI/Stream] est réglé sur [On] par défaut. Pour utiliser la diffusion en continu en
tant que vidéo principale, réglez [SDI] sur [On] et [HDMI/Stream] sur [Off], et surveillez l’état de la caméra sur un moniteur SDI.

Connecteur SDI OUT (type BNC)

Définissez le format de sortie à l’aide du menu [Monitoring] dans le menu Web ou le menu de la caméra.
Utilisez un câble coaxial de 75 Ω disponible dans le commerce pour le branchement.

Note

Vérifiez que le branchement entre l’appareil et le dispositif externe est mis à la terre avant d’allumer les dispositifs.

Il est recommandé d’allumer l’appareil et le dispositif externe après avoir branché le câble coaxial de 75 Ω.
Si le dispositif externe doit être raccordé à l’appareil pendant qu’il est allumé, raccordez d’abord le câble coaxial de 75 Ω
au dispositif externe, puis raccordez-le à l’appareil.

Pour commencer l’enregistrement sur l’appareil et sur le dispositif externe de manière simultanée
Lorsque la sortie de signal SDI est activée, réglez [Project] > [SDI/HDMI Rec Control] > [Setting] sur [SDI/HDMI Remote
I/F] ou [Parallel Rec] dans le menu de la caméra pour activer la sortie d’un signal de déclenchement REC vers le
dispositif externe raccordé au connecteur SDI OUT. Cela permettra de synchroniser l’enregistrement sur le dispositif
externe avec l’appareil.

Note

Si un dispositif externe raccordé ne prend pas en charge le signal de déclenchement REC, le dispositif ne peut pas être utilisé.

Lorsque [Project] > [SDI/HDMI Rec Control] > [Setting] est réglé sur [SDI/HDMI Remote I/F] dans le menu de la caméra, seul le
signal de déclenchement REC est émis lorsqu’aucun support d’enregistrement n’est inséré et que la touche d’enregistrement
START/STOP est utilisée.
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Connecteur HDMI OUT (connecteur de type A)

Définissez le réglage de sortie On/Off ainsi que le format de sortie depuis le menu [Monitoring] dans le menu de la
caméra.

Pour commencer l’enregistrement sur l’appareil et sur le dispositif externe de manière simultanée
Lorsque la sortie de signal HDMI est activée, réglez [TC/Media] > [HDMI TC Out] > [Setting] sur [On] et [Project] >
[SDI/HDMI Rec Control] > [Setting] sur [SDI/HDMI Remote I/F] ou [Parallel Rec] dans le menu de la caméra pour activer
la sortie d’un signal de déclenchement REC vers le dispositif externe raccordé au connecteur HDMI OUT. Cela permettra
de synchroniser l’enregistrement sur le dispositif externe avec l’appareil.

Note

Si un dispositif externe raccordé ne prend pas en charge le signal de déclenchement REC, le dispositif ne peut pas être utilisé.

Lorsque [Project] > [SDI/HDMI Rec Control] > [Setting] est réglé sur [SDI/HDMI Remote I/F] dans le menu de la caméra, seul le
signal de déclenchement REC est émis lorsqu’aucun support d’enregistrement n’est inséré et que la touche d’enregistrement
START/STOP est utilisée.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Connexion d’un RCP/MSU

Certaines fonctions de l’appareil peuvent être contrôlées à distance en connectant à l’appareil un panneau de
télécommande (RCP) tel que le RCP-3500/3501 ou une unité centrale de réglage (MSU) tel que le MSU-3500 avec un
câble LAN.
La méthode de connexion varie selon la configuration des dispositifs connexes et de l’application.

Pour plus de détails sur une connexion un-à-un entre l’appareil et un RCP, reportez-vous à « Connexion un-à-un
entre l’appareil et un RCP ».
Pour plus de détails sur la connexion de plusieurs caméras à l’aide d’un MSU ou d’un logiciel de commande de
caméra, reportez-vous à « Utilisation de l’appareil dans un environnement multi-caméras avec un MSU/logiciel de
commande à distance de la caméra ».

Rubrique associée

Connexion un-à-un entre l’appareil et un RCP

Utilisation de l’appareil dans un environnement multi-caméras avec un MSU/logiciel de commande à distance de la
caméra

5-041-957-23(1) Copyright 2022 Sony Corporation
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Connexion un-à-un entre l’appareil et un RCP

Note

Reportez-vous à « Liste des fonctions prises en charge » et configurez l’appareil afin qu’il corresponde aux conditions de
fonctionnement pour les fonctions que vous souhaitez utiliser, puis activez la connexion avec un RCP à l’aide de la procédure
suivante.

Rubrique associée

Listes des fonctions prises en charge

5-041-957-23(1) Copyright 2022 Sony Corporation

Mettez chaque dispositif sous tension.1

Réglez [Technical] > [RCP/MSU] > [CNS Mode] sur [Bridge] dans le menu Web de la caméra.2

Configurez les réglages suivants sur le RCP.

Pour plus de détails sur la configuration, consultez le mode d’emploi du RCP.

3

Réglez le mode de connexion sur le mode Bridge.1.
Enregistrez l’adresse IP de la caméra.2.
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Utilisation de l’appareil dans un environnement multi-caméras avec un MSU/logiciel
de commande à distance de la caméra

Vous pouvez connecter plusieurs caméras à l’aide d’un MSU ou d’un logiciel de commande à distance de la caméra.

Note

Reportez-vous à « Liste des fonctions prises en charge » et configurez l’appareil afin qu’il corresponde aux conditions de
fonctionnement pour les fonctions que vous souhaitez utiliser, puis activez la connexion avec un MSU ou un logiciel de
commande à distance de la caméra à l’aide de la procédure suivante.

Rubrique associée

Listes des fonctions prises en charge
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Mettez chaque dispositif sous tension.1

Configurez les réglages du réseau système à l’aide du MSU ou du logiciel de commande à distance de la
caméra.

Pour plus de détails sur la configuration, consultez le mode d’emploi du MSU ou du logiciel de commande à
distance de la caméra.

2

Configurez les réglages suivants à l’aide de [Technical] > [RCP/MSU] dans le menu Web de la caméra.3

Si vous utilisez une MSU, réglez [CNS Mode] sur [MCS]. Si vous utilisez un logiciel de commande à distance
de la caméra, réglez [CNS Mode] sur [PC Control].

1.

Réglez l’adresse IP du MSU maître ou du logiciel de commande à distance de la caméra dans [Master IP
Address].

2.

Réglez le numéro de caméra pour lequel la caméra sera enregistrée dans [Camera No.].3.
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Listes des fonctions prises en charge

Le tableau suivant présente les fonctions prises en charge et leurs conditions de fonctionnement correspondantes.

Panneau
d’opération Fonctions de l’appareil Conditions de fonctionnement

IRIS Réglage manuel du diaphragme –

AUTO IRIS Activation/Désactivation Auto Iris –

ND
Commutation de la position de préréglage du
filtre ND (Clear/Preset1 sur Preset3)

Cette fonction est activée lorsque [Shooting] > [ND
Filter] > [Mode] est réglé sur [Preset] dans le menu
de la caméra.

MASTER
GAIN

Réglage manuel du gain (appareils 3 dB)
Activé quand le mode de prise de vue est réglé sur le
mode Custom et que [Shooting] > [ISO/Gain/EI] >
[Mode] est réglé sur [dB] dans le menu de la caméra.

WHITE (R/B)
Réglage manuel de la balance des blancs (R
Gain/B Gain)

Activé lorsque [White Mode] est réglé sur [Memory
A(R/B)] ou [Memory A(T/T)].WHITE (Color

Temp)

Réglage de la balance des blancs
(teinte/température de couleur)

RCP – [Color Temp] : température de
couleur de la balance des blancs
RCP – [Balance] : valeur de teinte de la
balance des blancs

ATW
Activation/Désactivation de la fonction ATW
(balance des blancs à suivi automatique)

Activé quand le mode de prise de vue est réglé sur le
mode Custom

BLACK R/B Réglage de la balance des noirs
Activé quand le mode de prise de vue est réglé sur le
mode Custom
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Note

Configurez l’appareil afin qu’il corresponde aux conditions de fonctionnement pour les fonctions que vous souhaitez utiliser, puis
activez la connexion avec un RCP/MSU. Si les conditions de fonctionnement sont ajustées une fois que la connexion est activée,

Panneau
d’opération Fonctions de l’appareil Conditions de fonctionnement

MASTER
BLACK

Réglage du niveau de noir maître

Activé quand le mode de prise de vue est réglé
sur le mode Custom
H/V Ratio et Crispening sont activés quand
[Paint/Look] > [Detail] > [Manual Setting] est réglé
sur [On] dans le menu de la caméra.

DETAIL

Activation/Désactivation de la fonction de
détails
Réglage du niveau de détail
Réglage H/V Ratio
Réglage Crispening

User Matrix

Activation/Désactivation de la fonction de
correction de matrice utilisateur
Réglage des valeurs de correction de la
matrice (R-G/R-B/G-R/G-B/B-R/B-G)

Multi Matrix

Activation/Désactivation de la fonction de
correction de matrice multiple
Réglage de la teinte et de la saturation de
la couleur utilisées pour la correction de
matrice multiple

Knee

Activation/Désactivation de la fonction de
correction de courbe
Activation/Désactivation de la fonction de
courbe automatique
Activation/Désactivation du point de courbe
et de la pente de courbe

BARS Active/désactive les barres de couleur

SHUTTER

Activation/Désactivation de la fonction
d’obturation
Réglage de la valeur de la vitesse
d’obturation
(Activation/Désactivation de l’obturation
automatique, réglage de l’obturation
lente, réglage ECS non pris en charge.)

Note

Les réglages de l’obturation RCP
peuvent ne pas s’afficher en fonction
de la valeur de la vitesse d’obturation
configurée.

Les réglages de l’obturation RCP
peuvent ne pas s’afficher correctement
si l’obturation ne peut pas être
actionnée à partir de RCP.

Lorsque l’obturation automatique est activée, elle
continue à fonctionner même si vous
activez/désactivez l’obturation ou si vous modifiez la
valeur de la vitesse d’obturation à partir de RCP.
Lorsque l’obturation est réglée sur [Angle],
l’activation/désactivation de l’obturation ou la
modification du réglage de la vitesse d’obturation à
partir de RCP n’est pas prise en charge.
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un comportement inattendu peut se produire.
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À propos des opérations à l’aide du pupitre de télécommande RM-IP500 (en option)

Il est possible de commander l’appareil à l’aide d’un pupitre de télécommande Sony RM-IP500 fonctionnant avec la
version 2.2 ou ultérieure du logiciel. Les dispositifs communiquent via VISCA over IP (LAN).
Selon l’élément cible à commander, il peut être nécessaire de voir l’affichage de l’écran de l’appareil. Préparez un
moniteur pouvant être utilisé pour vérifier l’affichage de l’écran.
Les opérations suivantes sont prises en charge par le pupitre de télécommande RM-IP500.

Sélection de la caméra cible
Réglage du cadrage (panoramique, inclinaison, zoom)
Réglage de la mise au point (sauf les opérations tactiles)
Enregistrement et rappel des positions prédéfinies
Commande du menu de l’appareil (sauf le menu Web)
Réglage de la luminosité
Réglage de la balance des blancs
Réglage de la balance des noirs
Réglage du niveau d’entrée audio
Démarrage/arrêt de l’enregistrement
Exécution des fonctions des touches personnalisables de l’appareil

Pour obtenir plus de détails sur le fonctionnement du RM-IP500, consultez le mode d’emploi du RM-IP500.

Astuce

Lors de l’utilisation du RM-IP500, utilisez l’étiquette de fonctions de cet appareil fourni avec le RM-IP500.

RM-IP500 (à utiliser avec l’étiquette de fonctions pour cet appareil)
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Connexion d’un pupitre de télécommande RM-IP500

Pour les détails sur l’attribution des fonctions, consultez le mode d’emploi du RM-IP500.

5-041-957-23(1) Copyright 2022 Sony Corporation

Mettez le commutateur SETUP 3 de l’appareil sur la position ON pour activer la communication VISCA over
IP.

Note

Le réglage du commutateur est appliqué lors de la prochaine mise sous tension de l’appareil.

1

Connectez le RM-IP500 au même réseau que l’appareil.2

Suivez la procédure du mode d’emploi du RM-IP500 pour configurer la connexion VISCA over IP (LAN) sur
le RM-IP500.

Attribuez cet appareil en utilisant RM menu > AUTO IP SETUP > ASSIGN CAM.

3

Attribuez des fonctions de cet appareil à des touches et des boutons, si nécessaire, à l’aide des éléments
de menu RM suivants du RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4
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À propos de la synchronisation avec un dispositif externe

Pendant une prise de vue avec plusieurs appareils, ces derniers peuvent être synchronisés sur un signal de référence
spécifique ou un code temporel via le connecteur GENLOCK des appareils.

Pour plus de détails sur le genlock, consultez « Synchronisation de la phase du signal vidéo (Genlock) ».
Pour plus de détails sur la synchronisation des codes temporels, consultez « Verrouillage du code temporel sur
d’autres dispositifs ».

Rubrique associée

Synchronisation de la phase du signal vidéo (Genlock)

Verrouillage du code temporel sur d’autres dispositifs

5-041-957-23(1) Copyright 2022 Sony Corporation

454



Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Synchronisation de la phase du signal vidéo (Genlock)

Vous pouvez fournir un signal de référence au connecteur GENLOCK pour activer le genlock.
Les signaux de référence d’entrée pouvant être utilisés varient en fonction de la fréquence du système du format
d’enregistrement sélectionné.

Vous pouvez vérifier l’état de la synchronisation externe à l’aide de [Technical] > [Genlock] > [Reference] dans le menu
de la caméra.

Note

Si le signal de référence est instable, le genlock ne peut pas être obtenu.

La sous-porteuse n’est pas synchronisée.

5-041-957-23(1) Copyright 2022 Sony Corporation

Fréquence du système du format d’enregistrement Signaux de référence d’entrée pris en charge

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P 1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i 1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Verrouillage du code temporel sur d’autres dispositifs

Réglez l’appareil fournissant le code temporel sur un mode dans lequel la sortie de code temporel continue à défiler
(comme Free Run ou Clock).

Note

Vérifiez que le code temporel de référence et le signal vidéo de référence fournis sont en relation de phase conforme à la norme
de code temporel SMPTE.

Lors de l’utilisation d’un verrou externe, le code temporel acquiert instantanément le verrou avec le code temporel externe et la
valeur de code temporel externe apparaît dans la zone d’affichage des données temporelles. Cependant, ne commencez pas
immédiatement l’enregistrement. Patientez quelques secondes le temps que le générateur de code temporel se stabilise avant
l’enregistrement.

Si la fréquence du signal vidéo de référence et la fréquence d’images sur l’appareil ne sont pas les mêmes, un verrou ne peut
pas être acquis et l’appareil ne fonctionnera pas correctement. Si cela se produit, le code temporel n’acquerra pas de verrou
correctement avec le code temporel externe.

Si la source de code temporel externe est déconnectée, le code temporel peut changer d’une image par heure, par rapport au
code temporel de référence.

Pour déverrouiller le verrou externe
Modifiez le réglage [TC/Media] > [Timecode] dans le menu de la caméra.
La synchronisation externe se déclenche également en cas de modification de la fréquence du système et lorsque vous
démarrez un enregistrement en mode d’enregistrement spécial (Slow & Quick Motion ou Interval Rec).
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Réglez les réglages suivants dans [TC/Media] > [Timecode] dans le menu de la caméra.

Réglez [Mode] sur [Preset].
Réglez [Run] sur [Free Run].

1

Appuyez sur une touche personnalisable attribuée avec la fonction [DURATION/TC/U-BIT] pour afficher le
code temporel sur l’écran.

2

Envoyez un signal vidéo de référence HD ou SD au connecteur GENLOCK et le code temporel de référence
au connecteur TC IN.

Le générateur de code temporel de l’appareil acquiert le verrou avec le code temporel de référence et « EXT-LK »
apparaît à l’écran.
Une fois que 10 secondes environ se sont écoulées après le verrouillage du code temporel, l’état de verrouillage
externe est maintenu, même si la source de code temporel de référence externe est déconnectée.

3
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Connexion d’un microphone externe ou d’un dispositif audio externe

Vous pouvez entrer le signal depuis un microphone externe ou un dispositif audio externe et intégrer l’audio dans la
vidéo enregistrée ou la vidéo de sortie de l’appareil.

Connectez un microphone externe ou un dispositif audio externe à l’aide d’un câble XLR.

Lorsque l’audio est réglé sur [LINE] à l’aide de [Audio] > [Audio Input] > [AUDIO IN Select] dans le menu de la
caméra, le connecteur AUDIO IN fonctionne comme le connecteur AUDIO IN CH-1 et le connecteur AUDIO IN CH-
2.

1

N° de broche Fonction

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Mettez l’appareil hors tension et connectez le câble XLR au connecteur AUDIO IN.2

Réglez le commutateur SETUP 2 pour autoriser l’alimentation fantôme si nécessaire.

Réglez l’alimentation +48 V (alimentation fantôme) comme décrit ci-dessous.
Commutateur 2
Définit si l’alimentation +48 V (alimentation fantôme) est activée ou non lorsque le dispositif d’entrée audio est
connecté.

3
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Note

Mettre ce commutateur sur la position ON et connecter un microphone qui n’est pas compatible avec une source de +48 V
peut endommager le dispositif connecté. Vérifiez le réglage avant de connecter le dispositif.

Réglage Description

OFF (par
défaut)

Éteint l’alimentation fantôme +48 V et définit l’entrée LINE ou MIC comme source audio CH-1 et
CH-2.

ON
Allume l’alimentation fantôme +48V et définit le microphone compatible avec l’alimentation
fantôme comme source audio CH-1 et CH-2.

Mettez l’appareil sous tension et réglez le type de dispositif connecté à l’aide de [Audio] > [Audio Input] >
[AUDIO IN Select] dans le menu de la caméra.

4
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Gestion/Montage de plans à l’aide d’un ordinateur

Vous pouvez gérer/monter des plans à l’aide d’un ordinateur.

Importation de plans depuis un lecteur de carte (en option)

Connectez un lecteur de carte CFexpress Type A ou un lecteur de carte SD à votre ordinateur et utilisez un logiciel
prenant en charge le format d’enregistrement de cet appareil, comme Catalyst Browse, pour importer des plans.

Utilisation d’un système de montage non linéaire

Dans un système de montage non linéaire, un logiciel de montage (en option) qui prend en charge les formats
enregistrés par l’appareil est nécessaire.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Sortie d’un signal de fibre optique

Vous pouvez faire sortir un signal au format SDI converti en signal optique en connectant un module SFP+ (en option) au
connecteur OPTICAL de l’appareil. Utilisez un module SFP+ correspondant à la bande de signal de chaque format.
Bande de signal

4K (59.94p, 50p) : 12G
4K (autre que 59.94p, 50p) : 6G
HD (59.94p, 50p) : 3G
HD (autre que 59.94p, 50p) : 1.5G

Note

Utilisez un module conforme aux normes suivantes.

Normes SFF
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

Normes SDI
ST297/ST292/ST424/ST425/ST2081/ST2082

Le même signal que le connecteur de sortie SDI est envoyé au module SFP+.

L’appareil ne prend pas en charge l’entrée de signal de fibre optique.

Utilisez un module SFP+ pour la sortie de signal de fibre optique. Pour plus de détails sur les modules SFP+ vérifiés, contactez
votre revendeur ou votre technicien Sony.

5-041-957-23(1) Copyright 2022 Sony Corporation

* Niveau de puissance I (1,0 W)
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Connexion d’un signal tally

Cette section décrit la procédure de contrôle du signal tally.

Activation du témoin de signalisation à l’aide d’un signal provenant du pupitre de
télécommande

Vous pouvez allumer le témoin de signalisation grâce à une commande VISCA over IP depuis un dispositif externe,
comme le RM-IP500.
Réglez [Technical] > [Tally] > [Tally Control] sur [External] dans le menu Web ou le menu de la caméra.

Activation du témoin de signalisation depuis un dispositif externe

Vous pouvez allumer le témoin de signalisation de l’appareil en rouge ou en vert depuis un dispositif externe, comme le
RM-IP500 ou un commutateur-mélangeur. Vous pouvez contrôler le témoin à l’aide des commandes transmises sur le
réseau ou à l’aide de l’entrée de signaux tally depuis le connecteur OPTION de l’appareil.
Réglez [Technical] > [Tally] > [Tally Control] sur [External] dans le menu Web ou le menu de la caméra.
Lors de l’entrée d’un signal tally dans le connecteur OPTION, court-circuitez la broche 7 à la terre GND (broche 4 ou 5)
pour allumer le témoin de signalisation en vert, ou court-circuitez la broche 8 à la terre GND (broche 4 ou 5) pour allumer
le témoin de signalisation en rouge.

Note

Lorsque [Tally Control] est réglé sur [External], l’état de l’enregistrement de l’appareil n’est pas indiqué par le témoin de
signalisation.

Lorsque deux entrées de témoin, rouge et vert, sont reçues simultanément, le témoin de signalisation de l’appareil s’allume en
rouge.

Caractéristiques techniques des broches du connecteur OPTION

N° de
broche

Direction du
signal Caractéristiques techniques du signal

1 – Signal TX RS-232C (pour le contrôleur d’objectif)

2 – Signal RX RS-232C (pour le contrôleur d’objectif)

3 OUT

Sortie du témoin de signalisation vert
Sortie de faible niveau lorsque le témoin de signalisation s’allume en vert.
Hi-Z (sortie collecteur ouvert) lorsque le témoin de signalisation n’est pas
allumé en vert.
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Activation du témoin de signalisation d’un dispositif externe à l’aide d’un signal provenant
de l’appareil

Vous pouvez allumer le témoin de signalisation d’un dispositif externe à l’aide d’un signal provenant de l’appareil en
connectant les broches 3 et 6 du connecteur OPTION comme indiqué ci-dessous.
Exemple de connexion des broches 3 et 6 du connecteur OPTION

Note

N’appliquez pas une tension aux broches 7 et 8.

Ne connectez pas un dispositif externe pouvant appliquer une tension au connecteur OPTION.

Si un courant d’appel ou une tension inverse supérieur(e) à la puissance nominale est appliqué(e) aux broches 3 et 6, cela peut
entraîner un dysfonctionnement, de la fumée ou un incendie.

Réglez le signal de sortie à l’aide de [Technical] > [Tally] > [Tally Control] dans le menu Web ou le menu de la caméra.
[Internal] : état de l’opération d’enregistrement de l’appareil
[External] : AND-logique des signaux tally rouge/vert reçus de l’appareil via le signal IN ou le pupitre de télécommande.
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N° de
broche

Direction du
signal Caractéristiques techniques du signal

4 – GND (Terre)

5 – GND (Terre)

6 OUT

Sortie du témoin de signalisation rouge
Sortie de faible niveau lorsque le témoin de signalisation s’allume en rouge.
Hi-Z (sortie collecteur ouvert) lorsque le témoin de signalisation n’est pas
allumé en rouge.

7 IN
Entrée de contrôle externe de tally vert
Un court-circuit à la terre (broche 4 ou 5) fait s’allumer le témoin de signalisation de
l’appareil en vert.

8 IN
Entrée de contrôle externe de tally rouge
Un court-circuit à la terre (broche 4 ou 5) fait s’allumer le témoin de signalisation de
l’appareil en rouge.
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Sortie des données de suivi (free-d)

L’appareil peut émettre des informations de suivi du diaphragme, de la mise au point et du
panoramique/inclinaison/zoom synchronisées avec un signal de synchronisation.
La sortie des données est conforme au protocole free-d, une norme du secteur. Vous pouvez sélectionner la méthode de
sortie, en choisissant entre la sortie constante et la sortie à la demande des clients. Sélectionnez la méthode de sortie en
fonction de votre système VR/AR.

Format de sortie des données

Astuce

Les détails techniques sont fournis dans le « Manuel d’intégration de free-d ». Contactez un représentant commercial Sony.

Les données de suivi émises par l’appareil comprennent les données suivantes, conformément au format spécifié dans
le Type D0/D1 du protocole free-d.
Type D0 – poll/command

Vérifiez que l’appareil est mis sous tension.1

Définissez la méthode de sortie des données de suivi.

Pour une sortie constante

Pour la sortie à la demande des clients

2

Réglez [Technical] > [Tracking Data Output] > [Transfer Mode] sur [Always] dans le menu Web.1.
Réglez l’ID de l’appareil dans [Camera ID].2.
Spécifiez l’adresse IP de destination de sortie dans [Destination Address].3.
Spécifiez le numéro de port de la destination de sortie dans [Destination Port].4.
Appuyez sur la touche [OK].5.

Réglez [Technical] > [Tracking Data Output] > [Transfer Mode] sur [On Demand] dans le menu Web.1.
Réglez l’ID de l’appareil dans [Camera ID].2.
Spécifiez le numéro de port pour écouter les demandes des clients dans [Listen Port].3.
Appuyez sur la touche [OK].4.

Symbole Contenu Description

<D0> Message type

<CA> Camera ID

<CD> command

Prend en charge les commandes suivantes :

00 Stop stream mode
01 Start stream mode

<CK> Checksum
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Type D1 – camera position/orientation data

Note

Il se peut que les données de suivi soient retardées ou que les valeurs ne soient pas mises à jour dans les situations suivantes :

Lors de la sortie d’une vidéo RAW
Lors l’activation de la fonction S&Q Motion
Lors de l’affichage du menu de la caméra
Lors de l’affichage de l’écran des miniatures
Lors de la lecture de plans enregistrés
Lors de l’affichage du menu Web
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Symbole Contenu Description

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle Angle panoramique (−170° à +170°)

<TH><TM><TL> Camera Tilt Angle Angle d’inclinaison (−30° à +195°)

<RH><RM><TL> Camera Roll Angle Non pris en charge (toujours 0)

<XH><XM><XL> Camera X-Position Non pris en charge (toujours 0)

<YH><YM><YL> Camera Y-Position Non pris en charge (toujours 0)

<HH><HM><HL> Camera Height Non pris en charge (toujours 0)

<ZH><ZM><ZL> Camera Zoom Longueur focale

<FH><FM><FL> Camera Focus Distance de mise au point

<SH><SL> Spare/User Defined Position du diaphragme

<CK> Checksum
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Connexion d’un contrôleur d’objectif

Vous pouvez actionner le zoom d’un objectif zoom manuel à partir de l’application Web, de la RM-IP500 (option) ou de la
télécommande infrarouge en connectant un contrôleur d’objectif disponible dans le commerce (option) et compatible
avec cet appareil.
Pour plus de détails sur la connexion d’un contrôleur d’objectif, consultez le mode d’emploi du contrôleur d’objectif.
Pour plus de détails sur le réglage du zoom à l’aide d’un contrôleur d’objectif, consultez « Réglage du zoom à l’aide du
contrôleur d’objectif ».

Note

Avant d’utiliser un contrôleur d’objectif, lisez attentivement le mode d’emploi du contrôleur d’objectif et assurez-vous de bien
comprendre son utilisation. Sony ne sera pas responsable des réclamations de toute nature quelle qu’elle soit résultant de
l’utilisation d’un contrôleur d’objectif.

La fonction Clear Image Zoom n’est pas disponible lorsqu’un contrôleur d’objectif est activé. Il est recommandé de régler le
rapport Clear Image Zoom sur 1.0× ou de désactiver Clear Image Zoom.

Lorsque le contrôleur d’objectif est activé, les opérations de cadrage de la caméra ne peuvent pas être enregistrées ou lues.

Rubrique associée

Réglage du zoom à l’aide du contrôleur d’objectif

5-041-957-23(1) Copyright 2022 Sony Corporation
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Réglage du zoom à l’aide du contrôleur d’objectif

Utilisez la procédure suivante pour fixer un contrôleur d’objectif (option) et ajuster le zoom.

Pour vérifier l’état du contrôleur d’objectif
Appuyez sur la touche  (État de la caméra) dans la zone commune de l’écran de l’application Web pour afficher
l’écran d’état de la caméra.

Connectez un contrôleur d’objectif au connecteur OPTION sur le bloc de connecteur de l’appareil.

Pour plus de détails sur la fixation, consultez le mode d’emploi du contrôleur d’objectif.

1

Configurez le contrôleur d’objectif pour votre objectif zoom.

Pour plus de détails, consultez le mode d’emploi du contrôleur d’objectif.

2

Verrouillez le panoramique/l’inclinaison de l’appareil et fixez l’objectif zoom.

Pour plus de détails, consultez « Fixation d’un objectif ».

3

Ajustez le contrôleur d’objectif de manière à ce qu’il puisse faire fonctionner l’objectif zoom.4

Maintenez l’équilibre avant/arrière de la tête de caméra pour que la base coulissante soit à l’horizontale.

Pour plus de détails, consultez le mode d’emploi du contrôleur d’objectif et « Fixation d’un objectif ».

5

Réglez [Technical] > [Lens Controller] > [Setting] sur [On] dans le menu Web et appuyez sur la touche [OK].

L’appareil redémarrera. Attendez que l’opération de réinitialisation du panoramique/inclinaison soit terminée.

6

Appuyez sur la touche  (Initialisation du contrôleur d’objectif) dans l’onglet  (Others) dans
le panneau de commande de la caméra sur l’écran d’opération en direct de l’application Web.

Le contrôleur d’objectif se déplace pour détecter la plage de zoom. Pour plus de détails, consultez le mode d’emploi
du contrôleur d’objectif.
Lorsque l’indication  (Erreur du contrôleur d’objectif) passe à  (Contrôleur d’objectif prêt) en haut à gauche du
panneau d’image de la caméra, la préparation est terminée.

Note

Notez la plage de fonctionnement de l’objectif lors de l’initialisation du contrôleur d’objectif.

7

Ajustez le zoom à l’aide du curseur [Zoom] dans l’application Web ou des touches de commande de zoom
de la télécommande infrarouge.

8
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Vous pouvez vérifier l’état du contrôleur d’objectif sur cet écran.

Note

Lorsque vous changez d’objectif, initialisez le contrôleur d’objectif.

La fonction Clear Image Zoom n’est pas disponible lorsqu’un contrôleur d’objectif est activé. Il est recommandé de régler le
rapport Clear Image Zoom sur 1.0× ou de désactiver Clear Image Zoom.
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État Description

Off Utilisez le zoom motorisé dans un objectif à monture E.

Communication
Error

Une erreur de communication s’est produite entre l’appareil et le contrôleur d’objectif.
Vérifiez la connexion entre l’appareil et le contrôleur d’objectif, puis consultez le mode d’emploi du
contrôleur d’objectif et initialisez le contrôleur d’objectif.

Uninitialized Exécutez l’initialisation.

Initializing Attendez que l’initialisation soit terminée.

Initialization
Failed

Vérifiez la connexion entre l’appareil et le contrôleur d’objectif, puis consultez le mode d’emploi du
contrôleur d’objectif et initialisez le contrôleur d’objectif.

Working Contrôlez le zoom à l’aide du contrôleur d’objectif.

Rotation Error
La plage de mouvement du zoom mémorisée et la plage de mouvement de l’objectif peuvent ne
pas correspondre. Initialisez le contrôleur d’objectif.

System Error Vérifiez la connexion entre l’appareil et le contrôleur d’objectif, consultez le mode d’emploi du
contrôleur d’objectif et initialisez le contrôleur d’objectif, ou mettez l’appareil et le contrôleur
d’objectif sous tension de façon cyclique.Unknown Error
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Précautions d’utilisation

Précautions à prendre lors du transport et de l’emballage
Lors du transport ou de l’emballage de l’appareil, respectez les conditions suivantes et évitez de le soumettre à de fortes
vibrations ou à des chocs.

Retirez l’objectif et fixez le bouchon du boîtier.
Après avoir déplacé la tête de caméra (A) vers l’avant, tournez le levier de verrouillage de la tête de caméra (B) dans
la direction de la flèche pour verrouiller la tête de caméra.

Orientez la tête de caméra de manière à ce qu’elle soit vers l’avant et verrouillez-la à l’aide du levier de verrouillage
de panoramique/inclinaison.

Retirez les câbles de connexion.

Condensation
Si l’appareil est soudainement déplacé d’un endroit froid à un endroit chaud, ou si la température ambiante augmente
brusquement, de l’humidité peut se former sur la surface externe de l’appareil et/ou à l’intérieur de l’appareil. Ce
phénomène est connu sous le nom de condensation. Si de la condensation se produit, mettez l’appareil hors tension et
patientez le temps que la condensation disparaisse avant d’utiliser l’appareil. L’utilisation de l’appareil avec de la
condensation pourrait endommager l’appareil.

Phénomènes spécifiques aux capteurs d’images CMOS de caméra

Note

Les phénomènes suivants, qui peuvent se produire sur les images, sont propres aux capteurs d’images. Ils n’indiquent en aucun
cas un dysfonctionnement.
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Taches blanches
Bien que les capteurs d’image soient produits au moyen de technologies haute précision, il se peut dans de rares cas
que des mouchetures blanches apparaissent sur l’écran, provoquées par des rayons cosmiques, etc.
Ceci est un phénomène relatif aux capteurs d’image et ne représente pas un mauvais fonctionnement. Exécutez
régulièrement APR.
Les taches blanches sont surtout visibles dans les cas suivants :

Lors du fonctionnement à haute température ambiante
Lorsque vous avez augmenté le gain (la sensibilité)

Scintillement
Si la prise de vue est effectuée sous un éclairage fluorescent, des lampes au sodium, à vapeur de mercure ou LED,
l’écran peut scintiller ou les couleurs peuvent varier.

Unités de lecture de panoramique/inclinaison et de l’objectif
Si l’objectif et le mécanisme d’entraînement panoramique/inclinaison ne sont pas utilisés pendant une durée prolongée,
la viscosité de la graisse appliquée à l’intérieur peut augmenter, empêchant le mécanisme de bouger. Actionnez le
mécanisme de pivotement panoramique/inclinaison et l’objectif régulièrement.

Concernant les pièces consommables
Le ventilateur et la batterie rechargeable intégrée sont des consommables qui doivent être régulièrement remplacés.
Lorsque vous utilisez l’appareil à température ambiante, le cycle de remplacement est d’environ 5 ans. Mais, ce cycle
de remplacement ne représente qu’une indication et ne garantit pas la durée de vie de ces consommables.
Pour plus de détails sur le remplacement de ces pièces, veuillez contacter votre revendeur.

La durée de vie l’adaptateur CA et du condensateur électrolytique est de 5 ans environ, sous des températures de
fonctionnement normales et pour un usage normal (8 heures par jour, 25 jours par mois). Si l’utilisation dépasse la
fréquence d’utilisation normale, la durée de vie peut être réduite en conséquence.

Des inspections périodiques sont recommandées pour que l’appareil continue à fonctionner correctement et pour
prolonger la durée de son utilisation. Pour plus de détails sur les inspections, veuillez contacter un technicien Sony.

A propos de la batterie rechargeable intégrée
L’appareil possède une batterie rechargeable intégrée afin de stocker la date, l’heure et d’autres réglages, même lorsque
l’appareil est éteint. La batterie rechargeable intégrée sera chargée après 24 h si l’appareil est connecté à une prise
électrique grâce à l’adaptateur CA, ou s’il est alimenté via PoE++, que l’appareil soit allumé ou éteint. La batterie
rechargeable sera entièrement déchargée après environ 2 mois si l’adaptateur CA n’est pas branché à une source
d’alimentation. Utilisez votre appareil après avoir chargé la batterie. Néanmoins, même si la batterie rechargeable n’est
pas chargée, le fonctionnement de l’appareil n’est pas affecté tant que vous n’avez pas besoin d’enregistrer la date.

Emplacements d’utilisation et de stockage
Stockez dans un lieu aéré et de niveau.
Évitez d’utiliser ou de stocker l’unité dans les endroits suivants.

Lieux où l’appareil pourrait être mouillé (même sous une corniche).
À l’extérieur et lieux où la température dépasse 40 °C (104 °F)
N’oubliez pas qu’en été, dans les climats chauds, la température à l’intérieur d’un véhicule aux vitres fermées peut
facilement dépasser 50 °C (122 °F).
Lieux où la température est inférieure à 0 °C (32 °F).
Les endroits humides ou poussiéreux. Lieux où l’appareil pourrait recevoir la pluie
Lieux soumis à des vibrations ou à des chocs.
Lieux dans lesquels sont générés des rayons X, des radiations et des champs magnétiques puissants.
À proximité d’émetteurs radio ou de télévision générant de puissants champs magnétiques
Sous la lumière directe du soleil ou à proximité de chauffages pendant de longues périodes

Remarque sur les faisceaux laser

469



Les faisceaux laser peuvent endommager le capteur d’image CMOS. Si vous filmez une scène comprenant un faisceau
laser, veillez à ce que celui-ci ne soit pas dirigé directement vers le capteur d’image CMOS de la caméra. En particulier,
les faisceaux laser haute puissance provenant de dispositifs médicaux ou d’autres dispositifs peuvent causer des
dommages dus à la lumière réfléchie et à la lumière diffuse.

Pour empêcher les interférences électromagnétiques dues aux dispositifs de communication
portables
L’utilisation des téléphones portables et d’autres dispositifs de communication à proximité de cet appareil peut provoquer
des dysfonctionnements et des interférences avec les signaux audio et vidéo. Il est recommandé de désactiver les
dispositifs de communication portables à proximité de cet appareil.

Ne placez pas ce produit près d’appareils médicaux
Ce produit (y compris les accessoires) comporte un ou des aimants qui peuvent perturber les stimulateurs cardiaques,
les valves de dérivation programmables pour le traitement de l’hydrocéphalie ou d’autres appareils médicaux. Ne placez
pas ce produit près de personnes utilisant ce type d’appareil médical. Consultez votre médecin avant d’utiliser ce produit
si vous utilisez ce type d’appareil médical.

Mesures de sécurité
SONY NE PEUT ÊTRE TENUE RESPONSABLE DE TOUT DOMMAGE, DE QUELQUE NATURE QUE CE SOIT,
RÉSULTANT D’UNE INCAPACITÉ À METTRE EN PLACE DES MESURES DE SÉCURITÉ ADAPTÉES POUR LES
DISPOSITIFS DE TRANSMISSION, DE FUITES DE DONNÉES INÉVITABLES DUES AUX SPÉCIFICATIONS DE
TRANSMISSION OU DE TOUT AUTRE PROBLÈME DE SÉCURITÉ.
Selon l’environnement d’exploitation, il est possible que des tiers non autorisés sur le réseau puissent accéder à
l’appareil. Avant de connecter l’appareil au réseau, vérifiez que le réseau est bien protégé.
Pour des raisons de sécurité, lors de l’utilisation de cet appareil connecté au réseau, il est fortement recommandé
d’accéder à la fenêtre de commande via un navigateur Web et de modifier la limitation d’accès des valeurs d’usine
préréglées. Il est recommandé de définir un mot de passe avec une chaîne de caractères suffisamment longue,
difficile à deviner par les autres, et de le stocker en toute sécurité.
Lorsque vous connectez ce produit à un réseau, connectez-le via un système fournissant une fonction de protection,
tel qu’un routeur ou un pare-feu. Si vous vous connectez sans cette protection, des problèmes de sécurité pourraient
survenir.

Alimentation
Cet appareil n’est pas équipé d’un commutateur d’alimentation. Pour éteindre l’appareil, vérifiez que toutes les
opérations sont terminées et que l’appareil est en état de veille de l’alimentation électrique, puis débranchez
l’adaptateur CA. Lors de l’utilisation d’une alimentation PoE++, débranchez le câble LAN.
Si possible, utilisez une source d’alimentation depuis laquelle il est facile de brancher et débrancher la fiche
d’alimentation.
Si vous utilisez une prise dans un lieu poussiéreux, nettoyez la zone autour de la prise régulièrement pour éviter les
marques de claquage.
Débranchez la source d’alimentation électrique lorsqu’elle n’est pas utilisée.

Précautions concernant les parties mobiles
Assurez-vous que des corps étrangers ne pénètrent pas les parties mobiles.
N’appliquez pas un poids trop important en bougeant manuellement les parties mobiles. Cela pourrait entraîner un
dysfonctionnement.
N’obstruez pas le mouvement des parties mobiles. Cela pourrait provoquer une blessure ou un dysfonctionnement.
Les parties mobiles peuvent ne pas fonctionner normalement si l’appareil n’est pas utilisé durant une période
prolongée. Utilisez régulièrement les fonctions panoramique/inclinaison de l’appareil.

Précautions pour le fonctionnement en continu
L’appareil peut être alimenté 24 heures/24, 365 jours par an (état de veille).
Effectuez toujours un test de prise de vue et vérifiez que l’appareil fonctionne normalement.

La prise de vue en continu pendant des périodes supérieures à 24 heures n’est pas garantie.
Si la prise de vue dure plus de 24 heures, mettez l’appareil en veille, puis redémarrez-le.
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Notez que Sony ne sera pas responsable d’une compensation quelle qu’elle soit pour le contenu des images si vous
n’êtes pas en mesure de filmer en raison d’un dysfonctionnement lors de l’utilisation de cet appareil.
Vérifiez toujours que l’appareil fonctionne correctement avant l’utilisation. SONY NE PEUT ÊTRE TENUE
RESPONSABLE DE TOUT DOMMAGE, DE QUELQUE NATURE QUE CE SOIT, Y COMPRIS MAIS SANS
LIMITATION, LA COMPENSATION OU LE REMBOURSEMENT SUITE À LA PERTE DES BÉNÉFICES PRÉSENTS
ET À VENIR RÉSULTANT D’UN DYSFONCTIONNEMENT DE CET APPAREIL NI PENDANT LA PÉRIODE DE
GARANTIE OU UNE FOIS LE DÉLAI DE GARANTIE EXPIRÉ OU POUR TOUTE AUTRE RAISON QUE CE SOIT.
SONY N’ASSUMERA PAS DE RESPONSABILITÉ POUR LES RÉCLAMATIONS, QUELLE QU’ELLES SOIENT,
EFFECTUÉES PAR LES UTILISATEURS DE CET APPAREIL OU PAR DES TIERCES PARTIES.
SONY N’ASSUMERA PAS DE RESPONSABILITÉ POUR LA CESSATION OU L’INTERRUPTION DE TOUT
SERVICE LIÉ À CET APPAREIL, RÉSULTANT DE QUELQUE CIRCONSTANCE QUE CE SOIT.

Précaution concernant la fonction d’enregistrement
Effectuez toujours un essai d’enregistrement pour vérifier que l’enregistrement s’est fait correctement. SONY
N’ASSUMERA PAS DE RESPONSABILITÉ POUR LES DOMMAGES DE QUELQUE SORTE QU’ILS SOIENT,
INCLUANT MAIS NE SE LIMITANT PAS À LA COMPENSATION OU AU REMBOURSEMENT, SUITE AU
MANQUEMENT DE CET APPAREIL OU DE SON SUPPORT D’ENREGISTREMENT, OU DE TOUT AUTRE
SUPPORT OU SYSTÈME DE MÉMOIRE À ENREGISTRER UN CONTENU DE TOUT TYPE.
Vérifiez toujours que l’appareil fonctionne correctement avant l’utilisation. SONY NE PEUT ÊTRE TENUE
RESPONSABLE DE TOUT DOMMAGE, DE QUELQUE NATURE QUE CE SOIT, Y COMPRIS MAIS SANS
LIMITATION, LA COMPENSATION OU LE REMBOURSEMENT SUITE À LA PERTE DES BÉNÉFICES PRÉSENTS
ET À VENIR RÉSULTANT D’UN DYSFONCTIONNEMENT DE CET APPAREIL NI PENDANT LA PÉRIODE DE
GARANTIE OU UNE FOIS LE DÉLAI DE GARANTIE EXPIRÉ OU POUR TOUTE AUTRE RAISON QUE CE SOIT.
SONY N’ASSUMERA PAS DE RESPONSABILITÉ POUR LES RÉCLAMATIONS, QUELLE QU’ELLES SOIENT,
EFFECTUÉES PAR LES UTILISATEURS DE CET APPAREIL OU PAR DES TIERCES PARTIES.
SONY N’ASSUMERA PAS DE RESPONSABILITÉ POUR LA PERTE, LA RÉPARATION OU LA REPRODUCTION
DE TOUTES DONNÉES ENREGISTRÉES SUR LE SYSTÈME DE MÉMOIRE INTÉRIEUR, LE SUPPORT
D’ENREGISTREMENT OU TOUT AUTRE SUPPORT OU SYSTÈME DE MÉMOIRE.
SONY N’ASSUMERA PAS DE RESPONSABILITÉ POUR LA CESSATION OU L’INTERRUPTION DE TOUT
SERVICE LIÉ À CET APPAREIL, RÉSULTANT DE QUELQUE CIRCONSTANCE QUE CE SOIT.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Formats de sortie et limites

Cette section décrit les formats de sortie et limites.

Note

La résolution du format de sortie est limitée par les réglages [Project] > [Rec Format] > [Frequency], [Codec], et [Video Format]
accessibles depuis le menu Web ou le menu de la caméra.

La résolution du format de sortie est également limitée par l’association à la fréquence d’images S&Q. En plus du tableau des
formats de sortie du connecteur SDI OUT/HDMI OUT ci-dessous, la sortie HDMI passe en Full HD ou inférieur lorsque toutes les
conditions suivantes sont réunies.

[Shooting] > [S&Q Motion] > [Setting] est réglé sur [On]
[Shooting] > [S&Q Motion] > [Frame Rate] est supérieur à 60fps

Lorsque les conditions ci-dessus sont réunies, les options de sélection 4096×2160P et 3840×2160P de la sortie HDMI pour
[Monitoring] > [Output Format] > [SDI/HDMI] sont grisées et ne peuvent pas être sélectionnées.

L’image n’est pas émise si une résolution supérieure à celle de l’image de lecture est configurée.

Formats de sortie du connecteur SDI OUT/HDMI OUT

Lorsque la fréquence de système est de 50/59.94 Hz

Réglage Format de sortie sélectionnable

Mode
d’enregistrement/lecture

Résolution de sortie RAW/
Résolution d’enregistrement

interne
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P (par
défaut)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P (par
défaut)
1920×1080i
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Lorsque la fréquence de système est de 25/29.97 Hz

Réglage Format de sortie sélectionnable

Mode
d’enregistrement/lecture

Résolution de sortie RAW/
Résolution d’enregistrement

interne
SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A) (par
défaut)

1920×1080P (par
défaut)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A) (par
défaut)

1920×1080P (par
défaut)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A) (par
défaut)

1920×1080P (par
défaut)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Sortie arrêtée)
720×480P2)

720×576P3)

L’affichage de l’écran ne peut pas être superposé.1)

Lorsque la fréquence de système est de 59.942)

Lorsque la fréquence de système est de 503)
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Lorsque la fréquence de système est de 23.98 Hz

Réglage Output Format (résolution de sortie)

Mode
d’enregistrement/lecture

Résolution de sortie RAW/
Résolution d’enregistrement

interne
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i (par
défaut)

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
1920×1080i (par
défaut)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (par
défaut)

1920×1080i (par
défaut)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (par
défaut)

1920×1080i (par
défaut)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Réglage Output Format (résolution de sortie)

Mode
d’enregistrement/lecture

Résolution de sortie RAW/
Résolution d’enregistrement

interne
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P (par
défaut)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P (par
défaut)
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Lorsque la fréquence de système est de 24 Hz

5-041-957-23(1) Copyright 2022 Sony Corporation

Réglage Output Format (résolution de sortie)

Mode
d’enregistrement/lecture

Résolution de sortie RAW/
Résolution d’enregistrement

interne
SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P (par
défaut)

1920×1080P (par
défaut)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P (par
défaut)

1920×1080P (par
défaut)

1920×1080
1920×1080P (par
défaut)

1920×1080P (par
défaut)

Réglage Output Format (résolution de sortie)

Mode
d’enregistrement/lecture

Résolution de sortie RAW/
Résolution d’enregistrement

interne
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P (par
défaut)

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P (par
défaut)

4096×2160P
1920×1080P (par
défaut)
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Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Dépannage

Alimentation

Sortie d’image

Symptôme Cause Solution

L’appareil ne se
met pas sous
tension.

L’adaptateur CA n’est pas bien branché au
connecteur DC IN.

Insérez à fond le cordon d’alimentation.

Le cordon d’alimentation CA n’est pas bien
inséré dans l’adaptateur CA ou la prise CA.

Insérez à fond le cordon d’alimentation.

Le câble LAN n’est pas bien connecté entre le
dispositif d’alimentation électrique PoE++ et
l’appareil.

Vérifiez que le câble est inséré jusqu’à ce qu’il
se verrouille.

Le câble LAN est connecté au connecteur
OPTION, mais pas au connecteur LAN.

Connectez le câble LAN au connecteur LAN
correctement.

L’appareil est connecté à un dispositif
d’alimentation électrique qui ne prend pas en
charge PoE++ (conforme à la norme
IEEE802.3bt, Type 4, Classe 8).

Connectez l’appareil à un dispositif
d’alimentation électrique qui prend en charge
PoE++ (conforme à la norme IEEE802.3bt,
Type 4, Classe 8).

La consommation électrique totale dépasse la
puissance maximale du dispositif d’alimentation
électrique PoE++.

Consultez le mode d’emploi du dispositif
d’alimentation électrique PoE++.

Un câble réseau avec une catégorie de
puissance qui ne prend pas en charge
l’alimentation électrique PoE++ est connecté.

Utilisez un câble réseau de catégorie 5e ou
supérieure connecté au connecteur LAN.

La caméra, le dispositif d’alimentation électrique
PoE++ et les périphériques ne sont pas
connectés à la terre.

Connectez la caméra, le dispositif
d’alimentation nominale PoE++ et les
périphériques à la terre.

Symptôme Cause Solution

Aucune image n’est émise.

Les dispositifs connectés ne sont pas connectés
correctement.

Connectez les dispositifs
connectés correctement.

La configuration initiale n’est pas terminée.
Terminez la configuration
initiale à l’aide de l’application
Web.
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Pupitre de télécommande

Télécommande infrarouge

Symptôme Cause Solution

Aucune image n’est émise
du connecteur HDMI.

Un signal non pris en charge par le dispositif de
destination de sortie HDMI est configuré.

Modifiez le réglage du format
de sortie HDMI ou utilisez un
dispositif qui prend en charge
le signal de sortie.

Un câble qui ne prend pas en charge la sortie HDMI
standard est utilisé.

Utilisez un câble qui prend en
charge la sortie HDMI
standard utilisée.

Aucune image n’est émise
du connecteur SDI.

Un câble qui ne prend pas en charge la sortie SDI
standard est utilisé.

Utilisez un câble qui prend en
charge la sortie SDI utilisée.

Le moniteur connecté au connecteur SDI ne prend pas
en charge le signal de sortie.

Utilisez un moniteur qui prend
en charge la sortie SDI
standard.

Le format d’enregistrement est réglé pour la sortie
RAW.

Modifiez le format
d’enregistrement à un réglage
autre que la sortie RAW.

La sortie HDMI est réglée sur résolution SD. Réglez la sortie HDMI sur une
résolution autre que SD.

Aucune image n’est émise
de la fibre optique ou
l’image est déformée.

Le module utilisé n’est pas conforme aux normes SFF
ou SMPTE, ou ne satisfait pas au niveau de puissance
I (1,0 W).

Consultez « Sortie d’un signal
de fibre optique. »

Aucune image n’est émise
ou ni déformée lors de
l’utilisation d’une
synchronisation externe.

Un signal de synchronisation externe compatible au
format du signal vidéo configuré n’est pas émis.

Entrez un signal de
synchronisation externe
compatible au format du signal
vidéo.

Il y a du bruit dans l’audio.

La caméra, le dispositif d’alimentation électrique
PoE++ et les périphériques ne sont pas connectés à la
terre.

Connectez l’appareil, le
dispositif d’alimentation
nominale PoE++ et les
périphériques à la terre.

L’appareil est utilisé dans un environnement avec des
dispositifs qui génèrent des champs électriques et
magnétiques puissants (comme les antennes des
émetteurs TV/radio, les émetteurs de radio-amateur,
les moteurs de climatiseur, les transformateurs
d’alimentation).

Maintenez éloigné des
dispositifs qui génèrent des
champs électriques et
magnétiques puissants.

L’objectif, le support d’objectif et l’unité de lecture sont
en contact avec l’appareil ou un objet dans le milieu
environnant et un bruit anormal est émis.

Fixez l’objectif
correctement.

Vérifiez qu’il n’y a aucun
obstacle à proximité de la
caméra.
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RM-IP500

Application Web

Symptôme Cause Solution

La télécommande infrarouge ne
fonctionne pas lorsqu’elle est
actionnée.

L’utilisation de la télécommande
infrarouge est désactivée.

Réglez [Technical] > [IR Remote] >
[Setting] sur [On] dans le menu Web.

La pile est déchargée ou la polarité de
la pile est incorrecte.

Faites fonctionner la télécommande
infrarouge à proximité du capteur
infrarouge de l’appareil. Si la LED
d’alimentation clignote, remplacez la
pile.

La configuration initiale n’est pas
terminée.

Terminez la configuration initiale à l’aide
de l’application Web.

La vitesse d’opération de
panoramique/inclinaison est
lente.

La vitesse panoramique/inclinaison de
la télécommande infrarouge est réglée
sur le mode normal.

Mettez le commutateur SETUP 4 sur la
position ON sur le bloc de connecteur
de l’appareil.

L’opération a ciblé une caméra
autre que la caméra souhaitée.

Le signal infrarouge a été reçu d’une
caméra autre que la caméra
souhaitée.

Réglez [Technical] > [IR Remote] >
[Setting] sur [Off] dans le menu Web de
la caméra que vous ne souhaitez pas
contrôler.

Symptôme Cause Solution

La caméra ne peut pas être
commandée par le pupitre de
télécommande RM-IP500.

L’alimentation de la caméra
n’est pas connectée.

Vérifiez que le témoin POWER de l’appareil
s’allume en vert ou en orange.

La caméra ou le pupitre de
télécommande n’est pas
connecté au réseau.

Vérifiez les connexions de l’appareil et du
pupitre de télécommande.

La configuration initiale de la
caméra n’est pas terminée.

Terminez la configuration initiale à l’aide de
l’application Web.

La communication VISCA
over IP n’est pas activée.

Mettez le commutateur SETUP 3 sur la
position ON sur le panneau de connecteur de
l’appareil et redémarrez l’appareil.

L’adresse IP de la caméra a
changé.

Vérifiez l’adresse IP de la caméra à l’aide de
[Network] > [Wired LAN] dans le menu Web ou
le menu de la caméra.

L’adresse IP de la caméra a changé
en utilisant AUTO IP SETUP sur le
pupitre de télécommande RM-IP500.

Au moins 20 minutes se sont
écoulées depuis le
démarrage de la caméra.

Redémarrez l’appareil. L’adresse IP peut être
changée en utilisant AUTO IP SETUP durant
les 20 premières minutes après le démarrage
de l’appareil.
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Symptôme Cause Solution

Impossible de se connecter à l’aide
d’un navigateur Web.

Aucun câble LAN de catégorie
5e ou supérieure n’est
connecté.

Connectez un câble LAN de catégorie 5e ou
supérieure.

Connexion LAN incorrecte ou
le réseau connecté ne
fonctionne pas normalement.

Vérifiez que la LED Link pour le connecteur
LAN est allumée. Si la LED Link n’est pas
allumée, contactez votre administrateur
réseau.

L’alimentation de la caméra
n’est pas connectée.

Consultez la section « Alimentation » ci-
dessus.

Une adresse IP valide n’est pas
configurée pour l’appareil.

Effectuez une réinitialisation du réseau.

L’adresse IP configurée est en
cours d’utilisation sur un autre
dispositif.

Vérifiez que les adresses IP des
périphériques sont uniques.

Le masque de sous-réseau
configuré ne correspond pas au
sous-réseau utilisé.

Effectuez une réinitialisation du réseau.

L’appareil est en cours d’accès
sur le même réseau local via
un serveur proxy.

Modifiez la configuration pour qu’un serveur
proxy ne soit pas utilisé.

La passerelle par défaut
configurée pour l’appareil est
incorrecte.

Effectuez une réinitialisation du réseau.

L’URL saisie est incorrecte. Saisissez l’URL correcte et réessayez.

Le port HTTP est incorrect.

Affichez le menu de la caméra sur un
moniteur externe et vérifiez le réglage de
[Network] > [Wired LAN] > [HTTP Port]. Si
une valeur autre que 80 est configurée,
ajoutez le numéro de port HTTP au nom
d’hôte ou de l’adresse IP saisie dans le
navigateur Web.
Exemple : si le port HTTP est réglé sur 8080,
saisissez http://<Adresse IP>:8080

Le numéro de port HTTP de
l’appareil est filtré ou bloqué.

Modifiez le numéro de port HTTP de
l’appareil à un port qui n’est pas filtré ou
bloqué.

L’ancien cache du navigateur
Web a un effet négatif.

Supprimez le cache du navigateur Web.
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Symptôme Cause Solution

Impossible de se connecter à
l’application Web à l’aide du code
2D (code QR).

Le dispositif en cours
d’utilisation ne prend pas en
charge mDNS.

Utilisez un dispositif qui prend en charge
mDNS.
Si vous utilisez un appareil ne prenant pas en
charge mDNS, saisissez l’adresse IP
directement sur le navigateur Web.

La tablette ou l’ordinateur est
connecté à un réseau différent
de celui de la caméra.

Connectez la tablette ou l’ordinateur au
même réseau que celui de l’appareil.

Impossible de se connecter à
l’application Web en saisissant
manuellement l’URL.

Le dispositif en cours
d’utilisation ne prend pas en
charge mDNS.

Utilisez un dispositif qui prend en charge
mDNS.

La tablette ou l’ordinateur est
connecté à un réseau différent
de celui de la caméra.

Connectez la tablette ou l’ordinateur au
même réseau que celui de l’appareil.

L’écran d’authentification s’affiche
en permanence.

Le nom d’utilisateur ou le mot
de passe correct n’a pas été
saisi.

Saisissez le nom d’utilisateur et le mot de
passe enregistrés. Si vous avez oublié les
informations utilisateur enregistrées,
consultez « Commutateur RESET » dans
« Bloc de connecteur » afin d’initialiser les
informations utilisateur pour la connexion
réseau.

Le nom d’utilisateur et le mot
de passe peuvent avoir été
modifiés par un utilisateur qui
s’est connecté à l’aide d’un
autre navigateur Web.

Vérifiez le nom d’utilisateur et le mot de
passe correct avec l’administrateur de
l’appareil.

L’image de la caméra n’est pas
affichée sur l’application Web.

La sortie HDMI de la caméra
est réglée sur 720×480 ou
720×576.

Modifiez la résolution de la sortie HDMI de
l’appareil.

Un moniteur HDMI qui ne
prend pas en charge le signal
de sortie HDMI de la caméra
est connecté.

Supprimez le moniteur HDMI ou utilisez un
moniteur HDMI qui prend en charge les
réglages de sortie HDMI.

L’appareil a été redémarré et la
session a été déconnectée.

Attendez environ une minute et rechargez le
navigateur Web.

L’ancien cache du navigateur
Web a un effet négatif.

Supprimez le cache du navigateur Web.

La résolution d’image de la caméra
affichée dans l’application Web est
faible.

La résolution du flux vidéo 3
utilisé par l’application Web est
faible.

Augmentez la valeur à l’aide de [Stream] >
[Video Stream] > [Size 3] dans le menu Web.

Le menu de la caméra n’apparaît
pas lorsque vous appuyez sur la
touche [Menu].

Le menu de la caméra est
configuré pour ne pas être
incorporé dans le signal de
sortie HDMI.

Réglez [Monitoring] > [Output Display] >
[HDMI/Stream] sur [On] dans le menu Web.
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Prise de vue

Caméra

Symptôme Cause Solution

La valeur d’un réglage dans l’écran
des réglages n’est pas mise à
jour/affichée correctement.

L’écran des réglages de
l’application Web ne reflète pas
automatiquement les réglages
modifiés dans une autre
application Web.

Appuyez sur la touche [Reload] en bas de
l’écran des réglages de l’application Web. Les
valeurs des réglages sur l’écran de
configuration affiché sont rechargées et
mises à jour.

Les réglages des fichiers
Internet temporaires ont un
effet négatif.

Supprimez le cache du navigateur Web.

Impossible de télécharger le fichier
de configuration ou le journal.

La fonction du navigateur Web
de téléchargement de fichier
est désactivée.

Activez la fonction du navigateur Web de
téléchargement de fichier.

L’écran des réglages de
l’application Web est accessible,
mais il est impossible d’effectuer
des opérations sur l’écran
d’opération en direct et sur l’écran
d’opération de lecture.

L’écran d’opération de
l’application Web est verrouillé.

Réglez le commutateur de verrouillage
d’opération en haut à droite dans l’application
Web à la position  (Opération
déverrouillée).

L’écran de l’application Web prend
un certain temps pour s’afficher.

L’image en diffusion continue
de l’appareil est visualisée par
plusieurs utilisateurs
simultanément.

Réduisez le nombre d’utilisateurs qui peuvent
accéder à l’application Web simultanément.

L’image est déformée ou saccadée.

L’information vidéo n’est pas
transmise correctement en
raison d’encombrement dans le
chemin de communication.

Réduisez le débit binaire de la diffusion en
continu, réglez [Video Stream 3] > [Size] sur
la plus petite option, ou réduisez le débit pour
créer une marge entre les bandes de
communications.

Plusieurs navigateurs Web sont
en cours d’exécution sur la
tablette et occupent de la
mémoire.

Fermez tous les navigateurs Web qui
fonctionnent en arrière-plan.

Il y a trop d’onglets ouverts
dans le navigateur Web, ce qui
ralentit le fonctionnement.

Fermez les onglets qui ne sont pas utilisés.

L’accumulation excessive dans
le cache du navigateur Web et
l’historique de navigation
ralentit le fonctionnement.

Supprimez le cache du navigateur Web.

Symptôme Cause Solution

L’image semble déformée au début et à la fin
de l’opération de panoramique/inclinaison.

L’image peut être déformée si la
fonction de stabilisation d’image de
l’objectif est activée.

Désactivez la fonction de
stabilisation d’image de
l’objectif.

L’angle de vue a changé sans l’intervention
d’un utilisateur.

Une respiration de l’objectif s’est
produite.

Consultez « Compensation
de la respiration ».
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Panoramique/inclinaison

Symptôme Cause Solution

Impossible d’utiliser la mise au point, le
zoom ou le diaphragme.

Le réglage des commutateurs sur
l’objectif peut être incorrect.

Consultez « Vérification des
commutateurs d’objectif ».

Symptôme Cause Solution

Impossible de réinitialiser le
panoramique/inclinaison.

Le levier de verrouillage de
panoramique/inclinaison est en
position LOCK.

Faites glisser le levier de verrouillage de
panoramique/inclinaison en position UNLOCK.

La caméra ne s’arrête pas
dans la position prévue.

Le bloc de caméra est
déséquilibré.

Déplacez le bloc de caméra vers l’avant/l’arrière
sur la position appropriée comme indiqué dans
« Fixation d’un objectif », puis remettez
l’appareil sous tension.

Un objectif qui ne prend pas en
charge le panoramique/inclinaison
est fixé.

Consultez les informations sur la compatibilité
de l’objectif et fixez un objectif qui prend en
charge le panoramique/inclinaison, puis
remettez l’appareil sous tension.

Impossible d’exécuter la
réinitialisation de
panoramique/inclinaison. Exécutez une réinitialisation de

panoramique/inclinaison comme indiqué dans
« Réinitialisation de panoramique/inclinaison ».

Une force inattendue a été exercée
sur la tête de caméra, provoquant
une erreur de commande de
panoramique/inclinaison.

La caméra ne revient pas à
l’avant lorsque la touche

(panoramique/inclinaison
initiale) est enfoncée.

Le mode montage au plafond a été
activé.

Réglez [Pan-Tilt] > [P/T Direction] > [Ceiling]
dans le menu Web en fonction de l’installation
réelle, puis remettez l’appareil sous tension.
Lorsque la caméra est montée au plafond, le
bloc de connecteur sera à l’avant de la caméra.

L’opération de
panoramique/inclinaison est
restreinte.

La limite de plage de
panoramique/inclinaison est
configurée.

Effacez les réglages de limite de plage de
panoramique/inclinaison si nécessaire comme
indiqué dans « P/T Range Limit ».

Une force inattendue a été exercée
à la tête de caméra, provoquant
une erreur de
panoramique/inclinaison.

Exécutez une réinitialisation de
panoramique/inclinaison comme indiqué dans
« Réinitialisation de panoramique/inclinaison ».

L’opération de
panoramique/inclinaison s’est
déplacée dans la direction
opposée.

Le réglage du mode montage au
plafond est différent de l’état de
montage réel.

Réglez [Pan-Tilt] > [P/T Direction] > [Ceiling]
dans le menu Web en fonction de l’installation
réelle.

Les réglages liés à la direction de
panoramique/inclinaison ont
changé.

Vérifiez les réglages [Pan-Tilt] > [P/T Direction]
dans le menu Web.
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Symptôme Cause Solution

L’image ne se déplace pas de
manière fluide au début et à
la fin de l’opération de
panoramique/inclinaison.

Le réglage
d’accélération/décélération de
l’opération de
panoramique/inclinaison est trop
élevé.

Réduisez le réglage d’accélération/décélération
de l’opération de panoramique/inclinaison pour
rendre le mouvement plus fluide au début et à
la fin de l’opération de panoramique/inclinaison
à l’aide de [Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] dans le menu Web ou le menu
de la caméra. Notez que cela signifie que
l’objectif prend plus de temps pour atteindre la
vitesse maximale.

L’opération de
panoramique/inclinaison s’est
arrêtée.

Le bloc de caméra est
déséquilibré.

Déplacez le bloc de caméra vers l’avant/l’arrière
sur la position appropriée comme indiqué dans
« Fixation d’un objectif », puis remettez
l’appareil sous tension.

Le réglage de la courbe de rampe
(accélération/décélération) est trop
élevé pour l’objectif fixé.

Si un grand objectif est fixé, réduisez la valeur
de [Pan-Tilt] > [P/T Acceleration] > [Ramp
Curve] dans le menu Web ou le menu de la
caméra.

Un grand objectif est utilisé. Contactez votre technicien Sony.

L’appareil est bloqué lorsque
le panoramique/inclinaison
est utilisé.

Le levier de serrage de la vis de
fixation de la base du support
d’objectif heurte la caméra.

Pivotez le levier de serrage de la vis de fixation
de la base du support d’objectif pour qu’il pointe
vers le haut.

Le levier de serrage du support
d’objectif heurte la caméra.

Pivotez le levier de serrage du support d’objectif
pour qu’il pointe vers le haut.

Le levier de verrouillage de la tête
de caméra heurte la caméra.

Vérifiez que le levier de verrouillage de la tête
de caméra est complètement en position LOCK.

Un bruit anormal se produit
pendant l’opération de
panoramique/inclinaison.

La caméra est déséquilibrée.
Déplacez la tête de caméra vers l’avant/l’arrière
sur la position appropriée pour que la base de
la glissière soit à l’horizontale.

Le réglage de la courbe de rampe
(accélération/décélération) est trop
élevé pour l’objectif fixé.

Si un grand objectif est fixé, réduisez la valeur
de [Pan-Tilt] > [P/T Acceleration] > [Ramp
Curve] dans le menu Web ou le menu de la
caméra.

La tête de caméra n’est pas bien
fixée et il y a un bruit de
mouvement pendant l’opération.

Réglez le levier de verrouillage de la tête de
caméra sur la position LOCK.

Impossible de sauvegarder
une position prédéfinie.

Il n’est pas possible de
sauvegarder un préréglage si
l’option Clear Image Zoom est
utilisée.

Réglez le rapport Clear Image Zoom sur 1×.
(état dans lequel le rapport n’est pas affiché à
droite de  (Rapport de zoom))
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Enregistrement / lecture

Symptôme Cause Solution

Le cadrage est décalé lors de
la lecture d’une position
prédéfinie.

La température de l’environnement
peut avoir changé de manière
significative entre le moment où
une position prédéfinie a été
sauvegardée et le moment où elle
est lue.

Sauvegardez à nouveau la position prédéfinie.

L’étalonnage de l’objectif n’est pas
effectué.

Lancez l’étalonnage à l’aide de [Technical] >
[Lens] > [Lens Calibration] dans le menu de la
caméra.

L’objectif installé est différent de
celui qui était installé lors de la
sauvegarde du préréglage. Ou la
position de zoom pour le zoom
manuel est différente.

Sauvegardez à nouveau la position prédéfinie.

Le panneau de commande du
cadrage de l’application Web
est grisé et ne peut pas être
utilisé.

L’opération de
panoramique/inclinaison est
indisponible pendant l’affichage de
l’écran des miniatures et pendant
la lecture.

Affichez l’écran de contrôle de la lecture et
quittez l’affichage de l’écran des miniatures ou
arrêtez la lecture.

L’opération de
panoramique/inclinaison est
indisponible lorsque l’image de la
caméra ne peut pas être affichée
dans l’application Web.

Consultez « Application Web » dans
« Dépannage. »

Le levier de verrouillage de
panoramique/inclinaison est en
position LOCK.

Faites glisser le levier de verrouillage de
panoramique/inclinaison en position UNLOCK.

« Execute Pan-Tilt Reset »
est affiché sous le panneau
de commande du cadrage
dans l’application Web.

Une force inattendue a été exercée
à la tête de caméra, provoquant
une erreur de
panoramique/inclinaison.

Exécutez une réinitialisation de
panoramique/inclinaison comme indiqué dans
« Réinitialisation de panoramique/inclinaison ».

Symptôme Cause Solution

L’enregistrement ne démarre
pas lorsque vous appuyez
sur la touche
d’enregistrement
START/STOP.

La carte mémoire est pleine.
Remplacez la carte mémoire par une autre
possédant suffisamment d’espace.

La carte mémoire nécessite une
restauration.

Restaurez la carte mémoire comme indiqué
dans « Restauration de cartes mémoire ».

Le témoin d’enregistrement/de
signalisation est configuré comme un
témoin de signalisation, l’état
d’enregistrement ne peut donc pas être
déterminé par le témoin.

Configurez le témoin d’enregistrement/de
signalisation pour fonctionner comme un
témoin d’enregistrement comme indiqué
dans « Connexion d’un signal tally ».
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Transfert de fichiers

Diffusion en continu IP

Symptôme Cause Solution

L’enregistrement audio est
impossible.

Aucun microphone n’est connecté.
Connectez un microphone ou un dispositif
audio au connecteur AUDIO IN sur le bloc
de connecteur.

Le réglage [Master Input Level] est réglé
sur la valeur minimale.

Ajustez [Master Input Level].

Le son enregistré est
déformé.

Le réglage du niveau d’entrée audio est
trop élevé.

Ajustez [CH1 Input Level] sur [CH4 Input
Level] et [Master Input Level].

Lors de l’utilisation d’un microphone dans
un environnement bruyant, tel qu’une salle
de concert, réglez d’abord [AUDIO IN CH1
MIC Ref.] et [AUDIO IN CH2 MIC Ref.].

L’enregistrement audio
présente un niveau sonore
élevé.

Le réglage du niveau d’entrée audio est
trop faible.

Ajustez les réglages [Audio Input Level] et
[Audio] > [Audio] > [Audio Input] > [AUDIO
IN CH1 MIC Ref.] ou [AUDIO IN CH2 MIC
Ref.].

Impossible de lire les plans.

Le plan est en cours de modification.

La lecture des plans est impossible si vous
avez modifié les noms de fichiers ou les
dossiers ou si le plan est en cours
d’utilisation sur un ordinateur. Il ne s’agit
pas d’un dysfonctionnement.

Le plan a été enregistré à l’aide d’une
caméra différente de cet appareil.

Il se peut que les plans enregistrés à l’aide
d’une caméra différente de cet appareil
soient illisibles ou s’affichent dans une taille
incorrecte. Il ne s’agit pas d’un
dysfonctionnement.

Symptôme Cause Solution

Échec de
téléchargement du
fichier.

Le nom d’utilisateur et le mot de
passe sur le serveur ne sont pas
corrects.

Il se peut que le nom d’utilisateur et le mot de passe
sur le serveur ne soient pas corrects. Saisissez les
entrées correctes.
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Symptôme Cause Solution

La diffusion en continu
n’est pas disponible.

Le nom d’utilisateur ou le mot de
passe saisi dans l’application
client pour visualiser la diffusion
en continu depuis l’appareil est
incorrect.

Si le format de la diffusion en continu de l’appareil est
réglé sur [RTSP], [SRT-Listener] ou [NDI|HX], il est
nécessaire de saisir le nom d’utilisateur et le mot de
passe définis pour cet appareil dans l’application
client. Saisissez le nom d’utilisateur et le mot de
passe corrects.

Le protocole de la diffusion en
continu n’est pas défini.

Sélectionnez le protocole cible à l’aide de [Stream] >
[Stream Setting] dans le menu Web.

Six sessions RTSP ou plus ont
été réglées.

Réglez le nombre de sessions à cinq ou moins.

Le numéro de port UDP n’est pas
réglé correctement.

Réglez le numéro de port et d’autres réglages pour le
protocole cible à l’aide de [Stream] > [Stream] >
[Stream Setting] dans le menu Web.

La communication UDP est
bloquée.

Vérifiez les réglages du logiciel de sécurité.

L’audio n’est pas diffusé. La diffusion en continu de la sortie
audio est réglée sur [Off].

Réglez [Stream] > [Audio Stream] > [Setting] sur [On]
dans le menu Web.

La diffusion en continu a
été déconnectée.

Le réglage du protocole ou les
réglages de codec de la diffusion
en continu ont été modifiés
pendant la diffusion en continu.

Réglez le réglage de protocole et les réglages de
codec de la diffusion en continu avant de démarrer la
diffusion en continu.

La taille d’image de
[Video Stream 1] ne peut
pas être réglée sur
4096×2160 ou
3840×2160.

La taille d’image est de
1920×1080 lorsque [Output
Format] est réglé sur HDMI.

La taille d’image pour la diffusion en continu ne peut
pas être supérieure à la taille d’image HDMI. Modifiez
la taille d’image HDMI à l’aide de [Monitoring] >
[Output Format] dans le menu Web.

La fréquence d’images
de [Video Stream 1] ne
peut pas être réglée sur
60 FPS ou 50 FPS.

La fréquence d’images de la
diffusion en continu est réglée sur
29.97 ou moins.

La fréquence d’images utilisée pour la diffusion en
continu est limitée par la fréquence de système.
Modifiez la fréquence du système à l’aide de [Rec
Format] > [Frequency] dans le menu Web.

Le flux [Video Stream 3]
est inaccessible.

[Video Stream 3] ne prend pas en
charge RTSP/SRT/NDI.

Utilisez [Video Stream 1] ou [Video Stream 2].

L’écran RTSP/SRT n’est
pas mis à jour/affiché
correctement.

Le numéro de port utilisé pour
RTSP ou SRT est filtré ou bloqué.

Modifiez le numéro de port RTSP ou SRT à un port
qui n’est pas filtré ou bloqué par les dispositifs
recevant le flux. Ou modifiez le numéro de port utilisé
pour RTSP ou SRT sur l’appareil.

L’image est déformée ou
saccadée.

L’information vidéo n’est pas
transmise correctement en raison
d’encombrement dans le chemin
de communication.

Réduisez le débit binaire de la diffusion en continu ou
réglez le codec [Video Stream 2] ([Codec 2]) sur [Off]
pour créer une marge entre les bandes de
communications.

L’ordre des paquets vidéo a
changé dans le canal de
communication.

Utilisez le même fournisseur de service Internet pour
l’appareil et le récepteur.
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Connexion avec des dispositifs externes

Synchronisation externe

Tally

Contrôleur d’objectif

Symptôme Cause Solution

Non détecté comme un
dispositif NDI.

Le protocole de la diffusion en
continu n’est pas réglé sur
NDI|HX.

Le protocole de la diffusion en continu doit être réglé
sur NDI|HX afin de détecter l’appareil comme un
dispositif NDI. Réglez [Stream] > [Stream Setting] sur
[NDI|HX] dans le menu Web.

Impossible à utiliser
comme un dispositif NDI.

Aucune licence NDI|HX n’est
installée.

Installez une licence NDI|HX. Vous pouvez vérifier
l’existence d’une licence NDI|HX à l’aide de [Stream]
> [Stream] > [Stream Setting] > [NDI|HX] > [License]
dans le menu Web.

Symptôme Cause Solution

Impossible de
synchroniser avec une
source externe.

Un signal de synchronisation externe
compatible au format du signal vidéo
configuré n’est pas émis.

Entrez un signal de synchronisation externe
compatible au format du signal vidéo.

L’appareil est à double terminaison.
L’appareil comporte un terminateur 75 Ω.
Connectez directement à la source du signal (un
à un) ou utilisez un distributeur (séparateur).

Symptôme Cause Solution

Le témoin de
signalisation ne
s’allume pas.

La luminosité du témoin de signalisation
est réglée sur Off.

Réglez la luminosité appropriée à l’aide de
[Technical] > [Tally] > [Tally Lamp Brightness] dans le
menu Web.

Le témoin d’enregistrement/de
signalisation est configuré comme un
témoin d’enregistrement.

Configurez le témoin d’enregistrement/de
signalisation pour qu’il fonctionne comme un témoin
de signalisation comme indiqué dans « Connexion
d’un signal tally ».

Le RM-IP500 est connecté et VISCA
over IP est désactivé.

Mettez le commutateur SETUP 3 sur la position ON
sur le bloc de connecteur de l’appareil.

La connexion du connecteur OPTION
est incorrecte ou la broche cible n’est
pas court-circuitée à la terre (GND).

Court-circuitez la broche 7 ou la broche 8 du
connecteur OPTION à la terre (GND) comme
indiqué dans « Connexion d’un signal tally ».

Symptôme Cause Solution

[Communication Error]
s’affiche dans  (État de
la caméra).

La caméra ne peut pas
communiquer avec le
contrôleur d’objectif.

Vérifiez la connexion entre l’appareil et le contrôleur
d’objectif, puis mettez l’appareil et le contrôleur d’objectif
sous tension de façon cyclique.
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Rubrique associée

Sortie d’un signal de fibre optique

Bloc de connecteur

Compensation de la respiration

Vérification des commutateurs d’objectif

Fixation d’un objectif

Réinitialisation de panoramique/inclinaison

P/T Range Limit

Restauration de cartes mémoire

Connexion d’un signal tally

5-041-957-23(1) Copyright 2022 Sony Corporation

Symptôme Cause Solution

[Rotation Error] s’affiche
dans  (État de la
caméra).

Une erreur de rotation
s’est produite dans le
contrôleur d’objectif.

La plage de mouvement du zoom mémorisée et la plage de
mouvement de l’objectif peuvent ne pas correspondre.
Initialisez le contrôleur d’objectif.
Si le problème persiste, contactez le représentant du
fabricant du contrôleur d’objectif.

[System Error] s’affiche
dans  (État de la
caméra).

Une erreur de système
s’est produite dans le
contrôleur d’objectif.

Vérifiez la connexion entre l’appareil et le contrôleur
d’objectif, consultez le mode d’emploi du contrôleur d’objectif
et initialisez le contrôleur d’objectif, ou mettez l’appareil et le
contrôleur d’objectif sous tension de façon cyclique.
Si le problème persiste, contactez le représentant du
fabricant du contrôleur d’objectif.

[Unknown Error] s’affiche
dans  (État de la
caméra).

Une erreur inconnue
s’est produite dans le
contrôleur d’objectif.

Vérifiez la connexion entre l’appareil et le contrôleur
d’objectif, consultez le mode d’emploi du contrôleur d’objectif
et initialisez le contrôleur d’objectif, ou mettez l’appareil et le
contrôleur d’objectif sous tension de façon cyclique.
Si le problème persiste, contactez le représentant du
fabricant du contrôleur d’objectif.
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Manuel d’aide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Avertissements de fonctionnement

Si un avertissement, une précaution ou une opération nécessitant une confirmation survient sur l’appareil, un message
s’affichera dans le panneau d’image de la caméra, et le témoin POWER et le témoin NETWORK sur le panneau avant
ainsi que le témoin d’enregistrement/de signalisation commenceront à clignoter.

Note

L’indication clignotante du témoin d’enregistrement/tally est activée uniquement lorsque [Technical] > [Tally] > [Tally Control] est
réglé sur [Internal] et [Tally Lamp Brightness] n’est pas réglé sur [Off] dans le menu Web ou le menu de la caméra.

Messages d’erreur

Si le témoin POWER et le témoin NETWORK clignotent comme indiqué ci-dessous, prenez les mesures suivantes.

L’appareil arrêtera l’opération si l’écran suivant s’affiche.

Messages d’avertissement

Suivez les instructions fournies si l’écran suivant s’affiche.

Témoin
POWER

Témoin
NETWORK Cause et solution

Clignotement
orange lent

Clignotement
vert lent

L’appareil fonctionne normalement. Pour plus de détails, consultez
[Maintenance] > [System Log] dans le menu Web. Si le problème persiste même
après avoir mis l’appareil en mode veille ou après l’avoir mis hors tension puis à
nouveau sous tension, contactez votre technicien Sony.

Clignotement
orange rapide

Clignotement
vert rapide

Un dysfonctionnement est survenu dans l’appareil. Contactez votre technicien
Sony.

Message
affiché

Témoin
d’enregistrement/de

signalisation
Cause et solution

E + code
d’erreur Clignotement très rapide

Indique une anomalie dans l’appareil. L’enregistrement s’arrête, même
lorsque ●REC est affiché dans le panneau d’image de la caméra.
Mettez l’appareil hors tension, et vérifiez si vous détectez un problème au
niveau des dispositifs, des câbles ou du support raccordés. Si l’erreur
persiste après avoir remis l’appareil sous tension, contactez votre technicien
Sony. Il se peut qu’aucun affichage d’erreur ni aucune alerte sonore
d’avertissement ne survienne selon l’état de l’appareil.
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Message affiché Témoin d’enregistrement/de
signalisation Cause et solution

Temperature High Clignotement
La température interne est élevée.
Mettez le caméscope hors tension et laissez-le refroidir avant de
le faire fonctionner à nouveau.

Media
Temperature High

Clignotement
La température de la carte CFexpress est élevée.
Remplacez la carte ou et laissez-la refroidir avant de l’utiliser à
nouveau.

Voltage Low Clignotement La tension DC IN est faible (niveau 1). Vérifiez la source
d’alimentation.

Insufficient
Voltage

Clignotement très rapide
La tension DC IN est trop faible (niveau 2). L’enregistrement est
désactivé.
Raccordez une source d’alimentation différente.

Media Near Full Clignotement
La capacité restante de la carte mémoire est faible.
Remplacez-la dès que possible.

Media Full Clignotement très rapide
Les plans n’ont pas pu être enregistrés ni copiés car la capacité
restante de la carte mémoire n’est pas suffisante.
Remplacez-la immédiatement.

Clips Near Full Clignotement
Le nombre de plans supplémentaires pouvant être enregistrés
sur la carte mémoire diminue.
Remplacez-la dès que possible.

Clips Full Clignotement très rapide

Le nombre maximal de plans pouvant être enregistrés sur la
carte mémoire a été atteint.
L’enregistrement ou la copie de plus de plans est impossible.
Remplacez-la immédiatement.

Last Clip
Recording

Clignotement

Le plan en cours d’enregistrement est le dernier plan qui peut
être enregistré, étant donné que le nombre maximum de plans a
été atteint.
Préparez une nouvelle carte mémoire.

Media(A) Life
Near End1) Clignotement La carte mémoire approche de la fin de sa durée de vie.

Remplacez-la dès que possible.

Media(A) Life
End1) Clignotement très rapide

La carte mémoire a atteint la fin de sa durée de vie. Remplacez-
la immédiatement.

Media(A) Near
Full1) Clignotement Lorsque vous utilisez la fonction Simul Rec

Media(A) Full1) Clignotement très rapide Lorsque vous utilisez la fonction Simul Rec

Media(A) Clips
Near Full1) Clignotement Lorsque vous utilisez la fonction Simul Rec

Media(A) Clips
Full1) Clignotement très rapide Lorsque vous utilisez la fonction Simul Rec

Media(A) Last
Clip Rec1) Clignotement Lorsque vous utilisez la fonction Simul Rec
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Messages de précaution et d’opération

Les messages de précaution et d’opération suivants peuvent apparaître au centre de l’écran. Suivez les instructions
fournies pour résoudre le problème.

Message affiché Témoin d’enregistrement/de
signalisation Cause et solution

(Pas d’affichage) Clignotement

Une erreur inconnue s’est produite dans le contrôleur d’objectif.
Vérifiez l’état dans l’état de la caméra dans l’application Web.
Pour obtenir des informations détaillées, vérifiez le journal du
système dans l’application Web.

« (B) » s’affiche pour la carte située dans le logement B.1)

Message du viseur Cause et solution

Backup Battery End
Please Change

La capacité restante de la batterie de secours est insuffisante.
Connectez l’appareil à une source d’alimentation électrique pendant au
moins 24 heures pour charger la batterie de secours.

Unknown Media(A)1)

Please Change

Une carte mémoire qui a été divisée en plusieurs parts ou une carte
mémoire contenant plus de plans que ceux permis pour la manipulation de
l’appareil a été insérée.
La carte ne peut pas être utilisée dans l’appareil et doit être remplacée.

Cannot Use Media(A)1)

Unsupported File System

Une carte utilisant un système de fichiers différent ou une carte non
formatée a été insérée.
La carte ne peut pas être utilisée dans l’appareil et doit être remplacée ou
formatée à l’aide de l’appareil.

Media Error
Media(A) Needs to be Restored1)

Une erreur s’est produite avec la carte mémoire et la carte doit être
restaurée.
Restaurez la carte mémoire.

Media Error
Cannot Record to Media(A)1)

La carte mémoire peut être endommagée et ne peut plus être utilisée pour
l’enregistrement.
La lecture est possible, il est donc recommandé d’effectuer une copie et de
remplacer la carte mémoire.

Media Error
Cannot Use Media(A)1)

La carte mémoire peut être endommagée et ne peut plus être utilisée pour
l’enregistrement ou la lecture.
La carte ne peut pas être utilisée dans l’appareil et doit être remplacée.

Media(A) Error1)

Recording Halted
Playback Halted

L’enregistrement et la lecture se sont arrêtés parce qu’une erreur s’est
produite pendant l’utilisation de la carte mémoire.
Si le problème persiste, remplacez la carte mémoire.

Media Reached Rewriting Limit
Change Media(A)1)

La carte mémoire a atteint la fin de sa durée de vie.
Effectuez une copie de sauvegarde et remplacez la carte immédiatement.
Si vous continuez à utiliser la carte, la carte risque de ne plus pouvoir
enregistrer ou lire.
Pour plus de détails, reportez-vous au mode d’emploi de la carte mémoire.

The specified address is invalid.
L’adresse spécifiée est invalide.
Vérifiez que le réglage est correct.

Cannot Use Specified Port Number
Le numéro de port spécifié est invalide.
Vérifiez que le réglage est correct.
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Informations sur les erreurs de diffusion en continu RTMP

Les informations d’erreur suivantes peuvent s’afficher sur l’appareil. Effectuez les opérations suivantes si nécessaire.

Informations sur les erreurs de diffusion en continu SRT

Les informations d’erreur suivantes peuvent s’afficher sur l’appareil. Effectuez les opérations suivantes si nécessaire.

Message du viseur Cause et solution

Lens I/F Error(xx:xx)

Une erreur d’objectif a été détectée dans la communication I/F de l’objectif
lors de la fixation d’un objectif à monture E.
Vérifiez l’état du raccordement à l’objectif à monture E.
Si le problème persiste, contactez votre technicien Sony en vous
munissant du code d’erreur (cinq caractères entre parenthèses).

Cannot add auto upload job of Proxy file
because maximum number of upload
jobs was reached.

Le nombre maximum de tâches de transfert a été atteint.
Effacez toute tâche non désirée. Il est possible que le réglage de
destination de téléchargement automatique pour les fichiers proxy soit
également incorrect. Vérifiez que le réglage est correct.

Fan Stopped

Le ventilateur a arrêté de fonctionner.
Vérifiez l’absence de poussière ou de corps étrangers.
Si l’erreur persiste après avoir nettoyé la poussière ou dégagé les corps
étrangers, contactez votre technicien Sony.

« (B) » s’affiche pour la carte située dans le logement B.1)

Code d’erreur
Description Solution

RTMP RTMPS

1002
1004

2002
2004

Impossible de se connecter au
serveur RTMP.

Vérifiez que le réglage URL du serveur est correct.
Vérifiez le raccordement au réseau.

1003 2003
Impossible de résoudre le nom de
domaine.

Vérifiez que le réglage URL du serveur est correct.
Vérifiez la connexion au serveur DNS.

–
2005
2008

Erreur CRL
Vérifiez que le réglage URL du serveur est correct.
Vérifiez que la destination de la connexion est un site de
confiance.

2006 Erreur de certificat CA
Vérifiez que le réglage de l’horloge est correct.
Vérifiez que le certificat CA est correct.

– 2007
Aucun certificat CA n’est installé.
Erreur d’authentification du
certificat du serveur.

Installez un certificat CA.
Vérifiez que la destination de la connexion est un site de
confiance.

4002
La session RTMP a été
déconnectée.

L’appareil peut avoir été déconnecté côté serveur RTMP.
Vérifiez que les réglages correspondent au paramètre du
codec recommandé pour le service.

4003
La qualité de la connexion au
réseau est faible.

Vérifiez le raccordement au réseau.

Autre Autres erreurs.
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Code
d’erreur Description Solution

SRT-Caller

1001 Erreur inattendue
L’appareil peut ne pas fonctionner normalement. Mettez
l’appareil sous tension de façon cyclique.

1002
Communication déconnectée en raison
d’un changement de réglages

La communication a été déconnectée parce que les
réglages ont été changés.
Rétablissez la connexion.

5001 Erreur inattendue L’appareil peut ne pas fonctionner normalement. Mettez
l’appareil sous tension de façon cyclique.

5005 Échec de la connexion
Vérifiez que le réglage de destination de la connexion est
correct.

5006 Erreur de cryptage Vérifiez que le réglage de cryptage est correct.

5007 Erreur inattendue L’appareil peut ne pas fonctionner normalement. Mettez
l’appareil sous tension de façon cyclique.5008 Erreur inattendue

5009 Défaut de transmission
L’appareil a été déconnecté pendant la communication.
Vérifiez le raccordement au réseau.
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Liste des éléments de menu

Les tableaux suivants détaillent les éléments de menu de l’appareil.

Légende
« Menu de la caméra » et « menu Web »
● : disponible
▲ : certains éléments sont disponibles
– : non disponible

« All File » et « Scene File »
Oui : élément enregistré dans un fichier ALL ou un fichier de scène
Non : élément non enregistré

« All Reset (except for Network Settings) »
Lorsque [Reset]> [Reset] > [All Reset (except for Network Settings)] dans le menu Web est exécuté :
Oui : élément initialisé (sauf pour les réglages réseaux)
Non : non concerné

« Network Reset »
Lorsque [Reset]> [Reset] > [Network Reset] dans le menu Web est exécuté :
Oui : élément initialisé (réglages réseaux)
Non : non concerné

« Factory Default »
Oui : élément réinitialisé aux valeurs par défaut
Non : non concerné

Shooting

Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – Oui Oui Oui Oui Oui

ND Filter ● – Oui Oui*1 Oui Non Oui

Shutter ● – Oui Oui Oui Non Oui

Iris ● – Oui Oui Oui Non Oui

Auto Exposure ● – Oui Oui*2 Oui Non Oui

White ● – Oui Oui*3 Oui Non Oui

White Setting ● – Oui Non Oui Non Oui

Offset White ● – Oui Non Oui Non Oui

Focus ● ▲ Oui Non Oui Non Oui

S&Q Motion ● – Oui Non Oui Non Oui
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Project

Paint/Look

Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

LUT On/Off ● – Oui Non Oui Non Oui

Noise
Suppression

● – Oui Oui Oui Non Oui

Flicker Reduce ● – Oui Non Oui Non Oui

SteadyShot ● – Oui Non Oui Non Oui

[Mode] non concerné*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] non concerné*2

[Preset White] non concerné*3

Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Base Setting ● ● Oui Non Oui Non Oui

Rec Format ● ● Oui Non Oui*1 Non Oui

Cine
EI/Flex.ISO Set

● – Oui Non Oui Non Oui

Simul Rec ● ● Oui Non Oui Non Oui

Proxy Rec ● ▲ Oui Non Oui Non Oui

Interval Rec ● ● Oui*2 Non Oui Non Oui

Picture Cache
Rec

● ● Oui*2 Non Oui Non Oui

SDI/HDMI Rec
Control

● – Oui Non Oui Non Oui

Assignable
Button

● – Oui Non Oui Non Oui

All File – ● Non Non Non Non Non

[Frequency] non concerné*1

[Setting] non concerné*2

Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Scene File ● – Non Non Non Non Non

Base Look ● ▲ Oui*1 Non Oui*1 Non Oui*1

Reset Paint
Settings

● – Non Non Non Non Non
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Pan-Tilt

TC/Media

Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Black ● – Oui Oui Oui Non Oui

Knee ● – Oui Oui Oui Non Oui

Detail ● – Oui Non Oui Non Oui

Matrix ● – Oui Oui Oui Non Oui

Multi Matrix ● – Oui*2 Oui*2 Oui Non Oui

Données LUT importées en tant qu’apparence de base non concernées*1

[Axis] non concerné*2

Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

P/T Speed – ● Non Non Oui Non Non

P/T
Acceleration

● ● Non Non Oui Non Non

P/T Range
Limit

– ● Non Non Oui Non Non

P/T Direction – ● Non Non Oui Non Non

P/T Preset – ● Non Non Oui Non Non

Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Timecode ● – Oui*1 Non Oui Non Oui

TC Display ● – Oui Non Oui Non Oui

Users Bit ● – Oui*1 Non Oui Non Oui

HDMI TC Out ● – Oui Non Oui Non Oui

Clip Name
Format

● – *2 Non Oui Non Oui

Update
Media

● – Non Non Non Non Non

Format Media ● – Non Non Non Non Non

Media Life ● – Non Non Non Non Non

[Setting] non concerné*1

[Auto Naming] concerné, [Camera ID] non concerné*2
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Monitoring

Audio

Thumbnail

Technical

Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Output Format ● ● Oui Non Oui Non Oui

Output
Display

– ● Oui Non Oui Non Oui

Display On/Off ● – Oui Non Oui Non Oui

Video Signal
Monitor ● – Oui Non Oui Non Oui

Marker ● – Oui Non Oui Non Oui

Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio
Input

● ▲ Oui Non Oui Non Oui

Audio
Output

● ▲ Oui Non Oui Non Oui

Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Display Clip
Properties ● – Non Non Non Non Non

Set Clip Flag ● – Non Non Non Non Non

Lock/Unlock Clip ● – Non Non Non Non Non

Delete Clip ● – Non Non Non Non Non

Transfer Clip ● – Non Non Non Non Non

Transfer Clip
(Proxy)

● – Non Non Non Non Non

Filter Clips ● – Non Non Non Non Non

Customize View ● – Oui Non Oui Non Oui
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Network

Stream

Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Color
Bars

● – *1 Non *1 Non Oui

Genlock ● – Non Non Non Non Non

Tally ● ● Oui Non Oui Non Oui

Rec
Review

● – Oui Non Oui Non Oui

Zoom ● – Oui Non Oui Non Oui

IR
Remote

– ● Non Non Oui Non Oui

Lens ● – Oui Non Oui Non Oui

APR ● – Non Non Non Non Non

[Type] concerné, [Setting] non concerné*1

Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Camera Name – ● Non Non Non Non Oui

User – ● Non Non Non Oui Oui

Wired LAN*1 ▲ ● Non Non Non Oui Non

File Transfer ● ▲ Oui Non Oui Oui Oui

FTP Server 1 – ● Non Non Oui Non Oui

FTP Server 2 – ● Non Non Oui Non Oui

FTP Server 3 – ● Non Non Oui Non Oui

SSL – ● Non Non Non Oui Oui

Referer Check – ● Non Non Non Oui Oui

Brute Force
Attack Protection

– ● Non Non Non Oui Oui

Non configurable à l’aide du menu de la caméra (affichage uniquement)*1

Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Stream
Setting

– ● Non Non Oui*1 Non Oui*1
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Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Video
Stream

– ● Oui Non Oui Non Oui

Audio
Stream

– ● Oui Non Oui Non Oui

[NDI|HX] > [License] non applicable*1

Élément
(niveau 2)

Menu de la
caméra

Menu
Web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Language ● ● Oui Non Oui Non Oui

Accessibility – ● Oui Non Non Non Oui

Clock Set ● ● Oui*1 Non Oui*2 Non Oui

Reset – ● Non Non Non Non Non

Hours Meter ● – Non Non Non Non Non

Information – ● Non Non Non Non Non

System Log – ● Non Non Non Non Oui

HTTP Access
Log

– ● Non Non Non Non Oui

Service – ● Non Non Non Non Non

EULA – ● Non Non Non Non Non

Software – ● Non Non Non Non Non

Informations de date et d’heure non concernées*1

[Time Zone], informations de date et d’heure non concernées*2
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Éléments enregistrés avec une position prédéfinie

« Oui » indique un réglage qui est enregistré pour la position prédéfinie, et « Non » indique un réglage qui n’est pas
enregistré.

Éléments de panoramique/inclinaison

Éléments du zoom

Éléments de la mise au point

Emplacement d’affichage Élément Cible
enregistrée

Panneau de commande du cadrage de l’écran
d’opération en direct

Position de panoramique/inclinaison Oui

[Pan-Tilt Speed] Non

[Pan-Tilt] dans le menu Web

[P/T Speed] Non

[P/T Acceleration] Non

[P/T Range Limit] Non

[P/T Direction] Non

[P/T Preset] > [Pan-Tilt] Non

[P/T Preset] > [Default] > [Pan-Tilt
Speed] Oui1)

Les valeurs des réglages lors de la sauvegarde d’une position prédéfinie sont sauvegardées comme valeurs de cette position prédéfinie. Une
fois les valeurs sauvegardées, elles peuvent être modifiées pour chaque position prédéfinie. Pour plus de détails, consultez « Modification de la
vitesse de transition (panoramique-inclinaison/zoom/mise au point) des positions prédéfinies à l’aide de l’application Web ».

1)

Emplacement d’affichage Élément Cible
enregistrée

Panneau de commande du cadrage de l’écran
d’opération en direct

Position du zoom (distance de mise
au point)

Oui

[Zoom Speed] Non

[Pan-Tilt] > [P/T Preset] > [Default] dans le menu Web
[Zoom Sync] Oui1)

[Zoom Speed] Oui1)

[Technical] > [Zoom] dans le menu de la caméra [Zoom Type] Non

Les valeurs des réglages lors de la sauvegarde d’une position prédéfinie sont sauvegardées comme valeurs de cette position prédéfinie. Une
fois les valeurs sauvegardées, elles peuvent être modifiées pour chaque position prédéfinie. Pour plus de détails, consultez « Modification de la
vitesse de transition (panoramique-inclinaison/zoom/mise au point) des positions prédéfinies à l’aide de l’application Web ».

1)
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Rubrique associée
Modification de la vitesse de transition (panoramique-inclinaison/zoom/mise au point) lors de la restauration d’une
position prédéfinie

5-041-957-23(1) Copyright 2022 Sony Corporation

Emplacement d’affichage Élément Cible
enregistrée

Panneau d’image de la caméra de l’écran
d’opération en direct

Cible de suivi spécifiée pour l’AF de suivi en temps
réel

Non

Coordonnées spécifiées pour la mise au point sur un
point

Non

Onglet  (Focus) de l’écran d’opération
en direct

Commutateur [Touch Focus] Non

Commutateur [Auto Focus] Oui

État de la touche [Focus Hold] Non

État de la touche [Push AF/MF] Non

[Face/Eye Detection AF] Oui

[AF Subj. Shift Sens.] Oui

[AF Transition Speed] Oui

Position de mise au point Oui1)

[Shooting] > [Focus] dans le menu Web

[Push AF Mode] (y compris les réglages utilisant des
touches personnalisables)

Non

[Touch Function in MF] Non

[AF Assist Control] Non

[Pan-Tilt] > [P/T Preset] > [Default] dans le
menu Web

[Focus Recall] Oui2)

[MF Speed] Oui2)

[Shooting] > [Focus] dans le menu de la
caméra

Position et taille de la zone de mise au point réglées à
l’aide de [Focus Area]

Oui

Position de la zone de mise au point réglée à l’aide de
[Focus Area (AF-S)]

Oui

Pas restaurée lorsque le commutateur [Auto Focus] est réglé sur la position On. Restaurée lors d’un réglage sur Off.1)

Les valeurs des réglages lors de la sauvegarde d’une position prédéfinie sont sauvegardées comme valeurs de cette position prédéfinie. Une
fois les valeurs sauvegardées, elles peuvent être modifiées pour chaque position prédéfinie. Pour plus de détails, consultez « Modification de la
vitesse de transition (panoramique-inclinaison/zoom/mise au point) lors de la restauration d’une position prédéfinie ».

2)
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Diagrammes bloc

Audio Input

Audio Output

5-041-957-23(1) Copyright 2022 Sony Corporation
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Mise à jour du logiciel de l’objectif à monture E

Vous pouvez mettre à jour le logiciel d’un objectif à monture E en utilisant l’appareil.
Consultez le site Web pour connaître les objectifs qui peuvent être mis à jour, ainsi que le logiciel correspondant.
Le logiciel est mis à jour en utilisant le menu Web.

Note

N’effectuez pas les opérations suivantes tant que la mise à jour n’est pas terminée.

Déconnexion du réseau
Retrait d’un objectif
Mise hors tension

Si un message indiquant que la mise à jour a échoué s’affiche, vérifiez la description affichée et réessayez de mettre à jour.

5-041-957-23(1) Copyright 2022 Sony Corporation

Fixez un objectif à monture E sur l’appareil.1

Vérifiez [Maintenance] > [Information] > [Lens] > [Model Name] et [Version Number] dans le menu Web.

Le numéro de version du logiciel de l’objectif à monture E est affiché sur le côté.
Vérifiez le numéro de la version du logiciel et ensuite mettez à jour le logiciel si nécessaire.

2

Téléchargez le fichier de mise à jour du logiciel de l’objectif pour Windows (extension .exe) sur le dispositif
exécutant l’application Web.

3

Dans [Maintenance] > [Information] > [Lens] > [Version Up], appuyez sur la touche [Choose File] et
sélectionnez le fichier de mise à jour téléchargé.

4

Suivez les instructions qui s’affichent à l’écran.5
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Fixation du cache du bouton de déblocage de l’objectif

Vous pouvez éviter un retrait involontaire de l’objectif en fixant le cache du bouton de déblocage de l’objectif fourni avec
le support de plafond (option) CIB-PCM1 au bouton de déblocage de l’objectif.

Note

Ceci n’empêche pas l’objectif d’être complètement retiré.

Rubrique associée

Fixation d’un objectif

5-041-957-23(1) Copyright 2022 Sony Corporation

Fixez un objectif.

Pour plus de détails sur la fixation d’un objectif, consultez « Fixation d’un objectif ».

1

Faites glisser le levier de verrouillage de panoramique/inclinaison en position LOCK pour verrouiller le
panoramique/inclinaison de la tête de caméra.

2

Déplacez le bloc de caméra sur une position permettant de fixer le cache d’éjection d’objectif.3

Fixez le cache d’éjection d’objectif de façon à ce qu’il recouvre le bouton de déblocage de l’objectif.4

Sécurisez le cache d’éjection d’objectif à l’aide de la vis de retenue du cache d’éjection d’objectif.5
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Licences

Licence MPEG-4 AVC Patent Portfolio

CE PRODUIT EST SOUS LICENCE AVC PATENT PORTFOLIO POUR L’UTILISATION PERSONNELLE DU
CONSOMMATEUR OU TOUT AUTRE UTILISATION N’IMPLIQUANT PAS DE REMUNERATION
(i) ENCODAGE VIDEO EN CONFORMITÉ AVEC LE STANDARD AVC (« AVC VIDEO ») ET/OU
(ii) DÉCODAGE VIDEO AVC ENCODÉ PAR UN CONSOMMATEUR ENGAGÉ DANS UNE ACTIVITÉ PERSONNELLE
ET/OU OBTENU D’UN FOURNISSEUR VIDEO AYANT LA LICENCE DE DISTRIBUTION AVC VIDEO.
AUCUNE LICENCE N’EST ATTRIBUEE OU NE DOIT ETRE DESTINEE POUR TOUT AUTRE USAGE. DES
INFORMATIONS SUPPLEMENTAIRES PEUVENT ETRE OBTENUES DE MPEG LA, L.L.C. VOIR
HTTP://WWW.MPEGLA.COM

Obtention d’un logiciel sous licence GPL/LGPL

Ce produit utilise le logiciel auquel s’applique la licence GPL/LGPL. Ceci vous informe que vous disposez d’un droit
d’accès, de modification et de redistribution du code source de ces logiciels dans les conditions de la GPL/LGPL.
Le code source est disponible sur Internet. Reportez-vous à l’adresse URL suivante et suivez les instructions de
téléchargement.
https://oss.sony.net/Products/Linux/
Nous préférerions que vous ne nous contactiez pas au sujet du contenu du code source.

Code source μT-Kernel

Ce produit utilise le code source μT-Kernel sous licence T-Licence 2.1 attribuée par TRON Forum (www.tron.org).

5-041-957-23(1) Copyright 2022 Sony Corporation
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Caractéristiques techniques

Généralités

Poids
Environ 4,6 kg (10 lb 2,3 oz) (boîtier uniquement)
Environ 6,0 kg (13 lb 3,6 oz) (y compris l’objectif SELP28135G)

Dimensions
Consultez « Dimensions externes ».

Besoins en alimentation
19,5 V CC
PoE++ (conforme à la norme IEEE802.3bt, Type 4, Classe 8)

Consommation électrique
19,5 V CC : 80,0 W (max.)
PoE++ : 71,3 W (max.)　

Température de fonctionnement
0 °C à 40 °C (32 °F à 104 °F)

Température de stockage
−20 °C à +60 °C (−4 °F à +140 °F)

Format d’enregistrement (vidéo)
XAVC Intra
Mode XAVC-I 4K/QFHD : VBR, débit binaire 600 Mbps (max.), MPEG-4 AVC/H.264
Mode XAVC-I HD : CBG, 223 Mbps (max.), MPEG-4 AVC/H.264

XAVC Long
Mode XAVC-L QFHD : VBR, débit binaire 150 Mbps (max.), MPEG-4 H.264/AVC
Mode XAVC-L HD 50 : VBR, 50 Mbps (max.), MPEG-4 H.264/AVC
Mode XAVC-L HD 35 : VBR, 35 Mbps (max.), MPEG-4 H.264/AVC

Format d’enregistrement (audio)
LPCM 24 bits, 48 kHz, 4 canaux

Fréquence d’enregistrement élevée

XAVC Intra
Mode XAVC-I 4K : 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
Mode XAVC-I QFHD : 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Mode XAVC-I HD : 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
Mode XAVC-L QFHD 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Mode XAVC-L HD 50 : 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

506



Mode XAVC-L HD 35 : 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Durées d’enregistrement/de lecture
XAVC Intra
Mode XAVC-I QFHD : 59.94P, environ 30 minutes (avec CEA-G160T)
Mode XAVC-I HD : 59.94P, environ 78 minutes (avec CEA-G160T)

XAVC Long
Mode XAVC-L QFHD : 59.94P, environ 115 minutes (avec CEA-G160T)
Mode XAVC-L HD 50 : 59.94P, environ 155 minutes (avec CEA-G80T)
Mode XAVC-L HD 35 : 59.94P, environ 210 minutes (avec CEA-G80T)

Note

La durée d’enregistrement/lecture peut varier en fonction des conditions d’utilisation et des caractéristiques de mémoire. Les
durées d’enregistrement et de lecture concernent un enregistrement continu en tant que plan unique. Les durées réelles peuvent
être plus courtes selon le nombre de plans enregistrés.

Section d’entraînement panoramique/inclinaison

Vitesse de panoramique minimale : 0,02 deg./s
Vitesse d’inclinaison minimale : 0,02 deg./s
Vitesse de panoramique maximale : 60 deg./s
Vitesse d’inclinaison maximale : 60 deg./s
Plage de panoramique : −170 deg. à +170 deg.
Plage de d’inclinaison : −30 deg. à +195 deg.
Critère d’évaluation du bruit : NC35 ou moins
Positions prédéfinies : 100

Section de caméra

Imageur
Plein format 35 mm (35,6 × 23,8 mm), capteur Exmor R CMOS

Nombre de pixels
Environ 12,9 mégapixels (nombre total de pixels)
Environ 10,3 mégapixels (nombre de pixels effectifs)

Auto focus
Méthode de détection : détection de phase/détection de contraste

Filtres ND internes
CLEAR : OFF
1 : 1/4ND
2 : 1/16ND
3 : 1/64ND
ND variable linéairement : 1/4ND à 1/128ND

Sensibilité ISO
ISO 800/12800 (mode Cine EI, source lumineuse D55)

Monture d’objectif
Monture E

Latitude
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15+ arrêt

Vitesse d’obturateur
64F à 1/8000 sec (23.98P)

Angle d’obturateur
5,6° à 360°, 2 à 64 images

Ralenti et accéléré
XAVC QFHD : 1 fps à 120 fps
XAVC HD : 1 fps à 240 fps
XAVC 4K : 1 fps à 60 fps
XAVC HD (S35) : 1 fps à 120 fps

Equilibre des blancs
2000 K à 15000 K

Gain
−3 dB à +30 dB (incréments de 1 dB)

Base look
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Section audio

Fréquence d’échantillonnage
48 kHz

Quantification
24 bits

Réponse de fréquence
Mode MIC entrée XLR : 20 Hz à 20 kHz (±3 dB ou moins)
Mode LINE entrée XLR : 20 Hz à 20 kHz (±3 dB ou moins)

Plage dynamique
Mode MIC entrée XLR : 80 dB (typique)
Mode LINE entrée XLR : 90 dB (typique)

Distorsion
Mode MIC entrée XLR : 0,08% ou moins (niveau d’entrée −40 dBu)
Mode LINE entrée XLR : 0,08% ou moins (niveau d’entrée +14 dBu)

Section d’entrée/sortie

Entrées
DC IN

Conforme à la norme EIAJ, 19,5 V CC

AUDIO IN

Type XLR, 5 broches, femelle
Commutable LINE / MIC / MIC+48V
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MIC : référence −30 dBu à −80 dBu

GENLOCK IN

Connecteur BNC, 1,0 Vp-p, 75 Ω

TC IN

Connecteur BNC

Sorties
SDI OUT

Connecteur BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Connecteur type A

Connecteur de sortie OPTICAL

Conforme à SFP+
* L’appareil ne prend pas en charge l’entrée de signal optique.

Entrée/sortie
Connecteur LAN

RJ-45, 1000BASE-T

Connecteur OPTION

Connecteur d’entrée/de sortie de signalisation RJ-45

Section du logement de support

Logement de carte CFexpress Type A / SD (2)

Éléments fournis

Adaptateur CA (1)
Cordon d’alimentation (1)
Télécommande infrarouge (1)
Cache de boîtier (1) (fixé à l’appareil)
Plaque de retenue du câble HDMI (1)
Avant d’utiliser cet appareil (1)
Livret de garantie (1)

Dimensions externes

Les dimensions sont des valeurs approximatives.
Unité : mm (po.)

Boîtier de la caméra
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Support de plafond
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La conception et les caractéristiques techniques sont sujettes à modification sans préavis.

5-041-957-23(1) Copyright 2022 Sony Corporation
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Marques commerciales

 est une marque commerciale de Sony Group Corporation.
XAVC et  sont des marques déposées de Sony Group Corporation.
Les termes HDMI et High-Definition Multimedia Interface ainsi que le logo HDMI sont des marques commerciales ou
des marques déposées de HDMI Licensing Administrator, Inc. aux États-Unis et dans d’autres pays.
Microsoft et Windows sont des marques déposées ou des marques enregistrées de Microsoft Corporation aux États-
Unis et/ou dans d’autres pays.
Mac et macOS sont des marques déposées d’Apple Inc. aux États-Unis et dans d’autres pays.
Le logo « Catalyst Browse » est une marque commerciale ou une marque déposée de Sony Group Corporation.
IOS est une marque commerciale ou une marque déposée de Cisco aux États-Unis et dans d’autres pays et est
utilisé sous licence.
iPadOS, Safari et iPad sont des marques commerciales d’Apple Inc., déposées aux États-Unis et dans d’autres pays
et régions.
Android et Google Chrome sont des marques commerciales ou des marques déposées de Google LLC.
Wi-Fi est une marque déposée de Wi-Fi Alliance.
Le logo SDXC est une marque commerciale de SD-3C, LLC.
CFexpress et le logo CFexpress Type A sont des marques commerciales de CompactFlash Association.
NewTek™ et NDI® sont des marques commerciales ou des marques déposées de NewTek, Inc.
JavaScript est une marque déposée d’Oracle et/ou ses sociétés affiliées.
Intel, le logo Intel et Intel Core sont des marques commerciales d’Intel Corporation ou de ses filiales.
QR Code est une marque commerciale de Denso Wave Inc.
Tous les autres noms d’entreprises ou de produits sont des marques commerciales ou des marques déposées de
leurs détenteurs respectifs. Les éléments de marques commerciales ne sont pas indiqués par les symboles ™ ou ®
dans ce document.

5-041-957-23(1) Copyright 2022 Sony Corporation
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